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TÜRKMENISTANYŇ
DÖWLET SENASY

Janym gurban saňa, erkana ýurdum,
Mert pederleň ruhy bardyr köňülde.
Bitarap, garaşsyz topragyň nurdur,
Baýdagyň belentdir dünýäň öňünde.

Gaýtalama:
Halkyň guran Baky beýik binasy,
Berkarar döwletim, jigerim-janym.
Başlaryň täji sen, diller senasy,
Dünýä dursun, sen dur, Türkmenistanym!

Gardaşdyr tireler, amandyr iller,
Owal-ahyr birdir biziň ganymyz.
Harasatlar almaz, syndyrmaz siller,
Nesiller döş gerip gorar şanymyz.

Gaýtalama:
Halkyň guran Baky beýik binasy,
Berkarar döwletim, jigerim-janym.
Başlaryň täji sen, diller senasy,
Dünýä dursun, sen dur, Türkmenistanym!
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Giriş

Kompýuter tehnologiýasy iň ýaş ugurlaryň biridir. Kompýuter 
tehnologiýasynyň ösüş taryhy beýle bir uly bolman ol 40-50 ýyla 
deňdir. Kompýuter tehnologiýasy, tehnikasy diýen adalgalar bolsa on­
dan hem ýaşdyr. Bilşimiz ýaly, ilkibaşda elektron-hasaplaýyş maşyn, 
hasaplaýyş tehnikasy diýen adalgalar ulanylýardy. 20 ýyldan bäri bol­
sa EHM diýlen adalga ýuwaş-ýuwaşdan ýitip kompýuter adalgasyna 
öz ornuny berdi, hasaplaýyş tehnikasy adalgasy bolsa öňküler ýaly 
hasaplaýyş däl‑de kompýuter tehnikasy diýlip atlandyrylýar.

Kompýuter tehnologiýasy dünýäde öňdebaryjy ugurlaryň bi­
ridir. Häzirki wagtda habarlar-aragatnaşyk tehnologiýalary ýokary 
depginler bilen ösýär. Öýjükli telefon aragatnaşygynyň, maglumat 
tehnologiýalarynyň ösmegi munuň şaýadydyr. Şol tehnologiýalaryň 
düzümi öwrenilende olaryň kompýuter ugruna esaslanýandygyna göz 
ýetirmek bolýar.

Öz gezeginde, kompýuterlerde tehnikanyň başga ugurlarynyň 
soňky gazananlary ulanylýar. Bu bolsa onuň bilen işlemegi diňe 
aňsatlaşdyrman, eýsem amatly edip goýýar.

Türkmenistanda kompýuter tehnologiýalarynyň soňky gaza­
nanlary ulanylýar. Ýurdumyzda öňdebaryjy tehnologiýalary öwren­
mek boýunça uly işler alnyp barylýar. Şol işlerde Hormatly Prezi­
dentimiziň ýardam bermegi olaryň tiz depginde amala aşmagyny 
üpjün edýär. Ýurdumyzyň Baştutany innowasion tehnologiýalara üns 
berýär we olaryň has netijelileriniň döwletimiziň ähli pudaklaryna 
ornaşdyrylmagyna ýardam berýär.

Berkarar döwletimiziň bagtyýarlyk döwründe ýurdumyzyň is­
lendik pudagynyň öňünde täze meseleler goýulýar. Şol meseleleri 
üstünlikli çözmek üçin diňe bir tehnologiýalar ýeterlikli däl. Şol teh­
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nologiýalary ulanyp biljek ýokary bilimli hünärmenleri taýýarlamak 
wajyp meseleleriň biri bolup durýar.

Kompýuter tehnologiýalary öz düzümine birnäçe ugurlary we 
dersleri alýar. Olara umuman aýdanyňda programma düzmek, mul­
timediýa tehnologiýalary, grafika we bezeg işleri, tory dolandyrma, 
amallar ulgamy we programma üpjünçiligi, kompýuteriň içki gurluşy 
we ş.m. degişli etmek bolýar.

Kompýuterler bir wagtyň içinde birnäçe amallary ýerine ýetir­
ýärler. Mysal üçin, şol bir wagtyň özünde ol çylşyrymly hasap 
işlerini, çap etmegi, ses çykarmagy, faýllar bilen işlemegi we ş.m. 
amala aşyryp bilýär.

Häzirki wagtda kompýuterler önümçiligiň islendik pudagynda 
giňden ýaýrandyr. Şonuň üçin hem talyplaryň haýsy hünär boýunça 
bilim alýanlygyna garamazdan kompýuter tehnikasy öwrenilýär.

Ýokarda belläp geçilişi ýaly, Berkarar döwletimiziň bagtyýarlyk 
döwri täze talaplary bildirýär. Her bir hünäriň öz aýratynlygy hem 
onuň kompýuter tehnikasy bilen iş salyşýan meseleleri bar.

Meselem, binagärlik hünärinde çylşyrymly çyzgylar takyklygy, 
dogrulygy, bezegi talap edýär. Häzirki wagtda kompýuterde ulanyl­
ýan programmalaryň arasynda inženerçilik-çyzgy programmalary 
köp ulanylýar. Olara AutoCAD, 3DMAX, ArhiCAD ýaly program­
malar degişlidir. Olar çyzgylary tiz depginde, ýokary takyklyk bilen, 
ýokary derejeli bezegli we göze ýakymly edip taýýarlamaga, el bilen 
çyzylan çyzgydan tapawutlylykda, ýörite çap ediş gurluşda islendik 
mukdarda çap etmäge we ýalňyşlyklar ýüze çykanda tiz we arassa 
düzetmäge mümkinçilik berýär.

Gurluşygyň ugurlary üçin hem bu programmalar peýdalydyr. Se­
bäbi diňe çyzgylary amala aşyrmakdan tapawutlylykda, olar ölçegleri 
goýmagy, çyzgydaky desga-materialy ulanmak bilen, onuň mukda­
ryny kesgitlemegi hem üpjün edýär.

Kompýuter ykdysadyýetdäki çylşyrymly hasapçylyk işlerini 
amala aşyrmaga hem mümkinçilik berýär. Bu ýere diňe, hemmele­
re belli bolan Microsoft Excel programmasyndan başga birnäçe ha­
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sapçylyk işlerini ýerine ýetirmek üçin ýörite düzülen programmalary 
goşmak bolýar.

Himiýanyň önümçilik proseslerine degişli hasaplama işlerinde 
hem kompýuterler giňden ulanylýar.

Nebit we gaz ugry öz içine dürli hünärleri alýan hem bolsa, olaryň 
hemmesiniň alyp barýan işlerinde kompýuter serişdeleri ulanylýar. 
Meselem, geologiýa işleriniň netijelerini işläp bejermekde GeoFrame 
toplumy giňden peýdalanylýar.

Görşümiz ýaly kompýuter tehnologiýasy pudaklaryň ählisine 
giňden ornaşdyrylan hem-de adaty teskt redaktorlaryny ulanmak bi­
len çäklenmän, olaryň aýratynlyklaryna laýyklykda zerur kompýuter 
programmalary ulanylýar.

Bu bolsa ýene bir gezek, Hormatly Prezidentimiziň, dürli ugur­
daky hünärmenleriň Bagtyýarlyk döwrümizde kompýuter tehnikasy 
bilen giňden iş salyşmagyny gazanmak baradaky tabşyryklarynyň, 
onuň öňden görüjilikli syýasatynyň aýrylmaz bölegidigini görkezýär.

Beýleki hünärler boýunça bilim alýan talyplara kompýuter teh­
nikasy bilen işlemegi öwretmegiň esasy ugurlary barada gysgaça 
gürrüň edildi. Emma, kompýuter tehnologiýalary hünäri boýunça 
taýýarlanylýan talyplar bilen işlenilende aýry usulyýetden peýdalan­
mak gerek bolýar.

Eger beýleki hünärlerde kompýuter tehnologiýalary bilen ula­
nyjylyk ýagdaýda öwredilýän bolsa, kompýuter ugrundaky hünär­
ler has ýöriteleşdirilen, dolandyryjy we sazlaýjy wezipeleri ýerine 
ýetirmeklige gönükdirilen ugur bilen öwredilýär.

Tekst redaktorlary bilen işlenilende ýa-da beýleki bir ulanyjy 
programmalar ulanylanda kompýuter bilen işlemegiň ussatlygy dürli 
ulanyjylar üçin tapawutlandyrylmaýar. Emma, şol programmalaryň 
işini sazlamakda, häsiýetnamalaryny goýmakda ýa-da kompýuteriň 
işini düzetme işlerinde tapawutlanýar. Mundan başga hem, öz hünär­
leri  boýunça talyplara programmalary düzmegi, programmanyň 
döredijisi bolmagy öwredilýär.

Başgaça aýdylanda, beýleki hünärlere degişli talyplar öz ugrun­
daky meseleleri işlerinde kompýuteri netijeli peýdalanmagy öwren­
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ýän bolsa, kompýuter tehnologiýalary hünäri boýunça bilim alýan 
talyplar üçin kompýuteriň özi şol meseläniň biri bolup durýar. Sebäbi 
bu talyplara kompýuteri bejermek, sazlamak, gurnamak, onuň üçin 
programmalary ýüklemek, kompýuterleri torda sazlamak, kompýu­
terde programma düzmek zerurdyr.

Emma ýokarda agzalan işler ýöriteleşdirilen kompýuter ug­
rundan işleýän hünärmenler üçin gönükdirilen hem bolsa, bu işler 
kompýuteriň islendik ulanyjysy tarapyndan özleşdirilmegi mümkin.

Bu kitap kompýuter tehnologiýasynyň ýaş ugurlarynyň biri 
bolan kompýuter grafikasyna degişli redaktorlaryň işleýiş düzgün­
lerini öwretmeklige gönükdirilen. Kompýuter grafikasynyň amala 
aşyrylmagy adaty çeperçilik grafikasyna garanyňda düýpli tapawut­
lanýar. Bu diňe bir amala aşyryş serişdeleriniň aýratynlyklaryna bagly 
bolman, eýsem çyzgylaryň we suratlaryň kim tarapyndan ýerine ýeti­
rilýänligi bilen hem tapawutlanýar. Kompýuter grafikasynda çyzgyny 
taýýarlaýan adam hökmany suratkeş ýa-da binagär bolman hem biler. 
Bu aýratynlyk kompýuter grafikasyny öndürijiligi boýunça has neti­
jeli edýär. Kompýuter grafikasynda esasy orny onuň haýsy kompýuter 
programmasy arkaly ýerine ýetirilýändigi tutýar.

Bu okuw kitabynda kompýuter grafikasy boýunça iň meşhur 
programmalar bolan – Adobe Photoshop, CorelDraw, AutoCad ul­
gamynda işlemegiň düzgünleri we grafiki şekilleri taýýarlamagyň 
usullary barada gürrüň edilýär. Kitap öz düzüminde diňe maglumat 
beriji bölümleri saklaman, eýsem tejribe taýdan peýdaly görkezmele­
ri we maslahatlary hem saklaýar.

Bilşimiz ýaly, kompýuter tehnologiýasy gün-günden ösýär. 
Onuň ösüşi diňe bir kompýuter tehnikasynyň we oňa degişli bolan 
gurluşlaryň kämilleşmegi bilen bagly bolman, eýsem kompýuter 
programmalarynyň wagtal-wagtal täzelenmegi, öňki görnüşlerine 
görä kämilleşmegi bilen hem bagly bolup durýar.

Bu okuw kitabynda ýokarda agzalan programmalaryň işleýiş 
düzgüni uniwersal ýagdaýda, ýagny programmalaryň täzelenmegine 
bagly bolmadyk derejede beýan edilýär. Kitap arkaly öwrenilýän til­



simler grafiki programmalaryň soňky nesilleri üçin hem öz ähmiýeti­
ni ýitirmeýär. Şol sebäpli, kitabyň talyplara döwrebap bilim bermäge 
ýeterlik derejede ýardam berip biljekdigi aýdyňdyr.

Kitapda üns berilmeli zatlaryň biri – agzalan grafiki program­
malaryň hem iňlis hem-de rus dillerindäki görnüşlerinde işlemeklige 
gönükdirilendigidir. Kitabyň ýazgysynyň köp ýerlerinde program­
manyň iňlis dilinde görkezilýän buýruklarynyň, menýularyň gap­
dalynda rus dilindäki programmalardaky buýruklaryň, menýularyň 
ýazgylary ýaýyň içinde getirilendir.

Okuw kitaby kompýuter tehnologiýasy ugrunda işleýänler we 
okaýanlar üçin niýetlenen hem bolsa ondan giň okyjylar köpçüligi 
peýdalanyp biler.
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I. Grafika barada düşünje

Kompýuter tehnologiýasynyň geçen asyryň 90-njy ýyllarynda 
giňden ýaýramagy kompýuterde ulanylýan programma üpjünçiligi­
ne ägirt uly itergi berdi. Şol ýyllarda penjireli operasion ulgamlary 
giňden ulanylyp başlanylýar. Kompýuteriň tehniki taýdan düzüminde 
uly üýtgeşmeler bolup geçýär. Kompýuter öňki döwürlerde diňe ha­
saplama maksady bilen ulanylan bolsa, 1990-njy ýylyň dowamynda 
onuň niýetlenilişinde düýpgöter özgerişler bolup geçýär.

Ol özgermeler, ilkibaşda, kompýuterde grafikanyň, wideo, ses 
we animasiýanyň (hereketlendirilen şekil görnüşleriň) giňden ulanyl­
magy bilen baglydyr.

Grafika kompýuterde alnyp barylýan işleriň arasynda iň göw­
rümlileriniň biridir.

Kompýuterde düzülen grafikanyň kagyz ýüzüne çap ediji gural­
lar (printerler, plotterler) arkaly çykarylmagy bu babatdaky işleri has 
önümli edýär.

Windows operasion ulgamynda soňky ýyllarda DirectX prog­
rammasy uly ähmiýete eýe boldy. Bu programma operasion ulgamyň 
soňky nesilleri (wersiýalary) bilen bilelikde hem gurnalýar. Ol ulgam­
da wideo, grafika, ses, torlar we başgalar babatda belli bir işler ulgam­
laýyn işi alyp barýar. Onuň üsti bilen köp nusgalaýyn näsazlyklary, 
ses gurallarynyň ölçeglerini barlap, üýtgedip hem bolýar.

Kompýuterde grafika bilen işlemek üçin esasan wideoadapteriň 
hem-de işjeň huşuň parametrleri ýokary bolmaly. Sebäbi ýokarda 
aýdyşymyz ýaly grafiki maglumatlar kompýuterden iň köp resurslary 
talap edýär.

Kompýuterleşdirmegiň ägirt uly mümkinçiliklerine düşünmek 
üçin binagärlik çyzgylarynyň kompýuter grafikasyny adaty, elde çyz­
mak bilen deňeşdirmek ýeterlikdir:

– çyzgylar kompýuter grafikasy arkaly tiz amala aşyrylýar, ýeter­
lik çylşyrymly çyzgylary AutoCad programmasy arkaly 2-3 sagatda 
amala aşyrylýan bolsa, olary elde çyzmak üçin 2-3 gün sarp edilmeli 
bolýar;
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– kompýuter grafikasy tiz we arassa redaktirlenýär, şol wagtda 
bolsa elde çyzylan çyzgyny bozguç we galam arkaly redaktirlemek 
gerek, özem kompýuter grafikasy çyzgynyň öňki ýagdaýyny üýtget­
mezden ony ýatda saklamagy mümkin edýär, sebäbi şol çyzgynyň 
soňra gerek bolmagy ähtimal. Elde çyzylan çyzgyda bolsa, öňki ýag­
daýa çyzgyny getirmek üçin ýene-de bozguç we galam bilen işlemek 
gerek bolýar;

– kompýuter grafikasy adamyň özi bolmazdan şol bir suratyň 
ägirt köp sanly nusgasyny çap ediji gurluşlar arkaly tiz wagtda çap 
etmäge mümkinçilik berýär, şol wagtda bolsa, elde çyzylan çyzgylar 
bu wagtyň örän köp mukdaryny we adamlaryň köp sanyny (nusganyň 
sanyna deň bolmagy mümkin) talap edýär, özem kompýuter gra­
fikasynda hemme nusgalaryň hili deň bolýar. Emma çyzgylar elde 
çyzylsa, ol çyzan adama bagly bolýar;

– kompýuter grafikasynyň çyzgylary köp mukdarda ykjam gö­
terijilerde (disklerde, fleş-huşda, gaty disklerde) saklanylýar, elde 
çyzylan çyzgylaryň şol mukdaryny saklamak üçin bolsa aýry otaglar, 
binalar gerek bolýar.

Häzirki wagtda grafika boýunça kompýuterde birnäçe program­
malar bar.

Olar: Photoshop, CorelDraw, AutoCAD we başg. Bu program­
malaryň hemmesi belli bir derejede biri-birini gaýtalaýar, emma 
olaryň öz aýratyn niýetlenilişi hem bar.

Kompýuterde grafiki obýektleri döretmek we saklamak iki usul 
arkaly amala aşyrylýar – rastr ýa-da wektor şekil görnüşinde. Her 
şekiliň kysymy üçin öz kodirleme usuly bar.

Rastr şekili diýip monitoryň ekranynda görkezmek üçin ulanyl­
ýan nokatlaryň toplumyna aýdylýar. Rastr şekiliň ölçegi nokatlaryň 
mukdaryny bir nokadyň maglumat göwrümine köpeltmek arkaly kes­
gitlenýär. Ol maglumatyň göwrümi bolsa mümkin bolan reňkleriň sa­
nyna baglydyr. Gara-ak şekil üçin nokadyň maglumat göwrümi 1 bite 
deň, sebäbi ol ýa gara, ýa-da ak bolup biler, ony bolsa iki san bilen 
kodirlemek bolar – 0 we 1.

Reňkli nokady görkezmek üçin näçe bit gerek bolmagy müm­
kin? 8 reňk üçin – 3 bit, 16 reňk üçin – 4 bit, 256 reňk üçin – 8 bit 



14

(1 baýt) gerek bolýar. Aşakdaky tablisada 16 reňkden ybarat bolan 
reňk palitrasynyň kodirlenmegi görkezilen. Dürli reňkler we olaryň 
öwüşgini üç esasy reňkiň (gyzyl, gök, ýaşyl) ýoklugynyň ýa-da 
bolmagynyň we olaryň ýagtylygynyň hasabyna emele gelýär. Ekran­
daky her bir nokat 4 bit arkaly kodirlenýär.

Reňk Ýagtylyk Gyzyl Ýaşyl Gök
Gara 0 0 0 0
Gök 0 0 0 1
Ýaşyl 0 0 1 0
Mawy 0 0 1 1
Gyzyl 0 1 0 1
Melewşe 0 1 0 0
Goňur 0 1 1 1
Ak 0 1 1 0
Çal 1 0 0 1
Açyk gök 1 0 0 0
Açyk ýaşyl 1 0 1 1
Açyk mawy 1 0 1 0
Açyk gyzyl 1 1 0 1
Açyk melewşe 1 1 0 0
Sary 1 1 1 1
Ýiti ak 1 1 1 0

Wektor şekili elementar kesimlerden we ýaý halkalardan düzü­
len grafiki obýekt görnüşinde bolýar.

Şol elementar obýektleriň ýerleşişi nokatlaryň koordinatalary 
we radiusyň uzynlygy bilen kesgitlenýär. Her bir çyzyk üçin onuň 
kysymy (tutuş, punktir, ştrih-punktirli), galyňlygy we reňki bar. Wek­
tor şekili baradaky maglumat adaty harp-san görnüşinde kodirlenýär 
we ýörite programmalar arkaly işlenip bejerilýär.

Soňky wagtlarda fraktal grafika diýen düşünje emele gelip 
başlady. Ol edil wektor grafikasy ýaly matematiki hasaplamalara 
esaslanandyr. Emma fraktal grafikanyň binýat parçasy hökmünde ma­
tematiki formulalar hyzmat edýär, ýagny kompýuteriň huşunda hiç 
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hili obýekt saklanylmaýar we şekil diňe deňlemeler arkaly gurulýar. 
Şeýle usul arkaly hem-ä ýönekeý wagtal-wagtal düzümleri, hem-
de tebigy landşaftlary we üçölçegli obýektlere meňzetme döredýän 
çylşyrymly suratlary gurýarlar.

Umumy reňk barada gürrüň edilende, fizikany ýatlalyň. Hemme 
reňkler ýagtylygyň görünýän spektrinde bardyr.

Melewşe 400-450 nm, gök 450-480 nm, mawy 480-510 nm, 
ýaşyl 510-550 nm, sary-ýaşyl 550-575 nm, sary 575-585 nm, mämişi 
585-620 nm, gyzyl 620-700 nm.

Kompýuter grafikasynda reňk ygtyýary (beýleki reňkiň çuňlugy) 
düşünjesi girizilen. Ol reňk maglumatyny kodirlemeginiň usulyny 
kesgitleýär. Gara-ak şekili görkezmek üçin bir bit ýeterlik. Sekiz raz­
rýadly kodirleme reňkli tonuň 256 gradasiýasyny görkezmäge müm­
kinçilik berýär. Iki baýt (16 bit) 65536 öwüşgini kesgitleýär (bu High 
Color düzgüni). 24 razrýadly kodirleme usulynda 16,5 mln reňkleri 
kesgitlemek mümkin (True Color).

Tejribe taýdan monitoryň reňk ygtyýaryna reňk tutumy diýen 
düşünje golaý. Oňa ol ýa-da başga çykyş gural arkaly (monitor, prin­
ter, çap maşyny we başg.) çykaryp boljak reňkleriň çägine düşünilýär. 
Şekili additiw we subtraktiw usullar arkaly döretmegiň düzgünlerine 
laýyklykda reňk öwüşgini düzüm komponentlere bölmegiň usullary 
işlenip düzüldi, olar reňk modeller diýlip atlandyrylýar.

Şu ýerde biz reňk modelleri barada aýdyp geçeliň.
CIE Lab modeli
1920-nji ýylda CIE Lab giňişlik modeli döredildi (Communica­

tions Internationale de l’ Eclairage – yşyklandyryş boýunça halkara iş 
topary. L, a, b – bu ulgamda koordinatalaryň belligi). Ulgam enjama 
garaşsyz bolýar we şol sebäpli gurallaryň arasynda maglumatlar geçi­
rilende ulanylýar. Bu modelde islendik reňk ýagtylygy (L) we hroma­
tiki düzüm bölekler bilen kesgitlenilýär: a parametri – ýaşyldan gyzyla 
çenli çäkde üýtgeýär, b – gökden sara çenli. CIE Lab modeliniň reňk 
tutumy monitorlaryň we çap ediji gurallaryň mümkinçiliklerinden ep- 
-esli ýokary geçýär, şol sebäpli ony çykarmazdan öň özgertmeli bol­
ýar. Bu model reňkde bolup geçýän fotohimiki prosesleri poligrafiýa 
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prosesleri bilen ylalaşdyrmak üçin döredildi. Häzirki wagtda ol Ado­
be Photoshop programmasy üçin deslapdan alnan standart hökmünde 
çykyş edýär.

RGB modeli
RGB modeli additiw bolýar, ýagny islendik reňk özi bilen esasy 

üç reňkiň: gyzyl (Red), ýaşyl (Green) we gök (Blue) reňkleriň dürli 
derejedäki utgaşygydyr. Ol elektron taýdan görkezilmek üçin (mo­
nitorda, telewizorda) niýetlenen kompýuter grafikasy döredilen­
de we işlenende esas bolup durýar. Esasy reňkiň bir komponenti 
beýlekiniň üstüne düşende, ýagtylygyň şöhlelenmesi güýçlenýär. Üç 
komponentiň utgaşmagy ahromatiki çal reňki berýär, ýagtylygy ýo­
karlananda bolsa ak reňke golaýlaýar. 256 gradasiýa derejesinde gara 
reňke nol ähmiýetler, ak reňke bolsa 255 ähmiýetler degişli.

HSB modeli
HSB reňk modeli adam tarapyndan reňki duýmagyň aýratynlyk­

laryny iň ýokary derejede hasaba almak maksady bilen işlenip döre­
dilendir. Reňk üç komponent bilen teswirlenýär: öwüşgini (Hue), 
doýgunlygy (Saturation) we ýagtylygy (Brightness). Reňkiň ähmiýeti 
tegelegiň merkezinden çykýan wektor hökmünde saýlanýar. Merkez­
däki nokat ak reňke gabat gelýär. Tegelegiň perimetrindäki nokatlar 
bolsa arassa spektral reňklere gabat gelýär. Wektoryň ugry gradusda 
berilýär we reňk öwüşgini kesgitlenýär. Wektoryň uzynlygy doýgun­
lygy kesgitleýär. Ahromatiki diýlip atlandyrylýan aýry okda ýagtylyk 
bellenilýär, onuň nol nokady gara reňke gabat gelýär. HSB modeliniň 
reňk tutumy hakyky reňkleriň hemme ähmiýetlerini ýapýar.

HSB modelini suratkeşleriň işini meňzetme bilen kompýuterde 
döredilýän şekillerde ulanmak amatly. Şekil döredilenden soň ony 
çap etmegiň usulyna baglylykda başga reňk modeline özgertmek 
maslahat berilýär.

CMYK reňk modeli
CMYK modeli subtraktiw bolup durýar we ony neşirler çapa 

taýýarlanylanda ulanýarlar. Modeliň reňk komponentleri bolup ak 
reňkden esasy reňkleriň aýrylmagy esasynda alnan reňkler hyzmat 
edýär:

– mawy (cyan) = ak – gyzyl = ýaşyl + gök;



– gyrmyzy (magenta) = ak – ýaşyl = gyzyl + gök;
– sary (yellow) = ak – gök = gyzyl + ýaşyl.
Mawy, gyrmyzy we sary reňkleri goşmaça diýip atlandyrylýar. 

Sebäbi olar esasy reňkleri ak reňke çenli doldurýarlar. Şu ýerden CMY 
modeliniň esasy kynçylygy – goşmaça reňkleriň biri-biriniň üstüne 
düşmegi tejribede arassa gara reňki bermeýär. Şol sebäpli, reňk mode­
line arassa gara reňkiň komponenti goşuldy. Abrewiaturada 4-nji harp 
emele geldi CMYK (Cyan, Magenta, Yellow, Black).

Tejribe işleri
1. Ekranyň rugsadyny 1024x768 derejä goýmak.
2. Reňk ibermegiň ýagdaýyny 32 bit etmek.
3. Ekranyň rugsadyny 800x600 derejä goýmak.
4. Reňk ibermegiň ýagdaýyny 16 bit etmek.
5. Ekranyň çalyşmagynyň ýygylygyny 75 Gh edip goýmak.
6. Iş meýdanynyň suratyny çalyşmak.
7. Iş meýdanynyň dynç alyş zastawkasyny çalşyrmak.
8. Ekranyň çalyşmagynyň ýygylygyny 60 Gh edip goýmak.
9. Iş meýdanyň bezegini çalşyrmak.
10. Ekranyň çalyşmagynyň ýygylygyny 85 Gh edip goýmak.

2. Sargyt 1372
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II. Photoshop programmasyna giriş

Photoshop programmasy çyzgy redaktory bolmak bilen ol, esa­
san, çyzgy elementleriniň, suratlaryň, çyzgylaryň üstünde işlemäge 
niýetlenendir. Bu programma arkaly surat çekmegiň esasy tilsimleri­
ne, suratlary sazlamaklygyň ýollaryna, suratlara reňk bermegiň ele­
mentlerine seretmek maksada laýykdyr. Şeýle hem programma arkaly 
suratlardan bölüp almak serişdelerine, konturara kanallara, gatlara, 
süzgüçlere we suratlaryň üstünde geçirilýän amallara seretmeli.

Her bir çyzgy redaktorynyň özüne degişli işçi meýdany bolýar. 
Photoshop programmasynyň işçi meýdany Windows operasion ul­
gamynyň beýleki programmalarynyň penjirelerine meňzeşdir.

Photoshop programmasynyň penjiresiniň gurluşy aşakdaky su­
ratda görkezilendir.

Penjiräniň adynyň we ulgamlaýyn üç nokat ýerleşýän zolagyň 
aşagynda menýu setiri ýerleşýär.

Menýu setiri adatça şu bölümlerden ybarat:
File (Файл) – umuman faýllary açmak, täzesini döretmek, ýatda 

saklamak, ýerleşdirmek, ýapmak, skanirlemek, importirlemek ýa-da 
eksportirlemek, çap etmek, faýly tor boýunça ibermek, käbir amallary 
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awtomatlaşdyrmak, goşmaça programmalara geçmek we Photoshop 
programmasyndan çykmak üçin ulanylýar.

Edit (Правка) – menýuda şekili redaktirlemek üçin göçürip al­
mak, göçürilen zady goýmak, transformirlemek, şekiliň reňklerini gaý­
tadan kesgitlemek, şeýle hem dürli bezegleri we figuralary döretmek 
üçin buýruklar ýerleşen. Fade (Сглаживание) kömekçi menýunyň 
buýrugy köp amallaryň netijesini peseltmäge mümkinçilik berýär 
(meselem, soňky ulanylan filtriň, belli bir gural bilen redaktirlemegiň 
we çekmegiň buýruklarynyň netijelerini). Purge (Очистить) kö­
mekçi menýusynyň buýruklary huşy boşadýar. Photoshop program­
masy köp ýagdaýda işjeň huşy ulanman, emeli döredilen wirtual huşy 
ulanýar. Şol sebäpli, programmada köp ýerine ýetirilen hem ýörite 
döredilen taryhy amallar ýatda saklanylýar, buferde göçürilen zat­
lar saklanylýar. Şol kömekçi menýu şu üç parametri boşadýar. Şeýle 
hem Edit menýusy arkaly Color Settings (Цветовые установки), 
Preset Manager (Инициализация Менеджера) we Preferences 
(Предпочтения) buýruklaryny goýberip bolýar. Iň esasy buýruk 
Preferences buýrugydyr. Ol arkaly taryhy amallaryň möçberini, gural­
lara bolan kömekçi düşündirmeleri, faýllar açylanda, ýatda saklany­
landa we ýapylanda käbir düşündirmeleri, displeýiň we kursorlaryň 
görnüşlerini, fonuň açyklygyny we gammasyny, ölçeg birlikleri, çyz­
gyçlary, ugrukdyryjylary, torlary we başgalary dolandyrmak hem-de 
sazlamak bolýar.

Edit menýusynda käbir buýruklary klawiaturadan goýbermek 
üçin we olara düwmejikleriň utgaşygyny bellemek üçin hem kömekçi 
menýu bar (Горячие клавиши).

Image (Изображение) – Mode (Режим) kömekçi menýu arkaly 
şekili islendik 8 sany görkezilişe (şol sanda 4 sany reňk modeline, gara 
reňk görnüşine) geçirmek mümkin. Adjustments (Регулировки) 
kömekçi menýunyň buýruklary reňkiň tonuny, doýgunlygyny, ýagty­
lygyny kontrastlygyny üýtgetmäge mümkinçilik berýär. Image Size 
(Размер изображения) menýusynyň kömegi arkaly faýlyň, şekiliň 
ölçegini ýa-da rugsadyny üýtgetmek mümkin. Canvas Size (Размер 
холста) gepleşik penjiresi şekiliň ýerleşýän iş meýdanyny üýtgetmek 
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üçin ulanylýar. Mundan başga hem Image menýusy arkaly holsty is­
lendik tarapa, islendik burça öwürmek mümkin.

Layer (Слой) menýusynda ýerleşen buýruklar gatlary goşmagy, 
göçürmegi, üýtgetmegi, toparlaşdyrmagy, birleşdirmegi, baglanan 
gatlaryň özara ýerleşişini dolandyrmagy, şekili bir ýeke gata öwürme­
gi üpjün edýär. Bu menýunyň buýruklarynyň has çalt ulanylmagyny 
Layers (Слои) palitrasynyň üsti bilen gazanmak mümkin. Gat – bu 
şekilde ýerleşýän özbaşdak işlenilýän, üýtgedilmegi beýleki gatlara 
we fona degmeýän hem-de gat öçürilenden soňra hemme üýtgeme­
leri ýitýän grafiki bölekdir. Käwagt gat özüni şekil ýaly alyp barýar. 
Bu ýagadaýda gatyň üstündäki geometriki amallary transformirlemek 
buýrugy arkaly ýerine ýetirmek gerek.

Select (Выделить) menýusy belleme amallary ýerine ýetir­
ýär – All (Все) buýrugy tutuş gaty belläp alýar. Deselect (Снять 
выделение) öň bellenilen hemme gatlardan bellemegi aýyrýar. Re­
select (Восстановить выделение) buýrugy iň soňky gezek Dese­
lect buýrugy ulanylan töweregi gaýtadan belläp alýar. Color Range 
(Цветовой ряд) buýrugy aýratyn penjiräni açyp üýtgeýän ölçege 
görä reňki hasaba almak bilen bellemegi amala aşyrýar. Şol ölçeg 
0-dan 200-e çenli üýtgeýär. Ölçegiň iň pes ýagdaýynda saýlanyl­
ýan reňk sany az, ulaldygyça has golaý reňkleriň köp sany bellenip 
alynýar. Beýleki buýruklar bellenilen çäkleri giňeldýärler, gysýar­
lar, ulaldýarlar, çäkleriniň güýjüni peseldýärler, şeýle hem bellenilen 
töwerekleri kanallarda saklaýarlar.

Filter menýusy – bu Photoshop programmasynyň aýratynly­
gyny has doly görkezýär. Bu menýunyň buýruklary arkaly berlen 
şekili ýa-da onuň bellenilen töweregini islendik ýagdaýda çeperçi­
lik, ýagtylyk, plast, tolkun şekiliň detallaryny birsydyrgyn üýtgemek 
amala aşyrylýar.

View (Вид) menýusynyň Gamut Warning (Предупреждение 
о гамме) buýrugy 4 reňkde çap edilmejek reňkleri görkezýär. Pro­
of Setup (Установки пробного отпечатка) kömekçi menýusynyň 
buýrugy şekiliň dürli düzgünlerde (modellerde) nähili görünjekdigini 
görkezýär. Beýleki buýruklar şekiliň masştabyny dolandyrýar, şeýle 
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hem ekrana çyzgyçlary, koordinata toruny we kömekçi çyzyklary çy­
karýar.

Window menýusy – ekrandaky palitralaryň görkezilişini, şeýle 
hem açylan faýllardan biri-birine geçmekligi amala aşyrýar.

Photoshop programmasynda belli bir işleri alyp barmakda gural­
lar paneli uly rol oýnaýar.

Panelde islendik öz çagyryş klawişasy bar. Eger guralyň bel­
gisiniň ýüzünde kiçi gara üçburçluk bar bolsa, onda şol gurallaryň bir­
näçe görnüşi bar. Her görnüşi klawiaturadan saýla­
mak üçin Shift düwmejik bilen bilelikde guralyň 
çagyryş klawişasyny basmaly.

M – geometrik görnüşli töweregi saýlamak 
üçin gural palitrasy – tegelek we gönüburçly belle­
mek guraly ulanylýar.

Islendik görnüşli töweregi saýlamak üçin 
palitra L – Lasso, Poligonal Lasso, Magnetik Las­
so ulanylýar. 1-nji – bellenilýän töwerek galam bi­
len çyzylan ýaly alynýar, 2-nji – syçany basmak 
arkaly nokatlaýyn bellenilýär, 3-nji – şekiliň reňk 
kontrastlygy has köp üýtgeýän bolsa, özbaşdak şol 
töwerekleri aýry-aýry bellenilýär.

Şekiliň kemçiliklerini düzetmek üçin J pali­
trasy ulanylýar.

Klonlamak gurallaryň palitrasy S – çekiji gu­
ral arkaly saýlanan töweregiň göçürmesini çyzyp 
gidýär.

Pozmak üçin gurallaryň palitrasy E ulanyl­
ýar. (Pozmakdan galan reňk fonuň reňkine görä 
alynýar, fonuň reňki gural panelinde iki reňkli 
kwadratyň aşakysynda saýlanylýar, kwadratyň ýo­
karkysy üýtgetme gurallaryň reňki).

R – şekiliň çäkleriniň dürslügini sazlaýan gurallaryň palitrasy.
A – gönümel saýlap almak gurallarynyň palitrasy.
P – Sudurlar bilen işlemek gurallarynyň palitrasy.
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N – bellikleri döretmek üçin gurallarynyň palitrasy – ýazgy we 
owaz belligi.

K – bölekler bilen işlemek gurallarynyň palitrasy.
B – surat çekmek gurallarynyň palitrasy.
Şekiliň döreýiş taryhy bilen işleýiş palitrasy Y – şekilde rastr taý­

dan üýtgeme bolan töwerekleri faýlyň açylan ýagdaýyndaky görnüşe 
getirýär.

Reňk doldurma gurallarynyň palitrasy G – şekili gradiýent ýa-da 
islendik bir reňk bilen doldurýar.

O – şekilleri ýagtylandyrmak we garamtyl etmek gurallarynyň 
palitrasy.

T – tekst bilen işlemek gurallarynyň palitrasy – keseleýin we dik­
leýin tekst ýazmak üçin, tekst maskalaryny döretmek üçin ulanylýar.

U – çekmegiň wektor gurallarynyň paneli – çyzyk, dörtburçluk, 
tegelek, ellips, köpburçluklary we islendik görnüşli figuralary çek­
mek üçin ulanylýar.

I – reňk, burçlar we aralyklar bilen işleýiş paneli – şekiliň töwe­
regindäki islendik reňki saýlap almak, birnäçe reňkleri belläp goýmak 
we şekilde burçlary we aralyklary ölçemek gurallarydyr.

Tejribe işleri
	 Faýllary bir formatdan başga formata geçirmek üçin File menýusyndan 

Save As bendi saýlamaly we faýlyň adynyň aşagynda duran setirde şekiliň 
degişli formatyny kesgitlemeli. Soňra şekiliň hilini görkezmeli we her for­
mata degişli parametrleri sazlamaly.

Ýumuşlar
1. BMP formaty JPG formata geçirmeli.
2. JPG formaty TIFF formata geçirmeli.
3. TIFF formaty PSD formata geçirmeli.
4. JPG formaty BMP formata geçirmeli.
5. TIFF formaty BMP formata geçirmeli.
6. BMP formaty TIFF formata geçirmeli.
7. BMP formaty PSD formata geçirmeli.
8. PSD formaty TIFF formata geçirmeli.
9. JPG formaty PSD formata geçirmeli.
10. PSD formaty JPG formata geçirmeli.
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III. Şeki̇ller we i̇ş meýdany bi̇len i̇şlemek

Photoshop programmasynyň iş meýdanynda menýudan we gu­
rallar panelinden başga-da şekiller bilen işlemek üçin palitralar we 
gurallaryň opsiýalarynyň panelleri bar. Soňkusy ol ýa-da başga gural 
saýlanyp alnanda üýtgeýär. Mysal üçin (Brush) kist saýlanyp alnanda 
kistiň ölçegi, görnüşi, garyşyk düzgüni, açyk däldigi we akymlygy 
görkezilýär.

Düzgün opsiýasy köp gurallarda duş gelýär, ol şulardan ybarat:
Normal (Норма) – hemme baza reňkler üýtgedilýär.
Dissolve (Растворение) – hek ýaly, gury tekstura döredilýär, su­

rat çekiş ýa-da garyşma reňke eýe bolýar. Açyk däldigiň we akymyň 
ölçegleri näçe ýokary bolsa, şonça hem kistiň mazogy gaty bolýar.

Behind (Задний) – gatlar üçin elýeterli däl. Diňe açyk töwerek­
ler üýtgedilýär. Edil arassa asetat matanyň ters tarapynda surat çeki­
len ýaly bolýar, emma ony fon üçin ulanmak bolmaýar.

Clear (Очистка) – gatlar üçin elýeterli däl. Ştrihler ýerleşen 
ýerinde baza reňki açyk bolýar. Bu düzgüni Paint Bucket (Ведро с 
краской), Line (Линия), Fill Region (Залить область) basylan bolsa 
ýa-da Fill (Залить), Stroke (Очертить), Fill Path (Залить контур) 
we Stroke Path (Очертить контур) buýruklary ulanylanda diňe köp 
gatly şekile ulanmak mümkin. Bu düzgüni fona ulanyp bolmaýar.

Darken (Темнее) – surat çekiş ýa-da garyşyk gatyň reňkinden 
açyk baza reňkler üýtgeýär, beýleki reňkler üýtgemeýär. Eger surat 
çekiş reňki üýtgetjek bolýan reňkden garamtyl bolsa, ulanyp bol­
maýar.

Multiply (Умножение) – surat çekiş ýa-da garyşyk gatyň ga­
ramtyl reňki baza reňkiň has açyk töwereklerini garaltmak netijesini 
bermek üçin çalşyrýar. Surat çekiş ýa-da garyşyk gatyň açyk reňki 
hem baza reňkini garaldýar, ýöne onçakly güýçli däl. Ýarym açyk 
kölegeleri döretmek üçin örän peýdalydyr.

Color Burn (Затемнение цвета) – surat çekiş ýa-da garyşyk 
gatyň garamtyl reňki baza reňkini garaldýar, eger ol açyk bolsa onda 
baza reňki birnäçe ýagtylandyrylýar.

Linear Burn (Линейное горение) – çyzyklaýyn şekili garaldýar.
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Lighten (Светлее) – surat çekiş ýa-da garyşyk gatyň reňkine 
baglylykda garamtyl baza reňkler üýtgeýär, beýleki reňkler üýtge­
meýär. Eger surat çekiş reňki üýtgetjek bolýan reňkinden açyk bolsa, 
ulanyp bolmaýar.

Screen (Экран) – surat çekiş ýa-da garyşyk gatyň açyk reňki baza 
reňkiň has garamtyl töwereklerini çalşyrýar, şeýlelik bilen has açyk, 
reňksizlenen baza reňki emele gelýär. Surat çekiş ýa-da garyşyk gatyň 
garamtyl reňki hem baza reňkini ýagtyldýar, ýöne kän güýçli däl.

Color Dodge (Остветление цвета) – surat çekiş ýa-da garyşyk 
gatyň açyk reňki baza reňkini ýagtyldýar, eger ol garamtyl bolsa onda 
baza reňki birnäçe ýagtylandyrylýar.

Linear Dodge (Линейный сдвиг) – çyzyklaýyn şekili ýagty­
landyrýar.

Overlay (Перекрытие) – baza reňkiň garamtyl töwereklerini 
ýagtylandyrýar we açyk ýerleri garamtyllandyrýar. Gara we ak reňkleri 
üýtgemeýär, şonuň üçin şekilde hemme bölek parçalar saklanylýar.

Soft Light (Мягкий цвет) – eger surat çekiş ýa-da garyşyk gatyň 
reňki açyk bolsa baza reňki ýagtylandyrýar, eger garamtyl bolsa baza 
reňki garamtyllandyrýar. Şonda baza reňkiniň ýagtylyk ölçegleri sak­
lanylýar. Bu düzgün ulanylanda ýagtylandyryş netijesi ýumşak, çala 
bildirýän bolýar.

Hard light (Жесткий цвет) – eger surat çekiş ýa-da garyşyk 
gatyň reňki açyk bolsa baza reňki reňksizlenýär we eger garamtyl bol­
sa baza reňki garalýar. Baza reňkiň we gatyň arasynda kontrast artýar. 
Blikler we çylşyrymly effektler döredilende ol örän gowy guraldyr.

Vivid light (Яркий цвет) – şekiliň reňke görä ýagty ýerlerini 
belleýär.

Linear light (Линейный цвет) – çyzyklaýyn reňke görä baza 
reňki üýtgedýär.

Pin light (Точечный цвет) – baza reňkiň reňkine surat çekiş 
ýa-da garyşyk gatyň reňkini goşýar.

Difference (Разница) – baza reňki üçin negatiw effekti döredýär. 
Eger surat çekiş ýa-da garyşyk gatyň reňki açyk bolsa, onda negatiw 
effekt has anyk bolýar.

Exclusion (Исключение) – surat çekiş ýa-da garyşyk gatyň 
reňki garamtyl bolan ýerlerde baza reňki çal bolýar, reňkler açyk bo­
lan ýerlerde bolsa, baza reňki inwertirlenýär.
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Hue (Оттенок) – reňkiň tony garyşyk gatyndan alynýar. Baza 
reňkiniň ýagtylygy we doýgunlygy şonda üýtgemeýär.

Saturation (Насыщение) – reňkiň doýgunlygy garyşyk gatyn­
dan alynýar. Şonda baza reňkiniň tony we ýagtylygy üýtgemeýär.

Color (Цвет) – garyşyk gatyň tony we doýgunlygy ulanylýar. 
Baza reňkiniň ýagtylygy üýtgemeýär. Ol şekili ýeňil reňklemek üçin 
amatly düzgündir.

Luminosity (Яркость) – baza reňkiniň ýagtylygynyň ähmiýeti 
surat çekiş ýa-da garyşyk gatyň reňkiniň ýagtylygynyň ähmiýetleri 
bilen çalşyrylýar. Şonda baza reňkiniň tony we doýgunlygy üýtge­
meýär.

Photoshop programmasynda ýerine ýetirilýän amallaryň köpüsi 
palitralar arkaly ýerine ýetirilýär.

Color (Цвет) palitrasy reňkleri garmak we saýlamak üçin ulanyl­
ýar. Gurallar panelinde ýerleşen esasy we fon reňkiniň kwadratyna 
basyp, Color Picker (Выбор цвета) panelini çykaryp bolýar. Bu ýer­
de reňkiň giň spektri modellere baglylykda ýerleşen.

Swatches (Образцы) – taýyn nusgalar saýlanylan bolanda ula­
nylýar.

Styles (Стили) öň kesgitlenen we ýatda saklanylan effektleri we 
olaryň utgaşmasyny peýdalanmak üçin ulanylýar.

Navigator (Навигация) – şekiliň görünýän parçasyny saýlap, 
şol parçanyň masştabyny üýtgedip bolýar.

Info (Информация) palitrasynda kursor görkezýän pikseliň reňk 
komponentleri görkezilýär. Mundan başga hem bu ýerde kursoryň x 
we y koordinatalary görkezilen. Bu ýerde başga maglumatlar hem 
görkezilip bilner, belleýiş ýa-da Measure (Измеритель) guraly ula­
nylanda, transformasiýada. Şol parametrler üçin birlik ölçeglerini şol 
palitranyň ýokarsynyň sag tarapynda gök üçburçluga basyp goýmak 
mümkin. Şol üçburçluk beýleki palitralarda hem bar we käbir sazla­
malary elýeterli etmegi mümkin edýär.

Eger reňkiň ýanynda ýüzlenme belgisi duran bolsa, onda ol 
CMYK modeliniň daşyna çykýar we çapda öz öwüşginini üýtgeder.

Layers (Слой) – fonuň üstünde ýerleşen gatlary döretmäge, aýyr­
maga, goşmaga, görkezmäge/bukmaga, göçürmäge, toparlaşdyrma­
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ga, baglaşdyrmaga we ýerleşmeginiň yzygiderligini üýtgetmäge 
mümkinçilik berýär. Her gata öz garyşyk düzgüni we açyklyk dere­
jesi degişli bolup bilýär. Standart gatdan başga Photoshop program­
masynda: düzediji gaty (adjustment layer) we tekst gaty döredip bol­
ýar.

Channels (Каналы) palitrasynda şekili düzýän bir ýa-da birnäçe 
kanallar görkezilýär. Bu palitra arkaly bellenilen töwerekleri ýatda 
saklamak üçin alfa-kanallary hem döredip bolýar.

Paths (Контуры) palitrasy ulanylan sudurlar bilen işlemekligi 
üpjün edýär.

History (История) palitrasy arkaly bir ýa-da birnäçe amallary 
saýlap ýatyrmak bolýar. Eger şu palitranyň sazlanýan ýerine çyzykly 
däl ölçege rugsat berilmedik bolsa, onda has irki amal ýatyrylandan 
soň, ondan soňky amallar awtomatiki aýrylýar, eger rugsat berlen bol­
sa, onda ýitmeýär we diňe şol amal ýatyrylýar. Bu sazlama History 
Options (Опции палитры History) penjiresinde Allow Non-Linear 
History (Разрешить нелинейность событий) baýdajygyň bolma­
gy ýa-da aýrylmagy arkaly amala aşyrylýar. Bu palitra goşmaça bo­
lup, History brush (Кисть историческая) gabat gelýär. Palitrada şu 
guralyň belgisi şekiliň açylan ýagdaýynyň gapdalynda durýar. Şol se­
bäpli kist bilen işlenende, onuň degen ýerleri şekili açylan wagtynyň 
ýagdaýyna getirýär. Eger şol belgi haýsy‑da bolsa bir ýerine ýetirilen 
amalyň gapdalynda goýulsa, onda kist şol amalyň ýagdaýyna görä 
hemme zady yzyna gaýtarar. Art History Brush (Художественная 
восстанавливающая кисть) edil şol hereketleri gaýtalaýar, emma 
belli bir çeperçilik stili ulanyp ýerine ýetirýär.

Actions (Действия) palitrasynyň esasy wezipesi şekilleri işläp 
bejermegiň awtomatlaşdyrylmagy bolup durýar. Buýruklaryň yzygi­
derligini ýazyp, ony bir şekile ýa-da şekilleriň toparyna ulanmak 
mümkin, şeýle hem Actions palitrasy belli bir hereket etmek üçin 
«tiz» klawişalaryň elýeterligini belläp we alyp bilýär.

Character (Шрифт) palitrasy teksti ýazmagyň düzgünini bel­
leýär, şriftiň häsiýetnamalaryny gurallar paneliniň Туре (Текст) 
guralynyň opsiýalar paneli arkaly hem belläp bolar.
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Paragraph (Абзац) palitrasy tekstiň abzaslarynyň kesgitli hä­
siýetnamalary we başga häsiýetlerini üýtgedip bilýär.

Photoshop programmasynda iş meýdanyny amatly etmek mak­
sady bilen palitralary we panelleri wagtlaýyn aýyrmak hem-de yzyna 
getirmek ýola goýlan. Tab düwmejigi arkaly ekranda menýudan we 
şekilden başga zady aýryp bolýar. Shift we Tab düwmejikleriniň bile­
likde basylmagy başga gurallar panelini hem ekranda saklap galýar.

Palitralaryň we panelleriň depesinde gök zolaga syçanjyk bilen 
basylanda, şol gök zolaklardan başga töweregi ýitýär, şol zolaga ýene 
bir gezek basyp, paneli gaýtaryp bolýar.

Eger palitralar doly aýrylan bolsa, olary Window menýusy ar­
kaly gaýtaryp bolýar.

Programmada birnäçe şekil açylan ýagdaýynda biri-birine geç­
mek üçin CTRL we Tab düwmejiklerini ulanmak gerek.

Photoshop programmasynda şekil ilkibaşda açylanda (täze faýl 
döredilende) gepleşik penjiresi çykýar. Ol ýerde dörediljek şekiliň öl­
çegleri bellenilýär. Ölçegleriň gapdalynda birlikleri saýlap bolýar. Şol 
penjire arkaly şekiliň ulanjak modelini, rugsadyny, her kanala bolan 
bit ölçenilen huşy, fonuň reňkini we başgalary belläp bolýar.

Şekil bilen işlemekde Image menýusy uly rol oýnaýar. Bu 
menýu arkaly şekiliň ölçeglerini, şekiliň oturan holstunyň ölçeglerini 
goýmak mümkin. Holstuň ölçegleri goýlanda Canvas Size (Размер 
холста) gepleşik penjiresiniň her tarapyna uçly çyzyklar goýberilen 
kwadratyň şekili bar. Syçanjyk bilen haýsy-da bolsa üçly çyzyga basy­
landa ol ýitýär we holstuň artmagyny ýa-da kiçelmegini, garşylyky ta­
rapda bolmagyny belleýär. Soňra ini we beýikligi üýtgedilýän penjire­
de olaryň ähmiýetleri üýtgeýär. Meselem beýikligi 26 sm we ini 5 sm  
şekiliň holstunyň ölçegini üýtgetmek maksady bilen, şol gepleşik 
penjiresi açylsa we ýokarky uçly çyzyga basyp beýikligiň 26 sm bo­
lan ähmiýetini 30 edip ýapylsa, onda netijede şekiliň aşagyndan 4 sm 
boş ýer goşular. Onuň fonunyň reňki gurallar panelinde öň bellenilen 
fon reňkine gabat geler.

Şekiliň ölçegi üýtgedilende, şekiliň proporsiýalar saklanyl­
maly baýdajyk goýlan bolsa, onda iniň ýa-da beýikligiň üýtgedil­
megi beýleki ölçegiň awtomatiki üýtgedilmegine getirýär, mundan 



28

başga‑da rugsady hem üýtgedip bolýar. Şekil çap üçin ulanylanda 
300 dpi has amatly bolýar, sebäbi ol adaty çapyň rugsadydyr.

Şekili öwrüp hem bolýar. Eger ony 90 we oňa kratny burça 
däl‑de, başga islendik burça öwürmek gerek bolsa, onda buýruga 
basyp, sagadyň ugry (CW) ýa-da sagadyň ugruna garşy (CCW) baý­
dajyklary saýlap, burçuň ähmiýeti girizilýär. Mundan başga-da şekiliň 
eýýäm goýlan reňk düzgünini üýtgedip we reňk häsiýetnamalaryny 
belläp bolýar.

Islendik şekili Photoshopda 12-den gowrak formatlarda döredip, 
açyp, redaktirläp we ýatda saklap bolýar. Adatça diňe birnäçe format­
lar ulanylýar: TIFF, GIF, JPEG, EPS we Photoshop programmasynyň 
öz formaty.

Photoshop programmasynyň şonça formatlary işläp bilýändi­
gi sebäpli onuň üçin şekil islendik çeşmeden: skanerden, grafiki re­
daktordan, kompakt-diskden, fotosuratdan, wideoşekilden we beýle­
ki operasion ulgamlaryndan alnyp, şeýle hem şekil doly Photoshop 
programmasynyň özünde döredilip bilinýär.

Programmada skanirlemek File > Import > Twain_32 (Файл > 
> Импорт > Twain_32) ýol arkaly amala aşyrylýar.

Skanirlemekde esasy mesele şekiliň reňk görnüşini saklamakdyr. 
Eger gara-ak, ýarym ton we reňkli şekil gerek bolsa, bu ölçegler Ska­
ner gepleşik penjiresinde görkezilýär. Skaneriň rugsady dýuma bolan 
pikselde ölçenýär (dpi) we Resolution (Разрешение) parametri bilen 
kesgitlenýär – rugsat näçe ýokary bolsa, şonça hem nokatlaryň sany 
köp. Faýlyň göwrümi bu ýagdaýda hem uly bolýar.

Tejribe suratlary skanirlemek üçin 200-300 dpi amatly bolup, po­
ligrafiýa nusgalar üçin – 600 dpi.

Şekilleriň ölçegleri saýlanan reňk düzgünine baglylykda hem 
üýtgeýär. Meselem, her reňk üçin modeliň kanallary bar. Her kanala 
8 ýa-da 16 bit goýberilýär. Näçe kanal sany köp bolsa, şonça-da hem 
şekiliň faýlynyň ölçegi uly bolýar. Meselem, 4 kanaly bolan CMYK 
düzgünli faýl iň uly bolýar. Gara-ak reňkli şekiliň göwrümi pes bol­
ýar. RGB modeliň 3 kanaly bar, CIE Lab we HSB modelleriň hem 3 
kanaly bar.
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Her şekilde belli bir effektler bellenilýär. Photoshop, Advanced 
TIFF we Photoshop PDF aşakdaky elementler saklanylýan ýeke-täk 
formatlar:

• birnäçe gatlar we gatyň açyklygy;
• düzediji gatlar;
• redaktirlenýän tekst gatlary;
• gatyň effektleri;
• torlar we ugrukdyryjy çyzyklar;
• reňki dolandyryş ulgamynyň ICC-profilleri (PICT, JPEG, 
DCS we EPS formatlarda hem profiller saklanylýar);
• Lab şekiliň düzgüni (EPS we DCS formatlarda hem bu düz­
gün saklanylýar).

Şekiller skanirlenenden soň öz asyl nusgalaryna garanyňda 
örän pes hil bilen tapawutlanýar. Photoshop programmasy Image 
(Изображение) menýusynyň Adjustments (Регулировки) kömekçi 
menýusynyň Регулировки, Баланс цветов we Яркость контраст 
atly gepleşik penjireleri arkaly ol kemçilikleri düzetmäge mümkin­
çilik berýär.

Skanirlenen materialyň däneliligini peseltmek üçin Filter > Blur 
> Gaussian Blur (Фильтр > Размытие > Размытие по Гауссу) 
menýunyň buýrugyny uly bolmadyk rugsat bilen (1-den pes) ula­
nyp, 1 ýa-da 2 gezek Filter > Sharpen > Sharpen Edges (Фильтр > 
Резкость > Резкость контуров) buýrugyndan peýdalanylýar.

Serediş masştabyny üýtgetmek üçin «tiz» düwmejigi
Amal «Tiz» düwmejikler

Ulaltmak (penjiräniň ölçeglerini üýtgetmezden) Сtrl+«+»
Kiçeltmek (penjiräniň ölçeglerini üýtgetmezden) Сtrl+«–»
Ulaltmak (penjiräniň ölçeglerini üýtgedip) Ctrl+Alt+«+»
Kiçeltmek (penjiräniň ölçeglerini üýtgedip) Сtrl+АН+«–»
Actual pixels/100% masştab Ctrl+Alt+О (nol)
Ekranyň ölçegi boýunça getirmek Ctrl+О (nol)
Başga gural ulanan wagty ulaltmak Ctrl+«probel»
Başga gural ulanan wagty ulaltmak Alt+«probel»
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Rastr şekilleri
Ekrana çykarylanda şekiliň ölçeglerini pikselde üýtgetmek üçin:
1. Image > Image Size (Изображение > Размер изображения) 

menýunyň buýrugyny saýlamaly.
2. Resample Image (Отслеживать изменения) baýdajyk du­

randygyna göz ýetirmeli (установлен).
3. Iniň we beýikligiň özara gatnaşygyny saklamak üçin Cons­

train Proportions (Сохранять пропорции) baýdajygy aýyrmaly däl.
4. 72 ppi rugsady deň edip goýmaly.
5. Pixel Dimensions (Размеры в пикселах) toparynyň: Width 

(Ширина) we/ýa-da Height (Высота) parametrleriniň täze baha­
laryny girizmeli.

6. ОK düwmejigine basmaly.

Çapa çykarylanda şekiliň ölçeglerini üýtgetmek üçin:
1. Image > Image Size (Изображение > Размер изображения) 

menýunyň buýrugyny saýlamaly.
2. Document Size (Размер документа) böleginde ýerleşen 

Width (Ширина) we Height (Высота) meýdanlarynyň özi çykýan 
menýulardan ölçeg birlikleri saýlamaly.
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3. Width (Ширина) we Height (Высота) meýdanlaryna täze 
ähmiýetleri girizmeli. Resample Image (Отслеживать изменения) 
baýdajyk goýulmadyk bolsa, rugsat üýtgemeýär.

4. ОK düwmejigine basmaly.
Rugsady üýtgetmek üçin şol penjiräniň Resolution (Разреше­

ние) meýdanynda täze ähmiýeti girizmeli. Rugsat näçe ulaldylsa, 
şonça‑da şekiliň ýitiligi peselýär. Ony düzetmek üçin Filter (Фильтр) 
menýusynyň Unsharp Mask (Нечеткая маска) buýrugy ulanmaly.

Filtriň şeýle parametrlerini görkezmek mümkin: ýitiligiň dere­
jesini Amount (Количество) parametri arkaly ýokarlandyrmagy; 
kontrasty ulalýan her bir nokadyň töwereginde üýtgeýän gurşawa 
alýan pikselleriň sanyny (Radius (Радиус) parametri); filtriň haýsy 
nokatlarynyň täsir etjekdigini we etmejekdigini bar bolan kontrastyň 
iň pes derejesini görkezmek bilen kesgitlemegi (Threshold (kesgit­
lemek)

Radiusyň ähmiýeti näçe ýokary bolsa, şonça hem Amount 
parametriniň ähmiýeti pes bolup bilýär we tersine. Eger Threshold 
(Порог) ähmiýeti artdyrylsa, Amount (Количество) we Radius 
(Радиус) parametrleri ýokarlandyryp bolýar.

Fit Image (Подогнать изображение) buýrugy şekiliň rugsady­
na täsir etmeýär, diňe onuň fiziki ölçeglerine täsir edip bilýär. Şekil 
kiçeltjek bolnanda şu buýrukdan peýdalanylýar.

1. File > Automate > Fit Image (Файл > Автоматически > 
Подогнать изображение) buýrugy saýlamaly.

2. Iniň we beýikligiň ähmiýetlerini pikselde girizmeli. Beýleki 
meýdan OK düwmejigine basylandan soň, awtomatiki düzelýär.

3. ОK düwmejigine basymaly.
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Kendiriň ölçeglerini üýtgetmek
Canvas Size (Размер холста) buýrugy redaktirlemäge ýol 

berýän şekiliň töweregini üýtgedýär.
1. Eger şekiliň fony bar bolsa, fon reňkini saýlamaly.
2. Image > Canvas Size (Изображение > Размер холста) dia­

log penjiresini açmaly.
3. Width (Ширина) we/ýa-da Height (Высота) meýdanyna 

täze ähmiýeti girizmeli. Bir ululygyň üýtgedilmegi beýlekisine täsir 
etmeýär.

4. Şekili täze kendire görä geçirmek üçin Anchor (Якорь) kwad­
rata basmaly. Ýagty element şekiliň şol wagtky ýerleşişini görkezýär.

5. ОK düwmejigine basmaly. Hemme goşmaça meýdan şol 
wagtky fon reňki bilen doldurylar.

Şekil Crop (Кадрировать) guraly, Crop (Кадрировать) buýru­
gy ýa-da Trim (Подрезать) buýrugy arkaly kesilip bilner:

1. Crop (Кадрировать) guraly saýlaň ýa-da С klawişasyna bas­
maly.

2. Ýatda saklanjak bolýan töweregiň daşynda gönüburçlugy bel­
lemeli.

3. Bu guralyň Shield cropped area (Прикрыть область кад­
рирования) opsiýasy arkaly saýlanan bölek bilen aratapawudy güýç­
lendirmek üçin saýlanmadyk bölegi garaldyp bolýar. Eger Color 
(Цвет) nusgasyna basmaly. Garalanan töweregiň reňki üýtgedilmeli 
bolsa bu reňk üçin Opacity (Непрозрачность) parametriň ähmiýetini 
saýlamaly. Eger gaty kadrirlenýän bolsa, Cropped Area (Отсекаемая 
область) utgaşdyryjyny (pereklýuçateli) Delete (Удалить) ýag­
daýa goýmaly (çägiň içine düşmedik töweregi ýok etmek üçin ýa-da 
töweregi faýl bilen ýatda saklamak üçin hem‑de ol şekiliň çäginden 
daşarda ýerleşdirer ýaly Hide (Спрятать) ýagdaýa).

4. Bu guralyň çägini ulaldyp, öwrüp, kiçeldip, eger proporsional 
üýtgetmek gerek bolsa, onda Shift düwmejigi bilelikde basyp ýa-da 
Alt düwmejigi basyp, (merekeze görä) üýtgedip bolýar.

Bu guralyň Width (Ширина) we/ýa-da Height (Высота) op­
siýalaryna ähmiýeti girizip, şekili kesip bolýar.
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Köplenç çäk şekiliň araçäklerine berkidilýär, munuň öňüni al­
mak üçin çägi şekiliň gyrasynda çyzaňyzda Ctrl+Shift düwmejikleri 
basyp saklap, çyzmaly.

Eger bir şekili beýleki şekiliň çäklerinde ýerleşer ýaly edip kes­
mek gerek bolsa, iki şekili açmaly, maksatly şekili işjeňleşdirmeli, 
Crop guralyny saýlap, onuň opsiýalarynyň panelinde Front Ima­
ge (Внешнее изображение) düwmejigine basmaly, kesilmeli şekili 
işjeňleşdirmeli we punktir çägi çyzmaly. Kesilenden soň, Shift düw­
mejigini basyp, gaty maksatly şekile geçirmeli ýa-da göçürmeli. Rug­
sat awtomatiki düzeler.

Eger kesmek ölçegi şekilden uly bolan çäk arkaly ýerine ýetiril­
se, onda şekiliň kendiriniň ölçegi hem ulalýar.

Crop (Кадрировать) buýrugy Crop guralynyň opsiýalaryny 
ulanmagyň zerurlygy ýok bolanda peýdalydyr. Ony ulanmak üçin 
belleýiş çägi döredilmeli:

1. Rectangular Marquee (Прямоугольная область) guralyny 
saýlap, ýatda saklanylmaly töweregi bellemeli.

2. Image > Crop (Изображение > Кадрировать) buýrugyny 
saýlamaly.

Şekiliň daş töweregindäki artyk bolan açyk we reňkli töwerekleri 
tiz aýyrmak üçin Trim (Подрезать) buýrugy ulanylýar.

Rotate Canvas > Flip Horizontal и Flip Vertical (Повернуть 
холст > Перевернуть вдоль горизонтали и Перевернуть вдоль 
вертикали) buýruklary şekiliň hemme gatlaryny degişlilikde çepden 
saga we tersine hem-de ýokardan aşak we tersine geçirýär. Eger diňe 
bir gaty üýtgetmek gerek bolsa, onda Edit > Transform > Flip Ho­
rizontal ýa-da Flip Vertical (Правка > Трансформировать > Пе­
ревернуть вдоль горизонтали ýa-da Перевернуть вдоль вертика­
ли) buýruklardan peýdalanylýar.

Rotate Canvas toparynyň buýruklary şekiliň hemme gatlaryny 
öwürýärler. Eger diňe bir gaty öwürmek gerek bolsa Edit > Trans­
form (Правка > Трансформировать) kömekçi menýunyň öwrüş 
buýrugyndan peýdalanylýar.

3. Sargyt 1372
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Eger şekili belli bir burça öwürmek gerek bolsa, onda Image > 
> Rotate Canvas > 180°, 90° CW или 90° CCW (Изображение > 
> Повернуть холст > На 180°, 90° по часовой стрелке ýa-da на 90° 
против часовой стрелки) buýruklary saýlanylýar.

Eger şekil islendik burça öwrülmeli bolsa, onda aşakdaky amal­
lar ýerine ýetirilýär.

1. Image > Rotate Canvas > Arbitrary (Изображение > По­
вернуть холст > Произвольно) buýruk ýerine ýetirilýär.

2. Angle (Угол) meýdanynda –359,99°-dan 359,99°-a çenli is­
lendik san girizilýär.

Belleýiş amallary
Eger şekilde saýlanyp bellenen işjeň (aktiw) töwerek bar bolsa, 

onda diňe ony redaktirlemek mümkin, şekiliň galan bölegi gorany­
lan bolýar. Bellemek üçin: Rectangular Marquee (Прямоугольная 
область), Elliptical Marquee (Овальная область), Lasso (Лассо), 
Polygonal Lasso (Полигональное лассо), Magic Wand (Волшебная 
палочка) we Magnetic Lasso (Магнитное лассо), şeýle hem Color 
Range (Диапазон цветов) we Extract (Извлечь) ýaly gurallar ula­
nylýar.

Tutuş gaty belläp almak
Gaty saýlamaly, Select > All (Выделить > Все) menýunyň 

buýrugy ulanmaly ýa-da Ctrl+A klawişalary bilelikde basmaly. Çäk 
tutuş gaty gurşap alar.

Diňe gatyň açyk däl piksellerini belläp almak üçin, Ctrl düwme­
jigine basyp, Layers (Слои) palitrasyndaky gatyň adyna syçanjyk bi­
len basylýar. Ýa-da gatyň nusgasyna syçanjygyň sag düwmejigi bilen 
basyp, kontekst menýudan Select Layer Transparency (Выделить 
прозрачные пикселы слоя) element saýlanylýar.

Gönüburçluk we elliptik töweregi belläp almak:
1. Şekiliň gaty saýlanylýar.
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2. Rectangular Marquee (Прямоугольная область) ýa-da 
Elliptical Marquee (Овальная область) guraly, М ýa-da Shift+M 
düwmejiklerine basylyp işledilýär.

3. Eger Rectangular Marquee (Прямоугольная область) ýa-da 
Elliptical Marquee (Овальная область) guraly saýlanylsa, onda 
bellenilen töweregiň takyk ölçeglerini kesgitlemek üçin opsiýalar 
panelinde ýerleşen Style (Стиль) atly özi açylýan menýudan Fixed 
Size (Фиксированный размер) bendi saýlanylýar, soňra iniň we 
beýikligiň bahasy girizilýär.

4. Bellenilen töweregiň araçäklerini gowşatmak üçin, opsiýalar 
panelinde bellemegi döretmekden öň Feather (Растушевывание) 
parametriň bahasyny 0-dan ýokary edip girizmeli. Elliptical Mar­
quee (Овальная область) guraly üçin Anti-aliased (Сглаживание) 
baýdajygy aýyrmak mümkin.

5. Eger bellenilen töweregiň fiksirlenen ölçegi görkezilen bol­
sa (ýa-da Single Row Marquee (Строка пикселов) ýa-da Single 
Column Marquee (Столбец пикселов) gurallary saýlanylan bolsa) 
şekile syçanjyk bilen basylýar.

Islendik görnüşli bellenilen töweregi döretmek
Eger bellejek bolýan figura has çylşyrymly bolsa, onda onuň 

araçägini Реn (Перо) ýa-da Freeform Pen (Свободное перо) gu­
raly bilen Lasso (Лассо) guralyň deregine çyzmaly we soňra sudury 
bellenişde özgertmeli. Netije has takyk bolar. Bu amaly tersine-de ýe­
rine ýetirip bolýar.

Lasso arkaly bellenilen töweregiň araçäklerini gowşatmak üçin 
Select > Feather (Выделить > Растушевать) buýrugy ulanylýar 
ýa-da Ctrl+Alt+D düwmejiklerine basylýar. Eger Lasso (Лассо) gu­
raly bilen işlenende göni çyzygyň kesimini çyzmak gerek bolsa, onda 
syçanjygyň düwmejigini goýbermän Alt düwmejigine basylýar we 
burçlary döretmek üçin syçanjyga basyp durulýar. Kursory geçirip, 
soňra klawişa goýberilýär we islendik görnüşli belleýşi çyzmagy do­
wam etdirip bolýar.
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Köpburçluk görnüşli bellenilen töweregi döretmek
Bu maksatlar üçin Polygon Lasso (Полигональное лассо) gu­

raly ulanylýar. Alt düwmejigini basyp, poligonal belleýiş döredilýän 
mahaly egri çyzykly segmenti çyzmak bolýar.

Shift düwmejigine basyp, 45° burça bölünýän burç bilen gö­
nüçyzykly belleýiş çyzyklary gurmak bolýar.

Delete düwmejigine basyp, iň soňky döredilen burçy ýok edip 
bolýar, bu düwmejigi goýbermän birnäçe burçlary ýok etmek mümkin.

Reňke görä bellemek
Eger haýsy-da bolsa bir piksele Magic Wand (Волшебная 

палочка) guraly bilen basylsa, bir öwüşginiň ýa-da açyklygyň bir 
derejeli goňşy pikselleri belleniler. Soňra alnan töwerege goňşy däl, 
reňk boýunça meňzeş pikselleri Similar (Похожие) buýrugy arkaly 
ýa-da beýleki reňkiň piksellerini Shift klawişasyna basmak arkaly 
goşup bolýar.

Eger opsiýalar panelinde Contiguous (Смежные) baýdajyk 
goýlan bolsa, onda bellenilen töwerege birinji piksel bilen «bagly» 
bolan pikseller girer. Goňşy däl töwereklerden pikselleri aýyrmak 
üçin bu baýdajyk aýrylýar.

Bu guralyň opsiýalar panelinde Tolerance (Чувстивительность) 
meýdanyna belli bir san girizilse, onda saýlanylan piksele goşmaça 
şonça sana laýyk garamtyl we ýagtyrak reňkler hem goşulýar.

Magnetic Lasso (Магнитное лассо) guraly kursor hereket 
edende awtomatiki bellenilen töweregi döredýär. Töweregiň ara­
çägi figuranyň araçägini kesgitleýän golaý reňke ýa-da kölegäniň 
öwüşginine «ýelmeşýär».

Eger Magnetic Lasso (Магнитное лассо) guraly bilen işle­
nilende wagtlaýynça Polygon Lasso (Полигональное лассо) ulan­
mak zerur bolsa, onda Alt klawişasyny basyp saklap, şekile syçanjyk 
bilen basylýar.

Belleýiş çyzygy bellenilmeli däl töwerege ýelmeşýän bolsa, 
onda syçanjyk bilen belleniljek bolýan töweregiň gyrasyna basylýar 
we aralykdaky nokat döredilýär.

Bu guralyň opsiýalar paneliniň Feather (Растушевывание) 
parametriniň bahasy bellenilen töweregiň araçäginiň gowşama de­
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rejesini kesgitleýär, Width (Ширина) parametri 1-den 255-a çenli 
üýtgeýär we guralyň işleýän töweregiň pikseldäki ölçegini görkezýär. 
Ýokary kontrastly we takyk araçäkli şekil üçin uly ähmiýet saýlanyl­
ýar. Kontrastlygyň üýtgeýänligi kän bir bildirmeýän we biri birinden 
golaý ýerleşen figuraly şekil üçin uly bahany goýmaly däl.

Eger Edit > Preferences > Display&Cursors (Правка > Уста­
новки > Отображение курсоры) penjirede Other Cursors (Другие 
курсоры) toparynda Precise (Точно) görnüşi saýlanylsa, onda kursor 
ortasy kesişme bolan we diametri Width parametriniň bahasyna deň 
bolan tegelegiň görnüşine eýe bolýar. Precise düzgünine wagtlaýyn 
geçmek üçin CapsLock düwmejige basylýar.

Töwerek bellenilende Width parametriň bahasyny 1 piksele ki­
çeltmek üçin Shift klawişasyna, ulaltmak üçin bolsa Alt klawişasyna 
basmaly.

Edge Contrast (Контраст границ) parametri 1-den 100-e çen­
li üýtgeýär we figuranyň araçägini kesgitlemek üçin zerur bolan 
kontrastlylygyň derejesini görkezýär. Pes kontrastly şekiller üçin pes 
baha saýlanylýar.
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Iniň uly ýa-da kiçi bahasy girizilen bolsa, onda şol bahany hem 
araçäkleriň kontrasty üçin girizmeli.

Frequency (Частота) parametri 0-dan 100-e çenli üýtgeýär we 
bellenilen töwerek döredilen aralyk nokatlaryň goýulmagynyň ýygy­
lygyny kesgitleýär. Ýygylygy näçe pes bolsa nokatlar hem sonça az 
bolýar. Nädogry görnüşli figuranyň suduryny bellemek üçin uly baha 
saýlanylmalydyr.

Color Range (Диапазон цветов) buýrugy arkaly töweregi şeki­
liň reňkine baglylykda ýagtylygyň ýa-da tonuň çägini berip bellemek 
bolýar.

Saýlanylýan öwüşginleriň çägini giňeltmek üçin Fuzziness (Раз­
мытость) süýşgüji saga, azaltmak üçin bolsa çepe süýşürilýär.

Sampled Colors (Выбранные цвета) opsiýasy Select paramet­
rinde saýlanylsa, bellenilen töwerege köp öwüşginleri goşmak üçin 
onda Shift klawişany basyp, şekiliň penjiresinde ýa-da deslapdan 
seretmegiň penjiresinde syçanjyk bilen basylýar. Alt klawişany 
hem‑de syçanjygy basyp, bellenilýän töwerekden öwüşgini ýok et­
mek mümkin. Mundan başga-da şol maksatlar üçin plýus ýa-da minus 
belgili pipetkalary ulanmak mümkin.

Eger bellenilen töweregi zolak hökmünde ýerine ýetirmeli bol­
sa, onda birinji bellemegi islendik usul bilen geçirip, soňra Alt kla­
wişasyny basyp, ikinji çägi çyzylýar. Birinji we ikinji çägiň arasyn­
daky belleýiş töweregi bellenilen bolup galýar.

Bellenişden aýyrmak üçin Select > Deselect (Выделить > Снять 
выделение) buýrugy saýlamaly ýa-da Ctrl+D düwmejikleri basmaly.

Iň soňky bellenilen töweregi gaýtadan bellemek üçin Select > 
Reselect (Выделить > Снова выделить) buýrugy ýerine ýetirmeli 
ýa-da Ctrl+Shift+D düwmejiklerine basmaly.

Bellenilen we bellenilmedik töwerekleriň ýerini çalyşmak üçin 
Select > Inverse (Выделить > Инвертировать) buýruklary saýla­
maly ýa-da Ctrl+Shift+I düwmejikleri basmaly.

Mundan başga-da belleýiş gurallary saýlanylanda olaryň opsiýa­
lar panelinde 4 sany düwmejik bar. Olar eýýäm bellenilen töwerege 
täze töwerekleri goşmagy we aýyrmagy (Alt), iki bellenilen töweregiň 
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kesişmesini almagy (Alt+Shift) we öňkiniň deregine täze belleýşi 
döretmegi amala aşyrýar.

Bellemek arkaly winýetirlemegi amala aşyrmak mümkin, munuň 
üçin belleýişden öň opsiýalar panelinde Feather (Растушевывание) 
parametrine belli bir sany goýmaly (meselem), soňra bir töweregi 
belläp, bellemegi inwertirlemeli we bellenilen ýeri Delete klawişasy 
arkaly aýyrmaly. Bu amalyň netijesinde töwerek doly aýrylmaýar, ol 
kem-kemden öçýän ýaly görnüşe gelýär. Mundan başga-da Select > 
> Feather (Выделить > Растушевать) buýrugy arkaly ony belleýiş­
den soň hem goýup bolýar.

Bellemegiň ýene bir usuly Filter > Extract (Фильтр > Вы­
читание) buýrugydyr.

Utgaşdyrma
Photoshopda utgaşdyrma alyş-çalşyk buferiň birnäçe: Cut 

(Вырезать), Сору (Копировать), Paste (Вставить) we Paste Into 
(Вставить в) ýaly usullary, geçiriliş, klonlama we nusgalary ulanmak 
arkaly amala aşyrylýar. Şekiliň elementleriniň takyk ýerleşmeginiň 
we deňlenmeginiň, şeýle hem olaryň arasyndaky sepleriň düzlenme­
giniň usullaryny hem muňa degişli edip bolýar.

Eger şekiliň ýa-da onuň haýsy-da bolsa bir gatynyň bir töwe­
regi çäk bilen bellenilip, Move (Перемещение) guraly bilen (V 
klawişasy) ýa-da Ctrl klawişasy bilen bile basylyp süýşürilende çäk 
bilen bilelikde şol töweregiň pikselleri hem süýşürilýär.

Eger bellenilen töwerek Move (Перемещение) guraly ýa-da 
Ctrl düwmejigi basylyp, goşmaça Alt düwmejigine hem basyp ge­
çirilse, onda onuň göçürilmesi süýşüriler. Eger Alt düwmejigi basy­
lyp, okly klawişalar basylsa, göçürme 1 piksele, eger Alt-Shift bilen 
şol klawişalar basylsa, onda 10 piksele süýşer. Bu ýagdaýda täze gat 
döremeýär, hemme göçürilen töwerek şol bir gatyň içinde bolýar.

Göçürme amallary amala aşyrylanda bir zady ýatdan çykarmaly 
däl. Her şekiliň öz rugsady bar, şol sebäpli bir şekiliň töweregi başga 
şekile göçürilmeli we göçürilýän töweregiň ölçegleri saklanyljak bol­
sa, iki şekiliň rugsady Image > Image Size (Изображение > Размер 
изображения) buýruk arkaly deňleşdirilýär.
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Eger bellenilen töweregi gatlaga öwürmek gerek bolsa, onda 
Layer > New > Layer Via Сору (Слой > Новый > Посредством 
копирования) ýa-da Layer Via Cut (Посредством вырезания) 
buýrygy ýa-da Ctrl+J we Shift+Ctrl+J klawişalara basylýar.

Eger bir şekilden başga şekile alyş-çalyş bufere degmän geçir­
meklik gerek bolsa, onda iki penjiräni açyp, ikisini hem görner ýaly 
edip, bir şekilde töweregi belläp, Move guralyny basyp, syçanjyk 
bilen beýleki şekiliň penjiresine tarap eltmeli we getirip syçanjygy 
goýbermeli. Eger geçirilýän töweregi beýleki şekiliň merkezine goý­
mak gerek bolsa, onda syçanjygy goýbermezden Shift düwmejigi 
basmaly.

Köplenç bellenilen töweregi başga bellenilen töwerege goýmak 
(maska döretmek) gerek bolsa, onda göçürme amalyny goýmak bilen 
tamamlanylanda Edit > Paste Into (Правка > Вставить we başga) 
buýrugy peýdalanmaly ýa-da Ctrl+Shift+V klawişalary basmaly.

Magic Wand (Волшебная палочка), Smudge (Палец), Sharpen 
(Резкость), Blur (Размытие) ýa-da Clone Stamp (Клонирующий 
штамп) gurallary ulanylanda olaryň opsiýalar panelinde Use All 
Layers (Использовать все слои) baýdajygy aýrylan bolsa, onda bu 
gurallaryň täsiri diňe ulanylýan gata täsir edýär, şekiliň hemme gat­
laryna täsir etmeklik gerek bolsa, onda bu baýdajygy goýmaly.

Tor çyzgyç we ugrukdyryjy obýektleri takyk ýerleşdirmek üçin 
gerek. Çyzgyçlar ekranda görner we görünmez ýaly View > Rulers 
(Вид > Линейки) menýuny saýlamaly ýa-da Ctrl+R düwmejik­
leri basmaly. Çyzgyçlaryň häsiýetlerini (ölçeg birliklerini we başg.) 
üýtgetmek üçin, Preferences (Установки) gepleşik penjiresiniň 
Units&Rulers (Единицы измерения и линейки) menýusyna tiz gir­
mek üçin islendik çyzgyja iki gezek syçanjyk bilen basmaly.

Şekildäki obýektleri ýerleşdirmegi tertipleşdirmek üçin tor ula­
nylyp bilner. Tory goýmak üçin View > Show > Grid (Вид > Пока­
зать > Сетка) menýuny çagyrmaly ýa-da Ctrl+Alt+‘ klawişalara 
basmaly. View > Snap To > Grid (Вид > Прикрепить к > Сетка) 
buýruk işledilenden soň her obýektiň ýerleşişi kesgitlenilende ol toruň 
çyzyklaryna baglaşdyrylýar. Meselem, biz obýekti ýa toruň haýsy‑da 
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bolsa çyzygyna 8 piksele golaýlaşdyrsak, onda ol obýekt göni şol 
çyzyga awtomatiki süýşer.

Ugrukdyryjylary döretmek üçin çyzgyçlardan syçanjyk bilen 
kursory çekip gelmeli. Alt düwmejigine yzygiderli basyp, kese ýa-da 
dik ugrukdyryjyny döretmek mümkin. Eger döredilen ugrukdyryjy­
lary Move guraly süýşmez ýaly etmek gerek bolsa, onda View > 
> Lock Guides (Вид > Блокировать направляющие линии) buýru­
gy ýerine ýetirmeli ýa-da Ctrl+Alt+; klawişalaryna basmaly.

Measure (Измеритель) guraly çagyrmak üçin I ýa-da Shift+I 
düwmejigini basmaly ýa-da ony gurallar panelinden işletmeli. Çyzy­
lan çyzygyň eňňitlik burçy (А) we uzynlygy (D) Info (Информация) 
palitrasynda görkezilýär. Eger çyzyk çyzylanda Shift klawişasy 
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basylyp durulsa, eňňitlik burçy 45° bölünijilikli bolýar. Measure 
(Измеритель) guraly arkaly çyzyk çyzylandan soň, Alt düwmejigini 
basyp, kursor bilen çyzygyň bir ujundan burçy gurmak üçin çekmeli.

Clone Stamp (Клонирующий штамп) guraly obýektiň klonuny 
şol bir köp gatly şekiliň çäginde bir gatdan başgasyna we bir şekilden 
beýlekisine geçirmek üçin ulanylýar.

Clone Stamp (Клонирующий штамп) guraly panelden hem-de 
S ýa-da Shift+S klawişalaryny basyp çagyrmak mümkin.

Eger başlangyç nokat bilen bagly bolan bir üznüksiz klon gerek 
bolsa, onda bu guralyň opsiýalar panelinde Aligned (Выровненный) 
baýdajygyny goýmaly. Şol bir başlangyç nokada gabat gelýän birnäçe 
klonlary döretmek üçin şol baýdajygy aýyrmaly.

Başlangyç nokady döredip, töweregi klonlamak üçin Alt düw­
mejigi basyp, şol töwerege kursor bilen basylýar.

Öz nagşyňy döretmek üçin (pattern) Rectangular Marquee 
(Прямоугольная область) guraly işledip, şekiliň bir töweregini bel­
lemeli. Soňra Edit > Define Pattern (Правка > Определить узор) 
buýrugy saýlap, bir ady girmeli we ОK düwmejigine basmaly.

Pattern Stamp (Штамп узора) guraly işletmeli.
Pattern (Узор) meýdanyň okjagazyna basmaly we sanawyň 

içinde iň soňky duran kesgitlenen şekili saýlamaly.

Healing Brush guraly şekiliň kemçiliklerini aýyrmak «zen‑ze­
le», tozanyň yzy we ş.m. döretmek üçin niýetlenen. Ol arkaly saç 
örtügiň şekiliniň zaýalanan böleklerini dikeltmek we hallary, me­
nekleri we ş.m. ýok etmek mümkin. Bu gural panelden ýa-da J we 
Shift+J klawişalar arkaly çagyrylýar.

Bu guralyň işlemeginiň iki düzgüni bar: Sampled (По образцу) 
we Pattern (Текстурное). Birinji ýagdaýda has «akylly» gural, ikin­
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ji ýagdaýda – Pattern Stamp guralynyň gowulandyrylan görnüşi 
alynýar.

Şekiliň gyralaryny rastuşewka etmek üçin Select > Feather 
(Выделить > Растушевать) buýrugyny Ctrl+Alt+D klawişalary ba­
syp çagyrmaly. Radius (Радиус) meýdanynda 250-den ýokary geç­
meýän sany girizmeli. Töweregiň täsir edilýän ini şekiliň rugsadyna 
bagly, rugsat näçe uly bolsa, şonça-da radiusy uly edip görkezmeli. 
Radius 5 piksel edilip girizilse, onda täsir edilýän meýdanyň ini 10 
piksele deň bolýar.

Gatyň piksellerini goýmakdan we süýşürilmeginden galan 
görünýän sepleri aýyrmak üçin Defringe (Удалить бахрому) buýru­
gy ulanmaly. Bu buýruk bellenilýän töweregiň araçäginde pikselleri 



töweregiň içinde belli bir aralykda ýerleşen pikselleriň reňkine laýyk­
lykda gaýtadan reňkleýär.

Eger geçirilen we goýlan bölek gara fonda ýerleşen bolsa we 
tekizlenen bolsa, onda Layer > Matting > Remove Black Matte 
(Слой > Кайма > Удалить черную кайму) buýrugy peýdalanmak 
mümkin. Eger bölek ak fonda ýerleşen bolsa, onda Remove White 
Matte (Удалить белую кайму) buýrugy saýlamaly.

Soňra şekiliň bölegi goýlan gaty saýlamaly we Layer > Matting 
> Defringe (Слой > Кайма > Удалить бахрому) buýrugy goýber­
meli.

Tejribe işleri
1. A4 formatda boş surat döretmek.
2. Ini 220 mm, beýikligi 114 mm boş suraty döretmek.
3. Rugsady 150 dpi bolan boş surat döretmek.
4. Ini 800 pi, beýikligi 600 pi boş suraty döretmek.
5. Fony reňkli boş suraty döretmek.
6. Fony açyk bolan boş suraty döretmek.
7. Reňk düzgüni gara/ak boş suraty döretmek.
8. Reňk düzgüni gyzyl-gök-ýaşyl boş suraty döretmek.
9. Düzgüni 16 bit bolan boş suraty döretmek.
10. A3 formatda boş surat döretmek.
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IV. Gatlar

Gatlar bilen işlemek
Her gat üçin dury dälligiň derejesini belläp bolýar. Bir wagtda 

birnäçe gatlary redaktirlemek mümkin däl. Şekiliň bölegi üýtgedilse 
beýleki gatlara ol täsir etmeýär.

Eger File > New (Файл > Новый) buýrugy ýerine ýetirilenden 
soň açylan gepleşik penjiresinde täze şekil döredilende Contents 
(Содержание) parametri White (Белый) ýa-da Background Color 
(Фоновый цвет) ýagdaýa goýulsa, şekiliň iň yzda duran bölegi fon 
bolýar, ýagny ol gat bolmaýar. Transparent (Прозрачный) saýlanyl­
sa, onda ol gat bolar.

Layers (Слои) palitra­
synda gatlaryň sanawynda 
şolaryň ady ýerleşdirilen. 
Elbetde Background (Фон) 
sanawyň iň soňunda ýer­
leşýär. Palitrada şol wagt 
bellenilen gat işjeň bo­
lup durýar. Işjeň gatyň ady 
(ýa-da Background sözi) 
şekiliň penjiresiniň sözba­
şysynda ýerleşýär.

Eger şekil Photoshop (.psd) ýa-da Advanced TIFF (.tif) format­
dan başga islendik formatda ýatda saklanylsa, onda hemme gatlar 
birleşýär, şekiliň düzgüniniň üýtgedilmegi babatda bolsa (meselem, 
RGB düzgünden CMYK özgerme), eger gatlary saklamak gerek bol­
sa Don’t Flatten (He объединять) ýa-da Don’t Merge (He сливать) 
baýdajygy goýmaly.

100% açyk däl täze gaty döretmek üçin Layers (Слои) palitrasy­
nyň aşagyndaky Create a New Layer (Создать новый слой) düw­
mejige basmaly.
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Eger täze gaty käbir parametrleri goýup, döretmek gerek bolsa, 
onda Layers (Слои) palitrasynyň menýusyndan New Layer (Новый 
слой) buýrugy saýlamaly ýa-da Alt klawişasyny basmak bilen Cre­
ate New Layer düwmejigine syçanjyk bilen basmaly. Bu ýagdaýda 
aşakdaky penjire çykar.

Işlenmeýän gaty wagtlaýynça bukmagyň azyndan iki sebäbi bar. 
Birinjisi – olar ünsüňi çekýär, ikinji olarsyz programmanyň işewürligi 
ýokarlanýar.

Layers (Слои) palitrasynda bukjak bolýan gatyň gabadyndaky 
göz şekilindäki kwadrata basmaly. Ony görmek üçin ýene-de şoňa bir 
gezek basmaly.

Bir gatdan başgasyny bukmak üçin Alt klawişasyny basyp, 
şol gatyň göz şekilli kwadratyna basmaly. Beýleki gatlary gaýtadan 
görünýän etmek üçin şu amaly gaýtalamaly.

Islendik gat bilen transformasiýa amallaryny ýerine ýetirmek 
üçin Edit > Transform > (Правка > Трансформировать >) ýa-da 
Edit > Free Transform > (Правка > Свободная Трансформация >) 
menýunyň buýruklaryny ýerine ýetirmeli – Scale (Масштаб), Rota­
te (Поворот), Skew (Скос), Distort (Искажение) ýa-da Perspecti­
ve (Перспектива). Gatyň töwereginde çäk emele geler we ol arkaly 
degişli üýtgetmeleri ýerine ýetirmek mümkin.

Gaty ýok etmek üçin Layers (Слои) palitrasynda ýok edilmeli 
gatyň adyna we palitranyň Trash (Корзина) düwmejigine basmaly.

Gaty ýok etmegiň ýene bir usuly gatyň adyny belläp syçanjyk 
bilen kontekst menýudan Delete Layer (Удалить слой) bendi saýla­
makdyr.
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Köplenç transformasiýa amallaryny Free Transform (Произ­
вольная трансформация) guraly arkaly hem ýerine ýetirmek müm­
kin. Bu özgermeleriň birnäçesini ýerine ýetirmek gerekdir. Munuň 
üçin Edit > Free Transform (Правка > Произвольная трансфор­
мация) buýrugyny çagyrmaly ýa-da Ctrl+T klawişalary basmaly.

Mundan başga-da Move (Перемещение) guralyny işledip, op­
siýalar panelinde Show Bounding Box (Показать габаритную 
рамку) baýdajygy goýmaly. Bu buýruk ýerine ýetirilende şeýle tiz 
klawişalary ulanmak mümkin:

• Skew buýrugy ýerine ýetirmek üçin Ctrl+Shift klawişalary 
basmaly;
• Distort – Ctrl klawişalary basmaly;
• Perspective – Ctrl+Alt+Shift klawişalary basmaly.

Measure (Измеритель) guralyny işledip, gerek burçy kesgit­
läp, soňra guraly çalyşman, Edit > Transform > Rotate (Правка > 
> Трансформация > Поворот) buýrugy saýlanylsa gat görkezilen 
burça awtomatiki öwrüler.

Gatlaryň ýerini Layers (Слои) palitrasynda çalşyryp, olaryň ek­
randa görkezilmegini sazlap bolýar. Işjeň gatyň beýleki gatlara görä 
ýerleşişini Layer > Arrange > Bring to Front (Слой > Расположить 
> Поверх остальных), Bring Forward (Перенести вверх), Send 
Backward (Перенести вниз) ýa-da Send to Back (Ниже осталь­
ных) buýruklary arkaly hem üýtgetmek mümkin, degişlikde:

Ýokary geçirmek Ctrl+]
Beýlekileriň üstünden Ctrl+Shift+]
Aşak geçirmek Ctrl+[
Beýlekileriň aşagynda Ctrl+Shift+[

Şekiliň fonuny gat we gaty fon etmek mümkin. Birinji amaly ýe­
rine ýetirmek üçin Layers (Слои) palitrasynda fonuň adyna iki gezek 
basyp täze gatyň döredilýän ölçeglerini girizmek gerek. Ters amaly 
ýerine ýetirmek üçin Layer > New > Background From Layer 
(Слой > Новый > Фон из слоя) buýrukdan peýdalanmaly.

Gaty tiz saýlamak üçin Auto Select Layer (Автовыделение 
слоя) baýdajygy goýmaly, bu ýagdaýda syçanjyk bilen gat belle­
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nilse ol işjeň bolar. Bu amaly şeýle hem ol baýdajygy aýryp, Ctrl 
klawişasyny basyp, syçanjyk bilen işjeňleşdirip bolýar. Mundan 
başga-da syçanjygyň sag düwmejigine basyp, kontekst menýuny ça­
gyryp, bu ýerde şol pikselde duran gatlaryň adyny görmek bolar.

Gatlar bilen işlemegi aňsatlaşdyrmak üçin olary toplumlara sal­
mak amatly. Düzediji gatlar we garyşyk düzgünleri diňe bu topluma 
girýän gatlara degişli bolup bilýär. Toplumy döretmek üçin Layers 
(Слои) palitrasynyň aşagynda Create new set (Создать новый набор) 
düwmejigine basmaly. Şeýle hem Layer > New > Layer Set (Слой > 
> Новый > Набор слоев) buýrugy çagyrmak mümkin. Gaty toplumdan 
çykarmak üçin palitrada onuň adyny toplumyň adynda ýokary ýa-da 
toplumyň iň aşaky gatyndan aşak çykaryp amala aşyrmak mümkin.

Lock (Блокировка) opsiýasy şekiliň tötänleýin üýtgedilmeginiň 
öňüni alýar:

1. Layers (Слои) palitrasynda blokirlenmeli gaty saýlamaly;
2. Gatyň ýerleşişini blokirlemek üçin Lock position (Блоки­

ровать положение) baýdajygy goýmaly. Şunda gaty süýşürip bol­
maýar, emma ony redaktirlemek mümkin.

Eger Lock all (Заблокировать все) baýdajyk goýulsa, gat hem­
me redaktirleme amallaryndan goranylar.

Layers (Слои) palitrasynda Lock transparent pixels (Блоки­
ровать прозрачные точки) baýdajygy goýlan bolsa, onda gatyň diňe 
görünýän nokatlaryny redaktirlemäge ýol berilýän bolýar.

Lock transparent pixels (Блокировать прозрачные точки) op­
siýasy elmydama renderinge (bu gural obýekti hakyky görnüşe getir­
ýär) degişli bolmadyk tekst gaty üçin işledilen.

Bu ýerde bir zady bellemek gerek. Gatyň açyk dälligi 60% we 
onuň piksellerini redaktirlenýän guralyň açyk dälligi 100% (Brush 
guraly) bolsa, onda gural 60% açyk dällik bilen redaktirleýär. Eger 
guralyň açyk dälligi 100%-den pes bolsa, onda ýokarkydan hem pes 
bolar.

Photoshop programmasynda käbir amallar ýerine ýetirilende gat­
lar birleşdirilip ýa-da üýtgäp bilner. Olary aýry faýlda ýatda sakla­
mak üçin Layers (Слои) palitrasynda menýudan, Duplicate Layer 
(Дублировать слой) buýrugy saýlap açylan penjirede, Destination 
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(Целевой) toparynda, Document (Документ) meýdanynda New 
(Новый) ähmiýeti saýlamaly. As (Как) meýdanynda gatyň adyny gi­
rizmeli, Destination (Целевой) toparynda Name (Имя) meýdanynda 
täze döredilmeli faýly girizmeli.

Iki gaty birleşdirmek üçin palitrada iki, bile ýerleşen gatlaryň 
ýokarkysyny işjeňleşdirmeli. Eger gatlaryň toplumy saýlanylsa, onda 
onuň düzümine girýän hemme gatlar bir gata birikdirilýär.

Layers (Слои) palitrasynyň menýusyndan Merge Down (Слить 
с нижним) buýrugy saýlamaly ýa-da Ctrl+E klawişalaryna bas­
maly. Işjeň gat ondan aşakysy bilen birleşdiriler. Gatlaryň toplumyny 
birleşdirmek üçin Merge Layer Set (Слить набор. слоев) buýrugy 
saýlamaly.

Merge Visible (Слить видимые) buýrugy şol wagt hemme 
görünýän gatlary birleşdirýär, şonda görünmeýän gatlar üýtgemeýär. 
Munuň üçin Layers (Слои) palitrasyndan Merge Visible (Слить 
видимые) buýrugy saýlamaly ýa-da Ctrl+Shift+E klawişalary bas­
maly.

Flatten Image (Плоское изображение) buýrugy şol wagt gö­
rünýän gatlary birleşdirýär we görünmeýänleri ýok edýär. Munuň üçin 
Layers (Слои) palitrasyndan Flatten Image (Плоское изображе­
ние) buýrugy saýlamaly.

Hadysalar
3-nji temada hadysalar bilen işlemek boýunça gysgaça maglu­

matlar berlipdi. Allow Non-Linear History (Разрешить нели­
нейность событий) opsiýasy işledilmedik bolsa, onda bir hadysa 
gaýtarylyp, ondan soň täze amal ýerine ýetirilse ýa-da şol hadysa ýok 
edilse, onda ondan soňky amallar ýok edilýär, eger işledilen bolsa, 
onda ondan soňky amallar ýitmeýär.

Deslapdan History (История) palitrasynda 20 amal ýatda sak­
lanylýar. Eger bu sany azaltmaly ýa-da artdyrmaly bolsa, onda Edit > 
> Preferences > General (Правка > Установки > Общие) buýru­
gy çagyryp, şol penjirede History States (Состояния) meýdanynda 
1-den 100-e çenli san girizmeli.

Eger amallary huşdan boşatmak gerek bolsa, Edit > Purge > His­
tories (Правка > Очистить > Истории) buýrugyny ýerine ýetirmeli. 

4. Sargyt 1372



50

Eger palitrany diňe işjeň resminama üçin arassalamak gerek bolsa, 
onda palitranyň menýusyndan Clear History (Очистить историю) 
buýrugy çagyrmaly. Purge (Очистить) buýrugyny ýatyryp bolmaýar, 
History (Очистить историю) buýrugyny bolsa ýatyrmak mümkin.

Hadysany ýok etmek üçin ony syçanjyk bilen History (История) 
palitrasynda ýerleşen Delete current state (текущего состояния) 
düwmejiginiň üstüne getirmeli, eger şol hadysadan öňki hadysalary 
yzygiderli ýok etmek gerek bolsa, onda bu amal ýerine ýetirilende Alt 
klawişasyny basyp durmaly.

Снимок (snapshot) – hadysanyň göçürmesi ýaly, emma hady­
sadan tapawutlykda ony döreden palitradaky element ýok edilen bol­
sa-da, surat palitrada galar. Şol sebäpli belli bir amallar ýerine ýetiri­
lenden soň, amallaryň beýleki yzygiderligini ýerine ýetirmezden öň 
suraty döretmek maksadalaýyk. Şekil ýapylandan soň hemme suratlar 
ýok edilýär.

Suratda esasy boljak hadysanyň üstüne basyň. Create new snap­
shot (Создать новый снимок) düwmejigine basmaly. Mundan başga 
hem palitranyň menýusyndan New Snapshot (Новый снимок) bendi 
saýlamaly ýa-da Alt klawişany basyp, Create new snapshot (Создать 
новый снимок) düwmejigini syçanjyk bilen bilelikde basmaly.
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Açylan penjirede, From (Из) meýdanynda şekiliň hemme gatla­
rynyň suratyny almak üçin Full Document (Весь документ) görnüşi 
ýa-da Merged Layers (Слитые слои) görnüşini gatlaryň birleşen 
ýagdaýyndaky suraty almak üçin saýlamaly hem-de Current Layer 
(Текущий слой) görnüşi diňe şol wagt işjeň gatyň suratyny almak 
üçin saýlamaly.

Suraty ýa-da hadysa resminama özgerdilse, onda işiň togtadyl­
magynyň netijelerinden gorap bolýar. Munuň üçin gerekli suraty 
ýa-da hadysany belläp, Create new document from current state 
(Создать новый документ из текущего состояния) düwmejigine 
basmaly. Netijede şol ýagdaýdaky ikinji şekiliň penjiresi açylýar. Pa­
litradan islendik hadysa syçanjyk bilen alnyp, ikinji penjirä geçirilen­
de şol penjiredäki şekil şol geçirilen hadysanyň ýagdaýyna geler.

History Brush (Восстанавливающая кисть) guralyny umumy 
pikselleriň sany açylandan soň (meselem şekiliň düzgüni ýa-da ken­
diri üýtgedilenden, kesilenden soň) ulanmak mümkin däl.

Düzetme buýruklary
Aşakda düzediş buýruklaryny ulanmak boýunça hödürlemeler 

getirilen:
• redaktirlemegi amatly etmek üçin düzediş gatlary ulanmaly;
• gatyň bellenilen töweregine buýrugy ulanmazdan öň töwere­
gi bellemeli;
• gepleşik penjiresinde parametrleri dikeltmek üçin Alt kla­
wişasyny basyp, Reset (Восстановить) düwmejigine syçan­
jyk bilen basmaly;
• ulanyljak parametrleriň täsirini öňünden görmek üçin Ad­
justments (Корректировки) kömekçi menýusynyň gepleşik 
penjirelerinde Preview (Предварительный просмотр) op­
siýany ulanmaly. Bu opsiýa işledilenden soň CMYK düzgü­
ninde reňkler has takyk görkezilýär;
• buýrugyň ulanylmagynyň täsirini kem-kemden peseltmek 
üçin Edit > Fade (Правка > Ослабить) buýrugyny ulanmaly 
ýa-da Ctrl+Shift+F klawişalaryna basmaly;
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• Gepleşik penjiresini standart parametrleri bilen däl-de soňky 
goýlan parametrler bilen gaýtadan açmak üçin Alt klawişany 
bilelikde basyp durmaly.

Düzediş buýruklaryny ulanmagyň iki usuly bar. Olar şol wagt­
daky ulanylýan gata ýa-da düzediş gaty arkaly şekile ulanylyp bil­
ner. Adaty gatlardan tapawutlykda düzediş gatlary diňe şol wagtky 
ulanylýana dälde, eýsem onuň aşagyndaky hemme görünýän gatlara 
täsir edýär. Emma onuň aýratyn amatly tarapy – ol aşagyndaky gat 
bilen birleşdirilýänçä hiç pikseli üýtgetmeýär. Düzediş gatlary – reňki 
düzetmegiň netijesine deslapdan baha bermegiň amatly usulydyr.

Üstünde düzediji gatlar ýerleşmeli gaty saýlamaly. Layers 
(Слои) palitrasynyň aşagynda ýerleşen Create new fill or adjust­
ment layer (Создать новый слой заливки или корректирующий 
слой) düwmejigine basylandan soň çykýan menýudan düzediş buýru­
gyny çagyrmaly.
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Şeýle hem Layer > New Adjustment Layer (Слой > Новый 
корректирующий слой) kömekçi menýudan buýrugy hem çagyrmak 
bolýar. Düzediji gatyň şekili düzediji buýrugyň piktogrammasyny 
saklar we bu buýrugy redaktirlemegi we üýtgetmegi mümkindigi ba­
rada ýatladýan süýşgüçler bolar.

Düzediji gaty üýtgetmek üçin Layer > Layer Content Options 
(Слой > Опции содержимого слоя) buýrugy çagyrmaly.

Layer Style (Стиль слоя) gepleşik penjiresi arkaly düzedi­
ji gatyň aşagyndaky gatlaklar bilen garyşýandygyny dolandyrmak 
mümkin.

Aşaky gatlar bilen garyşanda haýsy kanallar aýrylmaly bolsa, 
olardan Channels (Каналы) baýdajygy aýyrmaly. Her kanal üçin ga­
ryşmagyň çägini goýmak üçin, Blend If (Смешивать если) menýu­
dan haýsy-da bolsa bir kanaly çagyrmaly, bir wagtda hemme kanallar 
bilen işlemek üçin Gray (Серый) ähmiýetini galdyrmaly.

Işjeň gatyň garamtyl töwereklerini ýok etmek üçin This Layer 
(Этот слой) meýdanynyň çep süýşgüjini saga süýşürmeli we eger 
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işjeň gatdan açyk reňkli töwerekleri ýok etmeli bolsa, onda sag 
süýşgüji çepe süýşürmeli.

Işjeň gatyň aşagyndaky gatlaryň garamtyl töwerekleri görner 
ýaly Underlying Layer (Нижележащий слой) meýdanynyň çep 
süýşgüjini saga süýşürmeli. Işjeň gatyň aşagyndaky gatlaryň açyk 
reňkli töwerekleri görner ýaly sag süýşgüji çepe süýşürmeli.

Düzediji gaty beýleki düzediji gat bilen birleşdimek mümkin däl, 
sebäbi olaryň pikselleri ýok, emma olary başga gat bilen birleşdirmek 
bolýar.

Düzediji gatyň düzediş buýrugyny üýtgetmek üçin Layer > 
> Change Layer Content (Слой > Изменить содержимое слоя) 
kömekçi menýuda bar bolan buýrugy çalşyrjak buýrugy çagyrmaly.

Düzediji gatyň ondan aşakysy bilen birleşmeginiň esasynda 
hemme üýtgetmeler hemişelik bolýar. Şol sebäpli üýtgetmeleriň doly 
we dogry geçirilendigine göz ýetirmeli.

Image > Adjustments (Изображение > Корректировки) kö­
mekçi menýunyň buýruklary düzediş buýruklaryň arasynda aýratyn 
orunlary tutýar. Olar gatlara gönümel ýa-da düzediş gatyň üsti bilen 
ulanylyp bilner. Ilkibaşda buýruklary ýarym tonly şekillere, soňra 
bolsa reňkli şekillere ulanmaly.

Auto Contrast (Автоконтраст) ýönekeý buýrugy iň açyk pik­
selleri aklara, iň garamtyllary – garalara öwürýär hem-de olaryň 
arasynda çal reňklileriň derejelerini tertipleşdirýär. Munuň üçin 
Image > Adjustments > Auto Contrast (Изображение > Коррек­
тировки > Автоконтраст) menýudan buýrugy çagyrmaly ýa-da 
Ctrl+Alt+Shift+L klawişalaryna basmaly.

Equalize (Выровнять) buýrugy işjeň gatyň ýagtylygyny ter­
tipleşdirip paýlaýar. Ol kontrastlyk ýetmeýän ýa-da örän garamtyl bo­
lan şekili gowulandyryp bilýär. Munuň üçin Image > Adjustments > 
> Equalize (Изображение > Корректировки > Выровнять) buýru­
gyny çagyrmaly. Buýrugyň täsiriniň töweregini çäklendirmek üçin 
ilki bilen şol töwerek bellenilýär, soňra Equalize (Выровнять) gep­
leşik penjiresinde Equalize selected area only (Выровнять яр­
кость только выделенной области) baýdajygy goýulýar. Tutuş gaty 
bellenilen töweregiň iň açyk we garamtyl reňkini hasaba almak bi­



55

len düzetmek üçin Equalize entire image based on selected area 
baýdajygy (Выровнять все изображение на основе выделенной 
области) goýmaly.

Gat ýa-da fon negatiw ýaly görünmegi üçin Invert (Инверти­
ровать) buýrugyny ulanmaly. Bu buýruk arkaly negatiwi pozitiwe 
öwürmek bolýar.

Gaty saýlap, Image > Adjustments > Invert (Изображение > 
> Корректировки > Инвертировать) buýrugyny saýlamaly ýa-da 
Ctrl+I klawişalaryna basmaly.

Düzediji gatyň üsti bilen aşaky gatlaryň inwertirlenmegini ýerine 
ýetirmek üçin Layers (Слои) palitrasynyň aşagynda ýerleşen Create 
new fill or adjustment layer (Создать новый слой заливки или 
корректирующий слой) düwmejige basylandan soň çykýan menýu­
dan Invert (Инвертировать) buýrugy saýlamaly.

Threshold (Порог) gepleşik penjiresi arkaly ulanylýan gatyň 
ýa-da fonuň kontrastyny reňkli ýa-da çal pikselleri gara ýa-da ak pik­
sellere öwürmek arkaly ýokarlandyrmak mümkin.

Häzirki gatda ýa-da fonda reňkleriň ýa-da derejeleriň mukdaryny 
azaltmak üçin Posterize (Превратить в плакат) buýrugyny peýda­
lanmaly. Munuň üçin gaty saýlap, Image > Adjustments > Posterize 
(Изображение > Корректировки > Превратить в плакат) buýrugy 
çagyrmaly. Preview (Предварительный просмотр) baýdajygyny 
goýmaly we Levels (Уровни) meýdanyna 2-den 255-e çenli san giriz­
meli. Trafaret çapyň ýa-da plakat stiliň netijesini goýmak üçin 4 we 8 
sanyň çägindäki ululygy girizmeli.

Eger reňki düzetmek üçin Levels (Уровни) buýrugy saýlanylsa, 
aýratynlykda we has takyk açyk, orta we garamtyl tonlary sazlamak 
mümkin. Bu ýagdaýda Brightness/Contrast (Яркость/Контраст) 
buýrugyny ulanmak has amatly bolýar.

Levels (Уровни) gepleşik penjiresi arkaly şekilleriň köp muk­
daryny bejermek mümkin.

Gaty saýlap, Image > Adjustments > Levels (Изображение > 
> Корректировки > Уровни) buýrugyny çagyrmaly ýa-da Ctrl+L 
klawişalaryna basmaly.
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• açyk tonlaryň ýagtylygyny we kontrastyny ýokarlandyr­
mak üçin Input Levels (Входные уровни) ak süýşgüji çepe 
süýşürmeli. Orta tonlaryň süýşgüji (polzunogy) hem süýşü­
rilýär;
• garamtyl tonlary ondan hem garamtyl etmek üçin Input Le­
vels (Входные уровни) gara süýşgüji saga süýşürmeli. Orta 
tonlaryň süýşgüji hem süýşürilýär;
• orta tonlary garaşsyz sazlamak üçin Input Levels (Входные 
уровни) çal süýşgüji süýşürmeli;
• kontrasty peseltmek üçin we şekili ýagtylandyrmak üçin 
Output Levels (Выходные уровни) gara süýşgüji saga süý­
şürmeli;
• kontrasty peseltmek üçin we şekili gara etmek üçin Output 
Levels (Выходные уровни) ak süýşgüji çepe süýşürmeli.

Derejeleri awtomatiki sazlamak üçin Image > Adjustments 
> Auto Levels (Изображение > Корректировки > Автоуровни) 
buýrugy çagyrmaly ýa-da Ctrl+Shit+L klawişalara basmaly ýa-da 
Levels (Уровни) gepleşik penjiresinde Auto (Авто) düwmejigine 
basmaly.

Şekiliň kontrastlygyny ýokarlandyrmak üçin Input Levels 
(Входные уровни) gara we ak süýşgüçleri mümkin boldugyça bi­
ri‑birine golaý süýşürmeli.

Auto Color buýrugy, surata alyş emeli yşyklandyrylanda emele 
gelýän şekilleriň sary we mawy ýagty düşmegini ýok etmek üçin ula­
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nylýar. Käbir ýagdaýlarda RGB şekiliň gök kanalyň ýagtylygyny we 
kontrastlygyny üýtgetmek ýeterlikdir.

Şol öwüşgini ýok etmek üçin Image > Adjustments > Auto Co­
lor (Изображение > Корректировки > Автоцвет) buýrugy ýerine 
ýetirmeli ýa-da Shift+Ctrl+B klawişalara basmaly.

Reňki saýlamak
Haýsy-da bolsa bir gural ulanylanda, 

tekst döredilende ýa-da Stroke (Обводка) 
buýrugy bilen işlenilende häzirki esasy reňk 
ulanylýar (fore-groundcolor).

Eraser (Ластик) guraly we kendiriň öl­
çegi ulaldylanda ýa-da fonda ýerleşen 
bellenilen Move (Перемещение) gu­
raly bilen töwerek hereketlendirilen­
de açylan meýdança häzirki fon reňki 
bilen doldurylýar (background color). 
Gradient (Градиент) guraly dürli 
reňkleri, şol sanda esasy we fon reňkini 
garyşdyrýar.

Esasy we fon reňki saýlamagyň birnäçe usullary bar:
• kesgitlenen meýdançalara ähmiýetleri girizmeli ýa-da reňk­
leri saýlamagyň panelinde uly reňk kwadratyna basmaly;
• Custom Colors (Цвета по выбору пользователя) gepleşik 
penjiresinde reňkleriň ulgamyny saýlamaly;
• sanly meýdançalara ähmiýetleri girizmeli ýa-da Color (Цвет) 
palitrasynda süýşgüçleri süýşürmeli;
• Swatches (Образцы) palitrasynda reňk nusgasyna basmaly;
• Eyedropper (Пипетка) guraly arkaly şekilde reňki saýla­
maly.

Işjeň däl kwadratyň reňkini saýlamak üçin Ctrl klawişasyny 
basyp saklamaly.

Swatches (Образцы) palitrasyna täze reňki goşmak üçin reňk 
nusgalarynyň tamamlanýan ýerinde onuň boş ýerine syçanjyk bilen 
basmaly – şol wagt ulanylýan reňk awtomatiki goşulýar. Eger bar bo­

Fon 
reňkiEsasy 

reňk
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lan nusgany çalşyrmak gerek bolsa, onda Shift klawişasyna basyp, 
şol çalşyrylmaly nusga basmaly. Palitradan reňki ýok etmek üçin Alt 
klawişasyna we şol reňk nusgasyna basmaly.

Eyedropper (Пипетка) guraly reňki saýlaýan töweregi üýt­
getmek üçin opsiýalar panelinde Sample Size (Размер пробы) 
parametriň şu bahalaryny görkezmeli: Point Sample (Точка) – ula­
nyjy tarapyndan syçanjyk bilen basylýan pikseli, 3 by 3 Average 

ýa-da 5 by 5 Average – 3x3 ýa-da 
5x5 pikselli töweregiň çägin­
däki reňkiň ortaça ähmiýetini. 
Eyedropper (Пипетка) guraly 
işledip we şekiliň penjiresinde 

syçanjygyň sag düwmejigi basyp, bu opsiýalary kontekst menýudan 
saýlamak mümkin.

Eyedropper (Пипетка) guraly işledilende esasyň reňkiň kwad­
raty işlenende fon reňki saýlamak üçin we ters ýagdaýda Alt kla­
wişasyna basyp, syçanjyk bilen reňk saýlamaly.

Tejribe işleri
1. Reňkli suraty gara/ak düzgüne geçirmek, kontrastlygyny gowulandyrmak 

we arassalama.
2. Garamtyl suraty agartmaly we hilini gowulandyrmaly.
3. Ak/gara düzgündäki suraty reňkli etmeli.
4. Fotosuratyň reňklerini doldurmaly we gowulandyrmaly.
5. Suratyň ýitiligini ýokarlandyrmaly.
6. Suratyň fonunyň reňkini dürli edip üýtgetmeli.
7. Suratyň fonuny gradiýent bilen doldurmaly.
8. Reňkleriň basyşyny üýtgetmeli.
9. Täze stili döretmeli.
10. Täze nusga döretmeli.
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V. Surat çekmek

Reňklemek
Image > Adjustments (Изображение > Корректировки) gep­

leşik penjireleri açylanda Ctrl+probel ýa-da Alt+probel düwmejik­
lere we şekile syçanjyk bilen basylsa şol şekiliň masştaby degişlikde 
ulalýar ýa-da kiçelýär. Eger diňe probele basylsa, onda şekili penjire­
de süýşürmek mümkin.

Bu gepleşik penjireleriniň parametrlerini öňki deslapky dereje­
lerine getirmek üçin Alt klawişasyny basyp saklap, Reset (Сброс) 
düwmejigine basmaly.

Esasy ýa-da fon reňki bilen bir tonly reňklemek üçin Color 
(Цвет) ýa-da Swatches (Образцы) palitrasynda reňki saýlamaly.

Gaýtalanýan nagyş üçin gerek bolan nusgany saýlamaly. Öz nus­
gaňy döretjek bolsaň, Rectangular Marquee (Прямоугольная об­
ласть) guraly arkaly gatyň haýsy-da bolsa bölegi bellenilýär, Edit > 
> Define Pattern (Правка > Определить узор) buýrugy çagyrylýar, 
Deselect (Снять выделение) buýrukdan peýdalanylýar ýa-da Ctrl+D 
klawişalaryna basylýar.

Amallar «Tiz» klawişalar
Esasy reňk bilen doldurmak, 100% açyk däl Alt+Backspace
Fon reňki bilen doldurmak, 100% açyk däl Ctrl+Backspace
Görünýän pikselleri esasy reňk bilen doldurmak 
(açyk däl töwerekleri) Alt+Shift+Backspace
Görünýän pikselleri fon reňki bilen doldurmak 
(açyk däl töwerekleri) Ctrl+Shift+Backspace

Gaty dolulykda reňk bilen doldurmak üçin ony saýlap, Layers 
(Слои) palitrasynda Lock transparent pixels (Блокировать проз­
рачные точки) baýdajygy aýyrmaly. Amalyň täsirini çäklendirmek 
üçin bellenilen töweregi döretmeli. Edit > Fill (Правка > Залить) 
buýrugy ýerine ýetirmeli ýa-da Shift+Backspace klawişalara bas­
maly.
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Use (Используя) açylýan 
menýudan gaty ýa-da bellenilen 
töweregi näme bilen doldur­
magy saýlamaly: Foreground 
Color (Основной цвет), Back
ground Color (Фоновый 
цвет), Black (Черный), 50% 
Gray (50% серый) ýa-da Whi­
te (Белый). Pattern (Узор) 
wariant saýlanylsa, Custom 
Pattern (Узор по выбору 
пользователя) meýdanyň okja­
gazyna basmaly we açylýan pa­
nelde nusgany saýlamaly. Blen­
ding (Смешивание) bölüminde 
Mode (Режим) we Opacity 
(Непрозрачность) parametrleri 

bellemeli. Eger Layers (Слои) palitrasynda Lock transparent pixels 
(Блокировать прозрачные точки) baýdajygy goýmak ýatdan çy­
karylan bolsa, onda onuň deregine bu ýerde Preserve Transparency 
(Сохранять прозрачность) baýdajygy goýmak mümkin.

Gatyň suduryny çyzmak üçin Edit > Stroke (Правка > Очер­
тить) buýrugyny çagyrmaly. Width (Ширина) meýdanynda 1-den 
16-a çenli bahany girizip, çyzygyň inini bellemeli. Reňki saýlamak 
üçin Color (Цвет) meýdanyndaky reňke basmaly we Color Picker 
penjireden reňki saýlamaly. Şeýle hem bu amalda Layer Style (Стиль 
слоя) penjiresinde Stroke (Очертить) opsiýasyny bellemeli.

Hue/Saturation buýrugy arkaly şekili işläp bejermek:
1. Gaty ýa-da onuň bellenilen töweregini saýlamaly;
2. Image > Hue/Saturation (Изображение > Тон/Насыщен­

ность) buýrugy ýerine ýetirmeli (Ctrl+U (Windows) klawişalar);
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3. Şekiliň hemme reňklerini sazlamak üçin Edit (Правка) men­
ýudan Master (Мастер) warianty saýlamaly ýa-da deslapdan döredi­
len diapazony bellemeli (diňe onuň bilen işlemek üçin).

Reňki reňkler paneliniň beýleki töweregine süýşürmek üçin Hue 
(Тон) süýşgüji çepe ýa-da saga süýşürmeli.

Saturation (Насыщенность) süýşgüji doýgunlygy peseltmek 
üçin çepe ýa-da artdyrmak üçin saga süýşürmeli.

Şekili ýagtylandyrmak üçin Lightness (Яркость) süýşgüji saga, 
gara etmek üçin bolsa çepe süýşürmeli.

Eger Edit (Правка) menýudan öň saýlanylan reňk diapazony 
alynsa, onda düzediş süýşgüji we reňki bellemek üçin pipetkalar 
elýeterli bolýar. Düzediş süýşgüji Hue (Тон), Saturation (Насы­
щенность) we Lightness (Яркость) opsiýalaryň täsir etjek diapazo­
nyny daraltmak ýa-da giňeltmek üçin ulanmak mümkin.

Deslapdan düzediş süýşgüji reňk tekeri 90° ýapýar: çepden 
we sagdan çal töwerekleriň her biri 30° we garamtyl-çal töwerek 
(reňkleriň diapazony) 30°.

Reňkiň çalşyrylmagy
1. Deslapdan saýlaman şekiliň reňklerini üýtgetmek üçin Repla­

ce Color (Заменить цвет) buýrugyny ulanmaly. Munuň üçin gaty 
ýa-da bellenilen töweregi saýlamaly. Image > Adjustments > Re­
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place Color (Изображение > Корректировки > Заменить цвет) 
buýrugy ýerine ýetirmeli.

2. Çalşyrylmaly reňke basmaly ýa-da Replace Color (Заменить 
цвет) gepleşik penjiresiniň serediliş böleginde reňki saýlamaly.

3. Fuz-ziness (Размытость) süýşgüji saýlanan reňk bilen bagly 
bolan reňkleri goşmak üçin saga süýşürmeli ýa-da beýleki reňk tö­
werekleri goşmak üçin Shift klawişasyny basyp, deslapky seretmegiň 
penjiresine syçanjyk bilen basmaly. Şeýle hem Shift klawişasyny 
basman Eyedropper+ (Пипетка+) guraly ulanmak mümkin.

Alt klawişasyny we deslapky seretmegiň penjiresine syçan­
jyk bilen basyp, reňkli töwerekleri aýyrmak mümkin. Ýa-da Alt 
klawişasynyň deregine Eyedropper– (Пипетка–) guraly işletmeli.

4. Saýlanan reňkleri üýtgetmek üçin Hue (Тон), Saturation 
(Насыщенность) we Lightness (Яркость) süýşgüçleri süýşürmeli 
(ýarym ton şekili üçin diňe Lightness (Яркость) süýşgüji elýeterli 
bolar). Nusga Sample (Проба) penjiresinde süýşgüçler süýşürilende 
üýtgeýär.
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Gaty ýa-da fony ýarym ton görnüşe özgertmek
Gatdan reňki aýyrmak, düzgüni çalşyrmak üçin (ony ýarym tona 

geçirmek üçin) Desaturate (Обесцветить) buýrugy saýlamaly.
1. Image > Adjustments > Desaturate (Изображение > Кор­

ректировки > Обесцветить) buýrugy saýlamaly ýa-da Ctrl+ Shift+U 
klawişalary basmaly.

Color Balance buýrugy
Gatyň açyk, orta ýa-da garamtyl tonuny düzetmek üçin ýa-da 

haýsy-da bolsa ýyly ýa-da sowuk öwüşgini girizmek üçin Color Ba­
lance (Баланс цвета) gepleşik penjiresini ulanmaly.

1. Image > Adjustments > Color Balance (Изображение > 
Корректировки > Баланс цвета) buýrugy saýlamaly (Ctrl+B).

2. Gepleşik penjiresiniň aşagynda düzedilmeli diapazony bel­
lemeli: Shadows (Темные тона), Midtones (Средние тона) ýa-da 
Highlights (Светлые тона).

3. Islendik süýşgüji goşjak bolýan reňke tarap süýşürmeli. Ýyly 
we sowuk tonlar biri-biri bilen jübütde ýerleşen. Meselem, süýşgüç­
leriň Cyan we Blue taraplaryna süýşürilmegi sowuk öwüşgini emele 
getirýär.
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Variations gepleşik penjiresinde reňki düzediş
Variations (Вариации) gepleşik penjiresi şekiliň reňkleriň dür­

li sazlamalary bilen görkezilişini amala aşyrýar. Şekiliň penjiresinde 
has takyk düzedişleri we üýtgetmeleri geçirmek üçin Color Balance 
(Баланс цвета) ýa-da Levels (Уровни) gepleşik penjirelerini ulan­
maly.

Variations (Вариации) buýrugyny Indexed Color düzgündäki 
şekil üçin ulanmak mümkin däl.

1. Image > Adjustments > Variations (Изображение > Кор­
ректировки > Вариации) buýrugyny ýerine ýetirmeli.

2. Gepleşik penjiresiniň ýokarsynda geçirijini Shadows (Тем­
ные тона), Midtones (Средние тона) ýa-da Highlights (Светлые 
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тона) düzgünine diňe şol töwerekleri üýtgetmek üçin goýmaly ýa-da 
Saturation (Насыщенность) bendi reňkiň diňe şu häsiýetini belle­
meli.

3. Fine/Coarse (Тонкий/Грубый) süýşgüji güýçli düzedişi ge­
çirmek üçin saga ýa-da uly bolmadyk üýtgetmeler üçin çepe süý­
şürmeli.

4. More... (Больше...) ýazgyly miniatýura basyp, şol reňki gata 
köp mukdarda goşmaly. Haýsy-da bolsa bir reňki azaltmak üçin 
diagonalyň beýleki ujunda ýerleşen reňke basmaly.

5. Özi bilen üýtgedilen gaty bolup durýan Current Pick (Те­
кущий выбор) miniatýurany Original (Исходное изображение) mi­
niatýura bilen deňeşdirip görmeli. Düzedişi ýatyrmak üçin başdaky 
şekile basmaly.

6. Lighter (Светлее) ýa-da Darker (Темнее) miniatýura tona 
degmän ýagtylygy üýtgetmek üçin basmaly.

Surat çekmek
Brush guraly
Brush (Кисть) (В klawi­

şany) guraly işledip, esasy reňki 
saýlamaly. Opsiýalar panelinde 
kistiň görnüşini saýlamak üçin 
Brush (Кисть) okuna basmaly. 
Piktogrammanyň aşagyndaky 
san kistiň pikselde bolan inini 
kesgitleýär.

Gönüçyzykly ştrihi döret­
mek üçin syçanjyk bilen bir gezek basyp, ştrihiň başyny bellemeli we 
Shift düwmejigini basyp, başga ýere syçanjyk bilen ştrihi tamamla­
maly.

Alt klawişasyny we şekiliň islendik ýerine basyp, gural işläp du­
ran wagty reňkiň nusgasyny almak mümkin.

Bar bolan kisti üýtgetmek
Photoshop programmasy bilen bilelikde kistleriň bibliotekasy­

nyň islendigini üýtgetmek mümkin:

5. Sargyt 1372
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1. Opsiýalar panelinde Brushes (Кисть) düwmejigine basyp, 
Brush Tip Shape menýusyna geçmeli.

2. Diameter (Диаметр) süýşgüjini süýşürmeli ýa-da ştrihiň dia­
metrini (inini) girizmeli (1-den 999-a çenli).

3. Hardness (Жесткость) süýşgüjini süýşürmeli ýa-da kistiň 
açyk däl yzyny kesgitleýän sany girizmeli – ştrihiň diametrine görä 
göterimde (0-100%).

4. Spacing (Интервал) süýşgüjini süýşürmeli ýa-da şol para­
metriň ululygyny girizmeli (0-999%). Ol näçe ýokary bolsa, kistiň 
yzlary şonça-da daşlykda ýerleşer.

Deslapdan gurnalan kistleriň köpüsi üçin üýtgedip boljak ýeke-
täk opsiýalar – bu Spacing we Diameter süýşgüçleridir.

5. Angle (Угол) meýdanyna belli bir bahany girizmeli (–180°-
dan +180°-a çenli).

6. Roundness (Округлость) parametriniň bahasyny girizmeli 
(0-100%) ýa-da iki sany gara nokadyň birini tegelegiň daşyna ýa-da 
içine çekmeli. Baha näçe ýokary bolsa, şonça-da kistiň görnüşi tege­
lege golaý bolýar.

7. Kistiň üýtgedilen häsiýetnamalary olary kistiň täze nusgasy 
hökmünde ýatda saklanýança wagtlaýyn bolar.
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8. Penjiräni ýapmak üçin gaýtadan Brushes (Кисти) düwmeji­
gine basmaly.

Bar bolan kist üýtgedilende onuň özi däl-de wagtlaýyn nusgasy 
modifisirlenen bolýar.

Täze kisti döretmek
1. Brush (Кисть) meýdanynda oka basmaly we saýlama paneli­

niň menýusyndan New Brush (Создать кисть) buýrugyny saýlamaly.
2. Kistiň üýtgedilen görnüşini ýatda saklamak üçin Create New 

Brush (Создать новую кисть) düwmejigine basmaly (emma täze 
nusga hiç bir biblioteka girmez). Täze kistiň piktogrammasy saýlama 
paneliniň iň soňunda ýerleşer.

Kisti ýok etmek
1. Kisti saýlama paneli açmaly.
2. Birinji usul: Alt klawişasyny we ýok edilmeli kiste syçanjyk 

bilen basmaly. Bu amaly ýatyryp bolmaýar.
Ikinji usul: ýok edilmeli kisti görkezip, açylýan menýudan Dele­

te Brush (Удалить кисть) buýrugy saýlamaly.

Şekiliň esasynda kisti döretmek
1. Rectangular Marquee (Прямоугольная область) guraly 

işletmeli.

Dry Media Brushes  
bibliotekasy

Thick Heavy Brushes 
bibliotekasy
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2. Şekiliň belli bir töweregini çäk bilen bellemeli (aňryçäk 
1000x1000 piksel).

3. Edit > Define Brush (Правка > Определить кисть) buýrugy 
saýlamaly.

4. Täze kistiň adyny girizmeli we ОK düwmejigine basmaly. Täze 
kistiň piktogrammasy saýlama panelinde iň soňky bolar. Bu kist bilen 
Brush (Кисть) guraly arkaly işlenende peýdalanmak mümkin. Redak­
tirleme palitrasynda Spacing (Интервал) parametrini sazlamaly.

Kisti täze bibliotekada ýatda saklamak
Täze kistleri bibliotekada ýatda saklamak üçin aşakdakylary ýe­

rine ýetirmeli:
1. Kisti saýlama paneliniň menýusynda Save Brushes (Сохра­

нить кисти) buýrugy saýlamaly;
2. Bibliotekanyň adyny girizmeli (.abr);

Wet Media Brushes bibliotekasySpecial Effects Brushes bibliotekasy
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3. Bibliotekanyň saklanyljak bukjasyny saýlamaly we Save 
(Сохранить) düwmejigine basmaly.

Töweregi Paint Bucket guraly bilen doldurmak.
Paint Bucket (Ведро с краской) guraly pikselleri esasy reňk 

ýa-da nagyş bilen çalşyrýar.
Paint Bucket (Ведро с краской) guralyny Bitmap düzgündäki 

şekile ulanyp bolmaýar.

Gural saýlanylandan soň paneliň Fill (Залить) meýdanynda Fo­
reground (Основной цвет) bahany we Mode (Режим смешивания) 
meýdanynyň bahasyny goýmaly. Düzgünden-düzgüne geçmek üçin 
Shift-«plýus» ýa-da Shift+«minus» klawişalary yzygiderli ulan­
maly. Multiply (Умножение), Soft Light (Мягкий свет) ýa-da Co­
lor Burn (Форсирование цвета) düzgünleri ulanyp görmeli.

Opacity (Непрозрачность) parametriniň bahasyny göterimde we 
Tolerance ýol bererligiň ululygyny (0-255) girizmeli. Şol ululyk näçe 
ýokary bolsa, şonça hem guralyň çalşyrjak reňkleriniň çägi ýokary 
bolýar. Ilkibaşda uly bolmadyk ýol bererligi goýmaly we doldurylýan 
töweregiň araçägini tekizlemek üçin Anti-aliased (Сглаживание) 
hem-de syçanjyk bilen basylýan töwerege diňe galtaşýan töwerekleri 
reňk bilen doldurmak üçin Contiguous (Смежные) baýdajygy goý­
maly.

Background Eraser (Ластик для фона) guraly
Bu gural üstünden kursor geçirilýän töwerekleri açyk edýär ýa-da 

ony fon reňki bilen doldurýar:
1. Bu guraly saýlamaly.
2. Opsiýalar panelinde Limits (Границы) menýudan şekiliň ni­

rede pozuljakdygyny saýlamaly:
1. Discontiguous (Несмежные), nokatlaryň galtaşýanlygyna 
garamazdan ýol bererlik bilen kesgitlenýän çäkdäki hem­
me nokatlary pozmak üçin. Eger bu opsiýa saýlanylsa onda 
mundan beýläk Sampling (Взятие образца) menýudan Once 
(Один раз) parametri saýlamaly;
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2. Continuous (Непрерывно), diňe, Tolerance (Допуск) pa­
rametri bilen kesgitlenýän çäkdäki galtaşýan, ilkinji syçanjyk 
bilen basylan pikselleriň reňkine gabat gelýän nokatlary poz­
mak üçin;
3. Find Edges (Найти края), diňe goňşy nokatlary ýok etmek 
üçin, emma obýektiň araçäklerini saklamaly (ýokary kontrast­
ly araçäkler degişlikde).

3. Tolerance (Допуск) parametriň bahasyny saýlamaly. Ol näçe 
ýokary bolsa, şonça-da syçanjyk bilen basylan ilkinji pikseliň reňkine 
meňzeş reňkleriň çägi giň bolýar.

4. Sampling (Взятие образца) menýudan aşakdakylary saýla­
maly:

• Continuous (Непрерывно), ýol bererlik bilen kesgitlenýän 
çäkdäki, üstünde kursor geçirilýän hemme pikselleri açyk et­
mek üçin;
• Once (Один раз), diňe üstünden kursor geçirilen ilkinji pik­
sele takyk gabat gelýän pikselleri açyk etmek üçin. Diňe bir 
reňki pozmak üçin bu opsiýany saýlamaly we ýol bererligi 1% 
etmeli;
• Background Swatch (Фоновый цвет), diňe, reňki fon bilen 
gabat gelýän pikselleri pozmak üçin. Bu opsiýa ulanylandan 
soň ýol bererligiň kiçi bahasyny goýmaly.

6. Pozmakdan belli bir reňki goramak üçin Protect Foreground 
Color (Защитить основной цвет) baýdajygy goýmaly we Sampling 
(Взятие образца) menýusynda Once (Один раз) opsiýanyň saýla­
nylandygyna göz ýetirmeli. Color (Цвет) palitrasynda esasy reňkiň 
kwadratyny işletmeli we Alt klawişany basyp, ony goýbermän şekiliň 
goranyljak pikseline basmaly.

7. Pozulmaly gaty, nokatlary saýlamaly.
8. Şeýlelikde kursoryň işjeň bölegi arassalanýar.
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Magic Eraser (Волшебный ластик) guraly
Bu gural kursory geçirmän, syçanjygyň ýönekeý basylmagy bi­

len pikselleri pozmaga mümkinçilik berýär. Ol berlen ýol bererligi 
hasaba almak bilen reňki syçanjyk bilen basylan piksele gabat gel­
ýän nokatlary pozýar. Bu gural edil Paint Bucket (Ведро с краской) 
ýaly işleýär, emma ondan tapawutlykda ol pikselleri goşmaýar-da ýok 
edýär. Eger açyk dälligi 100%-den pes edilse, onda Magic Eraser gu­
raly arkaly gatyň maksatly töwereklerini bölekleýin açyk edip bolýar.

Awtomatiki pozmagyň düzgüni
Awtomatiki pozmagyň düzgüninde (Auto Erase (Автоластик) 

opsiýasy goýlan Pencil (Карандаш) guraly bilen işlenilende) esasy 
reňkiň pikselleriniň üstünden kursor geçirilende fon reňki bilen surat 
çekiliş bolup geçýär. Eger kursory beýleki reňkiň pikselleriniň üstün­
den geçirilse, onda gural esasy reňk bilen çyzyp başlar.

Reňkleri çyrşama
1. Gaty saýlamaly.
2. Smudge (Палец) guraly R ýa-da Shift+R klawişalary basyp 

işletmeli.
Opsiýalar panelinde Brush (Кисть) meýdanynda oka basmaly 

we kistiň tipini saýlamaly.
3. Pressure (Давление) süýşgüji 100%-den pes baha geçirmeli.
4. Çyrşamagy esasy reňkden başlamak üçin opsiýalar panelinde 

Finger Painting (Рисование пальцем) opsiýasyny goýmaly. Eger 
şol opsiýa öçürilen bolsa çyrşaşdyrma ştrihiň başlanýan nokadyndan 
başlanar. Strength (Давление) parametriň bahasy näçe ýokary bolsa, 
şonça hem esasy reňk köp derejede ulanylar.

Gradiýent
Gradiýent reňklenmesi esasy reňk bilen iki ýa-da ondan hem köp 

reňkleriň arasynda kem-kemden biri-birine geçmeklik bolup durýar. 
Programma gradiýenti ulanmagyň iki usulyny hödürleýär. Birinji – 
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Gradient (Градиент) guraly gradiýenti gönümel gatyň düzümine 
ulanmaga mümkinçilik berýär.

Ikinji usul – doldurmagyň täze gatyny gradiýentli reňklemek 
(gradient fill layer), bu ýagdaýda gradiýent öz gatynda ýerleşýär. 
Gradiýentiň bu görnüşini redaktirlemek aňsat.

Gradiýenti doldurma gaty hökmünde ulanmak
1. Gaty saýlamaly. Gradient (Градиент) guralyny Bitmap ýa-da 

Indexed Color düzgündäki şekillere ulanmaklyk bolmaýar.
2. Gradient (Градиент) bendi Create new fill or adjustment 

layer (Создать новый слой заливки или корректирующий слой) 
düwmejigi bilen çagyrylýan menýudan çagyrmaly.

3. Gepleşik penjiresiniň ýokarsynda Gradient (Градиент) meý­
danyndaky oka basmaly we reňkleýşiň nusgasyny saýlamaly.

4. Style (Стиль) meýdanyndaky bahany saýlamaly: Linear 
(Линейный), Radial (Радиальный), Reflected (Отраженный), An­
gular (Угловой) ýa-da Diamond (Ромбовидный).

Gradiýentiň çykýan burçuny üýtgetmek üçin Angle (Угол) para­
metriň bahasyny bermeli.

Scale (Масштаб) süýşgüjini gradiýentiň gata görä masştabyny 
sazlamak üçin üýtgetmeli. Onuň bahasy näçe ýokary bolsa, şonça-da 
gradiýentiň reňkleriniň arasyndaky geçiş birsydyrgyn bolýar.
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Reverse (Обратить) baýdajygy gradiýentdäki reňkleriň geç­
meginiň ters tertibine çalşyrmak üçin goýmaly/aýyrmaly.

Dither (Размыть) baýdajygy gradiýente zolaklaryň emele gel­
meginiň mümkinligini iň pes ýagdaýa getirmek üçin goýmaly.

Align with layer (Выровнять со слоем) baýdajygy gradiýent 
doldurmagyň uzynlygyny gatyň çäginiň ölçeglerini hasaba almak bi­
len hasaplanar ýaly goýmaly.

Gradient guralyny ulanmak
Gradient (Градиент) guraly arkaly şekili diňe kursory süýşürip 

reňklemek mümkin. Her gezek kursor süýşürilende gata täze gra­
diýent ulanylýar. Gradiýent doldurmagyň gatyndan tapawutlylykda 
şu hili döredilen gradiýenti redaktirlemek kyn.

1. Gradient Tool (Градиент) guraly işletmeli (G или Shift+G).
2. Opsiýalar panelinde birinji meýdanyň okuna basyp, reňkleýşiň 

nusgasyny saýlamaly.

Gradiýentiň burçy 45° bölünijilikli bolar ýaly Shift klawişasyna 
basyp, kursory süýşürmeli.

Gradiýentiň nusgasyny döretmek we redaktirlemek
Gradiýentiň nusgasy üýtgedilse we ýok edilse, hakyky gradiýent 

gradiýentleriň şol wagtky ulanylýan bibliotekasynda üýtgemeýär.
1. Gradient (Градиент) guralyny işletmeli, soňra opsiýalar 

panelinde gradiýentiň nusgasyna basyp, Gradient Editor (Правка 
градиента) penjiresini açmaly.

Gatyň miniatýurasy

Gatyň maskasy
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2. Gradient Editor (Правка градиента) gepleşik penjiresinde 
üýtgetjek bolýan gradiýentiň nusgasyna basmaly.

3. Başlangyç reňki saýlamak üçin gradiýentiň paneliniň aşagynda 
ýerleşen öwüşginiň başlangyç markerine basmaly.

4. Swatches (Образцы) palitrasynda haýsy-da bolsa bir reňke 
basmaly ýa-da Color (Цвет) palitranyň aşaky böleginde ýerleşen 
spektriň paneline basmaly.

5. Ahyrky reňki saýlamak üçin ahyrky öwüşginiň markerine bas­
maly.

Gradiýente aralykdaky reňki goşmak üçin gradiýentiň paneliniň 
aşagyna syçanjyk bilen basmaly we marker döretmeli hem-de onuň 
üçin reňk saýlamaly.

Reňkleriň biri-birine geçmeginiň ýitiligine gözegçilik etmek 
üçin romb görnüşindäki markeri süýşürip durmaly.

Reňki ýok etmek üçin onuň markerini panelden aşak süýşürmeli. 
Soňky amaly ýatyrmak üçin Ctrl+Z klawişalardan peýdalanmaly.

Gradiýentiň reňkleriniň dury dälliginiň derejesini üýtgetmek
1. Gradient Editor (Правка градиента) gepleşik penjiresini aç­

maly we nusgany saýlamaly.
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2. Gradiýentiň paneliniň ýokarsynda ýerleşen dury dälligiň mar­
kerine basmaly.

3. Dury dälligiň derejesini saýlamaly.
Dury dälligiň goşmaça markerlerini goşmak üçin gradiýentiň 

paneliniň ýokarsyna basmaly we her marker üçin dury dälligiň koef­
fisiýentini girizmeli.

Gatlar barada goşmaşa maglumat
Gatyň dury dälligini üýtgetmek
Layers (Слои) palitrasynda gatyň dury dälliginiň derejesini 

bellemek mümkin. Programmada dury dälligiň hem esasy derejesi­
ni (Opacity meýdany) hem-de içerki derejesini (Fill meýdany) üýt­
getmek mümkin. Şol bahalar näçe pes bolsa, şonça hem işjeň gatyň 
aşagynda köp pikseller görner. Fonuň dury dälligini üýtgedip bol­
maýar.

Effektler
Gata şular ýaly ýörite effektleri ulanmak mümkin: Drop Sha­

dow (Отбросить тень), Inner Shadow (Внутренняя тень), Outer 
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Glow (Внешнее свечение), Inner Glow (Внутреннее свечение), 
Bevel and Emboss (Скос и рельеф), Satin (Атлас), Color Overlay 
(Наложение цвета), Gradient Overlay (Наложение градиента), 
Pattern Overlay (Наложение узора) we Stroke (Кайма).

Stiller bilen effektleri çalşyrmaly däl. Stil – gatyň bir ýa-da bir­
näçe effektleriň utgaşmasydyr.

Effektler Layer Style (Стиль слоя) gepleşik penjiresi ýa-da Add 
layer style (Добавить стиль слоя) bendi arkaly döredilýär we redak­
tirlenýär. Gatyň effektini şekiliň fonuna ulanmak mümkin däl.

Effektleri bir gatdan beýlekä göçürip bolýar. Munuň üçin olary 
belläp, syçanjyk bilen gerekli gatyň üstüne getirip goýmaly, olary edil 
gatlary ýaly bukup bolýar. Hemme effektleri bukup programmanyň 
tiz hereketliligini ýokarlandyrmak üçin Layer > Layer Style > Hide 
All Effects (Слой > Стиль слоя > Спрятать все эффекты) buýrugy 
saýlamaly. Olary görkezmek üçin Show All Effects (Показать все 
эффекты) buýrugy çagyrmaly;

Drop Shadow we Inner Shadow effektleriň ulanylmagy
1. Gaty saýlamaly.
2. Drop Shadow (Отбросить тень) effektiň adyna basmaly.
Blend Mode (Режим смешивания) menýudan garyşma düzgüni 

saýlamaly.
Kölegä başga reňk saýlamak üçin reňkiň nusgasyna basmaly.



77

Kölegäniň dury dälliginiň derejesini saýlamaly.
Angle (Угол) parametriň bahasyny saýlamaly. Ol başlangyç 

gatyň fuguralaryna görä kölegäniň burçuny kesgitleýär. Use Global 
Light (Использовать глобальное освещение) baýdajyk goýlan bol­
sa, onda Layer > Layer Style > Global Light (Слой > Стиль слоя > 
> Глобальный свет) gepleşik penjiresinde girizilen burç ulanylýar. 
Şol effektde aýratyn burçy ulanmak üçin şol baýdajygy aýyrmaly.

Bellik
Eger Use Global Light (Использовать глобальное освещение) 

baýdajyk goýlan ýagdaýynda aýry effekt üçin burç üýtgedilse, onda 
bu opsiýany ulanýan hemme effektler üçin burç hem üýtgeýär.

Distance (Расстояние) parametriň bahasyny saýlamaly, ol köle­
geden başlangyç gatyň figurasyna çenli aralygy (pikselde) ýa-da içki 
kölegäniň inini kesgitleýär.
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Spread (Распространение) parametri kölegäniň gyralarynyň 
goýulyk derejesini kesgitleýär. Inner Shadow (Внутренняя тень) 
effekti üçin kölegäni inçeldýän Choke (Уменьшение) parametriniň 
bahasyny saýlamaly.

Kölegäniň ölçegini Size (Размер) süýşgüji arkaly bellemeli. 
Quality (Качество) parametrleriň toparynda kölegäniň araçäkleri 
üçin sudury ýörite panelde saýlamak üçin Contour (Контур) okuna 
basmaly.

Outer Glow we Inner Glow effektleriň ulanylmagy
1. Swatches (Образцы) palitrasyny açmaly.
2. Gatyň adyna iki gezek syçanjyk bilen basmaly.
3. Outer Glow (Внешнее свечение) ýa-da Inner Glow (Внут­

реннее свечение) effektleriň atlaryna basmaly.
4. Structure (Структура) bölüminde parametrleriň bahalaryny 

bermeli.
Yşyklylygyň reňkini üýtgetmek üçin reňkiň nusgasyna basmaly 

we açylýan panelden reňki saýlamaly. Fonuň reňki bilen kontrast­
laşýan reňki saýlamaly, sebäbi daşky yşyklanmanyň açyk reňkini 
açyk fonda görmek örän kyn.

5. Noise (Шум) parametriň bahasyny goýmaly, ol yşyklanmagyň 
garjaşyklygynyň derejesini kesgitleýär.

Elements (Элементы) bölüminde parametrleriň bahalaryny saý­
lamaly.

Technique (Техника) açylýan menýudan Softer (Мягче) ýa-da 
Precise (Точно) warianty saýlamaly (maskanyň töweregiň suduryna 
näçe takyk laýyk gelýändigine gözegçilik etmek üçin).

Inner Glow (Внутреннее свечение) effekti üçin geçirijini Cen
ter (Центр) ýagdaýyna goýmaly (gatyň merkezi piksellerinde yşyk­
lanmany döretmek üçin). Eger geçiriji Edge (Граница) ýagdaýyna 
goýlan bolsa, onda yşyklanma obýektiň çäklerinden onuň içine gid­
ýän edilip döredilýär.

Outer Glow (Внешнее свечение) effekti ýagdaýynda Spread 
(Распространение) parametriniň ululygyny yşyklanmanyň inini kes­
gitlemek üçin bellemeli.
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Inner Glow (Внутреннее свечение) effekti üçin Choke 
(Уменьшение) parametriniň ululygyny düzetmeli, ol yşyklanmanyň 
inini kesgitlemegi amala aşyrýar.

Yşyklanmanyň ölçegini Size (Размер) ölçegi arkaly bellemeli.

6. Quality (Качество) bölüminde parametrleriň bahalaryny goý­
maly.

Yşyklanmanyň araçäginiň profili üçin suduryň nusgasyny saýla­
mak üçin Contour (Контур) meýdanyndaky oka basmaly.

Yşyklanmanyň içinde suduryň effektiniň ýerleşmegine gözegçi­
lik etmek üçin Range (Диапазон) parametriniň bahasyny saýlamaly.

7. Eger ýşyklanma gradiýenti saklaýan bolsa Jitting (Дрожание) 
parametrini gradiýentde reňkleri tötänleýin ýerleşdirmek üçin ulan­
maly.
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Bevel we Emboss effektlerini ulanmak.
Bevel and Emboss (Скос и рельеф) effekti gatyň figuralaryna 

yşygy we kölegäni goşup, göwrümli görnüşini döredýär.
1. Swatches (Образцы) palitrasyny açmaly.
2. Layers (Слои) palitrasynda gatyň adyna iki gezek syçanjyk 

bilen basmaly.
3. Bevel and Emboss (Скос и рельеф) effektiniň adyna bas­

maly.
4. Structure (Структура) bölüminde parametrleriň bahalaryny 

saýlamaly.
Style (Стиль) menýusynda şulardan bir warianty saýlamaly: 

Outer Bevel (Внешний скос), Inner Bevel (Внутренний скос), 
Emboss (Рельеф), Pillow Emboss (Выпуклый рельеф) ýa-da Stro­
ke Emboss (Рельефная кайма).

Technique (Техника) açylýan menýudan Smooth (Гладко), 
Chisel Hard (Твердый резец) ýa-da Chisel Soft (Мягкий резец) 
wariantlary saýlamaly.

Gatyň figurasyndan açyk meýdançalaryň we kölegäniň süýş­
meginiň derejesini görkezmek üçin Depth (Глубина) parametriniň 
bahasyny girizmeli.

Up (Вверх) we Down (Вниз) geçirijiler yşygyň we kölegäniň 
ýerlerini çalyşmaga mümkinçilik berýär.

Effekt üçin Size (Размер) parametriň bahasyny saýlamaly.
Figuranyň takyk araçäklerini ýumşatmak we şeýlelik bilen effek­

ti ýumşatmak üçin Soften (Смягчить) parametriniň bahasyny artdyr­
maly.

5. Shading (Затенение) bölüminde parametrleriň bahalaryny 
saýlamaly.

Angle (Угол) we Altitude (Высота) parametrler yşygyň çeş­
mesiniň ýerleşişini kesgitleýär. Bu bolsa bliklere we kölegelere täsir 
edýär. Gloss Contour (Контур блеска) okuna basmaly we açylýan 
panelde nusgany saýlamaly.

6. Highlight Mode (Режим света) we Opacity (Непрозрач­
ность) ýa-da Shadow Mode (Режим – тени) we Opacity (Непроз­
рачность) parametrleriň bahalaryny degişlilikde şekiliň açyk we ga­
ramtyl töwerekleri üçin goýmaly.
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Açyk we garamtyl tonlaryň reňkini üýtgetmek üçin reňkiň islendik 
nusgasyna basmaly we Color Picker panelinde täze tony saýlamaly.

6. Bevel and Emboss (Скос и рельеф) effektine yşyklanmanyň 
araçäklerine täsir edýän belli bir sudury goşmak üçin Bevel and Em­
boss (Скос и рельеф) adyň aşagynda ýerleşen Contour (Контур) 
ýazga basmaly. Contour (Контур) meýdanyndaky oka basmaly we 
nusgany saýlamaly.

Yşyklanmanyň içinde suduryň effektiniň ýerleşmegine gözegçi­
lik etmek üçin Range (Диапазон) parametriň bahasyny saýlamaly. 
Bu opsiýa Emboss (Рельеф) effektine hiç hili täsir etmeýär.

7. Effekte teksturany goşmak üçin Texture (Текстура) ýazga 
basmaly, soňra Texture (Текстура) meýdanyň okuna basyp, açylýan 
panelde suraty saýlamaly.

Suratyň masştabyny Scale (Масштаб) süýşgüji arkaly redaktir­
lemeli.

6. Sargyt 1372
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Depth (Глубина) parametrini suratyň açyk we garamtyl reňk­
leriniň kontrastyny düzetmek üçin üýtgetmeli.

Tekstura we gat sinhron hereket eder ýaly Link with Layer 
(Связать со слоем) baýdajygy goýmaly. Şekiliň penjiresinde kursor 
bilen teksturanyň şekilini gerek ýagdaýda ýerleşdirmeli.

Suduryň profiliniň üýtgedilmegi
Effektiň suduryny üýtgetmek üçin aşakdaky hereketleri ýerine 

ýetirmeli:
1. Bevel and Emboss (Скос и рельеф) effektiň ýagdaýynda 

Contour (Контур) ýazga basmaly;
2. Suduryň miniatýurasyna basmaly;
3. Contour Editor (Правка контура) gepleşik penjiresinde Pre­

set (Образец) açylan menýuda sudury saýlamaly;
4. Täze nokatlary goşmak üçin çyzga basmaly. Nokatlary süý­

şürip çyzgyny üýtgetmeli;
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5. Şol wagtda bellenilen nokady burçdaka özgertmek üçin Cor­
ner (Угол) baýdajygy goýmaly.

Profilleriň miniatýuralary araçäkleriň dürli stillerini görkezýär. 
Çal töwerekler özi bilen dury däl pikseller bolup durýar, aklar bolsa 
– açyk.

Satin effektiniň ulanylmagy
1. Satin (Атлас) effektine basmaly.
Blend Mode (Режим смешивания) meýdanyň bahasyny üýtge­

dip görmeli.
Reňki üýtgetmek üçin reňkiň nusgasyna basmaly.
Angle (Угол) parametriniň bahasyny üýtgetmeli. Ol burç Global 

Light (Глобальное освещение) parametriň bahasyna bagly däl.
Distanсе (Расстояние) we Size (Размер) parametrleriniň baha­

laryny goýmaly. Contour (Контур) meýdanynda oka basyp, effektiň 
araçäginiň profilini saýlamaly.



84

2. Açyk we garamtyl töwerekleriň ýerini çalşyrmak üçin Invert 
(Инвертировать) baýdajygy goýmaly.

Color Overlay effektiniň ulanylmagy
1. Bir gaty saýlap oňa iki gezek basmaly.
2. Color Overlay (Наложение цвета) effektiniň adyna basmaly.
Blend Mode (Режим смешивания) parametriň bahasyny saýla­

maly. Öňküniň üstünden goýmak üçin täze başga reňki saýlamaly.
3. Opacity (Непрозрачность) parametriniň bahasyny düzetmeli.

Gradient Overlay effektiň ulanylmagy
1. Gatyň adyna iki gezek basmaly.
2. Gradient Overlay (Наложение градиента) effektiniň adyna 

basmaly.
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Blend Mode (Режим смешивания) parametriň bahasyny saýla­
maly.

Opacity (Непрозрачность) parametriniň bahasyny düzetmeli.
Gradient (Градиент) meýdanynda oka basmaly we gradiýenti 

saýlamaly. Gradiýentiň ugruny üýtgetmek üçin Reverse (Обратить) 
baýdajygy goýmaly.

Style (Стиль) meýdanynda şu bahalardan saýlamaly: Linear 
(Линейный), Radial (Радиальный), Angle (Угловой), Reflected 
(Отраженный) ýa-da Diamond (Ромбовидный).

Gradiýenti gatyň figuralaryna görä deňleşdirmek üçin Align 
with Layer (Выровнять со слоем) baýdajygy goýmaly. Gradiýent 
üçin Angle (Угол) parametriň bahasyny goýmaly.

3. Scale (Масштаб) parametriniň bahasyny goýmaly.
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Pattern Overlay effektiniň ulanylmagy
1. Gatyň adyna iki gezek basmaly.
2. Pattern Overlay (Наложение узора) effektiniň adyna bas­

maly.
Blend Mode (Режим смешивания) parametriň bahasyny saýla­

maly.
Opacity (Непрозрачность) parametriniň bahasyny düzetmeli.
Pattern (Узор) meýdanynda oka basyp, islendik nusgany saýla­

maly.
Nagyş üçin Scale (Масштаб) parametriniň bahasyny saýlamaly.
Nagşy gat bilen baglaşdyrmak üçin Link with Layer (Связать 

со слоем) baýdajygy goýmaly.

Stroke effektiniň ulanylmagy
1. Gatyň adyna iki gezek basmaly.
2. Stroke (Кайма) effektiniň adyna basmaly.
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Size (Размер) parametriniň bahasyny saýlamaly. Position (По­
ложение) açylýan menýudan goýulýan fuguranyň araçäklerine görä 
ýerleşişini saýlamaly: Outside (Снаружи), Inside (Внутри) ýa-da 
Centered (По центру).

Blend Mode (Режим смешивания) parametriniň bahasyny 
saýlamaly.

Opacity (Непрозрачность) parametriniň bahasyny düzetmeli.
Fill Type (Тип заливки) menýuda gerek bolan görnüşi saýla­

maly: Color (Цвет), Gradient (Градиент) ýa-da Pattern (Узор).

Gatlary baglaşdyrmak we olary bir bitewi edip süýşürmek
1. Layers (Слои) palitrasynda baglaşmaly gatlaryň birine bas­

maly.
2. Birinji ädimde saýlanylan gat bilen baglaşmaly gatyň ýanyn­

daky ikinji sütüniň kwadratyna basmaly. Baglaşylýan gatlar hökman 
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yzygiderli ýerleşmeli däldir. Baglaşma nyşany işjeň däl baglaşylan 
gatlagyň ýanynda emele geler.

Iki we köp baglaşylan gatlary deňleşdirmek
Align Layers (Выровнять слои) buýrugy baglaşylan gatlaryň 

araçäklerini deňleşdirmek üçin ulanylýar.
1. Iki we ondan köp gatlar bilen baglaşylan gaty saýlamaly, şoňa 

görä beýleki gatlar deňleşdirilýär.
2. Layer > Align Linked > Top Edges (Слой > Выровнять свя­

занные > Верхние границы), Vertical Center (Положение центра 
по вертикали), Bottom Edges (Нижние границы), Horizontal 
Center (Положение центра по горизонтали), Left (Левый край) 
ýa-da Right (Правый край) buýruklary saýlamaly.

Bellenilen töwerek boýunça gatyň araçägini deňleşdirmek
1. Bellenilen töweregi döretmeli.
2. Şol töwerek boýunça deňleşdirilen gaty saýlamaly.
3. Layer > Align to Selection (Слой > Выровнять по выде­

ленной области) kömekçi menýudan buýrugy saýlamaly.
Saýlanylan gat bilen bagly bolan islendik gatlar hem deňleşerler.



Üç we ondan köp baglaşan gatlaryň tertipleşdirilmegi
Baglaşylan gatlarda şekilleri bellenilen tertipde Distribute 

Linked (Распределить связанные) buýrugy arkaly tertipleşdirmek 
mümkin.

1. Iki we ondan hem köp gatlar bilen baglaşan gaty saýlamaly.
2. Şol gatyň bir töweregini saýlamaly, şol töwerek boýunça 

beýleki gatlar deňleşdirilmeli.
3. Layer > Distribute Linked > Top Edges (Слой > Распределить 

связанные > Верхние границы), Vertical Center (Положение 
центра по вертикали), Bottom Edges (Нижние границы), Hori­
zontal Center (Положение центра по горизонтали), Left (Левый 
край) ýa-da Right (Правый край) buýruklary saýlamaly.

Gatlaryň şekilleri biri-birinden has uzakda ýerleşen iki sany 
gatyň arasynda birölçegli ýerleşdiriler.

Tejribe işleri
1. Çekilen suratda birnäçe gatlary döretmek.
2. Gatlary birleşdirmek.
3. Tekst gatyny döretmek.
4. Ýazylan tekstiň transformasiýalaryny üýtgetmek.
5. Ýazylan tekstiň kölegesini emele getirmek.
6. Ýazylan tekstiň ýylpyldysyny döretmek.
7. Teksti altyn şekilinde ýazmak.
8. Dürli gatlary ulanyp, kompozisiýa döretmek.
9. Jaýlaryň utgaşygyny döretmek.
10. Tekst maskasyny almak.
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VI. Goşmaça mümkinçilikler

Maskalar
Bellenilen töweregiň formasyny ýatda saklamagyň we üýt­

getmegiň ýörite iki sany usuly bar: alfa-kanallar we Quick Mask 
(Быстрая маска) düzgüni.

Eger bellenilen töwerek alfa-kanal diýlip atlandyrylýan ýörite 
döredilen ýarym ton kanalda saklanylsa, ony islendik ýagdaýda şekile 
ýüklemek mümkin. Faýlda 24 sany kanala çenli saklanylyp bilner, her 
kanal faýlyň göwrümini ulaldýar.

Alfa-kanallara bolan elýeterliligi Channels (Каналы) palit­
rasy arkaly almak mümkin. Olary ýatda saklamagy ýa-da ýükleme­
gi bolsa Select (Выделить) menýusynyň ýa-da Channels (Каналы) 
palitrasynyň buýruklary arkaly amala aşyrmak mümkin.

Quick Mask (Быстрая маска) düzgüni arkaly Photoshop pro­
grammasynda şekiliň bellenilen we bellenilmedik töwerekleriniň 
üsti ýarym dury reňkli maska bilen ýapylyp bilner, soňkularyň for­
masy surat çekiş ýa-da redaktirleýiş guraly arkaly üýtgedilip bilner. 
Maskalanan töwerekler üýtgemelerden goranylan. Alfa-kanallardan 
tapawutlykda tiz maskany ýatda saklap bolmaýar, emma Standard 
(Стандартный) düzgünine gaýdylanda maska ýatda saklanylyp bil­
jek bellenilen töwerege özgerdiler.

Quick Mask (Быстрая маска) düzgüni gurallar panelinden (Q 
klawişasy) çagyryp, gatyň belli bir bölegini bellesek, ýarym açyk 
tonirlenen maska bellenilmedik töwerekleriň üstüni alar, bellenilen 
töwerek bolsa görner. Maskanyň formasyny Pencil (Карандаш) ýa-da 
Brush (Кисть) gurallar arkaly üýtgetmek mümkin. Bellenilen töwe­
rek boýunça gara reňk bilen çyzylsa maskalanan (goranylan) töwerek 
ulalar, ak bilen çyzylsa kesilip alnan maskalanmadyk töwerek ulalar.

Aşakdaky görkezmeler ýerine ýetirilende maskany bellenilen 
töweregi ulanman döretmek mümkin:

1. Pencil (Карандаш) ýa-da Brush (Кисть) guraly işletmeli.
2. Gurallar panelindäki Quick Mask (Быстрая маска) düwme­

jige iki gezek basmaly.
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3. Color Indicates (Цвет означает) geçirijini Selected Areas 
(Выделенные области) ýagdaýa goýup, ОK düwmejige basmaly.

4. Gata gara ştrihleri çyzmaly. Bellenilen töwerekler maska bilen 
ýapylar we çyzylan ýerler bolsa bellenilen töwerege öwrüler. Soňra 
standart düzgüne gaýtmak üçin Q klawişasyna basmaly.

Sudurlar
Aşakda suratlary görkezilen Реn (Перо) toparynyň we figuralary 

gurmagyň gurallary arkaly sudur (path) diýlip atlandyrylýan wektor 
obýektleri döretmek mümkin.

Sudurlar düwün nokatlardan (anchor point) durýarlar, şol no­
katlar biri-biri bilen egri we göni çyzyklaryň segmentleri bilen bir­
leşdirilen. Suduryň formasyny üýtgetmek üçin düwün nokady süý­
şürmeli, goşmaly, ýok etmeli ýa-da segmenti süýşürmeli.
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Реn (Перо) ýa-da Freeform Pen (Свободное перо) gurallary 
arkaly döredilen sudurlar Paths (Контуры) palitrany ulanmak bilen 
görkezilýär, açylýar, ýapylýar, ýatda saklanylýar we ýok edilýär.

Bellenilen töweregi sudura özgertmek üçin aşakdaky amallary 
ýerine ýetirmeli:

1. Şekiliň bölegini saýlamaly.
2. Alt klawişasyna basmaly we ony goýbermän Paths palitrasy­

nyň aşaky bölegindäki Make work path from selection (Создать 
рабочий контур из выделенной области) düwmejige basmaly ýa-da 
Paths palitrasynyň menýusynda Make work path buýrugy saýla­
maly.

3. Tolerance (Допуск) parametriniň bahasyny 0,5-den 10-a çen­
li girizmeli (şol baha näçe kiçi bolsa, şonça düwün nokatlary kän we 
sudur has takyk bolar).

Bellenilen töwerek sudura özgerdilenden soň programma amal­
lary diňe sudur bilen alnyp barlar.

Täze iş sudurynyň ady Paths palitrasynda emele geler. Program­
ma tarapyndan hödürlenen ady hökmany üýtgedilmelidir, munuň üçin 
oňa iki gezek basmaly we täze at girizmeli.

Sudury Реn guraly arkaly gurmak
1. Munuň üçin Pen Tool guraly saýlamaly (Р ýa-da Shift+P 

klawişasy).
2. Göni çyzykly segmentleri almak üçin syçanjyk bilen şekiliň 

ýerlerine basyp durmaly, iki nokadyň arasy awtomatiki göni çyzyk 
bilen birleşer. Indiki kesimi 45° bölünijilikli burç bilen çyzmaly bolsa 
Shift klawişasyny basyp, soňra syçanjygy basmaly.

Eger egri çyzykly segmenti gurmak gerek bolsa, syçanjygyň çep 
düwmejigini basyp, ony süýşürmeli. Ugrukdyryjy çyzyklar emele geler.
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Soňky düwün nokadynda öwrümi döretmek üçin Alt klawişasy­
ny basyp, syçanjygy gerekli ugra süýşürmeli.

Soňky döredilen düwün nokadyny ýok etmek üçin Delete klawi­
şasyny basmaly, tutuş sudury ýok etmek üçin bolsa şol klawişany iki 
gezek basmaly.

3. Sudury ýapman onuň bilen işi tamamlamak üçin Ctrl klawi­
şasyny basmaly we syçanjyk bilen sudurdan daşary ýa-da beýleki 
guralyň piktogrammasyna basmaly. Nobatdaky sudury gurmazdan öň 
ondan öňki sudur işjeň däl ýagdaýa geçirilmedik bolsa, onda hemme 
goşmaça sudurlar şol bir at bilen ýatda saklanylar.

Sudury ýapmak üçin birinji düwün nokadyna basmaly.

Sudurlary süýşürmek üçin Path Selection Tool (Инструмент 
выбора контура) guraly (А ýa-da Shift+A klawişalary) peýdalan­
maly.

Sudurlaryň üstünden transformasiýa buýruklaryny ýerine ýetir­
mek hem mümkin.

Suduryň aýratyn bir nokadyna hem transformasiýanyň birnäçe 
buýruklaryny ulanmak mümkin. Munuň üçin Direct Selection Tool 
(Инструмент прямого выделения) guraly А klawişasyna basyp 
saýlamaly we gerekli nokady bellemeli.

Sudurlaryň göçürmesiniň birnäçe usullary bar. Olaryň biri Path 
Selection Tool guraly işledip, Alt klawişasyny basyp saklap, syçan­
jyk bilen sudury süýşürmek ýa-da palitrada suduryň adyny belläp, 
ony Alt klawişasyny basyp saklap, palitranyň Create new path düw­
mejigine getirmekdir.

Sudury wagtlaýyn görkezmezlik ýa-da görkezmek üçin palitrada 
onuň adyna Shift klawişasyny basyp, syçanjyk bilen basmaly.

Suduryň düwün nokatlaryny bellemegiň iki usuly bar. Birinji 
usulda suduryň adyny palitrada saýlap, Path Selection Tool guraly 
işletmeli we syçanjyk bilen sudury şekilde saýlamaly ýa-da onuň 
daşyndan punktirli çägi döretmeli. Netijede onuň hemme düwün no­
katlary bellenilip galar.

Ikinji usul – Direct Selection Tool guraly işletmeli. Sudury 
ýa-da onuň bölegini saýlap, soňra onuň bir düwün nokadyny belle­
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meli. Shift düwmejigini basyp saklap, suduryň beýleki düwün nokat­
laryny hem bellemek mümkin.

Sudurda hemme düwün nokatlary bellemek üçin Alt klawişasyny 
basmaly we sudury bellemeli.

Pen guraly bilen işlenende Direct Selection Tool guraly wagt­
laýyn işletmek üçin Ctrl klawişasyny basmaly.

Sudurlaryň formalaryny üýtgetmek üçin onuň düwün nokat­
larynyň ýerleşişini üýtgetmek ýa-da segmenti süýşürmek ýeterlik. 
Egri segmentiň formasyny ugrukdyryş çyzygy süýşürip ýa-da ony 
degişli düwün nokadyň daşyndan aýlap üýtgetmek mümkin.

Sudurlaryň düwün nokatlaryny aýyrmak we goşmak gurallar pa­
nelinden Pen guralyň goşmak we aýyrmak nyşanly görnüşlerini ulan­
maklyk arkaly amala aşyrylýar.

Eger opsiýalar panelinde AutoAdd/Delete (Автоматическое 
добавление/удаление) baýdajyk goýlan bolsa, Pen guraly görkeziji 
segmente getirilende Add Anchor Point Tool gurala öwrülýär ýa-da 
görkeziji düwün nokatda bolsa Delete Anchor Point Tool (Удалить 
узловую точку) gurala öwrülýär. Bu düzgüni wagtlaýyn aýyrmak 
üçin Shift klawişasyny basyp saklamaly.

Eger ugrukdyryş çyzygynyň manipulýatory iki segmentiň düz 
seplenmeginiň nokadynda süýşürilse, onda iki segment hem süý­
şüriler. Eger ugrukdyryş çyzygy suduryň döwülme nokadynda süý­
şürilse, onda diňe bir segment süýşüriler.

Düz seplenmeginiň nokadyny döwülmä özgertmek üçin Con­
vert Point Tool (Преобразовать узел) guraly işletmeli.

Eger amaly tersine ýerine ýetirmek gerek bolsa, onda gaýtadan 
Convert Point Tool guraly saýlamaly.

Ugrukdyryş çyzygynyň bir bölegini beýlekä garaşsyz öwürmek 
üçin Convert Point Tool guraldan peýdalanmaly.

Sudurlary Path palitranyň degişli düwmejikleri arkaly ýok et­
mek mümkin.

Sudury belleýşe öwürmek üçin Path palitrasynda sudury we 
kontekst menýudan Make Selection bendi saýlamaly.
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Amallar «Tiz» klawişalar
Sudury belläp 
almak

Ctrl klawişasy basylan mahaly suduryň adyna 
syçanjyk bilen basmak

Sudury belleýşe 
goşmak

Ctrl+Shift klawişalary basylan mahaly suduryň 
adyna syçanjyk bilen basmak

Sudury belleýişden 
aýyrmak

Ctrt+Alt klawişalary basylan mahaly suduryň adyna 
syçanjyk bilen basmak

Sudury belleýiş 
bilen kesişdirmek

Ctrl+Alt+Shift klawişalary basylan mahaly suduryň 
adyna syçanjyk bilen basmak

Fill Path (Заливка контура) buýrugy sudury belli bir reňk, gaý­
talanýan nagyş ýa-da beýleki şekil bilen doldurmagy amala aşyrýar.

1. Paths palitrasynda sudury işjeňleşdirmeli.
2. Layers palitrasynda reňklenen suduryň ýerleşjek gatyny saý­

lamaly.
3. Sudury akdan ýa-da garadan tapawutly reňk bilen doldurmak 

üçin Foreground color parametriň bahasyny bellemeli.
4. Alt düwmejigini basyp, Paths palitrasynyň aşaky bölegindä­

ki Fill path with foreground color (Заливка контура основным 
цветом) düwmejigine basmaly. Contents (Содержимое заливки) 
böleginde Use (Использовать) açylýan sanawyndan doldurmagyň 
degişli düzgünini saýlamaly.
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Figuralar
Figura (shape) geometrik obýekt ýa-da belli bir görnüşli töwe­

rekdir. Figura bir tonly ýa-da gradiýentli reňke eýe bolup ýa-da gaý­
talanýan nagyş bilen doldurylyp bilner, özem her figura öz gaty gabat 
gelýär.

Figura çyzylanda Shift düwmejigi basyp, kwadrat (gönüburç­
lugyň deregine), tegelek (ellipsiň deregine) we 45° bölünijilikli burç 
boýunça ýerleşen çyzyk çyzylýar.

1. Islendik figuralary saýlamagyň paneline täze elementi goşmak 
üçin täze döreden figuranyň adyny Layers palitrasynda saýlamaly.

2. Edit > Define Custom Shape (Правка > Определить заказ­
ную форму) buýrugy ýerine ýetirmeli, Custom Shape guralyň pane­
linde täze element emele geler.
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Figuranyň reňkini üýtgetmek üçin (gradiýent ýa-da gaýtalanýan 
nagyşly edip) Layer > Change Layer Contents (Слой > Изменить 
содержимое слоя) buýrugy ýerine ýetirmeli.

Figuranyň reňk doldurmasy islendik mahal üýtgedilip bilner.
1. Layers palitrasynda shape görnüşli elementiň adyna syçanjyk 

bilen iki gezek basmaly.
2. Reňk palitrasyndan täze reňki saýlamaly.

Shape görnüşli gaty rastr formadyna özgertmek
Shape görnüşli gatda pikselleriň üstünden dürli amallary ýeri­

ne ýetirmek üçin, meselem, surat çekmek ýa-da filtrlemek üçin, ilki­
başda gaty rastr formatyna geçirmek gerek.

1. Shape görnüşli gaty saýlamak üçin:
• Layer > Rasterize (Слой > Преобразовать в растровый 
формат) buýrugy goýbermeli ýa-da ol buýrugy Layers palit­
rasynda gerek bolan gaty saýlap, kontekst menýudan çagyr­
maly.

Tekst bilen işlemek
Photoshop programmasynda tekst wektorly bolup durýar.
Туре (Текст) guraly arkaly tekst döredilenden soň ol awtomatiki 

öz gatynda emele gelýär. Islendik wagtda onuň atributlaryny üýtget­
mek mümkin: şriftini, stilini, kegli, reňkini, kerningini, trekingini, se­
tirara aralygy, deňleşmegini baza çyzygyna görä ýerleşişini. Mundan 
başga dürli atributlar bir tekst gatdaky dürli harplara hem berlip bilner.

Şeýle hem, tekstiň düzümini, oňa gatyň dürli effektlerini ulan­
maga, garyşma düzgünini we açyk däl derejesini üýtgetmäge ýol be­
rilýär. Redaktirlenýän tekst gatyna filtrleri ulanmak mümkin, teksti 
çyzyp ýa-da ony gradiýent we surat bilen doldurmak mümkin. Bu 
amallary amala aşyrmak üçin tekst gatyny rastr formatyna Layer pa­
litrasynda tekst gaty belläp, kontekst menýudan Растеризация слоя 
bendi arkaly geçirmek gerek.

Bitmap, Indexed Color we Multichannel düzgünlerinde döre­
dilen tekst fonda emele gelip, gatda emele gelmeýär. Bu teksti redak­
tirlemek mümkin däl.

7. Sargyt 1372
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Tekst rastr formadyna özgerdilenden soň, onuň çap ediliş atribut­
laryny (meselem, şrift ýa-da stil) üýtgetmek mümkin däl.

Tekstiň islendik görnüşleri 
(redaktirlenýän we ş.m.) Туре 
(Текст) guraly, Layer (Слои) 
menýusy, Character (Шрифт) 
palitrasy, Paragraph (Абзац) 
palitrasy we opsiýalar paneli ar­
kaly döredilip bilner.

Redaktirlenýän tekst gaty
ny döretmek

1. Ilkibaşda Туре (Текст) 
guraly işletmeli – Т klawişasyny 
basmaly.

2. Setirleýin giriziş düzgüninde tekstiň başlangyç nokadyny goý­
mak üçin penjirä basmaly. Tekst bloguny girizmek üçin punktirli su­
dury çyzmaly, şonuň bilen tekstiň araçäkleri kesgitlener.

3. Opsiýalar panelinde 
aşakdaky amallary ýerine ýetir­
meli:
• Tekstiň ugrukdyrylmagyny 
(keselik/diklik) üýtgetmek üçin 
Туре guralynyň opsiýalar pane­
linde Туре düwmejige basmaly;
• Şriftleriň toparyny, şriftiň stili­
ni we kegelini saýlamaly;

Şeýle hem Anti-aliased 
(Сглаживание) meýdanynda 

literleri/ araçäklerini düzlemegiň usulynyň birini saýlamaly: Sharp 
(Резкое) Crisp (Жесткое), Strong (Сильное) ýa-da Smooth 
(Гладкое).
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Tekstiň elementlerini belläp almak

Amala Ýerine ýetirmegiň usuly
Setiriň bölegini 
bellemek

Syçanjygyň düwmejigine basmaly we kursory 
süýşürip almaly ýa-da setiriň başynyň bölegine 
basmaly, soňra Shift klawişasyny basyp saklap, onuň 
ahyryna basmaly

Sözi bellemek Oňa iki gezek syçanjyk bilen basmaly
Setiri bellemek Üç gezek syçanjyk bilen basmaly
Abzasy bellemek 4 gezek syçanjyk bilen basmaly
Tutuş teksti bel­
lemek

Ctrl+A klawişalaryny basyp, tekstiň içinde dört gezek 
basmaly ýa-da Layers (Слои) palitrasynda onuň 
nyşanyna iki gezek basmaly

Teksti masştablamak
Horizontal Scale (Масштаб по горизонтали) we Vertical 

Scale (Масштаб по вертикали) buýruklary diňe harplary goýmak 
(uzaltmak ýa-da gysgaltmak) üçin ulanmaly. Literleri deň ölçegli 
masştablamak üçin aşakda getirilen görkezmelerden peýdalanmaly 
ýa-da gerek bolan simwollary bellemeli we Character (Шрифт) pa­
litrasynda kegeli üýtgetmeli.

Saýlanan simwollary masştablamak
1. Layers (Слои) palitrasynda 

teksti saklaýan gaty saýlamaly.
2. Character (Шрифт) palit­

rasyny açmaly.
3. Horizontal Scale (Масштаб 

по горизонтали) we/ýa-da Vertical 
Scale (Масштаб по вертикали) meý­
danlarda masştabyň bahalaryny üýt­
getmeli.

Gatdaky tutuş teksti masştab
lamak:

1. Move (Перемещение) gura­
lyny işletmeli.

Diklik boýunça masştab

Keselik boýunça masştab
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2. Guralyň opsiýa panelinde 
Show Bounding Box (Показать га­
баритную рамку) baýdajygy goý­
maly.

3. Layers (Слои) palitrasynda 
gatyň adyna basmaly.

4. Gabara çägini onuň burçy 
boýunça çekip, şol bir wagtda masşta­
by dik we kese ugurlar boýunça üýt­
getmeli. Ululyklaryň birini üýtgetmek 
üçin çägiň gyraky manipulýatoryny 
süýşürmeli. Tekstiň proporsiýasyny 

saklamak üçin amallary Shift klawişasy basylyp duran ýagdaýynda 
ýerine ýetirmeli.

Goňşy simwollar üçin simwolara aralyklary goýmak:
1. Layers (Слои) palitrasynda tekst gaty saýlamaly.
2. Character palitrasynda Kerning (Kepнинг) menýusynda 

Metrics (Метрика) bendi saýlamaly.
3. Туре (Т klawişasy) guraly işledip üýtgedilmeli teksti belle­

meli.
4. Kerning (Кернинг) menýusynda gerek bolan ululygy giriz­

meli. Simwollary biri-birine golaý etmek üçin otrisatel sany girizme­
li. Simwollaryň arasyndaky aralygy Alt klawişasyna basyp, saga we 
çepe ugrukdyrylan okly klawişalara basmaly.

Keselik tekst üçin setirara aralygy 
goýmak:

Setirara aralyk (interlinýaž) – bu 
kursoryň duran setirden gönümel onuň 
aşagynda duran setire çenli dik aralyk. 
Her simwolda öz setirara aralygy bolup 
biler. Olardan has uly baha şol setir üçin 
setirara aralygy kesgitleýär.

Bellenilen simwollary baza çyzyga 
görä gyşartmak

Kerning Treking

Interlinýaž
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1. Layers (Слои) palitrasynda gerekli 
gaty saýlamaly.

2. Character (Шрифт) palitrasyny 
açmaly.

3. Baza çyzygyna görä gyşartmagyň 
meýdanyna bahany girizmeli – simwol­
lar baza çyzykda ýokarda ýerleşer ýaly 
položitel sany girizmeli, ondan pesde ýer­
leşdirer ýaly otrisatel bahalary girizmeli.

Simwollary goýup, gyşardyp, aşagyny 
çyzyp, özüni çyzyp, aşaky we ýokarky in­
deksde çyzyp ýazmak üçin Character 
(Шрифт) palitrasynda T harpyň degişli nyşanly düwmejiklerine bas­
maly.

Layer > Туре > Vertical (Слой > Текст > Вертикально) ýa-da 
Horizontal (Горизонтально) buýruklary arkaly tekstiň ýerleşişini 
dik ýa-da kese ugur boýunça üýtgetmek mümkin.

Paragraph (Абзац) palitra­
sy arkaly tekstiň ýerleşişiniň deň­
leşmesini sazlap bolýar.

Free Transform (Произволь­
ная трансформация) we transformasiýanyň beýleki buýruklary ar­
kaly teksti ýörite transformirlemek mümkin.

Tekst ýazylanda adatça onuň daşynda gabara çägi emele gel­
ýär. Teksti gabara çägi bilen bile ulaltmak ýa-da kiçeltmek üçin 
tekst gatyny Layer palitrasynda belläp, Type guralyny saýlap, Ctrl 
klawişasyny basyp, gabara çäginiň manipulýatorlaryndan çekip üýt­
getmeli. Eger teksti üýtgetmän gabara çägi üýtgetmek gerek bolsa, 
onda Ctrl klawişasyny basman üýtgetmeli.

Redaktirlenýän gatda tekstiň deformasiýasy
Photoshop programmasynda Warp Text (Деформировать 

текст) görnüşli birnäçe funksiýalar bar, olar gabara çägi we onuň 
içindäki teksti gyşartmaga mümkinçilik berýär. Şonda deformirlenen 
tekst redaktirlenýän bolup galar.

1. Layers (Слои) palitrasynda deformirlenmeli teksti saýlamaly.

Baza çyzygyna görä 
gyşartma
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2. Warp Text (Деформировать текст) gepleşik penjiresini aç­
mak üçin Layer > Type > Warp Text (Слои > Текст > Деформи­
ровать текст) buýrugy çagyrmaly ýa-da Туре (Текст) guraly işledip, 
opsiýalar panelinde Warp Text düwmejigine basmaly.

3. Style (Стиль) menýusynda tekstiň stilini saýlamaly.
4. Geçirijini Vertical (По вертикали) ýa-da Horizontal (По го­

ризонтали) ýagdaýa goýup, tekstiň deformirlenmeginiň amaly üçin 
esasy ugry bellemeli.

5. Bend (Изгиб), Horizontal Distortion (Горизонтальное ис­
кажение) we/ýa-da Vertical Distortion (Вертикальное искажение) 
süýşgüçlerini süýşürmeli.

Teksti edil wektor figuralary we sudurlary ýaly rastr formatyna 
geçirip bolýar. Ondan soň onuň bilen islendik rastr amallaryny ýerine 
ýetirmek mümkin.

Teksti Paste Into buýrugy arkaly şekil bilen doldurmak

1. Tekst gatyny döretmeli.
2. Gerekli şekili saklaýan gaty 

işletmeli.
3. Selection > All (Выделить > 

Все) buýrugyny peýdalanmaly ýa-da 
belleýşi syçanjyk bilen döretmeli.

4. Edit (Правка) menýusynda 
Сору (Копировать) buýrugyny ýeri­
ne ýetirmeli, oňa Ctrl+C düwmejik­
leri gabat gelýär.



103

5. Tekst gatyny saklaýan şekili bellemeli, soňra Ctrl düwmejigi 
basyp, şol gatyň adyna basmaly.

6. Edit (Правка) menýusynda Paste Into (Вставить в) buýru­
gy ýerine ýetirmeli ýa-da Ctrl+Shift+V klawişalaryny bilelikde bas­
maly.

Kem-kemden ýitýän teksti döretmek
1. Teksti döretmeli we onuň gatyny işjeňleşdirmeli.
2. Layers (Слои) palitrasynyň aşagynda Add a mask (Добавить 

маску) düwmejigine basmaly. Gatyň adynyň ýanynda maskanyň mi­
niatýurasy emele geler.

3. Gradient (Градиент) guraly saýlamaly.
4. Opsiýalar paneliniň Gradient meýdanynda üçburçly okly 

düwmejige basyp, araçäkdäki reňkleri saýlamaly. Linear gradi­
ent (Линейный градиент) düwmejige basmaly we Normal (Нор­
мальный) düzgünini saýlap, dury dälligiň 100% bahasyny girizmeli.

5. Syçanjygyň düwmejigini basyp saklap, kursory şekiliň penji­
resinde ýokardan-aşaga ýa-da sagdan-çepe süýşürmeli. Tekst gatynyň 
maskasy akdan-gara çenli gradiýent bilen doldurylar we gara reňkiň 
bar ýerinde bukulan bolar.

Redaktirlenýän tekstiň gatlaryna Layer Style (Стиль слоя) pen­
jiresindäki effektleri ulanmak mümkin. Olar bilen işlemek edil gatlar 
bilen goşmaça işlemek bölümdäki ýaly bolup geçýär.

Filtrler
Photoshop programmasynda filtrler arkaly effektleriň sansyz 

mukdaryny almak mümkin. Meselem, Color Halftone (Цветной 
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растр), Find Edges (Выделение 
краев), Emboss (Рельеф) ýa-da 
Wind (Ветер) filtrleri – has 
görünýän effektler üçin; Ar­
tistic (Художественный), 
Brush Strokes (Мазки кисти), 
Sketch (Эскиз) ýa-da Textu­
re (Текстура) – elde «çekilen» 
şekili döretmek üçin; Lighting 
Effects (Эффекты освещения) 
– şekili yşyklandyrmak üçin 
ulanmak mümkin.

Hemme filtrler 13 dereje boýunça Filter (Фильтр) menýusynda 
toparlara bölünen.

Filtri tutuş gata hem-de onuň bellenilen töweregine hem ulanyp 
bolýar.

Käbir filtrleri gönümel ulanyp bolýar (degişli buýrugy kömekçi 
menýudan saýlamak bilen). Beýleki filtrleri bolsa gepleşik penjirele­
rinde degişli parametleri goýup, ulanmak mümkin. Filter > Last Fil­
ter (Фильтр > Последний фильтр) (Ctrl+F) buýrugy saýlap, soňky 
ulanylan filtri şol öňki parametrler bilen gaýtalamak mümkin.

RGB we Multichannel düzgüninde hemme filtrler, CMYK, 
Grayscale we Lab Color düzgünlerinde bolsa olaryň käbiri elýeter­
lidir. Filtrler Bitmap we Indexed Color we her kanala 16 bit bolan 
düzgünlerinde ulanylyp bilinmeýär.

Filtrleriň gepleşik penjireleri
Köp filtrleriň gepleşik penjireleri deslapdan görmegiň penjirejik­

lerine eýedir.
Şonda şekiliň ölçegini dolandyrmak üçin (ulaltmak we kiçeltmek 

üçin) «plýus» we «minus» şekilleri bolan düwmejiklere basmaly.
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Edit > Fade (Правка > Ослабить) (Ctrl+Shift+F) buýrugy ar­
kaly islendik filtriň beren netijesini peseltmek mümkin.

Onuň üçin açylan gepleşik penjiresinde dury dälligiň derejesini 
peseltmeli.

Ýagtylygyň we kontrastyň bahalarynyň artdyrylmagy filtriň 
berýän effektiniň güýçlenmegine getirýär. Bu ýagdaýda Image > 
> Adjustments > Levels (Изображение > Корректировки > Уровни) 
buýrugyny saýlamaly we emele gelen Levels (Уровни) penjiresinde 
Input (Ввод) gara süýşgüjini saga, Output (Вывод) ak süýşgüjini 
bolsa biraz çepe süýşürmeli.

Käbir reňki ýok eden filtrler gatlaga ulanylandan soň gatyň 
reňkini üýtgetmek üçin (meselem Charcoal (Уголь) filtri ulany­
landa), Image > Adjustments > Hue/Saturation (Изображение > 
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> Корректировки > Тон/Насыщенность) buýrugyndan peýdalan­
maly we Colorize (Тонировать) baýdajygy goýmaly.

Sketch (Эскиз) kömekçi menýusynyň Water Paper (Мокрая 
бумага) başgasyndan bolan filtrler, gatyň reňkini ak reňke we surat 
çekilýän reňke öwürýär. Şonuň üçin Foreground color (Основной 
цвет) parametri öňünden saýlap, ondan soň şol filtrleri ulanmak ge­
rek.

Filtrler arkaly teksturany goýmak
Käbir filtrler üçin (meselem, Conte Crayon (Волшебный 

карандаш), Displace (Смещение), Glass (Стекло), Lighting Ef­
fects (Эффекты освещения), Rough Pastels (Пастель), Texture 
Fill (Текстурная заливка) ýa-da Texturizer (Текстуризатор) teks­
tura döretmek üçin standart nagşyň deregine, başga şekili ýükläp, 
ony nagyş hökmünde ulanmak mümkin. Şekiliň açyk we garamtyl 
töwerekleri teksturada galýan we çökýän ýerleri döredýär. Texture 
(Текстура) açylýan menýuny saklaýan filtriň gepleşik penjiresinde 
Load Texture (Загрузить текстуру) opsiýasyny işletmeli, gara we 
reňkli şekili Photoshop formatyna özgertmeli hem-de ОK düwmeji­
gine basmaly.

Epin-epin kagyzyň görnüşine meňzeş bolan teksturany döretmek 
üçin ak gyralary bolan gata Ripple (Рябь), Twirl (Скручивание) 
ýa-da Zigzag (Зигзаг) filtrleri ulanmaly:

1. Fon reňki hökmünde ak reňki saýlamaly.
2. Okantowka goşmak üçin Image (Изображение) menýusyndan 

Canvas Size (Размер холста) buýrugy ulanmaly (bir gatly şekili 
ulanmaly).

3. Rectangular Marquee (Прямоугольная область) guralyny 
saýlamaly (М ýa-da Shift+M klawişalary).

4. Şol guralyň opsiýalar paneliniň Feather (Растушевка) meý­
danyna 8 bahany girizmeli.

5. Şekiliň dörtden üç bölek töwereginiň daşyndan punktirli çägi 
çyzmaly.

6. Select (Выделение) menýusyndan Inverse (Инвертировать) 
buýrugy saýlamaly (Ctrl+Shift+I). Bu ýagdaýda bellenilen töwerek 
goşulan okantowkadan we şekiliň böleginden durýar.
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7. Filter > Distort > Ripple (Фильтр > Деформация > Рябь), 
Filter > Brush Strokes > Spatter (Фильтр > Мазки кисти > Раз­
брызгивание) buýruklaryny ýerine ýetirmeli ýa-da olaryň utgaşma­
syndan peýdalanmaly.

Fotosuraty surata öwürmek:
1. Şekili açmaly, Layers (Слои) palitrasynyň menýusynda Dup­

licate Layer (Дублировать слой) buýrugy saýlamaly.
2. Filter > Stylize > Find Edges (Фильтр > Стилизация > 

Выделение краев) buýrugy ýerine ýetirmeli.
3. Gatyň işjeň nusgasynda Add a mask (Добавить маску) düw­

mejige basmaly.
4. Gatyň maskasyny dury dälligiň derejesi 100%-den az bolan 

ýagdaýda gara reňk bilen reňklemeli – aşakda ýerleşen gatyň käbir 
töwereklerini görkezmek üçin.

5. Gara fonda has güýçli reňk effektini almak üçin gatyň mini­
atýurasyna basyp, Image & Adjustments > Invert (Изображение > 
> Корректировки > Обратить) buýrugy peýdalanmaly (Ctrl+I).

Galamly suraty almak üçin 2-nji ädimi ýerine ýetirmän, Trace 
Contour (Трассировка контуров) filtri, soňra bolsa Other (Другие) 
kömekçi bendinde Minimum (Минимум) filtri radiusyň bahasyny 1 
ýa-da 2 edip girizip, ulanmaly.

Akwarel filtri
Fotosuraty akwarel surata öwürmek üçin Other (Другие) kö­

mekçi menýudan Minimum (Минимум) we Noise (Шум) kömekçi 
menýudan Median (Медиана) filtrleri ulanmaly. Olary Watercolor 
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(Акварель) filtr bilen deňeşdirmeli. Aşakda birnäçe filtrleri bir şekile 
ulanmagyň nusgasy getirilen:

1. Gatyň nusgasyny döretmeli.
2. Gatyň nusgasyny işletmeli we Filter > Noise > Median 

(Фильтр > Шум > Медиана) buýrugy ýerine ýetirmeli.
3. Radius (Радиус) parametriň süýşgüjini 2 we 8 sanlaryň arasy­

na geçirmeli.
4. Filter > Others > Minimum (Фильтр > Другие > Минимум) 

buýrugy ýerine ýetirmeli.

5. Radius (Радиус) parametriň süýşgüji 1, 2 we 3 bellikde bol­
maly.

6. Filter > Sharpen > Sharpen More (Фильтр > Резкость > 
Резкость плюс) buýrugy ýerine ýetirmeli.

Mosaic filtriň ulanylmagy
Aşakdaky amallaryň netijesinde Mosaic (Мозаика) filtri bir­

näçe gönüburçly bellenilen töwereklere ulanylýar we mozaikanyň 
bölekleriniň bir wagtda ulanylmagy bolup geçýär. Gatyň maskasynda 
gradiýentiň ulanylmagy Mosaic filtriň effektini peselder, emma onuň 
elementleriniň ölçegini üýtgetmez.

1. Gaty bellemeli.
2. Rectangular Marquee (Прямоугольная область) guraly 

saýlamaly.
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3. Mozaikanyň başlanýan ýerinden şekiliň dörtden we bäşden bir 
böleginiň daşyny aýlamaly.

4. Pixelate (Объединение пикселов) kömekçi bendinden Mo­
saic (Мозаика) filtri saýlamaly.

5. Mosaic (Мозаика) gepleşik penjiresiniň Cell Size (Размер 
ячейки) meýdanynda 6 bahany girizmeli. Görülýän bahany kem‑kem­
den ulaltmak üçin bu amaly birnäçe gezek ýerine ýetirmeli.

6. Bellenilen töweregi we Rectangular Marquee (Прямоуголь­
ная область) guraly işjeň edip saklap, Shift klawişasyny basyp, punk­
tirli sudury ýanaşýan ýere süýşürmeli hem-de filtri ulanmaly we ş.m.

7. 4-6 ädimleri şekili doly işlenip bejerilýänçä Cell Size (Размер 
ячейки) meýdanyna degişlilikde 12, 24 we 30 bahalary girizip ulan­
maly.

Hereketiň illýuziýasyny döretmek
Hereketiň illýuziýasyny döretmek üçin hereketsiz durmaly 

obýekti belläp, ony täze gata göçürmeli, soňra fon şekiline Motion 
Blur (Размытие в движении) filtri ulanmaly.

1. Üýtgedilmän galmaly şekiliň bölegini bellemeli.
2. Select (Выделение) menýudan Feather (Растушевка) buýru­

gyny çagyrmaly (Ctrl+Alt+D).
3. Feather Radius (Радиус растушевки) meýdanyna 5 bahany 

girizmeli.
4. Bellenilen töweregi täze gata göçürmek üçin Ctrl+J 

klawişalaryny basmaly.
5. Fony saklaýan başlangyç şekili bellemeli.
6. Filter > Blur > Motion Blur (Фильтр> Размытие > Размытие 

в движении) buýrugy ýerine ýetirmeli.
7. Eňňitligiň burçunyň bahasyny Angle (Угол) –360°-dan +360°-

a çenli girizmeli. -17° baha girizilen bolýar.
8. Distance (Расстояние) bahany 1-den 999-a çenli girizmeli. 

Bu ýagdaýda 50 girizilmeli.

Şekile ýagtylygy goşmak
Lighting Effects (Эффекты освещения) filtri ýagtylygyň san­

syz effektini döretmäge mümkinçilik berýär. Şekilde 16-a çenli ýagty­
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lyk çeşmesini, her çeşme üçin öz reňkini, ýagtylygyň depginliligini 
(intensiwligini) we şöhleleriniň ugruny goýmak bolýar.

1. Şekil RGB reňk düzgüninde bolmaly.
2. Gaty ýa-da onuň bölegini belläp, saýlamaly.
3. Filter > Render > Lighting Effects (Фильтр > Освещение> 

Эффекты освещения) buýrugy ýerine ýetirmeli.
4. Style (Стиль) meýdanyndaky açylýan sanawdan Default (По 

умолчанию) görnüşi ýa-da ýagtylygyň taýyn effektini saýlamaly.
5. Light Type (Тип освещения) bölüminde şeýle amallary ýe­

rine ýetirmeli:
• Effekti deslapky seretmegiň penjiresinde görmek üçin On 
(Включить) baýdajygy goýmaly;
• Light Type (Тип освещения) meýdanyndaky açylýan sa­
nawdan ýagtylygyň toplumy deslapdan inçe, konus, elliptiki 
görnüşi berer ýaly onuň Spotlight (Прожектор) görnüşini 
saýlamaly;
• Intensity (Интенсивность) süýşgüjini ýagtylygyň güýjüni 
üýtgetmek üçin üýtgetmeli. Full (Полностью) iň ýagty yşygy 
kesgitleýär, Negative (Отрицательно) bolsa – iň garamtyly;
• Spotlight (Прожектор) yşyklandyryşyň görnüşi üçin Focus 
(Фокус), süýşgüji süýşürip, ellipsiň içindäki yşygy sazlamak 
mümkin. Eger süýşgüç Wide Focus (Широкий фокус) ýag­
daýa goýulsa, onda yşyk ellipsiň araçäklerine golaýlaşanda 
has ýagty bolýar;
• Yşygyň reňkini üýtgetmek üçin reňkiň nusgasynyň meýda­
nyna basmaly we palitrada gerek reňki saýlamaly.

6. Properties (Свойства) bölümindäki süýşgüçleri obýektiň 
üstüniň şeýle häsiýetlerini sazlamak üçin süýşürmeli:

• Gloss (Фактура) yşygyň düşýän üstden serpikme güýjüni 
kesgitleýär;
• Material (Материал) şekil yşyk çeşmesiniň reňkini nähi­
li serpikdirýändigini kesgitleýär: Plastic (Пластик) – yşygyň 
reňki serpigýär, Metall (Металл) – obýektiň özüniň reňki ser­
pigýär;
• Exposure (Экспозиция) şekiliň tutuş gatyny ýagtyldýar 
ýa-da garaldýar;
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• Ambience (Подсветка) yşyk çeşmesiniň we tutuş şekiliň 
yşyklandyrmasynyň arasyndaky tapawuda gözegçilik edýär.
• Yşygyň ýene bir çeşmesini goşmak üçin, ýanyp duran çyra 
görnüşindäki belgini deslapdan görmegiň penjiresine getirmeli.
• Yşyk çeşmesini ýok etmek üçin, onuň merkezi nokadyny se­
bet görnüşindäki düwmejige getirmeli;
• Yşyk çeşmesiniň göçürmesini döretmek üçin Alt klawişasy­
ny basyp, onuň merkezi nokadyny gerekli ýere getirmeli.

Yşygyň teksturalaýyn effektini döretmek üçin Texture Chan­
nel (Текстурный канал) bölüminde açylýan sanawdan tekstu­
rany saklaýan alfa kanaly saýlamaly. Height (Высота) süýşgüji 
süýşürip teksturanyň beýikligini sazlamaly. Bu funksiýa Spotlight 
(Прожектор) yşyk düzgünine has gabat gelýär.

Omni (Лампа) görnüşli ýagtylyk sferalaýyn ýagtylyk töweregi­
ni döredýär we fonaryň ýagtylygyna meňzeş bolýar.

Shift klawişasyny basyp we ellipsiň araçäk manipulýatoryny 
süýşürip, onuň ölçegini üýtgetmek mümkin (şonda burç üýtgemeýär). 
Ellipsiň ölçeglerini üýtgetmän burçy ýa-da ýagtylygyň ugruny üýt­
getmek üçin Ctrl klawişasyny basyp, radiusy süýşürmeli.

Eger şekiliň fony Lighting Effects (Эффекты освещения) 
filtriň ulanylmagy sebäpli has garamtyllanan bolsa, onda ony ýene bir 
gezek garamatyl töweregi ýagtylandyrmak üçin ulanmaly. Proper­
ties (Свойства) bölüminde Exposure (Экспозиция) we Ambience 
(Подсветка) süýşgüçleri biraz saga süýşürmeli.

Liquify buýrugy
Liquify (Исказить) buýrugy şekiliň gatyny towlap, egip, süýn­

dürip we beýleki usullar bilen deformirläp bilýär.
Şekili kist arkaly deformirlemek mümkin, ol kistiň ölçegleri we 

täsir ediş derejesi sazlanylýar. Mundan başga-da Freeze (Заморо­
зить) guralyny peýdalanyp bolýar – ol aýry töwerekleriň üýtgedil­
meginiň öňüni alýar. Eger üýtgedilen şekil doly ýa-da bölekleýin 
yzyna gaýtaryljak bolsa, onda Reconstruct (Реконструировать) gu­
ralyndan peýdalanmaly. Üýtgetmeler buýrugyň penjiresinden çyky­
lan ýagdaýynda hemişelik bolup galar.

8. Sargyt 1372
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1. Ýoýulmaly gaty saýlamaly. Backdrop baýdajygy işledilende 
Liquify guralyň täsirini birnäçe gatyň diňe birine degişli edip bolýar. 
Liquify (Исказить) buýrugy diňe rastr şekili bilen işleýär.

2. Liquify buýrugy Filter (Фильтр) menýudan saýlamaly 
(Ctrl+Shift+X).

3. Berlen şekili deformirlemek üçin Liquify gepleşik penjiresi­
niň gurallaryndan peýdalanmaly. Ilkibaşda Tool Options (Опции 
инструмента) bölüminde kistiň ölçegini (Brush Size) 1-den 600 pik­
sele çenli goýmaly, şeýle hem kistiň basyşynyň ululygyny (Brush 
Pressure) 1-den 100%-e çenli goýmaly we şekiliň ýoýulmagynyň 
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nähili bolup geljekdigini kesgitlemek üçin zen-
zeläniň üýtgemeginiň ululygyny (Turbulent Jitter) 
bellemeli.

4. Freeze (Заморозить) guraly işletmeli (F 
klawişasy), ol ýoýulmaly däl töwerekleri mas­
kalamak üçin ulanylýar. Soňra View Options 
(Режимы просмотра) bölüminde Freeze Color 
(Цвет маски) açylýan sanawdan reňki saýlamaly. 
Deslapdan gyzyl reňk goýlan. Şol wagtky ýagdaý­
da üýtgemän galmaly töwerekleri reňklemeli.

5. Maskalanan töwereklerden goragy aýyr­
mak üçin Thaw (Разморозить) guraly işletmeli 
(Т klawişasy) we onuň kömegi bilen reňklemeli.

6. Aşakdaky amallaryň islendigini saýlamaly:
• maskany inwertirlemek üçin Freeze 
Area (Область маски) bölüminde Invert 
(Инвертировать) düwmejige basmaly;
• şekilden hemme maskany aýyrmak üçin 
Thaw All (Разморозить все) düwmejige basmaly;
• Freeze (Заморозить) guraly arkaly döredilen maskany buk­
mak üçin View Options (Режимы просмотра) bölüminde 
Show Frozen Areas (Показать маскированные области) 
baýdajygy aýyrmaly.

7. Ýoýmagyň bir guralyny işletmeli:
• Warp (Деформация) guraly (W klawişasy) – kistiň here­
ketiniň ugrunda nokatlary süýşürýär.
• Turbulence (Волнение) guraly (А klawişasy) – kistiň here­
ketiniň ugrunda nokatlary süýşürip aýyrýar. Kistiň işlän ýerin­
de şekil suw bilen täsir edilen ýaly görünýär;
• Twirl Clockwise (Закрутка по часовой стрелке) (R kla­
wişasy) we Twirl Counterclockwise (Закрутка против 
часовой стрелки) guraly (L klawişasy) – syçanjygyň düwme­
jigi basylyp durka ýa-da şekil çekilip durka piksellere öwürýär. 
Brush Pressure (Нажим кисти) parametriň ululygy näçe ýo­
kary bolsa şonça hem öwürme tiz bolup geçýär.



116

• Pucker (Складка) (Р klawişasy) 
ýa-da Bloat (Раздувание) piktogram­
masy (B klawişasy) – syçanjygyň 
düwmejigi basylyp durka ýa-da şekil 
çekilip durka nokatlary kistiň mer­
kezine ýa-da garşy tarapa süýşürýär. 
Brush Pressure (Нажим кисти) 
parametriň bahasy näçe ýokary bolsa, 
şonça-da nokatlar tiz hereket edýär;
• Shift Pixels (Сдвиг пикселов) (S gu­
raly) – kistiň hereketiniň ugry boýun­

ça pikselleri süýşürýär. Deslapdan pikseller kistiň hereketiniň 
ugrundan çepe süýşürilýär. Alt klawişasyny basyp, olary saga 
süýşürip bolýar;
• Reflection (Отражение) (М klawişasy) – kistiň hereketiniň 
ugrunyň çepindäki nokatlary göçürip alýar we olary serpigen 
görnüşde şu guralyň täsir edýän zolagyna süýşürýär.

Şekili rekonstruirlemek
Şekil ýoýlandan soň ony Reconstruction (Реконструкция) 

bölümiň serişdeleri we Reconstruct (Реконструировать) guraly bi­
len doly ýa-da bölekleýin öňki ýagdaýa getirip bolýar.

Reconstruction (Реконструкция) bölüminde Revert (Восста­
новить) düwmejige basylsa şekil penjire açylan ýagdaýyndaky ýag­
daýa geler.

Reconstruct (Реконструировать) gural bilen dikeltmäge degişli 
bolan töwerekleri reňklemeli.
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Çap
Çapda diňe görünýän gatlar we kanallar görkeziler.
1. File > Print with Preview (Файл > Печать с предваритель­

ным просмотром) buýrugyny ýerine ýetirmeli ýa-da Ctrl+Alt+P 
klawişalaryny basmaly.

2. Source Space (Исходное пространство источника) bölü­
minde gerek bolan düzgüni goýmaly.

3. Print (Печать) gepleşik penjiresinde Print to File (Печать в 
файл) baýdajyk aýrylan bolmalydyr.

Şekiliň bölegini çap etmek üçin şol töweregi Rectangular Mar­
quee (Прямоугольная область) guraly bilen bellemeli. Soňra Print 
(Печать) gepleşik penjiresiniň Print Range (Диапазон страниц) bö­
lüminde geçirijini Selection (Выделенная область) ýagdaýda goý­
maly.
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Artyk rugsat
Eger şekiliň rugsady ekranyň rugsadyndan 2,5 esse ýokary bolsa, 

onda şekil çapa iberilende duýduryş berler, bu ýagdaýda şekili Image 
> Image Size (Изображение > Размер изображения) buýruk arkaly 
kiçeltmeli.

Print with Preview gepleşik penjiresi
1. Şekili sahypanyň merkezinde ýerleşdirmek üçin Center Ima­

ge (Изображение в центре) baýdajygy goýmaly ýa-da ony aýryp 
şekili sahypada ýerleşdirmek üçin sahypanyň ýokarsyndan we çep 
gyrasyndan bolan aralyklary girizmeli.

2. Scaled Print Size (Масштабирование при печати) bölümi­
niň Scale (Масштаб) meýdanynda ululygy üýtgetmeli ýa-da Height 
(Высота) we Width (Ширина) meýdanlaryna bahalary girizip, şeki­
liň çap üçin ölçeglerini üýtgetmeli.

Scale, Height we Width parametrleri biri-biri bilen bagly we 
olaryň biriniň üýtgemegi beýlekilere täsir edýär.

3. Scale to Fit Media (Масштабировать с подгонкой по 
размерам страницы) baýdajygy goýmaly. Şonda şekil ölçegini kagy­
zyň ölçegine gabat geler ýaly üýtgeder. Şol kagyzyň ölçegi File > 
> Page Setup (Файл > Параметры страницы) buýrugy arkaly saýla­
nylýar.

4. Show Bounding Box (Показать габаритную рамку) baýda­
jygy goýulsa şekiliň daşyna punktirli çyzyk aýlanylar. Şekiliň ölçeg­
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lerini çap üçin üýtgetmek üçin şol çyzygyň araçäklerini syçanjyk bi­
len çekip üýtgedip bolýar.

Şekiliň birnäçe göçürmesiniň bir sahypada çap edilmegi:
1. File > Automate > Picture Package (Файл > Автоматизация > 

> Пакет рисунков) düwmejiklerini ulanmaly.
2. Use meýdanynda çeşme saýlanylmaly:

• Frontmost Document – işjeň penjiräniň şekili;
• File – islendik grafiki format (Photoshop bilen goldanylýan);
• Folder – bir bukjada ýerleşen birnäçe faýllar.

3. Page Size meýdanynda kagyzyň formatyny saýlamaly.
4. Layout meýdanynda göçürmeleriň sanyny saýlamaly (1-20).
5. File çeşme diýlip saýlanylanda her penjirede grafiki faýly gör­

kezmeli.
6. Resolution meýdanynda rugsady görkezmeli.
7. Mode meýdanynda reňk modelini bellemeli.



Tejribe işleri
1. Şekile render etmek.
2. Şekile Sketch filtrini ulanmak.
3. Şekile pikselleme filtrini ulanmak.
4. Gausyň çalmagyny ulanyp, altyn görnüşdäki obýekt döretmek.
5. Şekile stilleşdirme filtrini ulanmak.
6. Şekilde ýitilik filtrini ulanmak.
7. Şekili süýndirmek.
8. Şekiliň aýry böleklerini ulaltmak.
9. Şekiliň aýry böleklerini kiçeltmek.
10. Çeperçilik filtrlerini ulanmak.
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VII. CorelDRAW programmasy

Esaslar, şekilleriň düzümi, çyzyklar, tekst, obýektler
CorelDraw programmasy grafika bilen işlemek babatda 

dünýäniň öňdebaryjy programmalarynyň biri bolup durýar. Ol esasan 
wektor grafikanyň üstünde alnyp barylýan amallary ýerine ýetirmäge 
mümkinçilik berýär. Ol diňe grafiki obýektleri bilen däl, eýsem tekst 
bilen işlemekde hem amatly mümkinçilikleri hödürleýär.

CorelDRAW programmasy grafiki 
obýektler bilen işlemek üçin program­
malaryň obýekt-integrirlenen toplumy 
bolup durýar.

«Integrirlenen toplum» sözleri Co­
relDRAW programmasynyň diňe bir 
anyk meseläni çözmek üçin aýry prog­
ramma däl-de, meseleleriň birnäçesi­
ni çözmek üçin niýetlenen program­
malaryň utgaşmasydygyny aňladýar. 
Toplumyň integrirlenmegi, oňa girýän 
programmalaryň özara maglumatlar 
bilen aňsat alyş-çalyş edip bilýändigini aňladýar. Şeýlelik bilen, 
toplumyň köp funksiýalylygy gazanylýar, dürli programmalaryň 
mümkinçilikleri bolsa öz bölekleriniň jeminden uly bolan bir bitewi 
zada birleşýär.

Esaslar 

Iş meýdany we ulanyjynyň interfeýsi
Programmanyň ulanylýan faýllaryny goýbermek üçin şu 

giňişlikleri gözlemeli – .CDR, .CMX, .WMF.
Programma goýberilenden soň, suratda görkezilen CorelDRAW 

programmasynyň ulanyjy interfeýsiniň esasy elementlerini saklaýan 
penjiresi açylýar.

Windowsyň standartlaryna laýyklykda penjiräniň adynyň aşa­
gynda menýu setiri ýerleşdirilen. CorelDRAW programmasynda 
menýu örän çylşyrymly – kömekçi menýularyň we buýruklaryň köp 

Wektor 
grafikasy

Rastr 
grafikasy
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sanysy ulanylýar. Edil beýleki programmalarda bolşy ýaly, menýu 
CorelDraw programmasynyň köp funksiýalaryna elýeterligi üpjün 
edýär, emma köp amallar onsuz hem ýerine ýetirilip bilner.

Iş meýdanynyň çep böleginde Corel firmasynyň önümleri üçin 
spesifiki bolan gurallar toplumy (toolbox) ýerleşdirilen. Ol iş düz­
günini saýlamak üçin niýetlenen. Düzgüniň saýlanylmagy gurallar 
toplumynyň düwmejikleriniň birine syçanjyk bilen basma arkaly 
amala aşyrylýar.

Gurallaryň düwmejikleriniň käbiri aşaky sag burçundan üçburç­
luk bilen ýerine ýetirilen, bu bolsa, şol düwmejigiň ýeke däl-de, 
birnäçe gurallar bilen baglaşandygyny görkezýär. Olaryň hemme­
sini görmek üçin syçanjygyň düwmejigini tiz basmagyň deregine 
ony basyp durmaly (1-2 sekuntdan soň goýbermeli) – ekranda anyk 
guralyň paneli açylar.

Menýu setiriniň aşagynda ýerleşen standart gurallar panelinde 
(toolbar) has köp ulanylýan buýruklara gabat gelýän dolandyryş ele­
mentleri ýerleşdirilen: faýllary açmak, ýapmak we ýatda saklamak, 

Menýu setirleri Gurallaryň standart paneli

Gurallaryň toplumy

Çap sahypasy

Atributlar
paneli

Iş stoly

Ýanaşdyrylan
penjireler

Reňkleriň ekran
palitrasy

Ýagdaý setiri
Sahypalar geçmek boýunçaa
dolandyryş elementler
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alyş-çalşygyň buferi bilen işlemek, suratlary görmegiň düzgünlerine 
we masştabyna gözegçilik etmek üçin.

Standart paneliniň aşagynda atributlar paneli (property bar) 
ýerleşdirilýär. Ol saýlanylan iş düzgünine laýyklykda hemişe üýt­
geýär, ol ulanyjynyň esasy iş guraly bolup durýar.

Sag araçägiň ugry boýunça ekran reňk palitrasy ýerleşen (color 
palette). Ol reňk doldurmanyň 
we obýektleriň sudurynyň 
reňkini bellemek üçin ulanyl­
ýar.

CorelDRAW penjiresiniň aşaky gyrasynda ýagdaý setiri ýerleşen 
(status bar). Onda bellenilen obýekt barada maglumatlar we prog­
rammanyň iş düzgüni barada maglumatlar görkezilýär.

Iş giňişliginiň esasy bölegi resminamalaryň penjirelerini (dra­
wing windows) ýerleşdirmek üçin niýetlenen. Resminama döredi­
lenden soň, ekranda surat ýerleşdirilmeli çap sahypasynyň görnüşi 
bolar. Sahypanyň araçäkleri kölegeli ramka görnüşinde görkezilen, 
emma olar şekiliň elementi bolup durmaýar. Şekili düzjek obýektler 
şol araçäkleriň içinde ýerleşdirilmelidir. Şekiliň penjiresiniň beýle­
ki giňişligi iş stoly diýlip atlandyrylyp, obýektleriň wagtlaýyn sak­
laýjysy hökmünde ulanylýar.

Resminamanyň çepki we ýokarky gyraňlarynda obýektleriň ko­
ordinatalaryny ölçemek we ugrukdyryjylary ýerleşdirmek üçin gulluk 
edýän koordinata çyzgyçlary (rulers) bar.

CorelDRAW interfeýsinde ýanaşdyrylýan penjireler (dockers) 
uly rol oýnaýar.

Täze resminamany döretmek
Deslapdan programma goýberilenden soň, hemişe resminama 

açylýar. Eger işiň dowamynda ýene bir resminama açmak zerurlygy 
ýüze çyksa, onda File (Файл) menýusynda New (Новый документ) 
bendi saýlamaly ýa-da gurallaryň standart paneliniň çep gyrasynda 
ýerleşen New (Новый документ) düwmejige basmaly.

Resminamalary açmak we ýapmak
CorelDRAW-da öň döredilen resminamalar Windows üçin stan­

dart usuly bilen açylýar: CorelDRAW bilen baglaşan faýlyň üstüne 
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syçanjyk bilen basylandan soň programma goýberilende; File > Open 
(Файл > Открыть) buýrugy ýa-da standart panelinde ýerleşen Open 
(Открыть) düwmejigi arkaly açylanda.

Açylan gepleşik penjiresinde Windowsyň islendik programma­
syndaky ýaly hemme standart elementler bar. Ondan başga-da, 
faýllaryň sanawyndan çepde, deslapky görmegiň töweregi bar. Previ­
ew (Предварительный просмотр) baýdajygy goýlan ýagdaýynda şol 
töwerekde faýlyň içinde saklanylýan şekiliň kiçeldilen görnüşi görke­
zilýär. CorelDRAW resminamalary ýatda saklanylanda esasy sözler 
ýa-da bellikler bellenilen bolsa, onda olar Keywords (Ключевые 
слова) we Notes (Замечания) meýdanlarynda görkezilýär.

Şekiliň kiçeldilen nusgalary faýl ýatda saklanylanda oňa goşul­
man hem bilýär. Bu ýagdaýda Preview (Предварительный про­
смотр) baýdajyk goýlan hem bolsa, deslapky görmegiň töwereginde 
hiç zat görünmeýär.

Ulanylýan resminamany ýapmak üçin File > Close (Файл > Зак­
рыть) buýrugy ulanmaly ýa-da şol penjiräniň sag ýokarky burçunda 
ýerleşen düwmejige basmaly.

Resminamalary ýatda saklamak
CorelDRAW-da resminamanyň ýatda saklanylmagy File > Save 

(Файл > Сохранить) buýrugyň saýlanylmagy ýa-da gurallaryň stan­
dart panelindäki Save (Сохранить) düwmejigine basmak arkaly ama­
la aşyrylýar. Eger bu resminama öň ýatda saklanylmadyk bolsa, onda 
ýörite Save Drawing (Сохранить документ) penjiresi açylýar.

Eger resminamany programmanyň öňki ir wersiýalarynda ýatda 
saklamaklyk gerek bolsa, onda bu penjiredäki Version (Версия) açyl­
ýan sanawa üns bermeli we bu sanawda gerekli wersiýany saýlamaly.

Eger faýl öň ýatda saklanylan bolsa, diske gaýtalanyş ýazgy Save 
Drawing (Сохранить документ) penjiresi açylmazdan bolup geçer.

Eger faýlyň göçürmesini döretmek gerek bolsa, File > Save As 
(Файл > Сохранить как) buýrugyndan peýdalanmaly.

Sahypanyň parametrlerini üýtgetmek
Täze resminama döredilenden soň, käwagt deslapdan kabul 

edilen çap sahypanyň ölçeglerini üýtgetmek gerek bolýar. Bu amal 
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aşakdaky panel arkaly sahypada hiç obýekt saýlanylmadyk wagty ýe­
rine ýetirilip bilner.

Kagyzyň formaty Listiň ölçegi Listiň ugrukdyrylmagy

Çap edilýän sahypalaryň ölçegi Paper Type/Size (Тип/формат 
бумаги) sanaw arkaly saýlanylýar, ol atributlar paneliniň iň çepinde 
ýerleşýär. Çap edilýän sahypanyň ölçegi hökman kagyzyň formatyna 
laýyk gelmän hem bilýär. Ol listiň ölçeglerinden kiçi bolsa ýeterlik. 
Eger çap sahypanyň ölçegi listiňkiden kiçi bolsa, şekiliň gyrasynda 
arassa meýdan bolýar.

Şekilleriň düzümi
Öň bellenilişi ýaly, CorelDRAW-da şekiller bilen işlemekde esas 

bolup obýektler hyzmat edýär. Hemme grafiki obýektleri iki derejä 
bölmek bolýar – çyzyklara we primitiwlere. Soňkulara şulary degişli 
etmek mümkin:

• gönüburçluklar;
• ellipsler;
• köpburçluklar we ýyldyzlar;
• halkaçlar;
• torlar;
• standart figuralar.

Gönüburçluklar
Görkezilen obýektleriň iň çepdäkisi – «klassyky» gönüburçluk. 

Hut şeýle görnüşdäki gönüburçluklar ilki döredilende görünýär. Ikinji 
obýekt 45° burça öwrülen. Üçünji obýektde 4 burçdan üçüsi tegelek­
lenen, iň sagdaky bolsa egrilen. Görnüşi ýaly gönüburçlugy beýleki 
obýektlerden tapawutlandyrmak kän bir aňsat hem däl, emma ony 
saýgarmak üçin obýekti saýlap, ýagdaý setire seretmeklik. Eger ol 
ýerde Rectangle on Layer 1 (Прямоугольник на слое 1) habar eme­
le gelse – şol obýekt gönüburçlukdyr.
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CorelDRAW-da hemme primitiwler degişli gurallar arkaly gu­
rulýar. Gönüburçluklar döretmek üçin Rectangle (Прямоугольник) 
düwmejigi ulanmaly.

Syçanjygyň görkezijisi gönüburçluk bilen kesişmäniň görnüşini 
alar.

Rectangle (Прямоугольник) guraly başga usul hem arkaly 
işletmek mümkin, munuň üçin sahypanyň boş ýerinde syçanjygyň 
sag düwmejigine basmaly we kontekst menýuda Create Object > 
Rectangle (Создать объект > Прямоугольник) menýuny saýlamaly 
ýa-da F6 klawişasyna basmaly.

Gönüburçlugy çyzmak üçin 
Rectangle (Прямоугольник) 
guralynyň görkezijisini döredil­
ýän obýektiň diagonaly boýunça 
süýşürmeli. Syçanjygyň görkeziji­
si süýşürilýän mahaly ýagdaý se­
tirde gönüburçlugyň beýikliginiň 
we ininiň şol wagtky bahalary 
görkezilýär, ekranda bolsa, onuň 

hemişe üýtgeýän abrisi görkezilýär. Syçanjygyň düwmejikleri goýbe­
rilen mahaly ekranda gönüburçluk emele geler, onuň daşynda ram­
ka hem-de markerler we içinde marker bolar, ýagdaý setirinde bolsa 
gönüburçluklaryň toparyna degişli bolan obýekt döredilendigi barada 
habar bolar.

Klawişa-modifikatorlaryň ulanylmagy
1. Gönüburçluk çyzylanda Ctrl klawişasy basylanda kwadrat 

çyzylýar.
Ctrl klawişasy beýleki funksiýalary hem ýerine ýetirip bilýär. 

Meselem, eger obýektiň öwrülmegi Ctrl klawişasynyň basylan ýag­

Belleniş çägiň markerleri

Obýektiň 
bellenilmeginiň 

markerleri

Obýektiň düwünleriniň 
markerleri
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daýynda amala aşyrylsa, onda obýekt birsydyrgyn öwrülmeginiň de­
regine 15° burç bilen bökmek arkaly öwrülýär.

2. Gönüburçluk çyzylanda we Shift klawişasy basylanda syçan­
jygyň görkezijisiniň süýşürilmeginiň başlanýan nokadynda burçdaky 
marker däl-de, merkeziň markeri bolýar. Bu usul gönüburçlugyň mer­
keziniň ýerleşmeginiň ýeri belli bolan mahaly amatlydyr.

Iki modifikatory bilelikde ulanmak mümkin.

Olaryň
koordinatalary

Aýratyn masştablamagy 
blokirlemek

Masştablamagyň
koeffisiýenti

Ini

Serpik-
diriş

Burçlaryň 
tegelekliginiň 
koeffisiýentleri

Egrilere
geçirmek

Burçlaryň aýratyn 
tegelekligini 
blokirlenmek

Öwrüliş
burçy

Beýikligi

Indi bolsa, gönüburçluklaryň atributlarynyň paneline göz ýeti­
reliň. Atributlar panelinde obýektiň modeliniň parametrini kesgit­
leýän dolandyryş elementleri we şol toparyň obýektleriniň üstün­
den standart amallary ýerine ýetirmegi mümkin edýän düwmejikler 
ýerleşdirilen.

• Object(s) Position (Координаты середины). Koordinata 
ulgamynda (adatça sahypanyň çepki aşaky burçy bilen bagly 
bolan) gönüburçlugyň ortasynyň koordinatalarynyň takyk ba­
halaryny saklaýan iki meýdan bar. Bu meýdanlara täze baha­
lary girizmek bilen gönüburçlugy süýşürmek mümkin.
• Object(s) Size (Высота и ширина). Bu meýdanlardaky ba­
halar gönüburçluklaryň ölçeglerini dolandyrýar.

Takyk aýdylanda, bu meýdanlarda obýektleriň ölçegleri däl-de, 
onuň gabaralary, ýagny ony belleýiş çägiň ölçegleri görkezilýär. Ta­
pawut şol çägiň taraplarynyň koordinata oklaryna elmydama parallel 
bolmagyndan ybarat. Şol sebäpli, 45° burça öwrülen kwadrat üçin 
iniň we beýikligiň bahalary onuň diagonalyna deň bolar.
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• Scale Factor (Коэффициенты масштабирования). Bu iki 
meýdanda çyzyklaýyn süýnmegiň we gysylmanyň koeffi­
siýentleri saklanylýar. Olary üýtgedip, obýektiň degişli özger­
dilmegini amala aşyrmak mümkin.
• Nonproportional Scaling/Sizing Ratio (Блокировка 
раздельного масштабирования). Eger bu düwmejik basylan 
bolsa, obýektiň bir tarapynyň ugry boýunça süýnmäge ýa-da 
gysylmaga ikinji tarap boýunça proporsional süýnmäge we 
gysylmaga getirer.
• Angle of Rotation (Угол поворота). Bu meýdanda obýektiň 
öwrüliş amalynyň dolandyryş parametriniň bahasy saklanyl­
ýar.
• Rectangle Corner Roundness (Коэффициенты закруг­
ления углов). Bu meýdanda gönüburçlugyň her burçunyň 
tegelekliginiň radiusynyň göräleýin (otnositel) bahalary sak­
lanylýar. Bahalar göterimde ölçenilýär, 100 % hökmünde gönü­
burçlugyň iň kiçi tarapynyň uzynlygynyň ýarysy kabul edilen.
• Round Corners Together (Блокировка раздельного за­
кругления углов). Eger bu düwmejik basylan bolsa, tegeleniş 
koeffisiýentleriniň dördüsinden islendik biriniň üýtgedilmegi 
beýleki koeffisiýentleriň şol bir ululyga awtomatiki üýtgedil­
megine getirer.

Gönüburçlugyň burçlaryny tegelemek
Gurallar toplumynda Shape 

(Форма) guraly saýlamaly, onuň gör­
kezijisini gönüburçlugyň burçunda 
ýerleşen islendik düwne süýşürmeli 
we ony gönüburçlugyň islendik tara­
pynyň ugry boýunça geçirmeli. Syçan­

jygyň görkezijisiniň gönüburçlugyň burçundan daşlaşmagy boýunça 
hemme dört burç tegeleklenip başlaýar, özem görkeziji näçe uzak 
süýşürilse, şonça hem tegeleklenmegiň radiusy uly bolýar.

Gönüburçlugyň diňe bir burçuny tegeleklemek üçin görkezijini 
gerek bolan burça getirmeli we syçanjyk bilen basmaly we soň görke­
zijini çekmeli. Diňe şol burç tegeleklener.
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Eger üns berilse, görkeziji çekilende düwünden emele gelen iki 
täze düwün biri-biri bilen deň hereketlenýär we olaryň süýşürilmegi 
biriniň gönüburçlugyň tarapynyň ortasyna ýetýänçä dowam edýär. 
Gönüburçlugyň burçunyň maksimal tegeleklik radiusy (100%) onuň 
iň kiçi tarapynyň ýarty uzynlygyna deň.

Eger tegeleklik koeffisiýentleriniň ýanyndaky gulpuň şekiline 
eýe bolan düwmejik basylsa, onda tegeleklik koeffisiýentleriniň biri­
niň üýtgedilmegi beýlekilere täsir etmeýär.

Ellipsler
CorelDRAW bilen işlenende ellipsleri öz diametri boýunça süýn­

dürilen tegelek hökmünde kabul etmek bolýar.
Edil gönüburçluk ýaly «ellips» 

obýektler topary öz içinde ellips bol­
man duran obýektleri hem alýar, ýag­
ny ellipslerden emele gelýän ellips­
leriň sektorlaryny we halkalaryny.

Geometriýada ellipsleriň ölçeg­
leri onuň ýarym oklarynyň ölçegleri 
bilen kesgitlenýär: CorelDRAW-da 
gabara gönüburçlugyň ölçegleri bi­
len (belleýiş çägi bilen gabat gelýän). 
Ellips belleýiş çägi taraplaryň 4 sany 
orta markerleri ýerleşýän ýerine degýär. Ýaňy çyzylan ellipsde diňe 
bir düwün bar.

Ellipsleriň, halkalaryň we sektorlaryň çyzylmagy we modifikasiýa
Sahypany grafika bilen doldurmazlyk üçin CorelDRAW resmi­

namasyna täze sahypany goşmaly. Munuň üçin Layout > Insert Page 
(Макет > Добавить страницу) buýrugyndan peýdalanmaly we açy­
lan gepleşik penjiresinde ОK düwmejigine basmaly ýa-da penjiräniň 
aşagynda sahypanyň adyna syçanjygyň sag düwmejigine basyp, kon­
tekst menýuda meňzeş atly menýuny çagyrmaly.

Ellips çyzmak üçin, gurallar toplumynda Ellipse (Эллипс) guraly 
saýlamaly we guralyň görkezijisini çyzyljak ellipsiň gabara çäginiň 

9. Sargyt 1372

Ellips guralyny 
görkeziji

Ellipsiň 
düwni
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diagonaly boýunça süýşürmeli. Syçanjygyň düwmejigi goýberilen­
den soň, ekranda ellips çyzylar.

Klawişa-modifikatorlar Ellipse (Эллипс) guraly bilen edil 
Rectangle (Прямоугольник) guraly bilen işleýşi ýaly işleýär. Ctrl 
klawişasyny basyp saklap, ellipsi däl-de, dogry tegelegi çyzmak bol­
ýar, Shift klawişasy ellipsi burçdan çekmän, gabara gönüburçlugyň 
ortasyndan çekip çyzmaga mümkinçilik berýär. Klawişa-modifika­
torlary syçanjygyň düwmejikler goýberilenden soň goýbermeli.

Gurlan ellipsiň düwnüni tapmaly we onuň üstüne syçanjygyň 
düwmejigini getirmeli. Ellipse (Эллипс) guralyň görkezijisi Shape 
(Форма) guralyň görkezijisi bilen çalşyrylmaly. Syçanjygyň düw­
mejigine basmaly we düwni gabara gönüburçlugynyň ortasyna tarap 
süýşürmeli, soňra bolsa ellipsiň araçäginden daşyna çykman, sagat 
diliniň ugruna süýşürmeli. Syçanjygyň düwmejigi goýberilenden soň, 
ellips sektora öwrüler. Şonda ýagdaý setirinde we atributlar panelin­
de sektoryň merkezi burçy we ony çäklendirýän radiuslaryň ugurlary 
görkeziler.

Ýene bir ellipsi çyzyp, onuň düwnüni içinden däl-de daşyna çe­
kip süýşürmeli. Netijede sektor däl-de ellipsiň halkasy çyzylar.

Ellipsiň düwni süýşürilende, Ctrl klawişasy basylyp durulsa, hal­
kanyň ýa-da sektoryň merkezi burçy 15° bökme bilen üýtgäp durar.

Ellips
Sektor

Halka
Halkanyň başy we soňy

Halkanyň ugry



131

Ellips toparynyň obýektleri üçin atributlar paneline seredeliň:
• Ellipse (Эллипс). Bu düwmejik ellips bolup durýan obýekt 
bellenilen bolsa basylýar. Sektor ýa-da halka saýlanylan ma­
haly bu düwmejige basylsa olar ýapyk ellipse öwrülerler.
• Pie (Сектор). Bu düwmejik sektor bolup durýan obýekt bel­
lenilen bolsa basylýar. Onuň basylmagy ellipsleri we halkalary 
sektora öwürýär.
• Arc (Дуга). Bu düwmejik halka bolup durýan obýekt belle­
nilen bolsa basylýar. Onuň basylmagy ellipsleri we sektorlary 
halka öwürýär.
• Starting and Ending Angles (Начало и конец дуги). Bu iki 
hasaplaýjyda sektoryň ýa-da halkanyň merkezini degişlilikde 
halkanyň başlangyç we ahyrky nokady bilen birleşdirýän ra­
diuslaryň ugrukdyryş burçlarynyň bahalary saklanylýar. Ug­
rukdyryş burçlar sektory ýa-da halkany döredýän ellips bilen 
bagly bolan koordinata ulgamynda bellenilýär, başlangyç 
şöhle bolsa (0°) merkezi we ellips çyzylanda beýlekilerden has 
çepde ýerleşen nokady birleşdirýär.
• Clockwise/Counterclockwise (Направление дуги). Bu 
düwmejik iki şöhleden olaryň haýsy ugur boýunça sagadyň 
ugry ýa-da oňa garşy ugur boýunça gitjekdigini kesgitleýär.

Köpburçluklar we ýyldyzlar
«Köpburçluk» toparyna CorelDRAW-da hemme geometriki 

köpburçluklar degişli – diňe dogrulary degişli: çykyp duranlar we 
ýyldyzlaýynlar (olary köplenç ýöne ýyldyz diýip atlandyrýarlar).

Edil ellipsler we gönüburçluklar ýaly köpburçluklar modifisirle­
nip we öz öňki şekilini tanamazça üýtgedip bilýärler.

Köpburçluklary gurmak üçin ýörite gural göz öňünde tutulan. 
Onuň düwmejigi Polygon (Многоугольник) guralyň panelinde 
beýleki iki guralyň düwmejikleri bilen bilelikde ýerleşdirilen.
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Beýleki primitiwleri gurmakdan tapawutlylykda 
köpburçluklar bilen işlenende, atributlar paneli bilen 
çyzmakdan soň däl-de, öň işlemek gerek bolýar. Me­
selem:
• Number of Points of Polygon (Количество узлов 
базового многоугольника). Bu hasaplaýjynyň ba­
hasy ellipsiň bazasynda gurulýan köpburçlugyň ellips­

de näçe düwnüň guruljakdygyny kesgitleýär, şeýlelik bilen ol 
köpburçlugyň taraplarynyň sanyny belleýär.

Bu hasaplaýjynyň maksimal bahasy 500, minimaly – 3.
• Star/Polygon (Звезда/Многоугольник). Bu düwmejikler 
ýyldyz köpburçlugyň çyzma düzgünini işledýär we öçürýär. 
Ýyldyzyň çyzylmagyny tarapynyň sany 5-den az bolmadyk 
köpburçluk üçin ulanmak mümkin.
• Sharpness of Polygon (Заострение углов многоугольника). 
Bu dolandyryş elementi (süýşgüçli utgaşan meýdan) diňe 

Tor

Köpburçluk
Halkaç

Köpburçlugyň burçunyň 
ýitelmegi

Baza köpburçlugynyň 
düwünleriniň mukdary

Köpburçlugyň tarapynyň 
ortasyndaky düwün

Baza köpburçlugynyň 
görkezijisi

Ýyldyz/Köpburçluk

Rectangle guralynyň 
görkezijisi
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taraplarynyň sany azyndan 7 bolan ýyldyz köpburçluklary bi­
len işlenende elýeterli. Bu parametriň bahasy näçe uly bolsa, 
şonça hem ýyldyzyň şöhleleri ýiti bolýar.

Köpburçluk gurlandan soň, baza köpburçlugynyň depelerinde 
ýerleşen düwünlerinden başga, onda köpburçlugyň her bir tarapynyň 
ortasynda ýerleşen goşmaça düwünler görkezilýär. Köpburçlugyň 
formasynyň Polygon (Многоугольник) guraly arkaly modifikasiýasy 
şol düwünleri süýşürmekden ybarat.

Köpburçluklaryň gurulmagy we modifisirlenmesi
Çyzylan köpburçlugyň düwünlerine üns bereliň. Polygon 

(Многоугольник) guralyň görkezijisini köpburçlugyň taraplarynyň 
ortasynda ýerleşen islendik düwnüň üstüne getireliň – şonda gör­
kezijiniň formasy üýtgemeli, bu bolsa Shape (Форма) guralyň 
wagtlaýyn işlenendigi barada habar berýär. Ctrl klawişasyny basyp 
saklap, şol düwni radius boýun­
ça merkeze çenli ýarym aralyga 
süýşürmeli. «Alnan» düwün bilen 
bilelikde köpburçlugyň tarapynyň 
ortasynda ýerleşen hemme beýleki goşmaça düwünler hem süýşer. 
Netijede ninzalaryň zyňýan ýaragy bolan sýurikene meňzeş figura 
emele geler.

Ctrl klawişasynyň basylmagy köpburçlugyň düwünleri süý­
şürilende olaryň baza ellipsiň radiuslary boýunça hereket bilen olaryň 
süýşmeginiň erkinligini çäklendirýär.

Indi guralyň görkezijisini köpburçlugyň depesinde ýerleşen esa­
sy düwnüň üstüne getirmeli we ony radius däl-de, merkeziň daşyndan 
sagat diliniň ugry boýunça süýşürmeli. Netijede, sýurikeniň şöhleleri 
mundan güýçli hem ýiti bolar we figura oklaýyn simmetriýany ýitirip, 
diňe merkezi simmetriýany saklap galýar.

Indi bolsa, ýene bir köpburçluk guralyň, emma ol indi tegelegiň 
içine däl-de, bir kese çekilen ellipsiň içine salnan ýaly bolsun (aşaky 
surat, çepden). Polygon (Многоугольник) guralyň görkezijisini 
belleniş çäginiň orta markeriniň üstüne getirmeli (mundan soň ol dört 
başly oka öwrülmeli) we köpburçlugy saga süýşürmeli. Syçanjygyň 
çep düwmejigini goýbermezden öň, onuň sag düwmejigine basmaly 
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(dört başly okuň ýanynda «plýus» nyşany emele gelmeli). Netijede, 
sahypada öň gurlan köpburçlugyň süýşürilen nusgasy emele geler. Bu 
amaly ýene iki gezek gaýtalamaly we 4 sany onburçluklardan ybarat 
bolan hatar emele geler.

Göçürmegiň bu usuly örän peýdalydyr.
Birinji nusgany Polygon (Многоугольник) guralyň görkezijisi 

bilen basyp bellemeli we köpburçlugyň hem-de ýyldyzyň düzgünlerini 
işlediş düwmejigine basmaly. Çykyp duran köpburçluk ýyldyza öwrü­
ler, köpburçluklaryň ýiteldiş meýdanynda bolsa 1 baha emele geler.

Beýleki nusgalarda ýiteldiş meýdanyndaky bahany artdyrmak 
bilen emele gelen ýyldyzyň burçlaryny ýitileşdirmegi görüp bolar.

Halkaçlar
Halkaçlar şekiliň düzüm bölekleri hökmünde örän seýrek ulanyl­

ýar, ýöne olaryň ukrukdyryjylar we traýektoriýalar hökmünde ulanyl­
magy örän gyzykly grafiki effektleri gazanmagy mümkin edýär.

CorelDRAW-da halkaçlaryň iki görnüşi bar: simmetriki we loga­
rifmik. Birinjiler üçin iki sany goňşy burumlaryň arasyndaky aralyk 
(onuň merkezinden geçirilen radiusyň ugry boýunça ölçenilen) tutuş 
halkaç üçin deň. Logarifmik halkaçda bu aralyk deňölçegli belli bir 
hemişelik sana – halkajyň giňeliş koeffisiýentine proporsional bolup 
artýar.

Bu koeffisiýent göterimde ölçenilýär. Bu koeffisiýentiň 0,333-e 
deň bolan bahasy, soňraky goňşy burumlaryň arasyndaky aralyk, on­
dan öňküleriňkiden üçden bir esse uludygyny aňladýar.

Aşakdaky suratda birinji spi­
ral simmetriki, ikinji halkaçda ko­
effisiýent 0,5-e, üçünjide koeffi­
siýent – 1-e deň.

Hakykatda bolsa, halkaçlar CorelDRAW-yň primitiwleri hök­
münde bolmaýarlar. Şol sebäpli programmada «halkaç» diýip ob­
ýektler topary ýok. Olar egriler toparynyň düzümine girýärler. 
Halkajyň dolandyryş elementleriniň hemme bahalary halkaç gurul­
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mazdan öň goýulmaly. Halkaç bellenilen bolanda, onuň dolandyryş 
elementleriniň bahalarynyň atributlar panelinde üýtgedilmegi oňa hiç 
hili täsir etmeýär.

Halkaçlar Spiral (Спираль) guraly arkaly çyzylýar, onuň düw­
mejigi Polygon (Многоугольник) guralyň panelinde ýerleşýär.

Burumlaryň 
sany

Logarifmik 
halkaç

Giňeliş 
koeffisiýenti

Spiral guralynyň 
görkezijisi

Torlar
Torlar hem edil halkaçlar ýaly aýry obýektler toparyny düzme­

ýär. Graph Paper (Диаграммная сетка) gural arkaly gurulýan şe­
kiliň fragmentleri özi bilen deň gönüburçluklaryň tertipleşdirilen to­
parlary bolup durýar. Bu fragmentleri Rectangle (Прямоугольник) 
guraly arkaly gurmak örän kyn. Bu guralyň düwmejigi Polygon 
(Многоугольник) guralyň panelinde ýerleşdirilen.

Tor şeýle yzygiderlilikde gurulýar: gurallar toplumynda Graph 
Paper (Диаграммная сетка) gural saýlanylýar, soňra atributlar pane­
linde setirleriň we sütünleriň sany görkezilýär we guralyň görkezijisi 
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gönüburçluk töweregiň diagonaly boýunça süýşürilýär. Tor elmyda­
ma deň inli sütünler we deň beýiklikli setirler bilen gurulýar.

Ýumuş nusgaly plakat döretmek
Täze sahypany döretmeli, ony atlandyrmaly we içinde setirler 

öwrenilen gurallara laýyk gelýän, öýjüklerinde bolsa obýektleriň nus­
galary ýerleşen tablisa görnüşinde plakaty çyzmaly.

Toruň 
setiriniň 

sany

Toruň
sütüniniň 
sany

Graph Paper guralyň görkezijisi
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Standart figuralar
Bu toparyň primitiwleri tejribede köp duş gelýän grafiki frag­

mentleri çyzmak üçin ulanylýar. Topar 5 bölege bölünen: baza figura­
lar (basic shapes), oklar (arrow shapes), blok-shemalaryň element­
leri (flowchart shapes), ýyldyzlar (star shapes), çykaryjylary 
(callout shapes). Aşaky suratda toparyň bölekleriniň düwmejikleri 
we olara degişli standart figuralaryň palitrasy görkezilen. Palitralar 
bölege degişli bolan guralyň atributlar panelindäki düwmejik arkaly 
açylýar.

Standart figuralaryň çyzylmagy ikä bölünýär: çyzmak we for­
many sazlamak. Figurany çyzmak üçin şulary ýerine ýetirmeli:

1. Perfect Shapes (Стандартные фигуры) guralyň düwmejigi­
ne basmaly.

2. Syçanjygyň görkezijisini çyzyljak standart figuranyň diago­
naly boýunça süýşürmeli.

Sahypada saýlanylan standart figura emele geler, ol belleniş mar­
kerler bilen gurşalar. Mundan başga standart figuralaryň köpüsinde 
bellenilende kiçi romb görnüşindäki reňkli marker – marker-modifi­
kator emele gelýär (aşaky surat, sagda). Syçanjyk arkaly marker-mo­
difikatory süýşürip, standart figuranyň daşky keşbini üýtgedip bolýar.



Çyzylan standart figurany soňra 
marker-modifikator arkaly gaýta­
dan sazlap, onuň gabaralaryny we 
ugrukdyrylmagyny atributlar paneliniň 

dolandyryş elementleri arkaly üýtgedip bolýar. Standart figuranyň 
formasyny marker-modifikator arkaly üýtgetmek mümkinçiligi 
figuranyň üstünden alnyp barylýan işiň tutuş dowamynda saklanylýar 
we ol diňe figura egri çyzyga öwrülende ýitýär.
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VIII. Çyzyklar

Egriniň modeli
CorelDRAW-da kabul edilen çyzygyň modeliniň esasynda iki 

düşünje durandyr: düwün we segment. Düwün bolup şekiliň tekiz­
liginde duran, segmentiň uçlarynyň biriniň ýagdaýyny belleýän 
nokat hyzmat edýär. Segment diýlip iki goňşy düwni birleşdirýän 
çyzygyň bölegine aýdylýar. Ýapyk çyzykda düwünleriň sany bilen 
segmentleriňki gabat gelýär, açyk çyzykda düwünleriň sany 1 san 
artyk bolýar.

Şu ýerde «çyzyk» diýlen adalga hökmünde egrileriň (curve) to­
paryna degişli bolan obýekte düşünilýär.

Düwün ondan öňki segmentiň häsiýetini doly kesgitleýär, şol se­
bäpli ýapyk däl çyzyk üçin iki ahyrky düwünleriň haýsysy başlangyç 
bolýandygyny, ýapyk çyzyk üçin bolsa çyzygyň ugruny (sagat ugry 
ýa-da oňa garşydygyny) bilmek zerur. Öňdäki segmentiň häsiýetle­
ri boýunça düwünleriň üç görnüşini belleýärler: ýapyk däl çyzygyň 
başlangyç düwni, şeýle hem gönüçyzykly (line) we egriçyzykly (cur­
ve) düwünler. Aşaky suratda aralykdaky 1 düwün we ahyrky düwün 
– gönüçyzykly, aralykdaky 2 düwün – egriçyzykly.

Egri çyzyjk üçin ýagdaý setiriň orta böleginde obýektiň toparynyň 
ady görkezilýär – Curve on Layer 1 (Кривая на слое 1), onuň çep 
tarapynda bolsa – şol egri çyzygyň düwünleriniň sany.

Suratdan görnüşi ýaly çyzygyň düwünleri kiçiräk kwadrat 
görnüşinde görkezilýär. Başlangyç düwün biraz ulurak kwadrat bolup 
görkezilýär.

Çyzygyň gönüçyzykly segmenti

Başlangyç düwün Ahyrky düwün

Çyzygyň egriçyzykly 
segmenti

Çyzygyň 
gönüçyzykly 
segmenti

Aralykdaky 
1 düwün 
görkezijisi

Aralykdaky 
2 düwün 
görkezijisi
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Redaktirlemede bellenilen düwünler hem ulaldylan görnüşinde 
görkezilýär.

Iň bolmanda bir egriçyzykly segment bilen goňşy bolan düwün­
ler üçin görnüşleriň ýene bir toparlanylyşy bar: olar döwlüş nokat­
laryna (cusp) we düzlenen düwünlere (smooth) bölünýärler. Ýagny, 
düzlenen düwnüň ýagdaýy hökmünde simmetriki düwün bolýar 
(symmetrical), emma şeýle düwün diňe iki egriçyzykly segmentiň 
arasyndaky düwün bolup durýar.

Aşaky suratda görkezilen düwnüň hemme komponentleri we 
diňe şol düwün Shape (Форма) gural arkaly bellenilen bolsa we şol 
egride başga düwün bellenilmedik bolsa ekrana çykarylýar.

Bellenilen 
düwün

Bellenilen düwnüň 
ugrukdyrjy nokatlary

Egriçyzykly segmentiň bellenilen düwnüne galtaşylýan tarapdan 
ugrukdyryjy nokat görkezilýär. Ekranda ol düwün bilen ştrihleme 
bilen birleşdirilen garaldylan kwadrat hökmünde görkezilýär. Bu 
ştrihleme çyzyk onuň düwne girýän nokadynda egriçykly segmente 
bolan galtaşyjy bilen gabat gelýär. Ugrukdyryjy nokat düwünden näçe 
daşlaşylsa, şonça hem egriçyzykly segment düwünden daşlaşylýança 
galtaşyjydan haýal gyşarýar. Iki egriçyzykly segmenti bölýän düwün 
bellenilse, ekranda 4 sany ugrukdyryjy nokat görkezilýär – her 
segmenitň iki uçlaryndan.

Düwnüň görnüşi (ol ýagdaý setirinde görkezilýär) onuň ugruk­
dyryjy nokatlarynyň özara ýerleşişini kesgitleýär.

Döwülme nokatlary
Düwün döwülme nokady diýlip oňa ýanaşýan segmentlere düw­

nüň özünden geçirilen galtaşyjylar bir çyzykda ýerleşmän doly açylan 
burçdan tapawutly burçy döredýän ýagdaýda atlandyrylýar. Döwül­
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me nokatlaryň mysallary aşakdaky 
suratda getirilen:

а) gönüçyzykly segmentleriň 
sepinde; b) gönüçyzykly we egri­
çyzykly segmentleriň sepinde;  
ç) iki egriçyzykly segmentleriň sepinde.

Düzlenen burçlar
Düwün düzlenen diýilýär ha­

çan-da oňa ýanaşýan segmentlere 
geçirilen galtaşyjylar bir çyzyk­
da ýerleşýän bolsa. Düzlenen dü­
wünleriň mysallary aşaky suratda 
getirilen:

a) gönüçyzykly we egriçyzykly segmentleriň sepinde; b) iki egri­
çyzykly segmentleriň sepinde.

Iki gönüçyzykly segmentleriň sepinde ýerleşen düwün düzlenen 
bolup bilmeýär.

Simmetrik düwünler
Simmetrik diýlip ugrukdyryjy nokatlar 

özünden deň daşlaşdyrylan düzlenen nokada 
aýdylýar. Döwlüş nokatlardan we düzlenen 
düwünlerden tapawutlykda simmetrik düwün­
ler örän seýrek ulanylýar.

Ýapyk, arasy açyk we birleşdiriji çyzyklar
Ahyrky düwün diýlip diňe bir segment bilen goňşy düwne aýdyl­

ýar. Ýokarda bellenilişi ýaly, öňünden gelýän segmenti bolmadyk 
düwün başlangyç diýlip atlandyrylýar.

Başlangyç düwne eýe bolan çyzyk ýapyk däl (open curve) diýlip 
atlandyrylýar. Ahyrky düwünleri ýok bolan çyzyga ýapyk (closed 
curve) çyzyk diýilýär.

Ýapyk çyzykda başlangyç we ahyrky düwnüň roluny şol bir 
düwün ýerine ýetirýär, şol sebäpli onda hem öňki we yzyndan gelýän 
segmentleri bar. Şeýlelik bilen, ýapyk çyzykda başlangyç düwün ýok. 

a b

a b ç
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Birleşdirilen çyzyklar – bu birnäçe şahalardan (subpath) ybarat 
bolan obýektler, şol şahalaryň her biri ýapyk ýa-da ýapyk däl çyzyk 
bolup durýar. Birleşdirilen çyzyklar, obýektler Combine (Соединить) 
buýrugy bilen birleşdirilen amallarda we beýleki obýektler (mese­
lem, tekstler) egri çyzyklara özgerdilende emele gelýär. Birleşdirilen 
obýektiň esasy tapawutly häsiýeti bir obýekte ulaldylan kwadrat bilen 
bellenilen birnäçe düwünleriň bolmagydyr. Birleşdirilen çyzyklary 
aýrylaşdyryp bolýar.

Suratda ýapyk (çepde), arasy açylan (ortada) we birleşdirilen 
(sagda) çyzyklar görkezilen CorelDRAW-da islendik grafiki obýekt 
egrilere öwrüp bolýar. Çylşyrymly obýektleri bir ýa-da birnäçe çy­
zyklaryň esasynda gurup hem bolýar.

Egri çyzyklary gurmak üçin halkaç guraly ulanylýar. Dürli 
görnüşli çyzyklary gurmagy mümkin edýän gurallar CorelDRAW-da 

Curve (Кривая) guralyň panelinde 
ýerleşýär.

Çyzyklar we Freehand guraly
Freehand (Произвольная кри­

вая) guraly syçanjygyň hereket ediş 
ýoluny egri çyzyga öwürýär. Şonda 
çyzygyň düwünleri we segmentle­
ri guralyň sazlanmasyna laýyklykda 
awtomatiki döreýär.

Superçyzyk
Bezýe 
egrisi

Egri

Pero

Ýarymçyzyk

Üç nokat boýunça egri
Birleşdiriji çyzyk

Ölçeg çyzygy
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Çyzyklary el bilen çyzmak
Curve (Кривая) gurallar panelinde Freehand (Произвольная 

кривая) guraly saýlamaly. Syçanjygyň görkezijisi saýlanylan gurala 
gabat gelýän görnüşe eýe bolar. Syçanjygyň düwmejigine basmaly we 
görkezijini süýşürip tegeleklenen ýapyk egrini çyzmaly. Syçanjygyň 
görkezijisi egriniň çyzylmagy başlanan nokadyna golaýlaşanda gör­
keziji öz görnüşini suratdaky ýaly üýtgeder (sagda). Eger syçanjygyň 
düwmejigi goýberilse ýapyk egri çyzylar.

Egri çyzylanda, çyzyk «başga ýere barsa», syçanjygyň düwmeji­
gini goýbermän Shift düwmejigine basyp saklamaly. Indi görkeziji 
çyzylan çyzygyň ugry boýunça yza süýşürilse «nädogry» bölegi po­
zup bolýar. Soňra klawişany goýberip, çyzmagy dowam etmek bolýar.

Egri çyzylandan soň Sha­
pe (Форма) guraly saýlamaly 
we onuň bilen islendik düwne 
basmaly, soňra bolsa ýagdaý se­
tirindäki habary okamaly. Soňra 
yzygiderli Tab düwmejigini 
basyp, düwünden-düwne geçip, olaryň görnüşini ýagdaý setirinden 
bilmeli. Netijede şular gelip çykar:

• Freehand (Произвольная кривая) gural bilen işlenende 
düwünler we segmentler awtomatiki döredilýär;
• Düwünleriň köpüsi döwlüş nokady bolup durýar;
• Segmentleriň köpüsi egriçyzykly bolýar.

Syçanjygyň tizligi egri çyzylanda näçe ýokary bolsa, şonça hem 
gurulýan düwünler biri-birinden daşda ýerleşer.

Ýaňky egri çyzylanda tegelenişden başlap, gönüçyzykly segment 
başlanmaly we soňunda Tab klawişasyny basmaly.

Indi bolsa bu guralyň kömegi bilen diňe gönüçyzykly segment­
leri çyzalyň. Guralyň görkezijisini birinji düwnüň ýerleşmeli ýerine 
getirmeli we syçanjygyň düwmejigine basmaly. Syçanjygyň düwme­
jiklerine basylmagy düwünleriň ýerleşmeli ýerinde iki gezek basmak 
bilen amala aşyrylýar. Soňky gezek başlangyç nokatda basylan ýag­
daýda çyzyk ýapyk bolup galýar.

a b
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CorelDRAW-yň soňky wersiýalarynda Freehand (Произволь­
ная кривая) gurala goşmaça hökmünde Polyline (Полилиния) gu­
raly girizilen. Onuň bilen birnäçe segmentlerden ybarat bolan egrileri 
çyzmak amatly. Başlangyç segment döredilenden soň, syçanjygyň 
düwmejigine basylýar, emma ol egriniň çyzylmagyny tamamlamaýar. 
Syçanjygyň düwmejigi basylan mahaly görkezijiniň süýşürilmegi 
egri çyzygyň egriçyzykly segmentini döredýär, syçanjygyň düwme­
jigi goýberilen mahaly görkezijiniň süýşürilmegi gönüçyzykly seg­
menti döredýär. Ýapyk däl egriniň çyzylmagyny tamamlamak üçin 
Probel klawişasyna basmaly.

Çyzyklar we Bezier guraly
Bezier (Кривая Безьe) guraly bilen işlände ulanyjy çyzyljak 

egriniň düwünleriniň ýerleşişini belleýär we çyzmagyň dowamynda 
onuň her biriniň ugrukdyryjy nokatlaryna täsir etmek mümkinçiligine 
eýe bolýar. Egriniň Bezier (Кривая Безье) guraly arkaly çyzylmagy 
egriniň her düwni bilen işlemegiň gaýtalanyş yzygiderliliginden yba­
rat. Gaýtalanyş görkezijiniň boljak düwnüň ýerine goýulmagyndan 
başlanýar. Soňra syçanjygyň düwmejigi basylýar we ony basyp sak­
lap, ugrukdyryjy nokatlaryň ýerleşişi takyklanýar hem-de ol syçanjyk 
bilen süýşürilýär (ilkibaşda düwünden, soňra bolsa – onuň daşynda). 
Deslapdan simmetrik düwünler döredilýär, emma syçanjygyň düw­
mejigi goýberilen mahaly düwnüň klawişa‑modifikatoryndan peýda­
lanylsa düzlenen düwün ýa-da döwlüş nokat dörediler. Syçanjygyň 
düwmejigi goýberilen mahaly düwnüň görnüşi we ugrukdyryjy nokat­
laryň ýerleşişi bellenilýär, soňra indiki düwnüň kesgitleniş gaýtala­
nyşy başlanýar. Gaýtalanyşdan çykmak üçin Probel klawişasyna bas­
maly.

Döwlüş nokady döredilende С klawişasyny basyp saklamaly 
(cusp). Düzlenen nokady döretmek üçin S (smooth) klawişa-modi­
fikator ulanylýar.

Çyzyklary Bezier guraly arkaly çyzmak
Gurallar toplumynda Bezier (Кривая Безье) guralyny saýla­

maly.
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Çyzygyň gurulmagyny çyzykly segmentden öň duran düwünden 
başlamaly. Görkezijini gerekli nokada goýmaly we syçanjygyň düw­
mejigine basmaly. Düwünden «çykarylan» ugrukdyryjy nokatlar gör­
ner ýaly düwmejigi goýbermän görkezijini biraz saga geçirmeli. In­
diki segmente bolan galtaşyjy berk kese bolar ýaly Ctrl klawişasyna 
basyp saklamaly. Syçanjygyň düwmejigini goýberip, soňra bolsa 
Ctrl klawişasyna basmaly, netijede egriniň bi­
rinji düwni gurulýar. Başda ol ýeke düwün bo­
lany üçin onuň üstünden iş tamamlanandan soň ol awtomatiki döwlüş 
nokady bolup durýar. Bu düwünde çyzyk ýapylan ýagdaýynda onuň 
görnüşi üýtgeýär.

Indi ikinji düwnüň gurulmagyna geçeliň. Onuň birinji düwün 
bilen bir kese çyzykda 
ýerleşmelidigi sebäpli, 
guralyň görkezijisini süýşürmezden öň gaýtadan Ctrl klawişasyny 
basyp saklamaly. Ikinji düwün edil birinji düwün ýaly gurulýar, ýöne 
syçanjygyň düwmejigi goýberilenden soň ol simmetrik bolar. 

Üçünji düwün ikinjiniň aşagynda 
ýerleşmelidir, şol sebäpli ikinji düwün bilen 
işlenenden soň Ctrl klawişasyny goýber­
mek hem mümkin. Bu gezek düwünden 
ugrukdyryjy nokady Ctrl klawişasyny goýbemän saga däl‑de çepe 
«çykarmaly». Tegelenme simmetriki bolar ýaly ugrukdyryjy nokat­
dan düwne çenli aralyk edil ikinji düwnüňki ýaly bolmalydyr.

Dördünji düwün edil üçünji ýaly gurulýar. Indi egrini ýapmak ge­
rek. Munuň üçin syçanjygyň görkezijisi başlangyç nokada süýşürilýär 
(ýörite okly nyşan emele gelýänçä) we syçanjygyň çep düwmejigine 
basylýar. Ugrukdyryjy nokady Ctrl klawiýasy basylan ýagdaýynda 
saga süýşürmeli (tegelenme simmetrik bolar ýaly) we netijede ýapyk 
egri çyzylar.

10. Sargyt 1372
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Täze Реn (Перо) guraly egrileri edil Bezier (Кривая Безье) 
guralyň teklip edýän usullary bilen çyzmaklygy mümkin edýär. Ta­
pawudy: syçanjygyň görkezijisi egriniň nobatdaky düwnüň ýerleşiş 
nokadyna süýşürilende ekranda egriniň entek gurulmadyk indiki 
segmentiniň daşky görnüşi görkezilýär.

Üýtgeýän inli çyzyklar we Artistic Media guraly
Artistic Media (Суперлиния) guraly arkaly «superçyzyklar» 

(Artistic Media Group) toparynyň düzüm obýektleri çyzylýar. Bu 
obýektleriň her biri iki bölekden ybarat – dolandyryjy obýektiň ro­
luny oýnaýan we tutuşlaýyn düzüm obýektiň formasynyň esasy pa­
rametrlerini kesgitleýän çyzykdan hem-de şol formanyň detallaryny 
kesgitleýän tabyn obýektden. Tabyn obýektiň roluny ýapyk egri 
çyzyk eýsem CorelDRAW-daky islendik obýekt oýnap biler, özem 
dolandyryjy obýekt hem-de tabyn obýekt superçyzyk gurulmazdan 
öň çyzylyp bilner, şeýle hem çyzmagyň dowamynda gurlup bilner. Bu 
mümkinçilikleri amala aşyrmak üçin Artistic Media (Суперлиния) 
guraly birnäçe düzgünde işläp bilýär. Artistic Media (Суперлиния) 
guralyň düzgünlerini saýlamak aşakda görkezilen atributlar paneli ar­
kaly amala aşyrylýar.

Taýýarlanma Basyş bilen
Çotga Düzlenme

Pürkgüç Kalligrafiýa Çyzygyň ini Taýýarlanmanyň 
ülňüsi

• Preset (Заготовка), Brush (Кисть), Sprayer (Распылитель), 
Calligraphic (Каллиграфия) we Pressure (С нажимом) 
düwmejikleri guralyň düzgünlerini işletmegi üpjün edýär.
• Süýşgüji bolan Freehand Smoothing (Сглаживание) meý­
dany düwünleriň döredilmeginiň ýygylygyny sazlamaga 
mümkinçilik berýär.
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• Artistic Media Tool Width (Ширина линии) hasaplaýjysy 
superçyzyk gurlanda tabyn obýektiň maksimal inini kesgit­
leýän bahany saklaýar.
• Preset (Схема заготовки) atly açylýan sanaw taýýarlanma 
düzgünde işlenende tabyn obýektiň ülňüsini saýlamagy üpjün 
edýär.

Kalligrafiýa düzgüni
Guralyň görkezijisi belli bir ýol boýunça süýşürilende bu ýol 

düzüm obýektiň dolandyryjy çyzygy hökmünde bellenilýär, şonda 
düzlenmegiň dolandyrjy parametriniň bahasy hasaba alynýar. Emma 
süýşürme tamamlanandan soň (syçanjygyň düwmejigi goýberilenden 
soň) awtomatiki ýene bir obýekt – ýapyk egri çyzyk çyzylýar. Onuň 
formasy dolandyryjy çyzygyň formasy we kalligrafiki peronyň hä­
siýetnamalary – ini we eňňitligi bilen kesgitlenýär.

Guralyň görkezijisi Eňňitlik burçy

Berlen inli kalligrafik pero ortaky nokady bilen dolandyryjy 
çyzygyň başlangyç düwnüne goýulýar, soňra onuň ugry boýun­
ça süýşürilýär. Tabyn obýekt peronyň başlangyç we ahyrky ýag­
daýlaryndan we onuň gyralarynyň hereket eden ýolundan ybarat bo­
lan ýapyk egri çyzyk bolup durýar. Aşaky suratda kalligrafik gural 
bilen çyzylan obýekt üç gezek görkezilen. Çepde ol Shape (Форма) 
guraly bilen okuna basylyp saýlanylan, ortada – Pick (Выбор) gu­
raly bilen obýektiň gyrasyna syçanjyk bilen basylyp, sagda kalligrafik 
peronyň eňňitlik bahasy 0-dan 60° çalşyrylan ýagdaýynda.
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Taýýarlanma düzgüni
Kalligrafiýa düzgüninden tapawutlykda taýýarlanma düzgüni 

dolandyryjy çyzygy iki usul bilen gurmaga mümkinçilik berýär: su­
perçyzygyň düzüm obýekti gurulýan mahaly ýa-da öňünden, soňra 
dolandyryjy obýekte özgertme bilen.

Birinji ýagdaýda kalligrafiýa düzgünindäki ýaly edilýär, ýöne 
kalligrafiki peronyň eňňitliginiň deregine tabyn obýektiň öň taýyn 
ülňüsi ulanylýar. Bu ülňüleri saklaýan sanaw atributlar panelinde 
emele gelýär.

Ikinji ýagdaýda çyzgy ilkibaşda Freehand (Произвольная 
кривая) ýa-da Bezier (Кривая 
Безье) guraly arkaly gurulýar, soňra 
Artistic Media (Суперлиння) gu­
raly saýlanylýar we taýýarlanma 
düzgüni işledilýär.

Eger dolandyryjy obýekt 
hökmünde birleşdirilen çyzyk ulanylsa, onda taýýarlanma onuň her 
şahamçasyna aýry ulanylýar. Taýýarlanma saýlanmazdan öň super­
çyzyk bolup duran obýekt bellenilse, onuň tabyn obýekti ýok edilýär, 
we täze tabyn obýekt bellenilýär.

Çotga düzgüni
Çotga düzgüninde tabyn obýekt dolandyryjy çyzgy boýunça 

gurulmaýar, ol diňe onuň formasy we superçyzygyň ini boýunça de­
formirlenýär. Deformasiýa üçin başlangyç material bolup sülereýler 
hyzmat edýär – ýörite .стх formatda CorelDRAW programmasynyň 
ýüklenen bukjasynda ýerleşen we \CustomMediaStrokes bukja­
da ýatda saklanylan şekiller. Deformasiýanyň manysy şekil-sülereý 
ini birleşdirilen obýektiň uzynlygyna, beýikligi bolsa superçyzygyň 
berlen inine deň bolar ýaly süýnýär ýa-da gysylýar, soňra bolsa do­
landyryjy çyzygyň formasyna laýyklykda gyşardylýar.

CorelDRAW-yň düzümine standart sülereýleriň toplumy girýär 
we olaryň içine täzelerini hem goşmak bolýar (diňe wektorlylary däl­
de, eýsem nokatlylary hem). Şekil \CustomMediaStrokes bukjasyna 
salnanda soň onuň ýönekeýleşdirilen şekili kist üçin atributlar pane­
linde sülereýleri görkezýän sanawda ýerleşdiriler.
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Sülereýleriň sanawy Sülereýleri ýok etmek

Sülereý hökmünde ýatda saklamak

Çyzyklary kist düzgünde çyzmagyň usullary edil taýýarlanma 
düzgüniňki ýalydyr.

Şekili sülereý hökmünde ýatda saklamak üçin ony Pick (Выбор) 
guraly arkaly saýlamaly, soňra Artistic Media (Суперлиния) guraly 
saýlamaly, kist düzgünini işletmeli we paneldäki degişli düwmejige 
basmaly hem-de açylan penjirede at bermeli. Sülereýleri ýok etmek 
üçin hem degişli düwmejik bar.

Sülereýiň fiziki ýok edilmegi syçanjyk bilen düwmejige basy­
lan ýagdaýda däl-de, CorelDRAW bilen iş tamamlananda amala 
aşyrylýar. Şol sebäpli programma ýapylman ýok edilen sülereý bilen 
işlemek mümkin.

Superçyzyklary çyzmak
1. Sahypada ýylanyň suratyny çekmeli (aşaky surat, ýokarda). 

Ilkibaşda ýylanyň tenine we kellesine gabat gelýän ýapyk çyzygy 
gurmaly. Gözleri we burun deşikleri hökmünde ellipsleri çyzmaly. 
Arkasynda egrem-bugram çyzyk hökmünde bolsa döwlen çyzygy 
ulanmaly.

2. Indi ýylanyň hemme böleklerini Pick (Выбор) guraly arkaly 
gönüburçluga salyp bellemeli.
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3. Artistic Media (Суперлиния) guraly saýlap, kist düzgünini 
işletmeli. Soňra disketa görnüşine eýe bolan düwmejige basyp, sü­
lereýi ýatda saklamak üçin faýlyň adyny girizmeli. OK düwmejigi 
basylandan soň täze sülereý ulanylmaga taýyn bolýar.

4. Esc (düwmejigine) basyp, ýylanyň bellenilmegini aýyrmaly. 
Artistic Media (Суперлиния) guraly arkaly islendik çyzyklary çyz­
maly. Netijäni ýokarky suratda görmek bolar.

5. Ýylany ýumak ýaly düýrlemek üçin Spiral (Спираль) guraly 
arkaly 2-3 burumdan ybarat bolan logarifmik halkajy çyzmaly. Artis­
tic Media (Суперлиния) guraly saýlap, ýylanyň sülereýini ulanmaly. 
Eger ýumak gaty dykyz bolsa superçyzygyň inini peseldip görmeli 
ýa-da obýekti ýok edip, halkajygyň giňeliş koeffisiýentini artdyryp, 
obýekti çyzmaly.

6. Ýylany halka düýrlemek üçin dolandyryjy çyzyk hökmünde 
ellipsi ulanmak gerek.

7. Original gönüburçluk çarçuwany (ramkany) ýasamak üçin 
gönüburçlugy gurmaly we onuň üç burçuny – çepdäki ýokarky bur­
çundan başgasyny tegeleklemeli. Bu superçyzygyň güýçli döwülme­
sinden azat eder.

Pürkgüç düzgüni
Artistic Media (Суперлиния) guralyň pürkgüç düzgüni bir 

tabyn obýekti däl-de, olaryň tutuş toparyny döredýär, ol öňden kesgit­
lenen şekiliň nusgalaryny we onuň böleklerini (pürkgüjiň şablonyny) 
dolandyryjy çyzygyň ugry boýunça ýerleşdirýär. Aşakdaky surat­
da iki mysal getirilen, olaryň şablony tapawutly, emma dolandyryjy 
çyzyklary bir görnüşlidir.

Ýöne, bu düzümli obýektleri çyzyklara örän kynçylyk bilen 
degişli etmek bolýar. Pürkgüç düzgüniniň funksional mümkinçilikleri 
örän giň. Ýagny pürkgüjiň şablonyna girýän şekiliň aýry böleklerini, 
olaryň dolandyryjy çyzykda ýerleşişini kesgitleýän parametrlerini, şol 
bölekleriň yzygiderliligini dolandyrmak mümkin. CorelDRAW-yň 
düzümindäki topluma pürkgüjiň şablonlarynyň köp mukdary girýär, 
şol şablonlaryň sanyny köpeltmegiň mümkinçiligi hem bar. Köplenç 
pürkgüç düzgüninde döredilen superçyzyklary original çarçuwalary 
we fonlary döretmek üçin ulanýarlar.
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Artistic Media ýanaşdyrylýan penjiresi
Superçyzyklary gurmak we üýtgetmek üçin diňe Artistic Media 

(Суперлиния) guralyň atributlar panelini ulanman, eýsem deň atly 
ýanaşdyrylýan penjiresini ulanmak hem bolýar. Ony ekranda gör­
kezmek üçin Window > Dockers > Artistic Media (Окно > При­
стыковываемые окна > Суперлиния) buýrugy saýlamaly.

Ýanaşdyrylýan penjirede superçyzyklaryň taýýarlanmasynyň, 
pürkgüjiň sülereýleriniň we şablonlarynyň şekilini saklaýan iki sanaw 
getirilen. Aşaky sanawda \CustomMediaStrokes bukjanyň düzümine 
gabat gelýän ülňüleriň doly toplumy getirilen, ýokarkyda – ýakynda 
ulanylanlar. Sanawyň düzümini görkezilýän obýektleriň menýusy ar­
kaly dolandyrmak mümkin, ol saga gönükdirilen üçburçlugyň şekilini 
göterýän düwmejik arkaly amala aşyrylýar. Menýuda üç sany düzgün 
pürkgüjiň taýýarlanmasyny, sülereýleriniň we şablonlarynyň görke­
zilmegini işledýär we öçürýär.

Bloklama düwmejigi ülňini saýlanylan çyzyga ulanmagyň düz­
günini dolandyrýar. Eger düwmejik basylan ýagdaýda bolsa, onda 
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sanawda bir ülňi saýlanylandan soň, derrew şol ülňi superçyzygy 
gurmak üçin ulanylýar. Eger düwmejik basylmadyk ýagdaýda bolsa, 
onda ülňini ulanmak üçin Apply (Применить) düwmejigine goşmaça 
basmak gerek bolýar.

Şu ýanaşdyrylýan penjiräniň elementlerini ulanmak superçyzyk­
lary gurmagyň üç düzgünleri: taýýarlanma, çotga we pürkgüç düz­
günleri bilen işlemegi aňsatlaşdyrýar.

Egri çyzygy superçyzygyň dolandyryjy egri çyzygyna özgert­
mek üçin ýanaşdyrylýan penjiräniň iki sanawynyň birinde nusganyň, 
sülereýiň ýa-da şablonyň gerek şekilini saýlamak we ony syçanjyk 
arkaly şol egri çyzygyň üstüne süýşürmek ýeterlikdir.

Şekili pürkgüjiň sülereýi ýa-da şablony hökmünde ýatda sakla­
mak üçin ony belläp, syçanjyk bilen aşaky sanawa süýşürmek ýe­
terlikdir. Syçanjygyň düwmejigi goýberilenden soň görkezilen şekil 
pürkgüjiň sülereýi ýa-da şablony hökmünde ýatda saklanylýandygyny 
görkezýän gepleşik penjiresi açylýar, soňra bolsa faýlyň ady berilýär.

Ulanylan şablonlar, 
sülereýler we ülňüler

Ulanmak

Görkezilýän 
obýektler

Taýýarlanmany 
ýok etmek

Sülereýi ýatda 
saklamak

Blokirowka



153

Edil şular ýaly netijäni ýanaşdyrylýan penjiräniň Save (Сохра­
нить) düwmejigi arkaly gazanmak mümkin.

Basyşly surat çekiş düzgüni
Bu düzgün ýörite enjamy talap edýär – tenzometrik grafiki 

planşeti, ol diňe peronyň üstünden hereketini bellemän, eýsem ulany­
jynyň pero basýan güýjüni hem hasaba alýar.

Bu düzgünde peronyň planşet boýunça süýşürilmegi super­
çyzygyň dolandyryjy egri çyzygyny döredýär, basyş bolsa onuň inini 
kesgitleýär (iň ýokary basyşly ýerlerde ol atributlar panelinde belleni­
len guralyň inine deň bolar).

Ekzotikanyň söýüjileri bu düzgüni planşetsiz hem ulanyp bi­
lerler. Peronyň hereketini syçanjyk arkaly, basyşy bolsa kursory do­
landyryjy klawişalar arkaly (ýokary we aşak) amala aşyrylýar.

Cyzgylaryň we ülňüleriň elementleri
CorelDRAW-daky käbir obýektler esasan ýörite şekiller: çyz­

gylar, ülňüler, diagrammalar, blok-ülňüler gurlanda ulanylýar. Kada 
bolşy ýaly, bu görnüşli şekiller dürli şertler bilen çyzylýar. Programma 
çyzgylary çyzmaga bolan standartlaryň hemmesini kanagatlandyryp 
bilmeýär, ýöne eger şekile önümiň gabara ölçeglerini goýmak ýa-da 
onuň aýry böleklerini çykaryş çyzyklar bilen görkezmek gerek bolsa, 
onda bu işi CorelDRAW programmasynyň kömegi bilen ýerine ýeti­
rip bolýar.

Olaryň köpüsi Curve (Кривая) guralyň açylýan panelinde jem­
lenen.
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Ölçeg çyzyklar
Curve (Кривая) guralyň panelinde Dimension (Размерные ли­

нии) guralyň saýlanylmagy ölçeg ülňüleriniň bir toparyny (çykaryş 
çyzykdan, ölçeg çyzykdan we ölçeg ýazgydan ybarat bolanlary) we 
çykaryş çyzyklary ulanmagy mümkin edýär:

• çyzykly ölçeg (Linear Dimension);
• burç ölçegi (Angled Dimension);
• çykaryjy (Callout).
Düzümli obýektiň içine dürli toparlaryň obýektleri girýär. Olary 

aýratyn üýtgetmek mümkin däl, üýtgetme tutuşlaýyn bolup geçýär 
we aýratyn obýektler boýunça ylalaşykly bolýar. Meselem, ölçeg ýaz­
gysy üýtgedilenden şoň göräleýin ölçeg ülňüsiniň çykaryş çyzyklary 
ýa ulalýar, ýa-da kiçelýär we ölçeg çyzygy süýşüp durýar.

Ölçeg ülňüsini, edil düzümli obýekti ýaly aýry böleklere bölmek 
mümkin. Munuň üçin Arrange > Break Apart (Монтаж > Разъеди­
нить) buýrugyny saýlamaly. Bu buýruk ýerine ýetirilenden soň dü­
zümli obýekt birnäçe obýektlere we obýektler toparyna öwrülýär. 
Emma bu yzyna gaýtarylmaýan hereketdir.

Ölçeg ülňüleri we çykaryjylar bilen işlenende atributlar paneli 
uly rol oýnaýar.

Tekstiň 
ýerleşişi

Awtoölçeg

Ölçegiň 
prefiksi

Burç ölçegiKese ölçeg
Ölçegiň gornüşi

Dinamiki 
baglaşdyryş

Çykaryş çyzygy

Ölçeg birlikleri 
görkezmek

Dik ölçeg

Ölçegiň 
goşulmasy

Ölçeýşiň 
takyklygy

Eňňit ölçeg

Ölçeg birligi

• Ölçeg ülňüsiniň görnüşini saýlaýyş düwmejikleriniň topary.
• Auto Dimension Tool (Авторазмер). Ölçeg ülňüsiniň gör­
nüşi ülňi düzülende syçanjygyň hereketi boýunça awtomatiki 
kesgitlenýär. Islendik çyzykly ölçegiň ölçeg ülňüsini gurma­
gyň prosesi syçanjygyň düwmejiginiň üç gezek yzygiderli 
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basylmagyndan ybarat: birinji çykaryş çyzygyň «ölçenilýän» 
obýekte birleşýän ýerinde, ikinji çykaryş çyzygyň birleşýän 
ýerinde we ölçeg ýazgysynyň we ölçeg çyzygyň ýerleşişi bel­
lenilende.

Obýektiň birleşiş nokady bolup, ölçeg ülňüsiniň elementleri, 
birleşiş çyzyklar we çykaryjylaryň başlary bagly bolup durýan no­
kat çykyş edýär. Guralyň görkezijisi meselem, Dimension Line 
(Размерная линия) guralyňky – birleşiş nokadynyň üstünden ba­
randa ol ekranda reňkli marker bilen görkezilýär. Birleşiş nokat­
laryna obýektleriň hemme düwünleri, şeýle hem belleýiş çäkleriň 
markerleriniň ýerleşýän ýeri degişli, eger olaryň ýerleşýän ýerinde 
obýektiň çyzygy bar bolsa. Meselem, gönüburçlukda hem-de ellips­
de belleýiş çäginiň aşaky tarapynyň ortasynda birleşiş nokady bar. 
Emma, gönüburçlukda şol çägiň burçlarynda birleşiş nokatlary bar, 
ellipsde bolsa ýok. Primitiwleriň ortasynda birleşiş nokatlary bar.

• Vertical Dimension Tool (Вертикальный размер). Dik öl­
çeg ülňüsi.
• Horizontal Dimension Tool (Горизонтальный размер). 
Kese ölçeg ülňüsi.
• Slanted Dimension Tool (Наклонным размер). Ölçeg çy­
zygynyň eňňitlik ugruny göz öňünde tutýan ölçeg ülňüsi.
• Callout (Выносная линия). Ýazgyny obýektdäki birleşiş 
nokady bilen baglaşdyrýan ýörite düzümli obýektiň saýlanyl­
magy.
• Angular Dimension Tool (Угловой размер). Burçuň ölçegi­
ni goýmagyň ölçeg ülňüsi.
• Dimension Style (Тип измерения). Bu açylýan sanaw 
ölçegiň bahasyny görkezmegiň formatyny dolandyrýar. Sana­
wa şular goşulan:
– Decimal (Десятичный) – ölçegiň bahasy onluk drob görnü­
şinde görkezilýär, onda drobuň razrýadlarynyň sany ölçeýşiň 
takyklygynyň sanawynda saýlaýyş bilen kesgitlenýär;
– Fractional (Дробный) – ölçegiň bahasy garyşyk natural drob 
görnüşinde görkezilýär, onuň drob böleginiň maýdalawjysy öl­
çeýşiň takyklygynyň sanawynda saýlaýyş bilen kesgitlenýär;
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– US Engineering (Инженерный) we US Architecture 
(Архитектурный) – ABŞ standartlary;
– Dimension Precision (Точность измерений). Bu sanawyň 
bahalary ölçegiň ähmiýetini ölçeg ýazgysynda takyklygyny 
dolandyrýar;
– Dimension Units (Единицы измерения). Bu açylýan sanaw 
ölçeg birlikleri saýlamagy we olaryň görkezilmegini saýlama­
ga mümkinçilik berýär;

Ölçeg çyzygyň üstünden

Ölçeg çyzygyň üzülmesine

Ölçeg çyzygyň aşagyndan

Hemişe kese boýunça

Ýazgyny merkezleşdirme

– Тext Position (Положение текста). Ölçeg ýazgysynyň 
ýerleşişini kesgitleýän düwmejikleri saklaýan panel;
– Dynamic Dimensioning (Динамическая привязка). Ölçeg 
ýazgysyny döretmegiň düzgünini dolandyrýan düwmejik. Ol 
basylan ýagdaýda bolsa, obýektiň ölçegi her gezek üýtgedilse 
ölçeg ýazgysy täzeden döredilýär. Ýogsam ölçeg ýazgysy öl­
çeg ülňüsi döredilende bir gezek döredilýär;
– Suffix for Dimension (Суффикс размера). Ölçeg sanyň 
soňundan teksti goşmagy mümkin edýän meýdan;
– Prefix for Dimension (Префикс размера). Ölçeg sanyň 
öňünden teksti goşmagy mümkin edýän meýdan;
– Show Units for Dimension (Показывать единицы 
измерения): Ölçeg ýazgysynyň düzümine ölçeg birlikleri 
goşmagy dolandyrýan düwmejik.
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Ölçegleri goýmak
1. Sahypada dogry altyburçlugy gurmaly. Atributlar panelini 

ulanmak bilen onuň dik ölçegini 50 mm‑e deň etmeli.
2. Gurallar toplumynda Dimension (Размерные линии) guraly 

saýlamaly we atributlar panelinde kese ölçegiň düwmejigine basmaly. 
Kese ölçeg ülňini gurmak atributlar panelinde dolandyryjy parametrle­
ri bermekden başlanylýar. Ölçegiň görnüşini Decimal (Десятичный) 
etmeli, ölçeg birlikleri hökmünde millimetrleri saýlamaly we ölçeg 
ýazgysyna olaryň ýazylmagyny gadagan etmeli. Görkezmegiň taky­
klygyny oturdan soň iki razrýada deň etmeli. Guralyň görkezijisi­
ni altyburçlugyň çepki aşaky burçuna getirmeli we birleşiş nokady 
reňkli marker bilen bellenilenden soň, syçanjygyň düwmejigine bas­
maly (aşaky a surat).

a b

ç d

3. Guralyň görkezijisini altyburçlugyň sagdaky aşaky burçuna 
getirmeli we ýokarky ýaly çykaryş çyzygyň ikinji nokadyny berkit­
meli (ýokarky b surat).

4. Guralyň görkezijisini aşak süýşürmeli, onuň bilen bile öl­
çeg çyzygy hem süýşer we çykaryş çyzyklar uzalar. Indi bolsa ölçeg 
ýazgysynyň ýerleşişini kesgitleýän gönüburçluk ortada durar ýaly 
görkezijini çepe süýşürmeli we ýene syçanjygyň düwmejigine bas­
maly.

5. Pick (Выбор) guraly saýlamaly we altyburçluga basmaly. Öl­
çeg ülňüsi birleşdirilenden soň, obýekt dolandyrylýan bolup galýar, 
ýagny onuň üýtgedilmegi oňa soň birleşdirilen obýektleriň awtoma­
tiki üýtgemegine getirýär. Eger ölçeg ýazgysyna basylsa, ol aýratyn 
belleniler we ony ölçeg ülňüsiniň çäginde islendik ýerde goýmak 
bolýar, beýleki obýektler hem şoňa görä üýtgeýär. Altyburçluk oňa 
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birleşdirilen hemme ölçeg ülňüler üçin dolandyryjy obýekt bolsa, öl­
çeg ýazgysy diňe özüne degişli ölçeg ülňi üçin dolandyryjy obýekt 
bolup durýar.

6. Edil şolar ýaly eňňitli we dik ölçeg ülňüleri çyzylýar.
7. Burç ölçegi üçin ölçeg ülňüsini çyzalyň. Birinji nokady bel­

lemezden öň ölçeg ýazgyny goşulmasyny (suffiksi) girizeliň – 
gradusyň belgisini. Munuň üçin atributlar paneliniň degişli ýerine 
kursory goýalyň, kömekçi klawiaturany Num Lock klawişasy arkaly 
sanlaryň giriziliş ýagdaýyna geçireliň we Alt klawişasyny basyp, on­
dan gradus belgisiniň 0176 koduny ýazalyň. Soňra ölçegiň bahasyny 
görkezmegiň takyklygyny drobly razrýadsyz, ýöne bir goşmaça bilen: 
çykaryş çyzyklaryň birleşme nokatlaryny kesgitlemezden öň (aşaky b 
we ç surat) syçanjyk bilen basmak arkaly burç ölçeginiň merkezini 
bellemek gerek – çykaryş çyzyklarynyň kesişýän nokadyny (aşaky 
a surat). Eger ölçeg ülňüsi doly obýekt bilen baglaşdyrylan bolsa, bu 
birleşme nokady bolmaly.

a b ç d

Eger ölçeg ülňüsi ýalňyş çyzylan 
we ony ýok etmek gerek bolsa, ony Pick 
(Выбор) guraly bilen saýlamaly, munuň 
üçin dolandyryjy teksti saýlamak hem ýe­
terlik we Del klawişasyna basmaly. Ölçenil­
ýän obýekt ýok edilse, onuň bilen bilelikde 
ölçeg ülňüsi hem ýok ediler.

Eger ölçeg ülňüsi gurlanda çykaryş 
çyzyklar obýektiň birleşme nokatlaryna bir­

leşmeýän bolsa, onda obýekt üýtgedilende üýtgemeýär we obýekt 
ýok edilende ýok edilmeýär.

8. Gurlan ülňülere üýtgetme girizmeli. Hemme üýtgetmeler Pick 
(Выбор) guraly bilen amala aşyrylýar.
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Çykaryş çyzyklar
Çykaryş çyzyklary aýratyn topary düzýän düzümli obýekt bo­

lup durýar. Olar iki segmentden ybarat, özem ikinji segmentiň 
ahyry çykaryjynyň ýazgysyna birleşdirilen. Ýazgy çykaryjylaryň 
toparynyň dolandyryjy obýekti bolup durýar. Ýazgynyň üýtgedil­
megi çykaryjynyň ikinji segmentiniň uzynlygyna we ýerleşmegine 
täsir edýär, şonda birinji segment üýtgedilmän galýar. Ýazgynyň 
uzynlygynyň üýtgedilmegi çykaryjynyň segmentlerine täsir etmeýär. 
Obýekt süýşürilende hem oňa birleşdirilen çykaryjy hem bile süýşýär.

Çykaryjyny çyzmagyň düzgüni Dimension (Размерная линия) 
guraly saýlanylandan we şol guralyň atributlar panelinde çykaryjynyň 
düwmejigine basylandan soň 4 amaldan ybarat bolýar.

1. Birinji syçanjyk bilen basma birinji segmentiň başyny bel­
leýär. Eger ol obýekte birleşme nokadynda ýerine ýetirilse çykaryjy 
obýekte birleşýär, ýogsam ol onuň bilen bagly bolmaýar.

2. Ikinji syçanjyk bilen basma birinji segmentiň ahyryny we ikin­
ji segmentiň başyny aňladýar. Eger ikinji segment gerek däl bolsa, 
onuň üçin nola deň bolan uzynlyk bellenilýär, şonuň üçin ikinji gezek 
syçanjyk bilen iki gezek basýarlar.

3. Üçünji syçanjyk bilen basma ikinji segmentiň ahyryny we 
çykaryjynyň ýazgysynyň başlanýan ýerini aňladýar.

Segmentleriň ugry kesgitlenende Ctrl klawişa-modifikatordan 
peýdalanmak amatly.

4. Üçünji (ýa-da ikinji) syçanjyk bilen basmadan soň ýazgynyň 
girizme düzgüni işläp başlaýar.

Düwün

Halkanyň ahyrky nokadyHalkanyň başy

Ýazgynyň tekstini girizmegi tamamlamak üçin gurallar toplu­
mynda Pick (Выбор) saýlamak ýeterlik.
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Birleşdiriji çyzyklar
Birleşdiriji çyzyklar çyzykly obýektleriň aýratyn toparyny 

düzýär, olar dürli ülňi şekilleri, aýratynlykda hem blok-shemalary 
çyzmak üçin örän amatly gural bolup durýar. Standart figuralar bilen 
utgaşyklykda Interactive Connector Tool (Соединительная линия) 
guraly bilen işlenende goşmaça amatlyklar döreýär.

Birleşdiriji çyzygyň iki ujy hem obýekte birleşme nokatlarynda 
birleşmelidir. Çyzylandan soň birleşdiriji çyzygy birleşme nokat­
laryny birleşdirýär. Birleşmegiň iki warianty bardyr: birleşdirilen 
obýektleriň özara ýerleşişine garamazdan berk kese ýa-da berk dik 
gönüçyzykly segmentlerden ybarat bolan döwlen çyzyk (döwlen 
birleşdiriji çyzyk) we göni çyzygyň kesimi (göni birleşdiriji çyzyk) 
bilen. Wariantyň saýlanylmagy guralyň atributlar panelinde ýerleşen 
Angled connector (Ломаная соединительная линия) we Straight 
connector (Прямая соединительная линия) düwmejikleri arkaly 
amala aşyrylýar.

Birleşdiriji çyzygyň gurulmagy Interactive Connector Line 
(Соединительная линия) gural saýlanylandan soň iki amal arkaly 
amala aşyrylýar.

Birleşdiriji çyzyk

Interactive 
Connector Line 

guralyň görkezijisi

Birleşdiriji 
çyzygyň 
düwni

1. Iki obýektiň birine birleşdiriji çyzygyň birleşýän nokadyny 
syçanjyk bilen basmak arkaly bellemeli.

2. Ikinji obýekte birleşdiriji çyzygyň birleşýän nokadyny syçan­
jyk bilen basma arkaly bellemeli.



Birleşdiriji çyzyk gurlandan soň onuň aýry segmentlerini In­
teractive Connector Line (Соединительная линия) guraly arkaly 
süýşürmek mümkin. Birleşme çyzygynyň birleşýän iki obýekti onuň 
üçin dolandyryjy bolup hyzmat edýär.

Birleşdiriji çyzyklary gurmak
Ilkibaşda gönüburçluk bilen ellipsi çyzyň, soňra bolsa olary 

birleşdiriji çyzyklaryň ikisi bilen baglaşdyryň, özem olary birleşme 
nokatlaryň iki aýry jübüdi bilen birleşdiriň. Ikinji birleşdiriji çyzygy 
döretmezden öň birleşdiriji çyzygyň görnüşini üýtgetmeli. Soňra Pick 
(Выбор) guraly arkaly dolandyryjy obýektleriň birini saýlamaly we 
ony ikinjiniň daşyndan süýşürip duruň.

Aýry ýagdaýlarda birleşdiriji çyzyk obýekte diňe bir ujy bilen 
birleşdirilip bilner. Şonda ikinji ujy sahypa birleşdirilen diýlip ha­
saplanylýar. Obýekte birleşdirilen birleşdiriji çyzygyň ujuny soňra 
aýryp bolýar, aýrylany bolsa birleşdirip bolýar. Döwlen birleşdiriji 
çyzygyň segmentiniň ortasynda birleşme nokady ýerleşýär, şol sebäp­
li döwlen birleşdiriji çyzyga beýleki birleşdiriji çyzygy birleşdirmek 
mümkin.

11. Sargyt 1372
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IX. Wektor grafi̇kasy we Autocad 
programmasy

AutoCAD ulgamynyň ilkinji wersiýalary Autodesk amerikan 
kompaniýasy tarapyndan eýýam 20-nji asyryň 80-nji ýyllarynyň 
başlarynda çykarylyp başlandy hem-de başdan original çözgüdi we 
ulanyjy üçin amatlylyk bilen özüne ünsi çekdi. Ulgamyň hemişe ös­
megi we bellikleriň hasaba alynmagy beýleki öňdebaryjy firmalaryň 
önümleri bilen utgaşykda bolmagy AutoCAD programmasyny dünýä 
belli etdi.

1 – Menýu setiri, 2 – gurallar paneli, 3 – Tool Palletes, 4 – koordinat okunyň 
piktogrammasy, 5 – goşmaçalaryň sanawyny görkezmegiň düwmejikleri,  

6 – modeliň giňişliginiň goşulmasy, 7 – listleriň goşulmasy, 8 – koordinatalaryň 
hasaplaýjysy bilen ýagdaý setiri, 9 – düzgünleriň düwmejikleri, Communication 

Center, 11 – buýruk setirleriň zolagy, 12 – kursor, 13 – geçiriş çyzgyçlar,  
14 – resminamanyň penjirelerini dolandyrýan düwmejikler.
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AutoCAD programmasynyň surat çekiş serişdesi hökmün­
de uly artykmaçlygy hökmünde çyzgylaryň geljekki arhiwiniň 
döredilmeginiň mümkinçiligi bolup durýar. Şeýle döredilen suratlaryň 
her biri redaktirlenýär.

Goranyş gurallaryň biri hökmünde parollar we elektron sanly 
gollar göz öňünde tutulan. Ekranyň merkezi bölegi – esasy iş zolagy, 
onda suratyň esasy görünýän bölegi ýerleşýär, onuň beýleki bölekleri 
sagda, çepde, ýokarda, aşakda, olara kursoryň üsti bilen çykyp bolýar. 
Kursor iki göni kesişýän çyzyklaryň we olaryň ortasynda kiçi gönü­
burçlyga eýe bolan görnüşe eýedir. Kesişýän çyzyklaryň uzynlygy 
Cursorsize üýtgeýän arklay üýtgedilip bilner. Grafiki ekranyň aşaky 
burçunda koordinatalaryň oky ýerleşýär.

Ekranyň ýokarky bölegini – File (Файл), Edit (Правка), View 
(Вид), Insert (Вставка), Format (Формат), Tools (Сервис), Draw 
(Рисование), Dimension (Размеры), Modify (Редакт), Express 
(Экспресс), Window (Окно), Help (Справка) ýazgylardan durany 
– menýu setiri diýip atlandyrarys.

Grafiki ekrany aşakdan Model, Layout1, Layout2 goşulmalaryň 
düwmejikleri çäklendirýär. Goşulmalar modeliň we listleriň arasynda 
geçirilişde ulanylýar. Deslapdan işjeň bolup model goşulmasy durýar.

Ekranyň aşaky böleginde Command ýazgy bilen çagyryş bar – 
bu ulanyjy bilen ulgam arasyndaky gepleşik geçirilýän töwerek, bu 
ýerde ulanyjy tarapyndan girizilýän buýruklar we jogaplar görkezil­
ýär. Bu bölek buýruk setirleriň zolagy diýlip atlandyrylýar. Command 
ýazgyny saklaýan soňky ýazgy buýruk setiri diýlip atlandyrylýar.

Buýruk setirleriň zolagynyň aşagynda ýagdaý setiri ýerleşen, 
onda koordinat hasaplaýjysy we düzgünleriň düwmejikleri Snap 
(Шаг), Grid (Сетка), Ortho (Opto), Polar (Otc-Поляр), Osnap 
(Привязка), Otrack (Отс-Прив), Lwt (Вес), Model (Модель) 
ýerleşdirilen. Koordinat hasaplaýjysy çyzgynyň meýdanynda 
ugrukdyrmak üçin gulluk edýär – ol öz koordinata ölçegini syçanjyk 
grafiki ekranda hereket edende üýtgedýär. Hasaplaýjy F6 funksional 
düwmejigi arkaly ýa-da syçanjygyň çep düwmejigine kursory şonuň 
setirine getirip öçürip we ýakyp bolýar.
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Communication Center düwmejigi Internet bilen baglanyşyk 
bolanda, AutoCAD programmanyň üýtgetmeleri ýa-da täzelenmeleri 
barada habar berýär.

6 sany panel bellenilen ýagdaýda ýerleşen. Gerek bolanda olaryň 
ýagdaýlaryny üýtgedip bolýar we grafiki ekranyň içine geçirilende 
olar «ýüzýän» orna eýe bolarlar. Ýüzýän ýagdaýda olar dürli görnüşe 
eýe bolup biler. Paneli geçirmek üçin syçanjyk bilen onuň gök reňkli 
töweregine basyp geçirmeli.

Menýu setiriniň aşagynda 4 sany panel görünýär: Standard 
(Стандартная) (ýokardan birinji setirde), Layers (Слои) и Styles 
(Стили) (ýokardan ikinji setirde) и Properties (Свойства) (ýokardan 
üçünji setirde). Bu panelleri geçirmek we aýyrmak gerek däl, sebäbi 
olar hemişe işde gerek bolýar. Dikligine ýerleşen iki panel degişlikde 
Draw (Рисование) и Modify (Редактирование) diýlip atlandyrylýar.

Panelleri çykarmak we aýyrmak üçin ýörite serişdeler bar. 
Kursory View (Вид) menýu getiriň we syçanyň sag düwmejigi­
ne basyň. Soňra Toolbars (Панели) setiri saýlaň. Açylan Custo­
mize (Адаптация) dialog penjiresinde dikligine hemme bar bolan 
panelleriň sanawy görkezilýär. Şolaryň gapdalynda baýdagy barlar 
grafiki ekranda görünýär.

Eger ekrana diňe bir paneli çykarmaly ýa-da aýyrmaly bolsa, 
onda kontekst menýudan peýdalanmaly. Kontekst menýu syçanjygyň 
sag düwmejigi bilen çagyrylýar. Syçanyň görkezijisini haýsy-da bol­
sa bir gurallar paneliň ýanyna getiriň we syçanjygyň sag düwmejigini 
basyň. Şol ýerde paneller bilen işleýän kontekst menýusy emele geler.

AutoCAD ulgamynda ulanyjy interfeýsiň täze parçasy bolup 
Tool Palettes (Палитры инструментов) gurallar palitrasynyň pa­
neli bolup durýar. Bu paneliň çykarylmagy we aýrylmagy Ctrl+3 
düwmejikleriň basylmagy arkaly bolýar.

Dolandyrmagyň ýene bir gyzykly elementleriniň biri bolup View 
(Вид) menýuda Clean Screen bendi bolup durýar. Ol Ctrl+0 düw­
mejigi arkaly ýa-da Command: setirinde Cleanscreenon we Cleans­
creenoff buýruklar bilen goýulýar ýa-da aýrylýar. Ol grafiki ekrany 
wagtlaýynça panelleri, penjiräniň adyny we b. aýyrmak arkaly ulald­
ýar.
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AutoCAD ulgamy ulanyjy bilen interaktiw işlemek üçin döre­
dilen. Ulanyjynyň ulgam bilen gepleşigi buýruklaryň dilinde alnyp 
barylýar. Buýruklary girizmegiň iň aňsat usuly olary buýruk setirinde 
girizmeklikdir.

Line (Отрезок) buýrugy aşakda görkezilen islendik görnüşinde 
klawiatura arkaly girizilip bilner.

LINE
Line
line
liNE
Buýruk ýazylandan soň Enter düwmejigi basmagy ýatdan çy­

karmaly däl, sebäbi ol AutoCAD ulgamy üçin şol buýrugy işläp 
başlamaklyk boýunça görkezme bolup durýar. Enter düwmejigi 
basylmaga siz buýruk setirinde ýazylan ýazgyny Delete, BackSpace 
düwmejikleri bilen üýtgedip bilersiňiz.

Buýruklary girizmegiň beýleki usuly hökmünde menýunyň 
degişli bentlerini we panelleriň düwmejiklerini saýlamak bolup 
durýar.

Commanda: setirde boş Enter basaňyzda, AutoCAD ondan öňki 
buýrugy ýerine ýetirer.

Öz işini başlan islendik buýrugyň işini bes etmek üçin ESC düw­
mejigini basmaly.

AutoCAD ulgamynyň çyzgylary (suratlary) dwg giňişligi bolan 
faýllarda (şu faýllarda grafiki maglumat ýazylýan formada DWG-
format diýilýär) saklanylýar. Faýllaryň atlary rus we latyn harplaryny, 
sanlary, (@, #, $, &, _, -) ýörite belgileri, şeýle hem probelleri sak­
lap bilýär. Beýleki simwollara (nokatlar, oturlar we ş.m.), kada bolşy 
ýaly, ýol berilmeýär, sebäbi olar gulluk simwollary bolup durýar we 
Windows operasion ulgamy tarapyndan nädogry interpretasiýa edilip 
bilner.

«Файл» menýusy
New (Новый) – täk resminama
Open (Открыть) – açmak
Close (Закрыть) – ýapmak
Partial Load (Частичная загрузка) – bölekleýin ýüklemek



166

Save (Сохранить) – ýatda saklamak
Save As (Сохранить как) – başga hili ýatda saklamak
eTransmit (Сформировать комплект) – toplum toplamak
Publish to Web (Публикация в Интернете) – Internetde neşir
Export (Экспорт) – eksport
Page Setup (Параметры листа) – listiň parametrleri
Plotter Manager (Диспетчер плоттеров) – plotterleriň dispet­

çeri
Plot Style Manager (Диспетчер стилей печати) – çapyň stil­

leriniň dispetçeri
Plot Preview (Предварительный просмотр) – deslapdan gör­

mek
Plot (Печать) – çap
Publish (Публикация) – neşir
Drawing Utilities (Утилиты) – utilitalar
Send (Переслать) – ibermek
Drawing Properties (Свойства рисунка) – suratyň häsiýetleri
Exit (Выход) çykmak.

«Open» kömekçi menýusy
Open (redaktirlemegiň doly mümkinçiligi bilen açmaklyk);
Open Read-Only (Diňe okamak düzgünde açmaklyk);
Partial Open (Bölekleýin açmaklyk);
Partial Open Read-Only (Diňe okamak düzgünde bölekleýin 

açmaklyk).
Bölekleýin açyş düzgüni tutuş suraty açman, eýsem diňe onuň 

bölegini açmagy mümkin edýär. Bu uly ölçegli faýllar bolanda amat­
ly. Eger bu düzgüni saýlan bolsaňyz Select File (Выбор файла) pen­
jiresinde Size Partial Open (Частичное открытие) dialog penjire­
si hödürlener. Saýlanyş gatlar boýunça (в Layer geometry to load 
(Загрузка объектов по слоям) töwereginiň sanawynda) we görnüşler 
(View geometry to load (Загрузка объектов по видам) töweregiň 
sanawynda) amala aşyrylyp bilner. Bölekleýin açyş şeýle hem Partial 
open (Откр часть) buýrugy arkaly hem ýerine ýetirilip bilner.

Ulgam bilen bilelikde ulgamyň gurnalan ýeriniň Sample 
bukjasynyň içinde (X:/AutoCAD2004/Sample) gyzykly mysallar ge­
tirilen.
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AutoCad köp resminama düzgüni goldaýar, şol sebäpli bir işiň 
dowamynda birnäçe surat açylyp bilner.

Window açylýan menýusy
Close (Закрыть) – ýapmak
Close All (Закрыть все) – hemmesini ýapmak
Cascade (Каскадом) – kaskad
Tile Horizontally (Слева направо) – çepden saga
Tile Vertically (Сверху вниз) – ýokardan aşaga
Arrange Icons (Упорядочить значки) nyşanlary tertipleşdirmek.
Menýunyň birinji bendi işjeň suraty ýapýar, ikinjisi – hemme su­

ratlary ýapýar. Bu bentlere Close (Закрыть) we Close all (Закрыть 
все) buýruklar degişli.

File (Файл) açylýan menýunyň Save (Сохранить) bendi we oňa 
laýyk gelýän Q save (Б сохранить)) şol bir atly suraty tiz ýatda sakla­
maga mümkinçilik berýär. Eger ony başga faýla ýazgy etjek bolsaňyz, 
onda Save As (Сохранить как) bendi ýa-da Save as (Сохранить как) 
buýrugy ulanmak gerek.

Files of type (Тип файла) açylýan sanaw arkaly suraty AutoCAD 
2004 DWG-formatynda, ýa-da AutoCAD 2000 DWG-formatynda, 
ýa-da ulgamyň şablonlary tarapyndan ulanylýan DWT-formatda, 
şeýle hem standartlaryň faýllarynda ulanylýan DWS formatda, ýa-da 
awtomatlaşdyrylan taslamaklygyň dürli ulgamlaryň arasynda grafiki 
faýllary geçirilende ulanylýan DXF-formatda ýatda saklamak müm­
kinçiligi bar.

Täze suratlar döredilende AutoCAD ulgamy olara: Drawingl, 
Drawing2 we b. şertli atlary berýär. Ulanyjy geljekde olary üýtgedip 
öz atlaryny berip biler.

Export (Экспорт) bendi we Export (Экспорт) buýrugy Au­
toCAD suratynyň grafiki maglumatyny beýleki grafiki toplumlaryň 
ýörite formatlaryny özgerdip bilýär.

Biziň seredilýän wersiýamyzda şu formatlara eksport edip bolar: 
WMF, SAT, STL, EPS, DXX, BMP, 3DS.

eTransmit (Сформировать комплект) bendi suratlaryň to­
paryny we olar bilen bagly kömekçi faýllary (şriftleri, çyzyklaryň 
kysymyny we ş.m.) beýleki guramalar we firmalara bermek üçin 
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niýetlenen, Publish to Web (Публикация в Интернете) bendi bolsa 
– olary saýtlaryň sahypasynda ýerleşdirmek üçin. Elektron poçtasy 
ulanylanda goşulma hökmünde suraty bermek üçin Send (Переслать) 
bendinden peýdalanmak bolar.

Page Setup (Настройка страницы), Plotter Manager 
(Диспетчер плоттеров), Plot Style Manager (Диспетчер стилей 
печати), Plot Preview (Просмотр) и Plot (Печать) bentleri 
sazlanylyşy geçirmek, şeýle hem çap etmek üçin niýetlenen.

Publish (Публикация) bendi suratlary ýene bir formada – DWF 
formada ýerleşdimegi mümkin edýär, ol Autodesk tarapyndan düzü­
len we Internetde ýerleşdirmek üçin gönükdirilen.

Eger grafiki ekranda bolup klawiaturada F2 düwmejige bassaňyz, 
ekranda AutoCAD Text Window (Текстовое окно AutoCAD) penji­
resi emele geler, ony aýyrmak üçin ýene F2 düwmejigi basmaly.

Primitiwler bilen işlemek
Kesimler, ýarym halkalar, tegelekler we beýleki grafiki obýekt­

ler islendik çyzgy faýly döredýän elementler bolup durýar. AutoCAD 
ulgamynda olar primitiwler adyny göterýärler.

Olar ýönekeý we çylşyrymly bolup durýar. Ýönekeý görnüşlere 
nokat, kesim, tegelek, ýarym halka, göni çyzyk, şöhle, ellips, splaýn, 
bir setirli tekst, çylşyrymly ýarymçyzyk, multi çyzyk, multi tekst (köp 
setirli tekst), ölçeg, wynoska, ygtyýar, ştrihleme, bloguň ýa-da daşky 
salgylanmanyň girmegi, atribut, rastr şekili girýär. Mundan başga 
hem giňişlik görnüşler bar.

Amallarynyň köpüsi Draw (Рисование) paneliniň düwmejikleri 
arkaly ýerine ýetirilip bilner.

Kesim
Buýruk setirinde Line diýip ýazalyň we Enter düwmejigini 

basalyň. Bu buýrugy şeýle hem Draw (Рисование) menýusynda 
Line (Отрезок) bendi ýa-da Draw (Рисование) gurallar paneli bilen 
çagyryp bolýar.

Ilkinji sorag:
Specify first point: (Первая точка:)
Eger buýrugy ýerine ýetirmejek bolsaňyz, onda ESC düwmejigi 

basyň, programmada islendik buýruk ýa-da amal şu düwmejik bilen 
kesilýär.
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Kesimiň birinji nokadyny bellemegiň iň ýönekeý usuly – syçan­
jyk bilen ekranda bellemek we onuň çep düwmejigini basmak. Mun­
dan başga hem onuň koordinat ulgamyna (0,0) baglylykda onuň ko­
ordinatalaryny (x,y) girizmek.

Birinji nokat görkezilenden soň AutoCAD nobatdaky sorag 
berýär:

Specify next point or [Undo]: (Следующая точка или [От­
менить]:)

Soragyň bir bölegi kwadrat ýaýyň içine girizilen. Bu soňky nokady 
görkezmegi ýa-da başga bir opsiýany ulanmagy aňladýar. Opsiýa hökmün­
de AutoCAD Undo (Отменить) hödürleýär. Ol öň girizilen başlangyç no­
kady goýmak buýrugy ýatyrýar. Opsiýany ulanmak üçin onuň adyny doly 
ýa-da uly harpyny ýazmaly we Enter düwmejigine basmaly.

Eger ekranda syçanjyk bilen nobatdaky nokady görkezseňiz, 
ekranda kesim emele geler. Line (Отрезок) buýrugy şunuň bilen ta­
mamlanmaz we şu sorag berler:

Specify next point or [Undo]: (Следующая точка или [От­
менить]:)

Ýagny bir buýruk bilen nobat boýunça birnäçe kesimleri gurup 
bolýar, netijede ekranda döwlen çyzygy emele getirip bolýar. Ekranda 
3-nji nokady görkeziň, netije nobatdaky sorag şular ýaly bolar:

Specify next point or [Close/Undo]: (Следующая точка или 
[Замкнуть/Отменить]:)

Bu ýerde Close (Замкнуть) opsiýasy emele geldi. Eger birnäçe 
opsiýadan saýlama bolsa, olar «/» simwol bilen aýry edilýärler. Kla­
wiatura bilen С ýazsaňyz we Enter bassaňyz, AutoCAD öňki kesi­
miň ikinji nokadyndan başlanýan we soňy birinji kesimiň başyna bar­
ýan kesimi çyzar. Eger kesimleriň ýapylmagy gerek däl bolsa, onda 
Enter düwmejigine basyň.

Başga bir usul bu syçanjygy grafiki ekranyň içine salyp sag 
düwmejigini basyp kontekst menýuny çagyrmaklyk. Bu ýerde hem 
buýruk setirindäki opsiýalar görkezilen.

Eger Enter ikinji nokat görkezilmän basylsa, onda kesim çyzyl­
man galar. Eger Enter birinji nokat görkezilmän basylsa, onda kesim 
öň iň soňky çyzylan çyzygyň, ýarym halkanyň ýa-da ýarymçyzygyň 
soňky nokadyndan çyzylyp başlanar.
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Eger buýruk setirinde buýruk bolmazdan Enter boş basylsa, 
onda öň ýerine ýetirilen buýruk ýerine ýetiriler.

Islendik çyzylan kesim boýunça buýruk setirinde List buýrugy 
goýberilip maglumat alyp bolar.

Geliň indi koordinatlary girizmegiň usullary bilen tanşalyň.
Birinji usuly syçanjyk bilen bellemek.
Ikinji (x, y) koordinatalary buýruk setirinde otur bilen aýry edip 

ýazmak, meselem 50.34, 56.
Üçünji usul @ belgini ulanyp ýazmaklyk. Bu belgi häzirki no­

kady ondan öňküsinden x koordinata boýunça 50 mm we y koordina­
tasy boýunça 25mm süýşürilip çyzylar.

Dördünji usul bu öňki nokada görä belli bir burç bilen kesgitli 
aralykda gurnamaklyk, meselem @33.5<45. Bu öňki nokatdan 33mm 
aralyk bilen 450 burç boýunça gurlan nokady çyzýar.

Bäşinji usul bu obýekt baglaşdyrma funksiýalaryna Object Snap 
(Объектная привязка) panel arkaly ýa-da şol bir wagtda Shift düw­
mejigini basyp syçanjygyň sag düwmejigine basmak bilen kontekst 
menýuny çykarmak arkaly çykmak mümkin.

Object Snap paneli

•  – aralykdaky nokady ulanmak bilen yzarlaýyş;
•  – başga (kömekçi) nokatdan süýşme;
•  – ahyrky nokat;
•  – ortalyk nokat;
•  – iki obýektiň ýa-da olaryň dowamlylygynyň kesişme no­
kady;
•  – iki obýektiň ýa-da olaryň dowamlygynyň hyýaly ke­
sişmesiniň nokady (ýagny obýektleriň tekizlige bolan proýek­
siýalary kesişýär);
•  – dowam nokady;



171

•  – ýarym halkanyň, tegelegiň ýa-da ellipsiň merkezi;
•  – ýarym halkanyň, tegelegiň ýa-da ellipsiň kwadrantlary­
nyň nokady (0°, 90°, 180° we 270° ýerleşen nokatlar);
•  – galtaşma nokady;
•  – obýekte perpendikulýar ýagdaýda;
•  – obýekte parallel ýagdaýda;
•  – teksti, blogy, daşky salgylanmagy goýmagyň nokady;
•  – düwün nokady;
•  – obýekte iň golaý nokady;
•  – obýekt baglaşdyrmagy ulanmazdan;
•  – baglaşdyrmagyň hemişelik düzgünlerini sazlamak.

Düzgünler
Buýruk setiriň zolagynyň aşagynda gönüburç düzgünli düwme­

jikler bar: Snap (Прив), Grid (Сетка), Ortho (Opto), Polar (По­
лярный), Osnap (О-Кадр), Otrack, Lwt (Вес), Model (Модель). 
Eger syçanjyk bilen şol düwmejigiň üstünden geçilse, onda gysgaça 
düşündiriş görkeziler: Snap Mode (Шаговая привязка), Grid Dis­
play (Отображение сетки), Ortho Mode (Режим «Орто»), Polar 
Tracking (Полярное отслеживание), Object Snap (Объектная 
привязка), Object Snap Tracking (Объектное отслеживание), 
Show/Hide Lineweight (Отображение линий в соответствии с 
весами), Model or Paper Space (Пространство модели или листа).

Snap (Прив) kesgitlenen sazlanylýan ädim bilen toruň nokat­
laryna bolan baglaşdyryş düzgüni işledýär we aýyrýar (hereketlendiriş 
berlen ädim bilen amala aşyrylýar ýa-da burç baglaşdyrma (kesgit­
lenen burçlaryň ýanynda hereketlendiriş segmentler boýunça berlen 
ädim bilen amala aşyrylýar). Snap (Прив) düwmejigiň işini <F9> 
klawiaturanyň F9 düwmejigi ýerine ýetirýär.

Grid (Сетка) düwmejigi sazlanylýan ädimli görkezilýän tory 
goýmagy we aýyrmagy amala aşyrýar. Bu tor Snap (Прив) düzgü­
ninde ulanylýan tordan tapawutly bolup biler. Analogy hökmünde F7 
düwmejigi bolup durýar.
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Ortho (Орто) düwmejigi ortogonallyk düzgüni işledýär ýa-da 
aýyrýar. Bu düzgün işlände kesimleriň göni çyzyklaryny göni keselik 
ýa-da diklik boýunça gurulýar. Işletmek üçin şeýle hem F8 düwmeji­
gi ulanmak bolar.

Polar (Полярный) düwmejigi Ortho (Орто) düzgüniň belli bir 
sazlanylýan ädim bilen burçlara bolan giňelmesi hökmünde çykyş 
edýär. Düwmejik polýar yzarlamanyň düzgünini işledýär ýa-da 
öçürýär. Düwmejigiň analogy bolup F10 düwmejigi durýar. Polar 
düzgüni işledilende Ortho awtomatiki öçürilýär, eger öň işledilen 
bolsa we tersine.

Osnap (О-Кадр) düwmejigi obýekt baglaşdyrmagyň funksiýa­
larynyň hemişelik işleýiş düzgünini işletmegi we aýyrmagy amala 
aşyrýar. Düwmejigiň analogy hökmünde F3 klawişasy bolup durýar.

Otrack düwmejigi bilen obýekt yzarlaýşyň düzgüni işledilende 
AutoCAD ulgamy obýekt baglaşdyrmagy ulanmak arkaly aralyk 
nokatdan polýar yzarlamagy ulanmagy mümkin edýär. Düwmejigiň 
analogy hökmünde F11 klawişasy bolup durýar.

Lwt (Вес) düwmejigi çyzgynyň elementleriniň galyňlygyny 
görkezilmegini ýa-da görkezilmezligini belleýär.

Model (Модель) düwmejigi modeliň ýa-da listiň giňişligiň 
arasynda geçmegi amala aşyrýar.

Düzgünleriň sazlanmagy Dsettings (Режимрис) buýruk bilen 
amala aşyrylyp bilner, ol Drafting Settings (Режимы рисования) 
gepleşik penjiresini açýar. Buýruk Tools (Сервис) menýusynyň 
Drafting Settings (Режимы рисования) bendi bilen hem, şeýle 
hem syçanjyk bilen Ortho (Opto), Lwt (Вес), Model (Модель)) 
düzgünleriň düwmejiklerinden başga düzgün düwmejikleriň üstünde 
getirilip sag düwmejigi basyp çagyrylýan kontekst menýunyň Set­
tings (Настройка) bendi bilen ýerine ýetirilip bilner.

Nokat
Nokat gurmak üçin Point (Точка) buýrugy ulanylýar, mundan 

başga hem ol Draw (Рисование) panelinden –  düwmejigi arkaly 
ýa-da Draw > Point > Single Point (Рисование > Точка Одиночная) 
gepleşik penjireden çagyrylyp bilner.
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Point (Точка) buýrugy Draw (Рисование) panelinden çagyry­
landa gaýtalanyş bilen işleýär we şu soragy berýär:

Current point modes: PDMODE = 0 PDSIZE = 0.0000 Spe­
cify a point: (Текущие режимы точек: PDMODE = 0 PDSIZE = 
0.0000 Укажите точку:)

Syçanjyk arkaly ýa-da kursor bilen nokadyň koordinatalaryny 
giriziň. Görkezilen ýerde nokat emele gelýär. Mundan beýläk prog­
ramma ýene ýokarky soragy berýär, eger buýrugy kesmeli bolsa 
Esc düwmejigi basmaly. Eger ulgam üýtgeýänler PDMODE = 0 we 
PDSIZE = 0 bolsa, onda nokat bir piksel bilen görkezilýär. Format 
(Формат) menýunyň Point Style (Отображение точек) bendi bi­
len Point Style (Отображение точек) gepleşik penjiresini çagyryp, 
nokadyň zerur şekilini saýlamaly, köplenç «х» görnüşde ündelýär. Şol 
penjirede hem nokadyň ölçeglerini belläp bolýar (Point Size (Размер 
точки) meýdany), sazlamalary geçirip penjiräni ýapyň, AutoCAD ul­
gamy awtomatiki hemme öň çyzylan nokatlary täze görnüşe getirer. 
Nokatlar Node (Узел) obýekt baglaşdyrmanyň funksiýasy eger bu 
funksiýasy işledilen bolsa ulanylyp bilner. Meselem, kesim çyzamyz­
da onuň ilkinji nokady hökmünde eýýam bar bolan nokady syçanjyk 
bilen ýanyna eltsek, şol nokadyň üstünde saryja belgi emele geler, 
eger syçanjygyň çep düwmejigine bassak, onda şol nokat kesimiň il­
kinji nokady hökmünde alnar.

Ekrandaky obýektleri belläp almagyň iki usuly bar. Birinji usul 
Buýruk setirinde eger Command: (Команда:) çagyryşy bar bolsa, 
syçanjygyň görkezijisini sag aşaky burçda goýalyň we onuň çep düw­
mejigine basyp hem-de goýberip ulgam buýruk setirinde şeýle sorag 
berer Specify opposite corner: (Противоположный угол:). Syçan­
jyk bilen ikinji burçy görkeziň. Mundan soňra hemme obýektlerde 
tutawaçlar (kiçiräk gök reňkli kwadratlar) emele geler. Obýektleri 
gönümel syçanjyk bilen olaryň üsti basylsa hem saýlap bolýar.

Belleýiş çägi çepden saga (ýönekeý diýlip atlandyrylýar) we sag­
dan çepe (kesiş diýlip atlandyrylýar) eltip bolýar. Birinji ýagdaýda 
çägiň içine diňe doly giren obýektler saýlanar, ikinji ýagdaýda bol­
sa şol çägiň araçäkleri degen obýektler saýlanar. Ýönekeý çäk tutuş, 
kesiş çägi bolsa punktir çyzyk bilen görkezilýär.
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Bellenilen obýektleri aýyrmak üçin Del düwmejigi basyň, bel­
leýşi aýyrmak üçin bolsa Esc düwmejigi basyň.

Nokady gurýan ýene bir iki sany gyzykly buýruk bar.
Divide (Разделить), ol kesimi ýa-da başga obýekti deň bölek­

lere bölýär. Buýruk klawiaturadan ýa-da Draw > Point > Divide 
(Рисование > Точка > Разделить) menýudan girizilip bilner. Kesimi 
çyzyň we Divide buýrugyny giriziň. Birinji sorag:

Select object to divide: (Выберите объект для деления:)
Çyzylan kesimi belläň. Indiki sorag:
Enter the number of segments or [Block]: (Число сегментов 

или [Блок]:)
Meselem, biz 8 girizýäris. Netijede kesim 8 sany deň bölege 

bölüner, we bölünýän ýerde 7 sany düwün nokatlary goýlar.
Measure (Размер). Ol hem klawiaturadan başga Draw > Point 

> Measure (Рисование > Точка Размер) menýu ýoly bilen ýerine 
ýetirilip bilner. Birinji sorag:

Select object to measure: (Выберите объект для разметки:)
Obýekti belleýäris. Ikinji sorag:
Specify length of segment or [Block]: (Длина сегмента или 

[Блок]:)
San girizilenden soň AutoCAD ulgamy bellenilen ýer haýsy 

uja golaý bolsa, şol ýerden başlap bellenilen aralyk bilen nokatlary 
goýuşdyryp çykýar.

Şöhleler
Şöhle – bir tarapa üznüksiz bolan we belli bir nokatdan başlan­

ýar. Ony gurmak üçin Ray (ЛУЧ) buýrugy gulluk edýär. Buýruk kla­
wiaturadan ýa-da Draw (Рисование) menýusyndan Ray (Луч) bendi 
arkaly çagyrylyp bilner. Birinji sorag:

Specify start point: (Начальная точка:)
Birinji nokatdan soň AutoCAD gaýtalanyş ýagdaýda beýleki no­

katlary soraýar we birinji nokatdan geçýän şöhleleri gurýar:
Specify through point: (Через точку:) Buýrugyň tamamlan­

magy – Enter ýa-da syçanjygyň sag düwmejiginiň basylmagy bolup 
durýar.
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Göni çyzyk
Göni çyzyklar kesimlerden we şöhlelerden tapawutlylykda iki 

taraplaýyn üznüksiz çyzyklar. Olary gurmak üçin Xline (Прямая) 
buýrugy ulanylýar, ol klawiaturadan, Draw (Рисование) menýusynyň 
Construction Line (Прямая) bendi ýa-da Draw (Рисование) gural­
lar paneliniň  düwmejigi bilen ýerine ýetirilip bilner. Birinji sorag:

Specify a point or [Hor/Ver/Ang/Bisect/Offset]: (Укажите 
точку или [Гор/Вер/Угол/Биссект/Смещение]:) Eger bu ýagdaýda 
nokat görkezilse (syçan bilen ýa-da seredilen başga usul bilen), onda 
AutoCAD birinji nokatdan geçýän göni çyzyklaryň toplumyny çyzyp 
başlar. Göni çyzygy tekizlikde gurnamak üçin iki nokat ýeterlik, şol 
sebäpli ikinji sorag:

Specify through point: (Через точку:). Göni çyzygyň toplumy 
geçmeli birnäçe nokatlary bermek mümkin.

Beýleki bäş opsiýalar buýrugy başynda elýeterli we şu ýagdaýlar­
da çyzmagy mümkin edýär – kese (Ноr (Гор)); dik (Ver (Вер)); belli 
bir burç bilen (Ang (Угол)); depesini we taraplaryny görkezilmeli bel­
li bir burçuň bissektrisasyny gurmak üçin (Bisect (Биссект)); beýleki 
çyzykly obýekte parallel bolanlary (Offset (Смещение)).

Ноr (Гор) opsiýasy şu soragy berýär: Specify through point: 
(Через точку:).

Kese çyzyklaryň geçmeli nokatlary görkezmek gerek. Edil şu 
ýagdaýda Ver (Вер) opsiýasy işleýär.

Ang (Угол) opsiýasy ulanylanda şu sorag berilýär:
Enter angle ofxline (0) or [Reference]: (Угол прямой (0) или 

[Базовая линия]:)
Bu ýagdaýda gorizontala (X okunyň položitel ugruna) görä öl­

çenilýän egiliş burçy ýazmaly. Eger Enter düwmejigi basylsa egiliş 
burçy nola deň bolar. Burçy san bilen (gradusda) ýa-da syçanjyk ar­
kaly bir nokady görkezip berip bolýar. Ulgam sorag berer:

Specify second point: (Вторая точка:)
Muňa beýleki nokady görkezmeli.
Eger Reference (Базовая линия) opsiýasy ulanylsa, onda Auto­

CAD beýleki soragy berer:
Select a line object: (Выберите линейный объект:)
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Göräleýin egiliş burçy alynjak bir çyzykly obýekti görkezmeli 
(kesim, şöhle ýa-da göni çyzygy). Burç berlenden soňra sorag beril­
ýär:

Specify through point: (Через точку:) we berlen egiliş burçy 
bilen göni çyzyklaryň geçmeli nokatlary (nokady) görkezmeli bolar.

Bisect (Биссект) opsiýasy depesi, birinji tarapyň nokady we 
ikinji tarapyň nokady görkezilmeli belli bir burçuň bissektrisasy bo­
lup durýan göni çyzygy gurýar. Birinji sorag:

Specify angle vertex point: (Укажите вершину угла:)
Ikinji sorag burçuň birinji tarapynyň nokady barada:
Specify angle start point: (Точка на первом луче угла:)
Soňra ikinji tarapyň nokady baradaky gaýtalanýan sorag berilýär:
Specify angle end point: (Точка на втором луче угла:)
Eger birnäçe nokat berilse we Enter basylsa, onda depesi we 

birinji tarapyň nokady gabat gelýän ikinji tarapyň nokady bolsa üýt­
geýän burçlaryň bissektrisalary çyzylar.

Offset (Смещение) opsiýasy kesimlere, şöhlelere we beýleki 
göni çyzyklara parallel göni çyzyklary gurýar. Birinji sorag:

Specify offset distance or [Through] <Through>: (Величина 
смещения или [Точка] < Точка >:)

Bu ýerde parallel çyzykly obýektleriň arasyndaky aralyk bolup 
durjak sany girizmeli, ýa-da Enter düwmejigi basmaly – eger Th­
rough (Точка) (ýa-da san berlen bolsa süýşüş ululygyň ölçegi) ta­
rapyndan hödürleýän ölçegler bilen razy bolunsa, ýa-da T harpyny 
girizmeli.

Eger süýşüş ululygy girizilse, onda indiki sorag şeýle:
Select a line object: (Выберите линейный объект:)
Çyzykly obýekti görkezmeli. Soňra:
Specify side to offset: (Укажите сторону смещения:)
Tekizlikde çyzykly obýekte her tarapyndan parallel çyzyklar 

çyzylyp bilner, şol sebäpli, baza elemente görä ýerleşjek guruljak pa­
rallel çyzygyň tarapynda islendik nokady görkezmeli.

Offset (Смещение) opsiýasynda Specify offset distance or 
[Through]: (Величина смещения или [Точка]:) soragyna Т (Т) jo­
gaby saýlanylsa, onda AutoCAD soraýar:
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Select a line object: (Выберите линейный объект:), soňra pa­
rallel çyzygyň geçmeli nokadyny soraýar:

Specify through point: (Через точку:).

Tegelekler
Tegelekleriň çyzylmagy Circle (Круг) buýrugy bilen ýerine ýe­

tirilýär. Buýrugy Draw (Рисование) panelinden  düwmejigi ýa-da 
Draw (Рисование) menýunyň Circle (Круг) kömekçi menýusynyň 
alty bendi bilen ýerine ýetirilýär.

Circle (Круг) buýrugy çagyrylanda AutoCAD sorag berýär:
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 

(Центр круга или [3T/2T/KKP (кос кос радиус)]:)
Eger nokat görkezilse, onda ol boljak tegelegiň merkezi bolar we 

şeyle sorag berler:
Specify radius of circle or [Diameter]: (Радиус круга или 

[Диаметр]:)
Bu ýagdaýda tegelegiň radiusynyň ululygy bolup durjak sany 

girizmek bolýar. Eger D (Д) simwoly girizilse, onda Diameter 
(Диаметр) saýlanylar. Onda diametriň ululygyny girizmek boýunça 
sorag berler:

Specify diameter of circle: (Диаметр круга:)
Eger tegelegiň merkeziniň deregine ЗР (ЗТ) opsiýasy saýlanylsa, 

onda AutoCAD tegelegi tekizligiň 3 nokady boýunça gurar. Nobat­
laýyn 1,2 we 3-nji nokatlar berilýär, ýöne olar bir çyzykda ýerleşmeli 
däldir.

Eger 2Р (2Т) opsiýasy saýlanylsa, onda diňe 2 nokat berler, ýöne 
iki nokat boljak tegelegiň diametrine degişli diýlip hasaplanylýar. 
Olaryň arasyndaky aralyk diametr bolup durýar. AutoCAD şeýle so­
raglary berýär:

Specify first end point of circle’s diameter: (Первая конечная 
точка диаметра круга:) we Specify second end point of circle’s di­
ameter: (Вторая конечная точка диаметра круга:)

Ttr (Kkp) opsiýasy gyzykly, ol beýleki iki obýekte galtaşýan we 
berlen radiusa eýe bolan tegelegi gurýar. Birinji sorag:

Specify point on object for first tangent of circle: (Укажите 
точку на объекте, задающую первую касательную:)
12. Sargyt 1372
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Saýlanan obýekte syçanjygyň görkezijisi getirilende AutoCAD 
ony tapandygyny düşündirme bilen görkezýär Deferred Tangent 
(Отложенная касательная). Bu obýekte bolan galtaşyş nokady soňra 
hasaplanjakdygyny aňladýar (ol entek belli bolmadyk ikinji obýekte 
bagly bolup durýar).

Ikinji sorag: Specify point on object for second tangent of cir­
cle: (Укажите точку на объекте, задающую вторую касательную:)

Üçünji sorag: Specify radius of circle: (Радиус круга:)
Radiusy san bilen ýa-da iki nokat bilen belläp bolar. Eger berlen 

maglumatlar bilen çyzuw mümkin däl bolsa onda ulgam bu barada 
habar berer.

Mundan başga hem Draw (Рисование) menýunyň Circle (Круг)
kömekçi menýusynda Tan, Tan, Tan (3 точки касания) bendi bar. 
Emma ol özbaşdak funksiýa däl-de ЗР (ЗТ) opsiýanyň bir bölegi, ol 
arkaly, obýekt baglaşdyrmagyň Tangent (Касательная) funksiýasy 
bilen üç galtaşma nokady arkaly tegelek gurulýar.

Tegelegiň merkezinden başga ýene-de 4 nokady bar, olara kwad­
rat diýilýär. Şol sebäpli tegelege degişlilikde 3 sany obýekt bag­
laşdyrmagyň funksiýasy degişlidir – Tangent (Касательная), Center 
(Центр), Quadrant (Квадрант).

Halka
Halka – bu tegelegiň bir bölegi bolup durýar. Ony gurmak üçin 

Arc (Дуга) buýruk klawiaturadan, Draw (Рисование) gural panelin­
den  düwmejigi arkaly ýa-da Draw (Рисование) menýusynyň Arc 
(Дуга) kömekçi menýudan çagyrylyp bilner.

Iň umumy warianta seredeliň. Birinji sorag:
Specify start point of arc or [Center]: (Начальная точка дуги 

или [Центр]:)
Jogap hökmünde başlangyç nokady ýa-da merkezi görkezip bo­

lar.
Eger ýöne Enter düwmejigi basylsa onda başlangyç hökmün­

de iň soňky obýektiň soňky nokady alnar (ýöne diňe kesimleriň we 
halkalaryň arasyndaky) we AutoCAD şol obýekte bolan halkany, 
galtaşyş çyzygy gurar. Ahyrky nokat soralýar (merkez we radius) 
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ahyrky nokat we obýekte bolan galtaşmagyň şerti boýunça kesgit­
lenýär:

Specify end point of arc: (Конечная точка дуги:)
Nokat görkezilenden soň obýektiň dowamy bolup duran halka 

gurulýar.
Specify start point of arc or [Center]: (Начальная точка дуги 

или [Центр]:) soraga başlangyç nokat girizilse AutoCAD soraýar.
Specify second point of arc or [Center/End]: (Вторая точка 

дуги или [Центр/Конец]:), eger ikinji nokat görkezilse, onda ulgam 
soňra soraýar:

Specify end point of arc: (Конечная точка дуги:)
Netijede üç nokat boýunça halka gurulýar. Ikinji nokadyň deregi­

ne Center (Центр) opsiýasyny saýlamak bolar, AutoCAD sorar:
Specify center point of arc: (Центр дуги:)
Merkeziň nokady görkezilenden soň:
Specify end point of arc or [Angle/chord Length]: (Конечная 

точка дуги или [Угол/Длина хорды]:)
Eger ahyrky nokady görkezilse, AutoCAD halkanyň radiusyny 

birinji nokat we merkez boýunça hasaplap ony dogurlaýar.
Soňky ýagdaýda halkany gurmagy tamamlanmagyň ýene iki ugry 

bar: Angle (Угол) we chord Length (Длина хорды). Angle (Угол) 
opsiýasy saýlanylanda belli burç girizilmeli we şol burç boýunça hal­
ka çyzylýar. Eger chord Length (Длина хорды) opsiýasy saýlanylsa, 
onda halka birinji nokatdan hordanyň uzynlygy boýunça çyzylar.

Ýarym çyzyk
Ýarym çyzyk – ol bir ýa-da birnäçe biri-biri bilen özara bagla­

nan gönüçyzykly ýa-da halkalaýyn segmentlerden düzülen. Ýarym 
çyzyk bir bitewi obýekt bolup işlenilýär.

Ýarym çyzygy çyzmak üçin Pline (Плиния) buýrugy gulluk 
edýär, ol klawiaturadan başga, Draw (Рисование) paneliň  düw­
mejigi arkaly ýa-da Draw (Рисование) menýusynyň Polyline (Поли­
линия) bendi arkaly çagyrylyp bilner.

Birinji sorag:
Specify start point: (Начальная точка:)
Ýarym çyzygyň başlangyç nokadyny görkezmeli. Ikinji sorag:
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Current line-width is 0.0000 Specify next point or [Arc/
Halfividth/Length/Undo/Width]: (Текущая ширина полилинии 
равна 0.0000 Следующая точка или [Дуга/Полуширина/Длина/
Отменить/Ширина]:)

Ýarym çyzyk – nol däl ine eýe bolup bilýän obýektleriň az sa­
nyna girýär. Öňki ýarym çyzyk üçin berlen ini saklanylýar we indi­
ki ýarym çyzyk üçin deslapdan hödürlenýär. Şol sebäpli AutoCAD 
Current line-width is (Текущая ширина полилинии) habar bilen 
ýarym çyzygyň haýsy ini bilen çyzyljakdygy barada duýdurýar. Eger 
şu halatda nokat görkezilse öňki soragy gaýtalaýar, ýöne oňa Close 
(Замкнуть) opsiýasy goşulýar:

Specify next point or [Arc/Close/Halfwidth/Length/Undo/
Width]: (Следующая точка или [Дуга/Замкнутъ/Полуширина/
Длина/Отменить/ Ширина]:)

• Arc (Дуга) – ýarym çyzygyň halka segmentleri çyzmagyň 
düzgünine geçmeklik;
• Close (Замкнуть) – ýarym çyzygy ýapyk goýýan gönüçyzyk­
ly parçanyň goşulmagy (şol bir wagtda Pline (Плиния) buýru­
gy tamamlanýar);
• Halfwidth (Полуширина) – ini görkezmeklik, ýöne ýarym 
iniň adalgasynda (ýagny zerur doly in 10 bolsa, ony almak 
üçin ýarym ini 5-e deň edip goýmaly);
• Length (Длина) – öňki parçanyň dowamy bolup durýan 
segmentiň berlen in bilen çyzylmagy, şonda ini san bilen ýa-da 
nokat bilen görkezip bolar;
• Undo (Отменить) – Pline (Плиния) buýrugynda soňky 
amalyň ýatyrylmagy;
• Width (Ширина) – indiki parça üçin ini görkezmeklik 
(ýarym çyzygyň her segmentinde öz ini bolup biler we ol 
parçanyň başynda onuň soňundakysy bilen gabat gelmän hem 
biler; in ýarym çyzygyň okunyň her tarapyna deň paýlanylýar.

Halka çyzmagyň düzgünine geçilen ýagdaýda (Arc (Дуга)) Au­
toCAD şeýle saýlamagy hödürleýär:

Specify endpoint of arc or [Angle/Center/Close/Direction/
Halfwidth/Line/Radius/Secondpt/Undo/Width]: (Конечная точка 
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дуги или [Угол/Центр/Замкнуть/Направление/Полуширина/Ли­
нейный/Радиус/Вторая/Отменить/Ширина]:)

Bu halatda halkanyň ahyrky nokady görkezilenden soň Au­
toCAD ýarym çyzygyň öňki parçasyna galtaşýan halka segmenti 
çyzýar. Beýleki opsiýalar:

• Angle (Угол) – halka segmenti üçin merkezi burçuň ulu­
lygyny görkezmek;
• Center (Центр) – halka segmenti üçin merkezi görkezmek;
• Close (Замкнуть) – ýarym çyzygy halka segmenti bilen ýap­
mak;
• Direction (Направление) – halka segmenti gurmak üçin 
galtaşyş çyzygyň ugruny görkezmeklik;
• Halfwidth (Полуширина) – indiki segment üçin ýarym ini 
görkezmeklik;
• Line (Линейный) – gönüçyzykly segmentleri çyzmagyň 
düzgünine geçmeklik;
• Radius (Радиус) – halka segmenti üçin radiusy görkezmek­
lik;
• Second pt (Вторая) – halka segmenti üç nokat boýunça gur­
mak üçin ikinji nokady görkezmeklik;
• Undo (Отменить) – Pline (Плиния) buýrugyň içinde iň 
soňky amaly ýatyrmaklyk;
• Width (Ширина) – indiki segment üçin ini görkezmeklik.

Halka segmentleri gurmagyň usullary halkalary gurmagyň Arc 
(Дуга) buýrugyna meňzeş.

Ýarym çyzyk çylşyrymly bolup durýar. Modify (Редактирова­
ние) panelindäki  düwmejik ýa-da Modify (Редакт) menýusynyň 
Explode (Взорвать) bendi bilen çagyrylýan Explode (Взорвать) 
buýrugy bilen ony kesimlere we halkalara bölüp bolýar. Şunda olaryň 
ini baradaky maglumat ýitýär.

Ulgamda öň çyzylan we yzygiderli baglaşan kesimleriň we 
halkalaryň ýarym çyzyga birleşmek mümkinçiligi bar.

Munuň üçin Pedit (Полред) buýrugy ulanylýar, Modify II 
(Редактирование-2) paneliň  düwmejigi we Modify > Object > 
Polyline (Редакт > Объект > Полилиния) menýu ýoly gabat gelýär. 
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Ilkibaşda buýruk ýarym çyzygy bellemek barada sorag berýär, biz ke­
simi ýa-da halkany bellänimizde ulgam olaryň ýarym çyzyk däldigi 
barada habar berýär we olary bir obýekte barada birleşdirmek boýun­
ça sorag berýär, Enter basylandan soň şu sorag emele geler:

Enter an option [Close/Join/Width/Edit vertex/ ‘Fit/’Spline/’De
curve/Ltype gen/Undo]: (Задайте опцию Замкнуть/Добавить/Ши­
рина/Вершина/С’Гладить/С’Плайн/Убрать сглаживание/Типлин/
Отменить]:)

Join opsiýasy saýlanylýar we gerekli yzygiderli obýektleri bel­
leýärsiňiz. Netijede bir bitewi ýarym çyzyk emele geler.

Ýörite görnüşli ýarym çyzyklar
AutoCAD ulgamynda gönüburçluklar, dogry köpburçluklar, hal­

kalar we düzediş çyzyklar ýaly obýektleri çyzmagyň birnäçe buýruk­
lary bar.

Gönüburçluklaryň çyzylmagy Rectang (Прямоугольник) buý­
rugy bilen amala aşyrylýar. Buýruk klawiaturadan, Draw (Рисова­
ние) panelindäki düwmejik arkaly ýa-da Draw (Рисование) men­
ýunyň Rectangle (Прямоугольник) bendi bilen çagyrylyp bilner. 
Başlangyç sorag:

Specify first corner point or [Chamfer/Elevation/Fillet/Thi­
ckness/Width]: (Первый угол или [Фаска/Уровень/Сопряжение/
Высота/Ширина]:)

Eger nokat görkezilse, ol gönüburçlugyň ilkinji burçy bolar, Au­
toCAD garşydaky burçy sorar ýa-da ölçegleri:

Specify other corner point or [Dimensions]: (Другой угол или 
[Размеры]:)

Eger ikinji nokat görkezilse, onda girizilen iki nokat hem gönü­
burçlugyň diagonallarynyň biri bolup durýar. Dimensions (Разме­
ры), opsiýasy saýlanylsa ona gönüburçlugyň iki ölçeginiň ähmiýet­
leri soralar:

Specify length for rectangles  <0.0000>:  (Длина прямоуголь­
ников <0.0000>:) we Specify width for rectangles <0.0000>: 
(Ширина прямоугольников <0.0000>:) – uzynlygy we ini.

Ölçegler girizilenden soňra AutoCAD ýene-de ikinji nokady so­
raýar, ýöne ol görkezilse ol diňe gönüburçlugyň ugrukdyrylmagyny 
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kesgitlär. Rectang (Прямоугольник) buýrugyň mümkin bolan op­
siýalary:

• Chamfer (Фаска) – gönüburçlugy her burçunda alynýan 
faskalaryň uzynlygyny görkezmeklik;
• Fillet (Сопряжение) – gönüburçlugy baglaşdyrmagyň ra­
diusyny görkezmeklik;
• Elevation (Уровень) – üçölçegli giňişligiň Z oky boýunça 
süýşen gönüburçlugy gurmak üçin derejäni görkezmeklik;
• Thickness (Высота) – üçölçegli giňişligiň Z okuň ugry 
boýunça galdyrylýan gönüburçlugyň beýikligini görkezmek­
lik;
• Width (Ширина) – gönüburçluk bolup durýan ýarym çyzy­
gyň inini görkezmeklik.

Polygon (Многоугольник) buýrugy dogry köpburçlugy ýa bir 
tarapyň ahyrky nokady, ýa-da merkeziň nokady we radiusy boýun­
ça çyzýar. Buýruk Draw (Рисование) paneliniň  düwmejigi ýa-da 
Draw (Рисование) menýunyň Polygon (Многоугольник) bendi 
boýunça çagyrylyp bilner. Birinji sorag:

Enter number of sides <4>: (Число сторон <4>:)
Bu ýerde köpburçlugyň taraplarynyň sanyny girizmeli, ýaýyň 

içinde öňki gezek ulanylan taraplaryň sany görkezilen. Indiki sorag:
Specify center of polygon or [Edge]: Укажите центр много­

угольника или [Сторона]:
Eger Е (С) opsiýasy saýlanylsa, onda AutoCAD tarapyň iki 

ahyrky nokady soraýar we olar boýunça gönüburçlugy gurýar. Eger 
opsiýanyň deregine nokat saýlanylsa, onda ulgam gönüburçlugyň öl­
çegi nähili görkeziljekdigini soraýar:

Enter an option [Inscribed in circle/Circumscribed about cir­
cle] </>; (Задайте опцию размещения [Вписанный в окружность/
Описанный вокруг окружности] <В>:)

I (В) jogap berlende, gönüburçluk belli bir tegelegiň içine sal­
nyp çyzylýar, С (О) jogapda – tegelegiň daşyndan çyzylýar. Diňe 
tegelegiň radiusy barada sorag galýar:

Specify radius of circle: (Радиус окружности:)
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Halka Donut (Кольцо) buýrugy bilen çyzylýar, içki we daşky 
diametr bilen saýlanylan ýarym çyzyk bilen çyzylýar. Buýruk kla­
wiaturadan başga, Draw (Рисование) menýusynyň Donut (Кольцо) 
bendi arkaly çagyrylyp bilner. Birinji sorag:

Specify inside diameter of donut <0.5000>: (Внутренний 
диаметр кольца <0.5000>:)

Içki (hem-de daşky) diametr san bilen ýa-da iki nokat bilen gör­
kezilip bilner. Ikinji sorag:

Specify outside diameter of donut <1.0000>: (Внешний диа­
метр кольца < 1.0000>:)

Iki diametr berlen soňra halkanyň ölçegleri hasaplanylýar we 
AutoCAD gaýtalamak bilen bir ölçegli halkalaryň merkeziniň no­
kadyny ýerleşdirmek boýunça sorag berýär:

Specify center of donut or <exit>: (Центр кольца или <вы­
ход>:)

Buýrugy Enter ýa-da syçanjygyň sag düwmejigi bilen tamamlap 
bolýar.

Revcloud
Bu buýruga Draw (Рисование) paneliň  düwmejigi we Draw 

(Рисование) menýunyň Revision Cloud (Облако правки) gabat gel­
ýär. Buýruk sorag berýär:

Minimum arc length: 15 Maximum arc length: 15 Speci­
fy start point or [Arc length/Object] <Object>: (Минимальная 
длина дуги: 15 Максимальная длина дуги: 15 Начальная тонка 
или [Длина дуги/Объект] <Oбъект>:)

Soragyň birinji setirinde buýrugyň goýlan sazlamalary görkezil­
ýär (halkalaryň iň kiçi we uly uzynlygy). Arc length (Длина дуги) 
opsiýasy bilen olary üýtgetmek mümkin. Object (Объект) opsiýasy 
bar bolan obýekte bulut formasyny bermegi mümkin edýär.

Nokatlar görkezilende döwlen çyzyk çyzylýar. Ol başdan bulut 
şekiline eýe bolýar. Ony syçanjygy basyp çyzmak zerur däl. Syçan­
jygy gerek bolan ugur boýunça geçirmek ýeterlikdir.

Object (Объект) opsiýasy saýlanylan bolsa ulgam obýekti so­
raýar. Obýekt görkezilenden soň halkalaryň ugruny çalyşmak barada 
sorag berilýär:
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Reverse direction [Yes/No] <No>: (Изменить направление 
[Да/Нет] <Нет>:).

Multiçyzyklar
Multiçyzyk – bu biri-birine parallel, döwlen çyzyklaryň toplu­

myndan ybarat bolan obýekt. Multiçyzyga girýän çyzyklaryň sany 
2-den 16-a çenli. Multiçyzyk goşmaça häsiýetlere eýedir, olara şular 
degişli: aralykdaky sepler, gyraňlar, tegelenen ýerler we reňk berme.

Multiçyzyklar Mline (Млиния) buýrugy bilen ýerine ýetirilýär. 
Buýruk klawiaturadan ýa-da Draw (Рисование) menýunyň Multili­
ne (Мультилиния) bendi arkaly çagyrylyp bilner.

Häzirki sazlamalary görkezilip birinji sorag berilýär:
Specify start point or [Justification/Scale/STyle]: (Начальная 

точка или [Расположение/’Масштаб/Стиль]:)
Eger birinji nokat görkezilse, onda indiki nokat boýunça sorag 

berilýär we ş.m. Üçünji soragda Undo (Отменить) opsiýasy, dördün­
ji nokatda Close (Замкнуть) opsiýasy emele gelýär.

Birinji nokady görkezmezden öň opsiýalaryň ähmiýetlerini goý­
mak mümkin. Justification (Расположение) opsiýasy Тор (Верх), 
Bottom (Низ) и Zero (Центр) ähmiýetleri alyp bilýär.

Ýazgylar
Ýazgylar Text (Текст) ýa-da Мтехт (Мтекст) buýruklar arkaly 

döredilip bilner. Birinji ýagdaýda bir setirli tekst, ikinji ýagdaýda – 
multitekst (köp setirli tekst) döredilýär. Bu buýruk klawiaturadan 
başga Text (Текст) paneliniň düwmejigi ýa-da Draw (Рисование) 
menýusynyň Text (Текст) kömekçi menýusynyň Single Line Text 
(Однострочный) bendi arkaly çagyrmak mümkin.

Buýruk goýberilenden soňra häzirki stil barada habar berilýär 
we: Current text style: «Standard» Text height: 2.5000 (Текущий 
текстовый стиль: «Standard» Высота текста: 2.5000). Stiliň 
düşünjesi öz içine şriftiň adyny we ony ulanmagyň käbir aýratynlyk­
laryny öz içine alýar (harplaryň eňňitligini we b.). Mundan başga 
hem AutoCAD öňki ýazgynyň beýikligini ýatda saklaýar (biziň my­
salymyzda bu 2.5 mm). Ýazgynyň gurulmagy şu soragdan başlanýar: 
Specify start point of text or [Justify/Style]: (Начальная точка 
текста или [Выравнивание/Стиль]:)
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Tekstiň başlangyç nokadyny görkezmek ýa-da Justify (Вырав­
нивание) we Style (Стиль) opsiýalarynyň birini saýlamak mümkin. 
Soňky opsiýa häzirki stiliň adyny üýtgetmegi mümkin edýär. Justi­
fy (Выравнивание) opsiýasy tekstiň haýsy ýagdaýda deňlenmegini 
saýlamagy mümkin edýär. Nokat görkezilen ýagdaýda ol baza 
çyzygyň başlangyjy bolup durýar. Indiki sorag:

Specify height <2.5000>: (Высота <2.5000>.)
Tekstiň beýikligini girizmeli (Başlanýan harplara degişlilikde) 

ýa-da ony ikinji nokat bilen görkezmeli. Soňra şeýle sorag emele gel­
ýär:

Specify rotation angle of text <0>: (Угол поворота текста 
<0>:)

Ýazgynyň aşaky esasynyň X okunyň položitel ugruna görä 
öwrüliş burçy belleýän sany giriziň (kese ýagdaýda ol 0). Öwrüliş 
burçy ikinji nokat bilen görkezip bolar. Ahyrky sorag:

Enter text: (Введите текст:)
Ýazgynyň başyny bellän ýeriňizde I harpyň şekilinde kursor 

emele geler. Klawiaturada islendik teksti ýazyň we Enter-i basyň. 
Ekranda ýazgy emele geler we AutoCAD gaýtadan sorar Enter text: 
(Введите текст:). Buýrugy tamamlamak üçin Enter ýa-da Esc düw­
mejigi basyň.

Eger ýazga ýörite belgileri (meselem, diametr) ýa-da aşagy we 
üsti çyzylan simwollary ýazmak zerur bolsa, onda göterim belgiden 
başlanýan aşakdaky dolandyryjy simwollary ulanmaly:

• %%nnn – Windows üçin grafiki amaly goşundylarda ula­
nylýan kodirlemegiň häzirki tablisasynda nnn belgili simwoly 
goýmak (nnn üç sany çalşyrýar), (meselem, %%193 –bu 193 
belgili simwol, ýagny «Б»);
• %%о – üstünden çyzmagy goýmak/aýyrmak;
• %%u – aşakdan çyzmagy goýmak/aýyrmak;
• %%d – gradusyň «°» simwolyny goýmak;
• %%р – goşmak-aýyrmak «±» simwoly goýmak;
• %%с – diametriň simwolyny goýmak;
• %%% – göterimiň simwolyny goýmak «%».

Deňlemegiň opsiýasy gyzyklydyr, olar başlangyç nokadyň de­
regine Justify (Выравнивание) opsiýasy saýlanylsa elýeterli bolýar:
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Enter an option [Align/Fit/Center/Middle/ Right/TL/TC/
TR/ML/MC/MR/BL/BC/BR]: (Задайте опцию [Вписанный/По­
ширине/Центр/Середина/Вправо/ВЛ/ВЦ/ВП/СЛ/СЦ/СП/НЛ/НЦ/
НП]:).

Align (Вписанный) we Fit (По ширине) opsiýalar gyzy­
kly, olar harplaryň ölçeglerini anyk bir ýerleşiş boýunça gabat ge­
tirýärler. Align (Вписанный) opsiýasy ulanylanda AutoCAD baza 
çyzygyň ahyrky nokatlary hökmünde boljak iki nokady soraýar – olar 
ýazgynyň eňňitliginiň burçuny we tekstiň ini boýunça ölçegini kes­
gitleýär, harplaryň beýiklik boýunça ölçegleri bolsa harplaryň inine 
proporsional edilip hasaplanylýar. Fit (По ширине) opsiýasynyň 
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ýagdaýynda baza çyzygyň ýerleşişini we uzynlygyny kesgitleýän iki 
nokady görkezmeli, emma AutoCAD harpyň beýikligini hem soraýar, 
mundan soň tekst ýa giňeýär ýa-da gysylýar.

Мтехт (Мтекст) buýrugy çyzga ýeterlikçe uzyn tekstiň tutuş 
abzaslary girizmegi mümkin edýär (şunda emele gelýän primitiwe 
multitekst diýilýär), onda deňleşdiriş we redaktirleýiş Microsoft 
Word ýaly tekst redaktorlaryň mümkinçiligine golaýlaşýar. Buýru­
ga Draw (Рисование) we Text (Текст) panelindäki  düwmejigi, 
şeýle hem Draw > Text > Multiline Text (Рисование > Текст > 
> Многострочный) menýunyň bendi gabat gelýär.

Мтехт (Мтекст) buýrugy başda hereket edýän tekst stili barada 
habar berýär we multitekstiň ini boýunça zolagyň çäklerini kesgit­
leýän nokatlaryň birini girizmegi soraýar. Beýiklik boýunça aşaky 
çäk şundan bellenilmeýär we awtomatiki tekstiň girizilmeginiň do­
wamynda süýşýär. Şeýlelik bilen, başda:

Current text style: «Standard» Text height: 2.5 Specify first 
corner: (Текущий текстовый стиль: «Standard». Высота текста: 
2.5 Первый угол:)

Soňra: Specify opposite corner or [Height/Justify/Line 
spacing/Rotation/Style/Width]: (Противоположный угол или 
[Высота/Выравнивание/ Межстрочный интервал/Поворот/Стиль/
Ширина]:)

Nokatlar görkezilenden soň multitekstiň redaktorynyň penjire­
si açylýar. Multitekstiň penjiresiniň ýokarsynda Text Formatting 
(Форматирование текста) ýörite paneli çykarylýar, ol redaktoryň 
penjiresini dolandyrmagyň gurallaryny saklaýar.

Tekst ýazylandan soň Text Format­
ting (Форматирование текста) paneliniň 

 düwmejigine basmaly ýa-da Ctrl+Enter 
düwmejikleriň utgaşmagyny basmaly, mun­
dan soň AutoCAD grafiki ekranda bitewi 
çylşyrymly bolup duran multiteksti döreder.

 düwmejigi droblary we indeksleri ýaz­
maklygy dolandyrýar. Sanawjy we maýdalawjy 
ýa kese çyzyk bilen aýry edilip bilner ýa-da hiç 



189

zat, ýa-da eňňitli çyzyk bilen aýry edilip bilner. Droblaryň düwme­
jigini ulanmazdan öň syçanjyk arkaly emele geljek sanawjynyň we 
maýdalawjynyň şu simwollaryň biri bilen aýry edilen meýdanyny 
bellemek gerek: /, ^ или #. Soňra şol düwmejige basmaly.

 düwmejigiň eýýam drobuň görnüşine eýe bolan tekstiň belle­
nilen meýdanyna ulanylmagy ony öňki görnüşine getirýär.

Kursor multitekstiň redaktorynyň içinde bolanda syçanjygyň sag 
düwmejigiň basylmagy kontekst menýuny çagyrýar.

Kontekst menýu şu elementlere eýe:
• Undo (Отменить) – redaktoryň penjiresinde soňky amaly 
ýatyrýar;
• Redo (Повторить) – soňky ýatyrmagyň hereketini ýok edýär;
• Cut (Вырезать) – tekstiň bellenilen bölegini kesip alýar we 
alyş-çalyş buferine girizýär;
• Сору (Копировать) – tekstiň bellenilen bölegini alyş-çalyş 
buferine göçürip alýar;
• Paste (Вставить) – alyş-çalyş buferinden teksti goýýar;
• Indents and Tabs (Отступы и позиции табуляции) – şol 
atly gepleşik penjiresini çagyrýar;
• Justification (Выравнивание) – deňleşdiriş amallaryň kö­
mekçi menýusyna geçmek;
• Find and Replace (Найти и заменить) – teksti gözlemek 
we ony çalşyrmak üçin Замена (Replace) gepleşik penjiresini 
çagyrmak;
• Select All (Выбрать все) – redaktoryň penjiresindäki tutuş 
teksti belläp alýar;
• Change Case (Изменить регистр) – bellenilen tekstiň meý­
danynda ýokarky (Uppercase) ýa-da aşaky (lowercase) regis­
tre geçmeklik;
• AutoCAPS (Авто-CAPS) – täze teksti ýokarky registre ge­
çirýär;
• Remove Formatting (Убрать форматирование) – tekstiň 
bellenilen meýdanynyň goşmaça formatirlenmesini aýyrýar 
(kursiw, galyňlyk, aşagy çyzmagy);
• Combine Paragraphs (Объединить абзацы) – abzaslary 
bir abzasa birleşdirýär;
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• Symbol (Символ) – ýörite simwollaryň goýulmagynyň 
menýusyna geçmeklik;
• Import Text (Импорт текста) – txt и rtf giňişlikli faýllardan 
teksti alýar.

Multitekstiň häsiýetlerini umuman sazlamak üçin Мтехт 
(Мтекст) buýrugyň başynda çykýan opsiýalary ulanmak zerur:

• Rotation (Поворот) – multitekstiň X okuna görä goşmaça 
öwrülmegini belleýär;
• Line spacing (Межстрочный интервал) – setir ara inter­
waly dolandyrýar.

Opsiýalaryň soňkusy saýlanylanda ulgam soraýar:
Enter line spacing type [At least/Exactly] <At least>: (Меж­

строчный интервал [Минимум/Точно] <Минимум>:)
At least (Минимум) opsiýasy programmanyň interwaly setirleriň 

arasyndaky iň pes aralygy saklap özi hasaplaýan ýagdaýyny belleýär. 
Exactly (Точно) opsiýasy saýlanylanda setirleriň arasyndaky aralyk 
tekstiň aýratynlyklaryna garamazdan bellenilýär. Indiki sorag:

Enter line spacing factor or distance <1x>: (Значение 
межстрочного интервала <1х>:)

Bu ýagdaýda х harpy tekstiň harplarynyň 1,66 köpeldilmegi ar­
kaly bellenilýär, şol sebäpli setirara aralygy 1,5 esse ulaltmak üçin 
1,5х girizmeli. Ähmiýetler 0,25 we 4х aralykda bolmalydyr.

Ölçegler
Ölçegleri, ýazgy çykaryş çyzgylary goýma amallary Dimensi­

on (Размеры) menýusynyň buýruklary we Dimension (Размеры) 
paneliniň düwmejikleri arkaly ýerine ýetirilýär.

AutoCAD programmasy goýlan ölçegleri obýektlere assosiatiw 
edip goýýar, ýagny obýektler üýtgände olar hem şoňa görä üýtgeýär.

Birinji buýruk – Dimlinear (Рзмлинейный) – çyzykly ölçegle­
ri goýmak üçin niýetlenen. Oňa Dimension (Размеры) paneliniň  
düwmejigi we Dimension (Размеры) menýunyň Linear (Линейный) 
bendi gabat gelýär. Gönüburçlugyň ölçegini goýalyň. Soragyň birinji 
buýrugy:
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Specify first extension line origin or <select object>: (Начало 
первой выносной линии или <выбрать объект>.)

Işi ýerine ýetirmegiň iki görnüşi bar. Birinji – wagtlaýyn ýa-da 
hemişelik obýekt baglaşdyrma arkaly gönüburçlugyň ýokarky çep 
burçunyň nokadyny görkezeliň we AutoCAD ulgamynyň şeýle so­
ragyna:

Specify second extension line origin: (Начало второй вы­
носной линии:) ýokarky sag nokady görkezeliň. Öz gezegine Auto­
CAD ölçeg çyzygy nirä goýmalydygyny soraýar:

Specify dimension line location or [Mtext/Text/Angle/Ho­
rizontal/Vertical/Rotated]: Положение размерной линии или 
[Мтекст/Текст/Угол/Горизонтальный/Вертикальный/Повёрну­
тый]:)

Obýektde görkezilen nokatlar boýunça AutoCAD ölçegiň 
haýsy görnüşiniň (kese, dik) gurulmagy gerekdigini kesgitleýär. 
Ylalaşylandan soň diňe syçanjyk arkaly ölçegiň durjak derejesini gör­
kezmek galýar. Gurlan ölçeg bir bitewi primitiw bolup durýar. Syçan­
jyk bilen bellenilende ol tutuşlaýyn saýlanylýar. Zerur bolanda ony 
Explode (Расчленить) buýrugy arkaly has ýönekeý düzüm böleklere 
bölmek bolýar.

Buýruk ýerine ýetirilende aşaky opsiýalardan peýdalanmak 
mümkin:

• Mtext (Мтекст) – multitekstiň mümkinçiliklerini ulanýan 
has çyşyrymly ölçeg tekstini girizmek;
• Text (Текст) – deslapdan hödürleýän tekstden tapawutly öl­
çeg teksti girizmek;
• Angle (Угол) – ölçeg çyzyga görä ölçeg tekstiniň burçuny 
görkezmek;
• Horizontal (Горизонтальный) – kese ölçegi goýmak;
• Vertical (Вертикальный) – dik ölçegi goýmak;
• Rotated (Повернутый) – öwrülen (eňňitli) ölçegi goý­
mak; AutoCAD sorar: Specify angle of dimension line: (Угол 
поворота размерной линии:).

Iki nokady görkezmegiň deregine <select object> (<выбрать 
объект>) opsiýasyny ulanmak mümkin, ol birinji çykaryş çyzygyň 
deregine Enter basylsa güýje girýär:
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Select object to dimension: (Выберите объект для нанесения 
размера:) Kesimi ýa-da ýarym çyzygyň gönüçyzykly bölegini 
görkezmek gerek.

Ölçegi käbir parametrleri amatly bolmasa, buýruk setirinde Dim­
scale ýazyp we Enter basyp olary, ýagny tekstiň ululygyny üýtgetmek 
mümkin.

Dimaligned (Рзмпарал) buýrugy, oňa Dimension (Размеры) 
paneliniň  düwmejigi ýa-da Dimension (Размеры) menýunyň 
Aligned (Параллельный) bendi gabat gelýär, ol saýlanan kesime 
ýa-da iki görkezilen nokada ölçegi parallel goýmagy mümkin edýär.

Dimordinate (Рзмордиhatа) buýrugy görkezilen nokadyň abs­
sisasyny ýa-da ordinatasynyň ähmiýetini görkezmek üçin ulanylýar. 
Bu buýruga Dimension (Размеры) paneliniň  düwmejigi we Di­
mension (Размеры) menýunyň Ordinate (Ординатный) bendi gabat 
gelýär. Birinji sorag:

Specify feature location: (Укажите положение элемента:). 
Koordinatasy çykarylyp görkeziljek nokady görkezmek gerek. Indiki 
sorag:

Specify leader endpoint or fXdatum/Ydatum/Mtext/Text/
AngleJ: (Конечная тонка выноски или [Хзначение/Узначение/
Мтекст/Текст/Угол]:)

Çykaryş çyzygy gutarjak nokady görkezmeli. Şonda ulgamyň 
özi haýsy koordinatany görkezmegi özi kesgitlejek bolýar.

Buýrugyň beýleki opsiýalary:
• Xdatum (Хзначение) – abssisanyň çykarylmagyny görkez­
mek;
• Ydatum (Узначение) – ordinatanyň çykarylmagyny görkez­
mek;
• Mtext (Мтекст) – multitekstiň mümkinçiliklerini ulanýan 
has çyşyrymly ölçeg tekstini girizmek;
• Text (Текст) – täze teksti girizmek;
• Angle (Угол) – çykaryş ýazgynyň eňňitlik burçuny görkez­
mek.

Dimradius (Рзмрадиус) buýrugyna Dimension (Размеры) 
paneliniň  düwmejigi we Dimension (Размеры) menýunyň Ra­
dius (Радиус) bendi gabat gelýär. Buýruk radiusyň ölçegini goýmak 
üçin niýetlenen we başda şu soragy berýär:
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Select arc or circle: (Выберите дугу или круг:) Soňra: Spe­
cify dimension line location or [Mtext/Text/Angle]: (Положение 
размерной линии или [Мтекст/Текст/Угол]:) Ölçeg çyzygyň ýerleşiş 
nokady ölçegiň daşynda ýa-da içinden goýuljakdygyny çözýär.

Dimdiameter (Рзмдиаметр) buýrugy diametri goýmak üçin 
niýetlenen. Oňa Dimension (Размеры) paneliniň  düwmejigi we 
Dimension (Размеры) menýunyň Diameter (Диаметр) bendi gabat 
gelýär.

Dimangular (Рзмугловой) buýrugy kesimleriň arasynda we 
halkanyň (ýa-da tegelegiň böleginiň) burç ölçeglerini goýmak üçin 
niýetlenen. Oňa Dimension (Размеры) paneliniň  düwmejigi we 
Dimension (Размеры) menýunyň Angular (Угловой) bendi gabat 
gelýär. Buýruk soraýar:

Select arc, circle, line, or <specify vertex>: (Выберите дугу, 
круг, отрезок или <указать вершину >:) Munuň üçin halkany, ýa-da 
tegelegi (onda iki görkezilen nokatlaryň arasyndaky halkanyň ölçegi 
görkezilýär), ýa-da kesimi (soňra ýene bir kesim soralýar we olaryň 
arasynda burç ölçenilýär). Eger Enter basylsa, onda AutoCAD üç no­
kady – burçuň depesini birinji we ikinji ahyrky nokatlary sorar.

Qdim (Бразмер) buýrugy bir görnüşli ölçegleriň we ölçeg 
zynjyrlaryň toparlarynyň tiz döredilmegi üçin niýetlenen. Buýru­
ga Dimension (Размеры) paneliniň  düwmejigi we Dimension 
(Размеры) menýunyň Quick Dimension (Быстрый размер) bendi 
gabat gelýär. Buýrugyň birinji soragy:

Associative dimension priority = Endpoint Select geometry 
to dimension: (Приоритет ассоциативного размера = Конточка 
Выберите объекты для нанесения размеров:) Bir görnüşli ölçegle­
rini goýmak zerur bolan obýektleri görkezmeli. Soňra:

Specify dimension line position, or [Continuom/Stagge­
red/Baseline/Ordinate/Radius/Dlameter/datumPoint/Edit/Set­
tings] <Continuous>: (Положение размерной линии или /Цепь/
Ступенчатый/Pазовый/Ординатный/Радиус/Диаметр/Точка/
Изменить/ Установки] <Цепь>:). Ölçeg çyzygyň ýerleşiş ýerini 
görkezmekden başga şu opsiýalardan peýdalanmak mümkin:

• Continuous (Цепь) – ölçeg zynjyry bellemek;

13. Sargyt 1372
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• Staggered (Ступенчатый) – basgançaklaýyn ölçegleri bel­
lemek;
• Baseline (Базовый) – baza ölçegleri bellemek;
• Ordinate (Ординатный) – ordinata ölçegleri bellemek;
• Radius (Радиус) – radiuslary goýmaklyk;
• Diameter (Диаметр) – diametrleri goýmaklyk;
• Datum Point (Точка) – baza ýa-da ordinata ölçegleri üçin 
täze baza nokadynyň saýlanylmagy;
• Edit (Изменить) – birnäçe ölçegleriň üýtgedilmegi (Auto­
CAD bar bolan ölçegleriň nokatlaryny goşmagy ýa-da aýyr­
magy) soraýar;
• Settings (Установки) – ileri tutuljak obýekt baglaşdyrmagyň 
beýleki funksiýasynyň saýlanylmagy.

Dimbaseline (Рзмбазовый) buýrugy şol bir baza nokadyndan 
birnäçe çyzyk ölçegleri gurmaga mümkinçilik berýär. Dimbaseline 
(Рзмбазовый) buýrugy, klawiaturadan başga, Dimension (Размеры) 
paneliniň  düwmejigi ýa-da Dimension (Размеры) menýunyň 
Baseline (Базовый) bendi arkaly çagyrylyp bilner. Buýruk birinji 
çyzygyň ýerleşişini soramaýar hem-de ikinjini sorap başlaýar:

Specify a second extension line origin or [Undo/Select] < Se­
lect >: (Начало второй выносной линии или [Отменить/Выбрать] 
<Выбрать>:) Baza ölçegleriň toparyň bazasy hökmünde adatça 
öňündäki çyzyk ölçegi gulluk edýär we onuň birinji nokady indiki 
çyzyk (baza) ölçegler üçin birinji nokat bolup durýar. Ikinji nokat 
saýlanandan soň, gaýtalanyş bilen indiki nokatlary hem görkezmek 
bolýar we olaryň saýlanmagyny Esc düwmejigi bilen tamamlap bolar. 
Eger ulgam soňky ölçegi kesgitläp bilmese onda goşmaça soraýar:

Select base dimension: Linear, Ordinate, or Angular Associ­
ative Dimension Required (Выберите исходный размер: Выбрать 
линейный, ординатный или угловой размер) Undo (Отменить) 
Dimbaseline (Рзмбазовый) buýrugyň soňky ädimini ýatyrýar, Select 
(Выбрать) opsiýasy bolsa baza hökmünde beýleki ölçegi saýlamagy 
mümkin edýär.

Dimcontinue (Рзмцепь) buýrugy biri-birine dowam bolup 
durýan birnäçe çyzyk ölçegleri gurmagy mümkin edýär. Dimconti­
nue (Рзмцепь) buýrugy Dimension (Размеры) paneliniň  düwme­
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jigi ýa-da Dimension (Размеры) menýunyň Continue (Цепь) bendi 
arkaly çagyrylyp bilner.

Ştrihleme we reňk berme
Suratyň ýapyk töwereklerini ştrihlemek üçin Hаtсh (Штрих) 

buýrugy gulluk edýär, ol Draw (Рисование) paneliniň  düwme­
jigi ýa-da Draw (Рисование) menýunyň Hatch (Штриховка) bendi 
arkaly çagyrylýar. Hatch (Штрих) buýrugy ýapyk çyzyk bilen çäk­
lendirilen töwerekleriň ştrihlemesini we reňk bilen doldurylmagyny 
hem-ä suduryň içinde nokatlary görkezmek arkaly, hem-de obýektleri 
saýlamak arkaly amala aşyrýar. Bu buýruk awtomatiki sudury kesgit­
leýär. Boundary Hatch and Fill (Штриховка и заливка по контуру) 
dialog penjiresini çagyrýar.

Dialog penjiresi biri-birini çalşyrýan üç goşmaça eýe. Hatch 
(Штриховка) ştrihlemegiň parametrini belleýär. Ştrihleme bilen 
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doldurylýan töwerek bu penjiräniň sag tarapyndaky parametrler bi­
len bellenilýär. Туре (Тип) sanawy ştrihlemegiň aşaky nusgalaryny 
hödürleýär:

• Predefined (Стандартный);
• User defined (Из линий);
• Custom (Пользовательский).

AutoCAD ulgamy standart ştrihlemekligiň uly sanawyny hödür­
leýär. Ştrihlemegiň saýlanylmagy Pattern (Образец) sanawy arkaly 
ýa-da wizual taýdan köp nokatly şekilli düwmejige basyp amala aşy­
rylýar.

Standart nusgalaryň sanawynda Solid atly ştrihleme bar, ol ştrih­
leme bolman reňk doldurmagy amala aşyrýar.

Ellips
Ellips – bu nokatlaryň geometriki ýerleşişi, şonda şol nokatlardan 

iki bellenilen nokada (fokus) çenli iki aralygyň jemi deň. Ellipsleriň 
we elliptik halkalaryň gurulmagy Ellipse (Эллипс) buýrugy arkaly 
amala aşyrylýar, ol Draw (Рисование) paneliniň  düwmejigi 
ýa-da Draw (Рисование) Draw > Ellipse > Axis, End (Рисование >
> Эллипс Ось, Конец) menýu arkaly çagyrylyp bilner. Birinji sorag:

Specify axis endpoint of ellipse or [Arc/Center]: (Конечная 
точка оси эллипса или [Дуга/Центр]:) Eger birinji nokat görkezilen 
bolsa indiki sorag şeýle bolar:

Specify other endpoint of axis: (Вторая конечная точка оси:) 
Bu soraga ellipsiň okunyň ikinji ahyrky nokadyny görkezmeli. Auto­
CAD ulgamy ilkinji nokatlar boýunça ellipsiň merkezini hasaplaýar 
(birinji we ikinji nokadyň arasyndaky kesimiň ortasy). Soňra: Spe­
cify distance to other axis or [Rotation]: (Длина другой оси или 
(Поворот/:) Şol wagt ellipsiň ikinji okunyň uzynlygy boljak sany gi­
rizmek mümkin. Eger üçünji nokat görkezilse, onda ulgam merkez­
den şol nokada çenli bolan aralygy ölçär we ony ikinji okuň daýnasy 
hökmünde alar we bu maglumatlar boýunça ellipsi gurar. Eger soňky 
ýagdaýda daýnanyň deregine Rotation (Поворот) opsiýasy saýlany­
lsa, onda ellips XY tekizligine göräleýin görkezilen burça öwrülen 
tegelegiň proýeksiýasy hökmünde gurlar (has takyklaýyn, baş okuna 
göräleýin). Eger burç nola deň bolsa, onda adaty tegelek emele geler. 
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Eger birinji soraga jogap hökmünde Center (Центр) opsiýasy saýla­
nylsa – indiki habar şeýle bolar:

Specify center of ellipse: (Центр эллипса:) Ellipsiň merkezi 
görkezilenden soň şu soralar: Specify endpoint of axis: (Конечная 
точка оси:) Mundan soň öň görkezilen ýaly ahyrky sorag berilýär 
(Specify distance to other axis or [Rotation]: (Длина другой оси 
или [Поворот/:)).

Elliptik halkasyny gurmak üçin Ellipse (Эллипс) buýrugynda 
birinji soraga jogap hökmünde Arc (Дуга) opsiýasyny saýlamaly. 
Edil şeýle işi Draw (Рисование) paneliniň  düwmejigi we Draw > 
Ellipse Arc (Рисование > Эллипс Дуга) bendi ýerine ýetirýär. Auto­
CAD ulgamynyň indiki soragy:

Specify axis endpoint of elliptical arc or [Center]: (Конечная 
точка оси эллиптической дуги или [Центр]:) Soňra: Specify other 
endpoint of axis: (Вторая конечная точка оси:) Indiki sorag: Spe­
cify distance to other axis or [Rotation]: (Длина другой оси или 
[Поворот]:) Indi halkany ellipsiň bölegi hökmünde bellemek boýun­
ça sorag berilýär:

Specify start angle or [Parameter]: (Начальный угол или /
Параметр]:) Başlangyç burç san ýa-da syçanjyk bilen birinji oka görä 
görkezilýär (sanama sagat ugruna garşy okuň birinji nokadyndan al­
nyp barylýar). Soňra: Specify end angle or [Parameter/Included an­
gle]: (Конечный угол или [Параметр/Внутренний угол]:) Ahyrky 
burçy ýa-da Included angle (Внутренний угол) opsiýasyny saýlap 
halkanyň içerki (merkezi) burçuny görkezmek bolar.

Spline (Сплайн) buýrugy – berlen nokatlardan takyk geçýän 
ýa-da elýeterligiň çäginde olardan gyşarýan başlangyç, ahyrky we 
iki nokatda galtaşmagyň şertine gabat gelýän ýylmanak çyzygy – 
splaýny çyzmak üçin niýetlenen. Buýruk klawiaturadan başga Draw 
(Рисование) paneliniň  düwmejigi ýa-da Draw (Рисование) 
menýunyň Spline (Сплайн) bendi arkaly çagyrylýar. Buýrugyň 
başlangyç soragy:

Specify first point or [Object]: (Первая точка или [Объект]:) Eger 
nokat görkezilse, onda şu sorag berler: Specify next point: (Следующая 
точка:) Ikinji nokat girizilenden soňra indiki nokatlaryň görkezilmegi 
ýa-da Close (Замкнуть) opsiýasy arkaly ýapylma mümkin:
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Specify next point or [Close/Fit tolerance] <start tangent >: 
(Следующая тонка или [Замкнуть/Допуск] <касательная в на­
чале>:) Enter basylsa, galtaşmagyň başlangyç burçy görkeziler:

Specify start tangent: (Касательная в начальной точке:) Eger 
ýapylan splaýn gurulsa, onda galtaşma bolan sorag biraz üýtgär: Spe­
cify tangent: (Направление касательной:) Burç san ýa-da syçanjyk 
arkaly görkezilip bilner. Eger Enter basylsa, onda başlangyç nokat­
da çyzygy gurmak üçin araçäk şerti ulanylmaýar. Eger splaýn ýapyk 
däl bolsa, onda başlangyç galtaşma çyzyk soralandan soň soňky no­
katda galtaşmagyň ugry barada sorag berilýär: Specify end tangent: 
(Касательная в конечной точке:)

Eger birinji nokadyň deregine Object (Объект) opsiýasy saýla­
nylsa, AutoCAD ulgamy öň gurlan we Spline (Сплайн) opsiýasy bi­
len ýylmanan iki ölçegli we üç ölçegli ýarym çyzyklaryň splaýnlara 
özgermesine başlar we şu soragy berer: Select objects to convert to 
splines... Select objects: ‘Выберите объекты для преобразования в 
сплайны... Выберите объекты:).

Seýrek ýönekeý görnüş zolaklar we figuralar degişli bolup biler. 
Trace (Полоса) buýrugy diňe klawiaturadan girizilýär we hemişelik 
inli döwlen çyzyklary – zolaklary çyzmak üçin niýetlenen. Birinji so­
rag:

Specify trace width <1.0000>: (Ширина полосы <1.0000>:) 
Ini san bilen ýa-da iki nokat bilen görkeziň. Indiki sorag: Specify 
start point: (Начальная точка:) Zolagyň oklaýyn çyzygyň başlangyç 
nokadyny görkezmeli. Soňra:

Specify next point: (Следующая точка:) Gaýtalanyşda nobat­
daky nokatlary görkeziň we gurmagy Enter düwmejigi bilen tamam­
lamaly. Segmentler bir bitewi obýekti emele getirmeýär.

Solid (Фигура) buýrugy – yzygiderli ýerleşen reňklenen dört­
burçluklary ýa-da üçburçluklary gurýar. Dörtburçlugyň depeleri aşa­
ky nokatlar bilen gurulýar:

Specify first point: (Первая точка:) soňra: Specify second po­
int: (Вторая тонка:) Mundan beýläk: Specify third point: (Третья 
точка:) Dörtburçlugyň üçünji nokady hökmünde diagonal boýunça 
ikinji nokadyň garşysynda ýerleşen nokady görkezmeli (ýogsam fi­
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gura towlanan bolar). Soňra dördünji nokat soralýar. Eger dördünji 
nokadyň deregine Enter basylsa, onda üçburçly figura gurulýar.

Specify fourth point or <exit>: (Четвертая точка или <выход>:) 
Soňra ýene üçünji nokat soralýar, sebäbi nobatdaky dörtburçlugyň 
birinji we ikinji nokady bolup, ondan öňki dörtburçlugyň üçünji we 
dördünji nokat bolup biler. Üçünji nokadyň deregine Enter basylsa 
buýruk tamamlanar.

Solid (Фигура) buýrugy bilen gurlan figuralar bir bitewi obýekti 
gurmaýarlar.

Işiň dowamynda örän peýdaly bolup maglumat buýruklary bol­
ýar. Olary Inquiry (Справки) panelinde çagyryp bolýar:

• Distance (Расстояние);
• Area (Площадь);
• Region/Mass Properties (Область/Масса);
• List (Список);
• Locate Point (Координаты).

Bu amala şeýle hem Tools (Сервис) menýunyň Inquiry (Сведе­
ния) kömekçi menýusy arkaly çykyp bolýar:

• Dist (Дист);
• Area (Площадь);
• Massprop (Масс-Хар);
• List (Список);
• Id (Коорд).

Tejribe işleri
1. 20x35 ölçegde gönüburçlugy gurmaly.
2. Radiusy R=50 bolan tegelegi gurmaly.
3. Uzynlygy 45 bolan we x okuna 560 gradus bilen duran kesimi gurmaly.
4. Dogry üçburçlugy gurmaly.
5. Daşyndan aýlanan tegelegiň radiusy R=36 bolan dogry altyburçlugy gur­

maly.
6. Içinden aýlanan tegelegiň radiusy R=18 bolan dogry sekizburçlugy gur­

maly.
7. 6 göni çyzykdan we 7 sany egri çyzykdan ybarat bolan ýarym çyzygy gur­

maly.
8. 20x35 ölçegde gönüburçlugyň hemme tarapynyň ölçeglerini goýmaly.
9. Radiusy R=50 bolan tegelegiň ölçeglerini kesgitlemeli.
10. 3 mysalda görkezilen çyzygyň burçunyň ölçegini goýmaly.
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X. Geometriýany redaktirlemek

Geometriýany redaktirlemek aşakdaky usullar arkaly mümkin:
• eljagazlar arkaly ýönekeýleri redaktirlemegiň amallary;
• umumy redaktirlemegiň buýrujylary – göçürme, ýerini üýt­
getme, uzaltma we ş.m.;
• çylşyrymly ýönekeýleri redaktirlemegiň ýörite buýruklary.

Eger buýruk setirinde Command: (Команда:) çagyryşy bar bol­
sa, onda ekranda görünýän obýektleri belläp bolýar we olarda eljagaz­
lar – obýektleriň mahsus nokatlarynda gök kwadratlar emele geler.

Line (отрезок) üçin mahsus nokatlar ahyrky we ortaky nokat 
bolýar. Öň gurlan kesime syçanjyk bilen basyň. Ahyrky we ortaky 
nokatlar reňk bilen bellenilýär.

Adatça saýlanan obýektleriň eljagazlary gök reňke eýe bolup 
durýar. Emma, eger kursor haýsy-da bolsa nokadyň üstünde geçiri­
len mahaly ol ýaşyl reňke eýe bolar. Eger syçanjyk bilen nokada çep 
düwmejigi bilen basylsa onda, ol gyzyl reňke eýe bolar. AutoCAD 
şeýle habar berýär:

** Stretch ** Specify stretch point or [Base point/Copy/Undo/
Exit]: (** Растянуть ** Точка растягивания или [Базовая точка/
Копировать/Отменить/Выход]:) Eger klawiaturada 90,240 ýazyl­
sa we Enter basylsa – kesim derrew üýtgär: onuň bellenilen nokady 
X = 90, Y = 240 koordinatalara eýe bolar. Nokadyň ýerini, syçanjyk 
bilen goýup bolýar.

Eger eljagaz saýlanylandan soňra Enter ýa-da Space (<Про­
бел>) klawişalar basylsa, onda AutoCAD meňzeş, ýöne Move 
(Перенести) buýrugyna degişli bolan soragy hödürleýär. Yzygiderli 
Enter basylsa onda Rotate (Повернуть), soňra Scale (Масштаб), 
mundan soň bolsa – Mirror (Зеркало), soňra bolsa ýene Stretch 
(Растянуть) buýrugyň soraglary emele gelýär.

Eger syçanjyk bilen ahyrky eljagaz däl-de, ortakysy saýlanylsa, 
onda AutoCAD oňki soragyň edil şol opsiýalary bilen teksti hödür­
leýär. Syçanjyk bilen ortaky nokady görkeziň. Kesim täze ýere geçer.

Xline (прямая) baza nokady we ondan uly bolmadyk aralykda 
iki nokat bellenilýär. Eger baza nokady bilen geçirilse, onda tutuş 
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göni çyzyk geçirilýär, eger beýleki nokatlar bilen geçirilse, onda baza 
nokady öňki ýerde galýar, göni çyzygyň bolsa eňňitligi üýtgeýär.

Edil şonuň ýaly şöhleleri redaktirlemek üçin eljagazlaryň ulanyl­
magy (primitiwiň ady – Ray). Şöhlede iki eljagaz baza nokadyndaky 
we ugry kesgitleýän nokatda bellenilýär. Baza nokady geçirilse tutuş 
şöhle geçirilýär, ikinji nokat geçirilse şöhläniň eňňitligi üýtgeýär.

Tegelekde (Circle): merkezde we kwadrantlarda 5 nokat belle­
nilýär. Merkezdäki eljagaz geçirilende tegelek täze ýere geçirilýär, 
beýleki galan nokatlar boýunça üýtgedilende tegelek giňelýär ýa-da 
gysylýar.

Arc (дуга) ýönekeýde üç eljagaz: ahyrlarynda we merkezinde 
bellenilýär. Eljagazyň islendiginiň süýşürilmegi üç nokadyň esasynda 
täze halkanyň gurulmagyna getirer.

Ýarym çyzyk List (Список) buýrugyň maglumat sahypasynda 
iki at bilen görkezilip bilner: Lwpolyline, ýagny ykjam ýarym çyzyk, 
we Polyline, ýagny doly ýarym çyzyk. Ykjam ýarym çyzygy käwagt 
ýeňil diýip atlandyrýarlar. Eljagazlar ýarym çyzykda segmentleriň 
ahyrynda we halka segmentleriň ortaky nokatlarynda bellenilýär. 
Saýlanan eljagaz täze ýere geçirilende gönüçyzykly segmentler edil 
kesimleriň ahyrky nokatlary çekilende üýtgeýşi ýaly halka segment­
ler bolsa edil halkalaryň üýtgeýşi ýaly üýtgeýär.

Mline (мультилиния) eljagazlar arkaly edil ýarym çyzyklar ýaly 
üýtgeýär.

Text (текст) we Мтехт (мультитекст) tekstiň ýerleşişini we 
deňlemesini häsiýetlendirýän nokatlarda eljagazlara eýe bolýar­
lar. Eljagazyň islendigi teksti täze ýere süýşürmek üçin ulanylyp 
bilner. Deňlemegiň käbir usullarynda (Fit (По ширине), Aligned 
(Вписанный)) bir nokadyň hereketi şeýle hem tekstiň eňňitligini 
üýtgedip bilýär. Dimension (Размеры) menýusynyň buýruklary Di­
mension (размер), Leader (выноска) we Tolerance (допуск) ýö­
nekeýleri döredýär. Olaryň üýtgedilmegi islendik eljagaz boýunça 
amala aşyrylyp bilner, ol bolsa olaryň süýşürilmegine we görnüşiniň 
üýtgedilmegine getirer.

Emma ölçeg redaktirlenende eljagazlary diňe ölçegli ýönekeýde 
bellemän, eýsem obýektiň özünde hem bellemek gerek. Eger ölçegiň 
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çykaryş çyzygy berkidilen eljagazy syçanjyk bilen hereketlendirilse, 
onda diňe esasy obýektiň üýtgedilmegi bolman, onda ýönekeý ölçe­
giň üýtgedilmegi bolup geçýär.

Dimension diňe baza nokatlarynda eljagazlara eýe bolman, 
eýsem çykaryş çyzyklarda we ölçeg tekstinde hem olara eýe bolup 
durýar. Bu eljagazlar çykaryş çyzygyň we ölçeg tekstiň ýerleşişini 
üýtgetmäge kömek berýär.

Hatch (штриховка или заливка) eljagazlar arkaly redaktirlen­
mesi netijeli däl, sebäbi ştrihleme agyrlyk merkezinde bolan diňe bir 
eljagaza eýe we onuň bilen ştrihlemegi diňe täze ýere geçirip bolýar. 
Şol bir wagta hem ştrihlemegiň assosiatiwlilik häsiýetini ýada sal­
mak gerek. Şol boýunça suduryň redaktirlenmesi oňa bagly edilen 
ştrihlemegiň üýtgedilmegine getirer.

Ellipsiň we elliptik halkanyň eljagazlary dürli ýerlerde bellenil­
ýär. Doly ellipsde olaryň ýerleşişi tegelegiň eljagazlarynyň ýerleşişi­
ne meňzeş. Merkezi eljagaz hereketlendirilende tutuş ellips hereket­
lenýär. Eger elliptik halkanyň merkezi nokady süýşürilse, bu 
halkanyň üýtgedilmegine getirer, sebäbi AutoCAD halkanyň ahyrky 
nokatlaryny öňki ýerinde saklajak bolýar.

Spline (сплайн) eljagazlar arkaly redaktirlenmesi ýarym çy­
zygyň redaktirlenmesine meňzeş, emma bir eljagazyň hereketlenmesi 
splaýnyň beýleki böleklerine täsir edýär.

Eger eljagazlar arkaly Trace (полоса) redak­
tirlesek, onda ol figura öwrülýär. Edil şeýle Solid 
(фигура) redaktirlenýär.

Eljagazlar bilen redaktirlemede amatly gu­
ral bolup kontekst menýusy çykyş edýär. Eger re­
daktirlemek üçin eljagaz saýlanan bolsa hem-de 
syçanjygyň sag düwmejigi basylsa, onda aşakdaky 
kontekst menýu çykar.
• Enter – Enter düwmejigiň basylmagy (umumy 
redaktirleme buýruklaryň gaýtalanyş ýagdaýda 
saýlanmagy);
• Move (Перенести) – obýektleri geçirmek (Move 
(Перенести) buýrugy);
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• Mirror (Зеркало) – obýektleri simmetriýalamak (Mirror 
(Зеркало) buýrugy);
• Rotate (Повернуть) – obýektleri öwürmek (Rotate (По­
вернуть) buýrugy);
• Scale (Масштаб) – baza nokadyna göräleýin obýektleri 
masştablamak (команда Scale (Масштаб) buýrugy);
• Stretch (Растянуть) – obýektleri süýndürmek (Stretch (Рас­
тянуть) buýrugy);
• Base Point (Базовая точка) – Stretch (Растянуть) buýrugy 
ýerine ýetirmek üçin başga baza nokady görkezmek;
• Сору (Копировать) – obýektleri göçürip almak (Copy (Ко­
пировать) buýrugy);
• Reference (Ссылка) – Rotate (Повернуть) buýrugy üçin 
Reference (Опорный угол) opsiýasyny ýa-da Scale (Мас­
штаб) buýrugy üçin Reference (Опорный отрезок) opsiýa­
syny saýlamak;
• Undo (Отменить) – soňky buýrugyň hereketini ýatyrmak (U 
(О) buýrugy;
• Properties (Свойства) – obýektleriň häsiýetlerini dolandyr­
mak (Properties (Oкносв) buýrugy);
• Exit (Выход) – eljagazlar bilen redaktirlemek düzgüninden 
çykmaklyk.

Eger belli bir nokat saýlanmadyk bol­
sa we syçanjygyň sag düwmejigine basylsa 
başga kontekst menýu çagyrylar.

Bu menýunyň düzümi ondan öňki kon­
tekst menýunyňka meňzeşdir, emma onda 
Erase (Стереть) diýen we obýektleri ýok 
edýän bent emele geldi.

Ilkinji bolup kontekst menýusyna soňky 
buýrugyň gaýtalanyşy ýerleşdirilýär. Eger 
ýarym çyzyk saýlanylsa, onda bu menýuda 
goşmaça ikinji bent emele gelýär – Polyline 
Edit (Редактировать полилинию). Onuň 
emele gelmegi obýektiň görnüşi bilen ba­
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gly, sebäbi çylşyrymly obýektleriň redaktirlemegiň aýratyn buýruk­
lary bar.

Properties (Свойства) bendi Properties (Окносв) buýruga ga­
bat gelýär we häsiýetleriň üýtgeme penjiresini çagyrýar.

Deselect All (Отменить выбор) bendi eljagazlaryň görkezilme­
gini aýryp bilýär.

Beýleki bentler adatça işjeň buýruklar ýok mahaly syçanjygyň 
sag düwmejigi basylanda çykýan kontekst menýunyň düzümine gir­
ýär.

Quick Select (Быстрый выбор) bendi Qselect (Бвыбор) buýru­
gyna gabat gelýär we Quick Select (Быстрый выбор) gepleşik penji­
resini çagyrýar, ol bolsa has takyk ýagdaýda (reňk, çyzygyň görnüşi, 
gat boýunça we ş.m.) täze ýa-da häzirki toplanyşa girizmek ýa-da 
aýyrmak üçin obýektleri saýlap almagy tizleşdirýär.

Quick Select (Быстрый выбор) penjiresiniň düzümi obýekt­
leri saýlamagyň deňlemesini düzmegi mümkin edýär meselem, = 
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Equals (= Равно), <> Not Equal (<> Не равно), > Greater than (> 
Больше), < Less than (< Меньше), Select All (Выбрать все). Ge­
rek bolan amal Operator (Оператор) sanawynda goýulýar. Mundan 
başga hem aşaky meýdanlar ulanylýar:

• Apply to (Применить) – amaly nämä ulanmagy görkezýär 
(Entire drawing (К целому рисунку), Current selection (К 
текущему набору));
• Object type (Тип объектов) – obýektleriň görnüşiniň sa­
nawyny saklaýar (Line (Отрезок), Polyline (Полилиния) 
we ş.m.) tutuş suratyň ýa-da häzirki toplanyşyň; Multiple 
(Несколько) birnäçe ýönekeý görnüşleriň bellenilendigini 
görkezýär;
• Properties (Свойства) – saýlamagy amala aşyrmak mümkin 
bolan häsiýetleriň sanawyny saklaýar (Color (Цвет), Layer 
(Слой). Linetype (Тип линии), Linetype scale (Масштаб 
типа линии), Plot style (Стиль печати), Lineweight (Вес 
линии), Hyperlink (Гиперссылка)); eger häzirki toplanyşda 
obýektler bar bolsa, onda sanaw anyk görnüşli obýektleriň hä­
siýetlerini saklap biler (Area (Площадь), Closed (Замкнуто), 
Thickness (Высота), Global width (Глобальная ширина) 
we ş.m.);
• Value (Значение) – obýekteriň saýlanylmaly ähmiýetleri; 
ähmiýetleriň sanawy saýlanylan häsiýetiň görnüşine bagly 
(meselem, Color (Цвет) häsiýeti üçin bu reňkleriň sanawy).

How to apply (Отобранные объекты) töweregi Include in new 
selection set (Включить в новый набор) we Exclude from new 
selection set (Исключить из нового набора) geçirijiler arkaly şol 
deňleme bilen saýlanan obýektleri täze toplanyşa ýa goşmagy, ýa-da 
şol berlen ölçeg boýunça toplanyşdan aýyrmagy mümkin edýär. Döre­
dilýän toplanyşyň häzirki toplanyşa Append to current selection set 
(Добавить к текущему набору) baýdajygy gurnap goşmak mümkin.

Kontekst menýunyň indiki bendi Find (Найти) Find (Найти) 
buýrugyna gabat gelýär we Find and Replace (Найти и заменить) 
gepleşik penjiresini çagyrýar, ol bolsa ýönekeý tekstde setiri tapmagy 
(gerek bolsa çalşyrmagy) amala aşyrýar.
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Eger Command: (Команда:) buýrugyň soragyna obýektleri bel­
lesek, onda bu Select (Выбрать) buýrugyň ýerine ýetirilmegine geti­
rer. Buýrugyň özi klawiaturadan hem girizilip bilner:

Select objects: (Выберите объекты:), eger klawiaturada «?» 
belgisini ýazyp, soňra Enter basylsa aşakdaky ýazylar:

Expects a point or Window/Last/Crossing/BOX/ALL/ Fen­
ce/WPolygon/CPolygon/Group/Add/Remove/Multiple/Pre­
vious/Undo /Auto/SingleSelect objects: (Требуется точка или 
Рамка/’Последний /Секрамка /БОKС/Все/Линия/Рмн-угол/
Смн-угол/Труппа/Добавить/’Исключить /Несколько/Текущий/
Отменить/Авто/Единственный Выберите объекты:)

Opsiýalar:
• Window (Рамка) – soňra görkeziljek iki nokady ýerleşişine 
garamazdan adaty çägiň burçlary hökmünde hasaplamagy 
mümkin edýär;
• Last (Последний) – ekranda görünýänlerden iň soňky çyzy­
lan obýekti saýlamagy mümkin edýär;
• Crossing (Секрамка) – soňra görkeziljek iki nokady 
ýerleşişine garamazdan kesiş çägiň burçlary hökmünde hasap­
lamagy mümkin edýär;
• Box (Бокс) – çägiň burçlaryna baglylykda çägi adaty ýa-da 
kesiş görnüşine getirýän görkeziş düzgüne geçirýär;
• All (Все) – suratyň hemme doňdurylmadyk obýektlerini 
saýlaýar,
• Fence (Линия) – açyk ýarym çyzygy gurmagy mümkin edýär 
we toplanyşa şol çyzygyň kesişip geçen obýektleri goşulýar;
• WPolygon (РМн-угол) – köpburçlugyň görnüşinde çägi 
gurýar we onuň içine düşen obýektler saýlanylýar;
• CPolygon (СМн-угол) – kesiş çägine meňzeş emma köp­
burçluk görnüşinde;
• Group (Группа) – topary saýlaýar (öň Group (Группа) 
buýrugy bilen düzülen obýektleriň toplanyşyny);
• Add (Добавить) – toplanyşa obýekytleri goşmak düzgüne 
geçmekligi mümkin edýär;
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• Remove (Исключить) – obýektleri toplanyşdan aýyrmaklyk 
düzgüne geçmekligi mümkin edýär;
• Multiple (Несколько) – obýektleri reňk bilen bellemeýär we 
munuň bilen işi tizleşdirýär;
• Previous (Текущий) – toplanyş hökmünde AutoCAD tara­
pyndan öň düzülen toplanyşy almagy mümkin edýär;
• Undo (Отменить) – obýekti toplanyşa goşmagyň ýa-da 
aýyrmagyň soňky amalyny ýatyrýar;
• Auto (Авто) – awtomatiki saýlamagyň düzgüne geçirýär. 
Munda görkeziş nokatda obýekt görkezgije düşse, onda ol 
saýlanýar, başga ýagdaýda bolsa girizilen nokat adaty ýa-da 
kesiş çägiň birinji nokady bolup durýar;
• Single (Единственный) – diňe bir obýekti saýlaýyş düzgüne 
geçirýär, obýekt saýlanylsa amal tamamlanýar.

Group (Группа) buýrugy Object Grouping (Группы объектов) 
gepleşik penjiresini açýar.
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Umumy redaktirlemegiň buýruklary

Obýektleri redaktirlemegiň buýruklarynyň düwmejikleri (göçür­
me, geçirme, uzaltma we ş.m.) Modify (Редактирование) panelinde 
ýerleşdirilen.

Bu buýruklaryň her birini, klawiaturadan ady boýunça girizip 
bolýar, şeýle hem Modify (Редактирование) menýusyndan çagyryp 
bolýar. Bu toparyň köp buýruklary öňünden saýlanan obýektleriň 
toplanylyşy bilen işleýär ýa-da, eger şol toplanyş ýok bolanda Select 
objects (Выберите объекты) soragy berýärler. Galan buýruklar re­
daktirlenýän obýektleri degişli halatda soraýarlar.

Erase (Стереть) buýrugyna gabat gelýän  düwmejigi, ekran­
dan saýlanan obýektleri aýyrýar we olary suratdan ýok edýär.

Bu buýrugyň hereketiniň netijesi, edil beýleki buýrugyňky ýaly 
Standard (Стандартная) paneliniň  düwmejigi ýa-da U (О) we 
Undo (Отменить) buýruklar arkaly ýatyrylyp bilner.

Copy (Копировать) buýrugyň  düwmejigi saýlanan obýektle­
ri ilkinji we ahyrky nokatlar bilen kesgitlenýän wektora parallel edi­
lip göçürýär. Eger buýruk goýberilende saýlanan obýektler ýok bolsa, 
onda obýektleri saýlamak barada sorag berilýär. Obýektler saýlanan 
soňra saýlawy Enter, ýa-da syçanjygyň sag düwmejigi arkaly bes et­
meli. Obýektler saýlanan soňra birinji sorag:

Specify base point or displacement, or [Multiple]: (Базовая 
точка или перемещение, или (Несколько!:) Birinji nokady görkeziň. 
Indiki sorag:

Specify second point of displacement or <use first point 
as displacement: (Вторая точка перемещения или <считатъ 
перемещением первую точку>:)

Ikinji nokady görkeziň. Netijede saýlanan obýektleriň göçürmesi 
emele geler, ol nusgasyndan berlen wektora süýşürilen bolar.

Eger ikinji nokadyň deregine Enter düwmejigi basylsa, onda bi­
rinji girizilen nokadyň koordinatlary hereketlendirişiň koordinatlary 
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bolup durýar. Meselem, eger haýsy-da bolsa bir obýekti göçürmeli 
bolsa we göçürme nusga görä X oky boýunça 145 mm-e we У oky 
boýunça -3,75mm-e süýşürilmeli bolsa, onda birinji nokady girizmek 
boýunça soraga 145,-3.75 girizmeli. Soňra ikinji nokada bolan soraga 
Enter düwmejigi basyň.

Multiple (Несколько) opsiýasy saýlanan obýektleri köp ge­
zek göçürmek üçin niýetlenen. Buýrugyň tamamlanmagy Enter 
düwmejigiň we syçanjygyň sag düwmejigini bassaň buýruk tamam­
lanar.

Mirror (Зеркало) buýrugynyň  düwmejigi saýlanan obýekt­
leri iki nokat bilen kesgitlenýän oka görä simmetriýaly göçürmek 
üçin niýetlenen.

Obýektler saýlanandan soň AutoCAD soraýar:
Specify first point of mirror line: (Первая точка оси отра­

жения:)
Soňra jogapdan soň, ikinji nokat soralýar:
Specify second point of mirror line: (Вторая точка оси отра­

жения:)
Ikinji nokady görkeziň.
Mundan soň başlangyç obýektleri ýok etmeli ýa saklamaly bara­

da sorag berler:
Delete source objects? [Yes/No] <N>: (Удалить исходные 

объекты? [Да/Нет] <Н>:)
Bellik. Simmetriýalanýan obýektleriň arasynda tekstler bar bol-

sa, olar hem oka görä simmetriýalanylýar we käwagt okalmaýan ýag-
daýa gelýärler. Tekstler öwrülmez ýaly Mirrtext ulgam üýtgeýäni üçin 
0 bahany goýmaly.

 düwmejigi Offset (Подобие) buýrugyna gabat gelýär. Şeýle 
hem buýrugy Modify (Редакт) menýusyndan Offset (Подобие) ben­
di arkaly çagyryp bolýar.

Bu buýruk çyzykly obýektlere (kesimlere, şöhlelere, göni çyzyk­
lara, ýarym çyzyklara, halkalara, tegeleklere, ellipslere we splaýnlara) 
meňzeş (parallel) çyzyklary çyzmak üçin niýetlenen. Parallel çyzygy 
çyzmagyň iki görnüşi bar: nusgadan belli bir aralyk we berlen nokat­
dan çyzmak. Buýrugyň birinji soragy:
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Specify offset distance or [Through] <Through>: (Величина 
смещения или [Точка] < Точка >:)

Burçly ýaýyň içinde deslapdan bolan baha durandyr (öňki ýerine 
ýetirilen buýrukdan galan, ol položitel san ýa-da Through (Точка) 
opsiýanyň ady bolup biler.

Eger aralyk san bilen girizilende şeýle sorag berilýär:
Select object to offset or <exit>: (Выберите объект для 

создания подобных или <выход>:)
Bir obýekti görkeziň. Soňra AutoCAD obýektden haýsy tarapa 

parallel çyzygy gurmagy soraýar:
Specify point on side to offset: (Укажите точку, определяющую 

сторону смещения:)
Ekranda obýektden parallel çyzyk bilen bir tarapda ýerleşen is­

lendik nokady görkezmeklik ýeterlik.
Offset (Подобие) buýruk bilen işiň başynda Specify offset dis­

tance or [Through]: (Величина смещения или [Точка]:) soraga Т 
(Т) opsiýa saýlanylan bolsa, onda AutoCAD ilkibaşda soraýar:

Select object to offset or <exit>: (Выберите объект для 
создания подобных или <выход>:) we obýekt görkezilenden soň 
nokat soralýar: Specify through point: (Через точку:). Saýlanylan 
obýekte parallel çyzygyň geçmeli nokadyny görkezmeli.

Array (Массив) buýrugyň  düwmejigi şol bir obýektleriň 
göçürmeleriniň toparyny döretmek üçin niýetlenen, özem göçür­
meler belli bir tertip boýunça gönüburçly we tegelekli massiwiň 
öýjüklerinde ýerleşen. Buýrugy mundan başga hem, Modify (Pe-
дакт) menýusyndan Array (Массив) bendi arkaly çagyryp bolýar. 
Islendik ýagdaýda buýruk aşakdaky penjiräni çagyrýar. Penjiräniň 
düzümi iki sany geçirijiniň ýagdaýyna bagly: Rectangular Array 
(Прямоугольный массив) we Polar Array (Круговой массив).

Birinji ýagdaýda obýektleriň massiwiniň näçe setirden (Rows) 
we sütünden (Columns) durjakdygyny, obýektleri saýlamagy (Select 
objects), setirleriň arasyndaky (Rows offset), sütünleriň arasyndaky 
(Columns offset), massiwdäki elementleriň arasyndaky burçy (An­
gle of array) gurnamak bolýar.
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Ikinji ýagdaýda massiwiň tegeleginiň merkezi nokadynyň ko­
ordinatlaryny (Center point: X we Y), obýektleriň sanyny (Total 
number of items), obýektleri saýlamagy (Select objects), tegelegiň 
burç boýunça uzynlygyna obýektleriň ýerleşişini (Angle to fill), 
obýektleriň tegelegiň ugry boýunça öwrülmegini (Rotated items as 
copied) we b. gurnamak bolýar.

 düwmejigi Move (Перенести) buýruga gabat gelýär, ol saýla­
nan obýektleri iki nokat bilen berlen wektora parallel edip geçirmegi 
mümkin edýär. Buýrugy şeýle hem, Modify (Pe-дакт) menýusyndan 
Move (Перенести) bendi arkaly çagyryp bolýar. Bu buýrugyň so­
raglary we amallary Copy (Копировать) buýrugyňka meňzeşdir. 
Obýektler saýlanylandan soň birinji sorag:

Specify base point or displacement: (Базовая точка или 
перемещение:)

Birinji nokady görkeziň. Indiki sorag:
Specify second point of displacement or <use first point 

as displacement: (Вторая точка перемещения или < считатъ 
перемещением первую точку >:)

Hereketlendiriş wektoryň ikinji nokadyny görkeziň. Eger mu­
nuň deregine Enter basylsa, onda birinji nokadyň koordinatalary 
hereketlendiriş koordinatalary hökmünde seredilýär.

Rotate (Повернуть) buýrugyň  düwmejigi saýlanan obýektle­
ri baza nokadyna görä berlen burça öwürmegi mümkin edýär. Buýru­
gy şeýle hem, Modify (Редакт) menýusyndan Rotate (Повернуть) 
bendi arkaly çagyryp bolýar.

Ilkibaşda buýruk burçlary ölçemegiň düzgünleri barada habar 
berýär:

Current positive angle in UCS: ANGDIR=counterclockwise 
ANGBASE=0 (Текущие установки отсчета углов в ПСК: 
ANGDIR=против ч/с ANGBASE=0)

Obýektler saýlanylandan soň birinji sorag:
Specify base point: (Базовая точка:) Öwrüliş ýerine ýetiriljek 

baza nokady görkeziň. Soňra: Specify rotation angle or [Referen­
ce]: (Угол поворота или {Опорный угол]:). Burçy klawiaturadan 
girizip ýa-da syçanjyk arkaly görkeziň
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Burçy girizmegiň deregine burçy Reference (Опорный угол) 
opsiýasy arkaly mümkin. Meselem, içinde kesim bolan üçburçlugy 
1 nokada göräleýin üçburçlugyň 1 we 2 nokat bilen belgilenen sag 
tarapy kese bolar ýaly öwürmeklik gerek.

Select objects: (Выберите объекты:) soraga syçanjyk arkaly 
üçburçlugy we kesimi belläp saýlaň we Enter basyň. Base po­
int: (Базовая точка:) soraga obýekt baglaşdyrma arkaly 1 nokady 
belläň. Specify rotation angle or [Reference]: (Угол поворота или 
[Опорный угол]:) soraga jogap hökmünde R (О) opsiýasyny saýlaň. 
Şu sorag berler:
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Specify the reference angle <0>: (Опорный угол <0>:) Burçy 
iki nokat arkaly görkezmek usuly saýlalyň. 1 nokady görkeziň we 
Specify the second point: (Вторая точка:) soraga 2 nokady görkeziň. 
Başlangyç burç şeýlelik bilen kesgitlenen bolup durýar. Soňra Auto­
CAD soraýar:

Specify the new angle: (Новый угол:). Täze burç hökmünde 
klawiaturadan 0 girizmeli. Üçburçluk keselik ýagdaýyna çenli öwrü­
ler.

Scale (Масштаб) buýrugyna gabat gelýän  düwmejigi saýla­
nan obýektleri baza nokadyna göräleýin masştablamagy (ýagny ulalt­
magy ýa-da kiçeltmegi) mümkin edýär. Şeýle hem buýrugy Modify 
(Редакт) menýusyndan Scale (Масштаб) bendi arkaly çagyryp bolýar.

Scale (Масштаб) buýrugy obýektler saýlanylandan soň soraýar: 
Specify base point: (Базовая точка:) Baza nokadyny görkeziň. 
Soňra:

Specify scale factor or [Reference]: (Масштаб или /Опорный 
отрезок]:)

Obýektleri ulaltmak üçin 1-den uly sany girizmeli, kiçeltmek 
üçin – 1-den kiçi bolan položitel sany girizmeli. Eger masştablamagy 
drob esse ýerine ýetirmeli bolsa (meselem, 3/7), onda Referen­
ce (Опорный отрезок) opsiýasyndan peýdalanmaly. Bu opsiýanyň 
saýlanmagyna AutoCAD şu soragy berýär:

Specify reference length <1>: (Длина опорного отрезка <!>:)
7-lik sany giriziň. Specify new length: (Новая длина:)
3 giriziň we ulgam gerek bolan özgermäni ýerine ýetirer (özgeriş 

koeffisiýenti ikinji uzynlygyň birinjä bölünmegi hökmünde hasapla­
nylar).

Stretch (Растянуть) buýrugy, Modify (Редактирование) pa­
neliniň  düwmejigi gabat gelýär, obýektiň formasyny süýndüriş 
arkaly üýtgetmäge niýetlenen. Buýrugy şeýle hem Modify (Редакт) 
menýusyndan Stretch (Растянуть) bendi arkaly çagyryp bolýar.

Buýruk adatça ýarym çyzygyň üstünden ýerine ýetirilýär (emma 
welin ol halkalary, elliptik halkalary, splaýnlary we beýleki çyzykly 
süýndürip bilýär, onuň käbir depelerini iki nokat bilen berilýän wek­
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tora parallel edip süýşürip, obýektiň geometriýasyny üýtgedip bolýar. 
Buýrugyň birinji soragy:

Select objects to stretch by crossing-window or crossing-poly­
gon... Select objects: (Выберите растягиваемые объекты секущей 
рамкой или секущим многоугольником...Выберите объекты:)

Aşaky suratda gönüburçluk şekilindäki ýarym çyzyk görkezilen, 
onuň iki çep depesini süýşürmek gerek.

Gönüburçlugy kesiş çäg bilen saýlaň, emma çägiň içinde 
gönüburçlugyň diňe çep depeleri düşer ýaly bellemeli, soňra Enter 
basyň. Soňra birinji nokat barada sorag berilýär:

Specify base point or displacement: (Базовая точка или 
перемещение:) Birinji nokady görkeziň: Specify second point of 
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displacement or <use first point as displacement>: (Вторая точка 
перемещения или <считать перемещением первую точку >:) 
Hereketlendiriş wektoryň ikinji nokadyny görkeziň.

Buýrugyň ýerine ýetirilişiniň netijesinde ýarym çyzygyň çägiň 
içine düşmedik depeleri öňki ýerlerinde galdy, kesiş çägi bilen belle­
nilen depeler bolsa görkezilen wektora parallel süýşýärler.

Lengthen (Увеличить) buýrugy, Modify (Редакт) menýusynyň 
Lengthen (Увеличить) bendi gabat gelýär, ol kesimleri, halkalary 
we ýarym çyzygyň ahyrky segmentlerini berlen ululyga ulaldýar 
(uzynlygyň ýa-da burç birliginde).
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Buýrugyň birinji soragy: Select an object or [DElta/Percent/
Total/DYnamic]: (Выберите объект или /Дельта/Процент/Всего/
Динамика]:)

Eger şu ýagdaýda obýekti saýlasak, onda AutoCAD onuň şol 
wagtky parametrlerini görkezýär, (kesim ýa-da ýarym çyzygyň seg­
menti üçin – uzynlygy, halka üçin bolsa – uzynlygy ýa-da merkezi 
burçy). Buýrugyň opsiýasy:

• Delta (Дельта) – uzaltmagyň ululygy görkezilýär (san ar­
kaly);
• Percent (Процент) – öňki uzynlykdan göterimde täze uzyn­
lyk görkezilýär:
• Total (Всего) – täze doly uzynlyk çyzykly we burç birlikler­
de görkezilýär;
• Dynamic (Динамика) – uzaltmagyň ululygy dinamiki ýag­
daýda görkezilýär, ýagny bir nokady syçanjyk arkaly gör­
kezmek arkaly, indiki görkezilen nokada çenli aralyk bolsa 
uzaltmagyň ululygy bolup durýar.

Delta (Дельта) opsiýasy ýagdaýynda AutoCAD soraýar:
Enter delta length or [Angle] <0.0000>: Приращение длины 

или [Угол/ <0.0000>:)
Muňa Siz goşmaça uzaltmagyň ululygyny millimetrde görkez­

ýärsiňiz (položitel san bilen) eger uzynlyk uzaldylanda we otrisatel 
eger kiçeldilende, AutoCAD ulgamy indiki soragy berýär:

Select an object to change or [Undo]: Выберите объект для 
изменения или [Отменить]:

Eger obýekt görkezilse, ol üýtgeýär (uzalýar ýa-da kiçelýär), 
özem obýekt görkezilende bellenilen nokada golaý bolan uçdan 
başlanýar.

Eger uzynlygyň goşmaça uzaldylmagyna Angle (Угол) opsiýasy 
saýlanylsa, onda ulgam burçuň goşmaça uzaldylmagyny sorar:

Enter delta angle: (Введите приращение угла:)
Goşmaça ulaltmagyň ululygyny giriziň (ol otrisatel hem bolup 

biler) we indiki soraga jogap hökmünde üýtgedilýän obýekti saýlaň.
Lengthen (Увеличить) buýrugyň beýleki opsiýalary hem 

meňzeşräk işleýärler.
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 düwmejigi Trim (Обрезать) buýrugyna gabat gelýär, bu 
buýruk ony kesip geçýän beýleki obýektler arkaly kesip aýyrmagy we 
ony gerekli obýekte çenli uzaltmagy mümkin edýär. Buýrugy şeýle 
hem Modify (Редакт) menýusynyň Trim (Обрезать) bendi arkaly 
çagyryp bolýar. Birinji sorag:

Current settings: Projection = UCS Edge = None Select cut­
ting edges... Select objects: (Текущие установки: Проекция = 
ПСК Кромки = Без продолжения Выберите режущие кромки... 
Выберите объекты:)

Bu habaryň birinji setirinde buýrugyň şol wagtky parametrleri 
görkezilen, olar gerek bolan halatda üýtgedilip bilner.

Obýektleri görkezmegiň tertibi bu ýagdaýda örän wajyp. 
Ilkibaşda «kesiji erňekleri» görkezmeli – biziň mysalymyzda bu bir 
kesime deň. Kesiji obýektleriň saýlanylmagynyň soňy – bu Enter 
düwmejiginiň basylmagy. Indiki sorag: Select object to trim or shift-
select to extend or [Project/Edge/Undo]: (Выберите обрезаемый 
объект или с клавишей <Shift> выберите удлиняемый объект или 
[Проекция/Кромка/Отменить]:)

Bu soraga jogap hökmünde kesilmeli obýektleri görkeziň (bu 
mysalda – agzalan kesim arkaly), emma şonda obýektleri edil aýryl­
magy böleginde görkezmeli. Kesilýän obýektleri görkezmegiň dere­
gine görkezmeleri üýtgetmek ýa-da öňki hereketi ýatyrmak mümkin. 
Project (Проекция) opsiýasy saýlanylsa AutoCAD teklip edýär:

Enter a projection option [None/Ucs/View] <Ucs>: (Задайте 
опцию проецирования [Нет/Пск/Вид] <Пск>:) Saýlamak üçin 
hödürlenýän opsiýalar, kesmeklik diňe kesiji erňekler arkaly ama­
la aşyrylman, eýsem olaryň proýeksiýalary arkaly amala aşyrylyp 
bilner, proýesirlemegiň usuly bolsa ýa koordinatalaryň häzirki ul­
gamynda (Ucs (Пек) opsiýasy), ýa-da häzirki görnüş boýunça (View 
(Вид) opsiýasy). None (Нет) opsiýasy proýeksiýasynda kesmekligiň 
mümkinligini aýyrýar (ýagny kesiji we kesilýän obýektler bir tekiz­
likde ýerleşmeli bolýar).

Edge (Кромка) opsiýasy saýlanylsa şu sorag berler:
Enter an implied edge extension mode [Extend/No extend] 

<No extend >: (Режим продолжения кромки до воображаемого 
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пересечения [С продолжением/ Без продолжения] <Без продол­
жения>:)

Bu ýerde kesiji erňekleriň dowamlyklary amalda çykyş edýänli­
gi kesgitlenýär. Extend (С продолжением) düzgüni saýlanylsa kes­
meklik diňe saýlanylan kesiji erňekler arkaly däl-de, eýsem olaryň 
dowamlyklary arkaly amala aşyrylýar.

Extend (Удлинить) buýrugy, muňa  düwmejigi gabat gelýär 
«araçäkli erňekleriň» toplanylyşyny saýlamagy mümkin edýär, soňra 
bolsa şol erňeklere çenli uzalýan obýektleri görkezýär. Buýrugy şeýle 
hem Modify (Редакт) menýusyndan Extend (Удлинить) bendi ar­
kaly çagyrmak mümkin. Obýektleriň görkezilmeginiň yzygiderliligi 
örän wajyp, sebäbi ulgam araçäkli we uzaldylýan obýektleri tapawut­
landyrmalydyr.

Birinji habar hereket edýän düzgünler barada (düzgünler Trim 
(Обрезать)) buýrugy bilen umumylaşdyrylan we özlerine çenli uzalt­
maklyk amalyny ýerine ýetirmeli araçäkli erňekleri görkezmeli:

Current settings: Projection = UCS Edge = None Select boun­
dary edges... Select objects: (Текущие установки: Проекция = 
ПСК Кромки = Без продолжения Выберите граничные кромки... 
Выберите объекты:)

Araçäkli erňekleriň toplanylyşyny düzmeli obýektleri saýlamaly 
we olaryň saýlanylmagyny Enter düwmejigi arkaly tamamlaň. Soňra:

Select object to extend or shift-select to trim or [Project/Edge/
Undo]: (Выберите удлиняемый объект или с клавишей <Shift> 
выберите обрезаемый объект или [Проекция/Кромка/Отменить]:)

Şol araçäkli erňekleriň toplanylyşyna çenli uzadylmaly obýektle­
ri görkeziň, özem her bir uzaldylýan obýektiň görkeziş nokady uzadyl­
magy amala aşyryljak tarapyň ahyryna golaý bolan bolmalydyr.

Break (Разорвать) buýrugy iki görkezilen nokatda obýekti üz­
mek üçin niýetlenen. Buýrugy şeýle hem Modify (Редакт) menýu­
syndan Break (Разорвать) bendi arkaly çagyrmak mümkin. Mundan 
başga hem, oňa Modify (Редактирование) panelinde iki düwmejik 
gabat gelýär.  düwmejigi Break (Разорвать) buýrugy iň umumy 
ýagdaýynda çagyrýar.

Buýrugyň birinji soragy: Select object: (Выберите объект:)
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Obýekti görkeziň, deslapdan obýekti görkezen nokadyňyz 
üzülmegiň birinji nokady bolar. Soňra:

Specify second break point or [First point]: (Вторая тонка 
разрыва или [Первая точка]:) Eger obýekti görkezen nokadyňyz bi­
rinji nokat bolmaly däl bolsa, onda degişli opsiýany saýlap gaýtadan 
birinji nokady görkeziň. Soňra Enter basyp ikinji nokady görkezeliň.

Modify (Редактирование) paneliniň  Break at Point 
(Разорвать в точке) düwmejigi birinji we ikinji üzme nokatlaryň ga­
bat gelýän ýagdaýyny mümkin edýär, emma obýekti görkeziş nokady 
üzme nokady bolup bilmeýär.
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 düwmejigi Chamfer (Фаска) buýrugy amala aşyrýar, ol 
iki sany kesişýän gönüburçly segmentleri (kesimleri, şöhleleri, göni 
çyzyklary) olaryň kesişýän nokadyndan belli bir aralykda kesme 
amalyny (faska almagy) ýerine ýetirýär, şonda ol kesilýän ýerleriň 
nokatlaryny birikdirýän kesimi çyzýar. Buýrugy mundan başga hem 
Modify (Редакт) menýusyndan Chamfer (Фаска) bendi arkaly ça­
gyryp bolýar. Buýruk hem kesişýän, hem-de kesişmeýän, emma paral­
lel däl kesimleriň üstünden ýerine ýetirilýär (şonda kesimler ilkibaşda 
kesişýänçä uzaldylýar).

Chamfer (Фаска) buýrugy ilkibaşda düzgünleriň häzirki ýag­
daýyny habar berýär, soňra bolsa obýekti saýlamak barada sorag 
berýär:

(TRIMmode) Current chamfer DistJ = 0.0000, Dist2 = 0.0000 
Select first line or [Polyline/Distance/Angle/Trim/Method/mUlti­
ple]: ((Режим С ОБРЕЗКОЙ) Параметры фаски: Длина! = 0.0000, 
Длина2 = 0.0000 Выберите первый отрезок или /Полилиния/
Длина/Угол/Обрезка/Метод/Много]:)

Eger faskanyň hereket edýän parametrlerini üýtgetmeklik gerek 
däl bolsa, onda gönümel birinji obýekti görkezmeklige geçmek bol­
ýar. Emma köplenç faskalaryň zerur bolan uzynlygyny goýmak gerek 
bolýar. Ol Distance (Длина) opsiýasy arkaly amala aşyrylýar, ol öz 
soragyny berýär:

Specify first chamfer distance <0.0000>: (Первая длина 
фаски <0.0000>:)

Birinji uzynlygy görkezeliň – meselem, 75 mm. Soňra:
Specify second chamfer distance <75.0000>: (Вторая длина 

фаски <75.0000>:)
Ikinji uzynlygy giriziň – meselem, ýene bir gezek 75 mm. Soňra:
Select first line or [Polyline/Distance/Angle/Trim/Method/

Multiple]: (Выберите первый отрезок или {Полилиния/Длина/
Угол/Обрезка/Метод/ Много]:) Birinji kesimi bellemek gerek. 
AutoCAD şonda soraýar: Select second line: (Выберите второй 
отрезок:) Ikinji kesilýän obýekti görkeziň. Eger ilkibaşda Multi­
ple (Много) opsiýasy ulanylsa, birinji faska gurlandan soň Cham­
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fer (Фаска) öz işini tamamlamaýar, gaýtalanyş bilen redaktirlenýän 
obýektleriň nobatdaky taýyny.

Trim (Обрезка) opsiýasy sorag berýär: Enter Trim mode op­
tion [Trim/No trim] <Trim>: (Режим обрезки [С обрезкой/Без 
обрезки] <С обрезкой>:) Bu halatda iki düzgüniň birini saýlamaly. 
Adaty düzgün – Trim (С обрезкой). No trim (Без обрезки) düzgü­
ni saýlanylsa goşmaça kesim gurlup, başlangyç segmentler ýok edil­
meýär.

Düzgüni goýmaklyk indiki Fillet (Сопряжение) buýrugyna hem 
degişli bolýar. Buýrugyň beýleki opsiýasy Method (Метод). Bu ýag­
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daýda şu sorag berilýär: Enter trim method [Distance/Angle] <Dis­
tance>: (Метод построения [Длина/Угол/ <ДлинаУ:)

Buýruk faskanyň iki usuly arkaly alynýar. Birinji – Distance 
(Длина) opsiýasy berlende, onda kesimlerden alynýan iki uzynlyk 
görkezilýär. Ikinji – Angle (Угол) opsiýasy ulanylanda, şonda uzynlyk 
we burç görkezilýär, onuň aşagynda faskanyň goşmaça kesimi birin­
ji segmente göräleýin gurulýar. Iki usulyň görkezmelerini AutoCAD 
Chamfera, Chamferb (Distance (Длина) usuly) we Chamferc, 
Chamferd (Angle (Угол) usuly) ulgam üýtgeýänlerde saklaýar.

Fillet (Сопряжение) buýrugy obýektleri berlen radiusly halka 
arkaly baglaşdyrýar (meselem, kesimleri, halkalary we tegelekleri). 
Oňa Modify (Редактирование) paneliniň  düwmejigi we Modi­
fy (Редакт) menýusynyň Fillet (Сопряжение) bendi gabat gelýär. 
Buýruk düzgünleri boýunça Chamfer (Фаска) buýrugyna meňzeş.

Buýruk tarapyndan berilýän birinji habar şol wagtky sazlamalar 
barada maglumaty we aşakdaky soragy saklaýar:

Current settings: Mode = TRIM, Radius = 0.0000 Select first 
object or [Polyline/Radius/Trim/Multiple]: (Текущие настройки: 
Режим = С ОБРЕЗКОЙ, Радиус сопряжения = 0.0000 Выберите 
первый объект или [Полилиния/Радиус/Обрезка/Много]:)

Radius (Радиус) opsiýasy degişli sorag berlenden soň bag­
laşdyrmagy / şol wagtky ähmiýetini üýtgetmegi mümkin edýär:

Specify fillet radius < 0.0000 >: (Радиус сопряжения 
<0.0000>:)

Radiusyň ululugy goýlandan soň gaýtadan şu sorag berilýär: Se­
lect first object or [Polyline/Radius/Trim/Multiple]: (Выберите 
первый объект или [Полилиния/Радиус/Обрезка/Много]:).

Eger şol wagtky sazlamalar sizi kanagatlandyrýan bolsa, birin­
ji obýekti baglaşdyrmak üçin belläň. Soňra: Select second object: 
(Выберите второй объект:)

Ikinji obýekt görkezilende, AutoCAD ýa gerek bolan halkany 
gurar ýa-da berlen radius bilen baglaşdyrmagyň mümkin däldigi ba­
rada habar berýär. Baglaşdyrýan obýektler hökmünde ýarym çyzygyň 
goňşy bölekleri bolup durýan ýa-da bir segment bilen aýry edilen iki 
bölegi hem çykyş edip bilýär.
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Multiple (Много) opsiýasy obýektleriň gaýtalanyş ýagdaýda 
baglaşdyrmagyny amala aşyrýar. Polyline (Полилиния) opsiýasy 
berlen radius arkaly bir ýarym çyzygyň hemme depesini tegelemegi 
mümkin edýär.

Modify (Редактирование) paneliniň iň soňky  düwmejigi Ex­
plode (Расчленить) buýrugyna gabat gelýär, bu buýruk öňki bölüm­
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de seredilipdi ol has ýönekeý obýektlere ýarym çyzyklary, bloklaryň 
girişlerini, ölçegleri we beýleki çylşyrymly obýektleri bölýärler.

Ýarym çyzyklary redaktirlemek
Iki ölçegli ýarym çyzyklaryň ýörite redaktirlenmesi Pedit 

(Полред) buýrugy arkaly ýerine ýetirilýär, oňa Modify II (Редакти­
рование-2) paneliniň  düwmejigi we Modify > Object > Polyline 
(Редакт Объекты > Полилиния) menýusy gabat gelýär.

Şu soraga ýarym çyzyk saýla­
nylandan soňra Select polyline or 
[Multiple]: (Укажите полилинию 
или [Несколько]:) AutoCAD 
aşakdaky opsiýalaryň sanawyny berýär

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/
Decurve/Ltype gen/Undo]: (Задайте опцию [Замкнуть /Добавить 
/Ширина /Вершина /Сгладить /Сплайн /Убрать сглаживание/Тип­
лин/Отменить]:)

Buýrugyň opsiýalary:
• Close (Замкнуть) – ýapylmadyk (açyk) ýarym çyzygy ýap­
ýar; eger ýapyk ýarym çyzyk bellenilen bolsa, onuň deregine 
Open (Разомкнуть) opsiýasy emele geler;
• Join (Добавить) – ýarym çyzyga täze segmentleri goşýar;
• Width (Ширина) – ýarym çyzygyň hemme segmentleriniň 
inini täze ähmiýete üýtgedýär;
• Edit vertex (Вершина) – ýarym çyzygyň depelerini redak­
tirlemek düzgünine geçýär (depeleriň ýerini üýtgetme, depele­
ri şok etme, depeleri goşmak, aýry segmentleriň inini üýtget­
mek we ş.m.);
• Fit (Сгладить) – halka segmentler arkaly ýarym çyzygy düz­
leýär;
• Spline (Сплайн) – ýörite deňleme boýunça ýarym çyzygyň 
başlangyç we ahyrky nokadyndan splaýny geçirýär;
• Decurve (Убрать сглаживание) – Fit (Сгладить) we Spli­
ne (Сплайн) opsiýalar bilen ýerine ýetirilen tekizlenmegi 
aýyrýar;
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• Ltype gen (Типлин) – çyzygyň görnüşini gurmagy do­
landyrýar (segmentler üçin aýratynlykda ýa-da tutuş ýarym 
çyzyk boýunça);
• Undo (Отменить) – soňky amaly ýatyrýar.

Mundan başga hem Enter düwmejigiň basylmagy (opsiýa 
saýlamaklygyň deregine) Pedit (Полред) buýrugyny tamamlaýar.

Iň çylşyrymly opsiýa – Edit vertex (Вершина), ol ýarym 
çyzygyň depeleri bilen işlemek düzgüni çagyrýar, bu bolsa depeleriň 
ýerleşişini üýtgetmegi, olary ýok etmegi, goşmagy, şeýle hem belli 
bir segmentiň inini üýtgetmegi we ýarym çyzygy böleklere bölmegi 
amala aşyrýar. Bu opsiýa saýlanylandan soň AutoCAD sorag berýär:

Enter a vertex editing option [Next/Previous/Break/ lnsert/
Move/Regen/Straighten/Tangent/Width/Exit] <N>: Задайте 
опцию редактирования вершины След/ Пред/ Разорвать/ 
Вставитъ/ Перенести/ Реген/ Выпрямитъ/ Касателъная/ Ширина/ 
Выход] <С>:) Şonda ýarym çyzygyň birinji depesinde х belgisi eme­
le gelýär, bu bolsa şol wagtky ulanylýan depäniň belgisini aňladýar. 
Depeleriň yzygiderliginiň tertibi ýarym çyzyk çyzylanda olaryň 
döreýiş yzygiderligine gabat gelýär.

Bu düzgünde şu opsiýalar elýeterli:
• Next (След) – indiki depä geçmeklik;
• Previous (Пред) – ondan öňki depä geçmeklik;
• Break (Разорвать) – şol wagtky ulanylýan depeden başlap 
ýarym çyzygy üzmeli;
• Insert (Вставить) – şol wagtky ulanylýanyndan soň täze de­
päni goşmaklyk;
• Move (Перенести) – şol wagtky ulanylýan depäni täze ýere 
geçirmek;
• Regen (Реген) – şol wagtky görkezmeler bilen ýarym çyzygy 
regenerirlemek (gaýtadan çyzmak);
• Straighten (Выпрямить) – şol wagtky depeden başlap meý­
dançada ýarym çyzygy göneltmek (goňşy depeleri ýok etmek­
lik);
• Tangent (Касательная) – şol wagtky ulanylýan depä galtaşyş 
çyzygyň ugruny geljekde ýerine ýetiriljek Fit (Сгладить) 
amaly üçin bellemek;
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• Width (Ширина) – şol wagtky ulanylýan depede başlanýan 
meýdançada ýarym çyzygyň inini bellemek;
• Exit (Выход) – depeleri redaktirleme düzgüninden çyk­
mak we gaýtadan ilkinji soraga gaýtmaklyk: Enter an option 
[Close/Join/Width/Edil vertex/Fit/Spline/Decurve/Ltype 
gen/Undo]: (Задайте опцию [Замкнуть/Добавить/Ширина/
Вершина/Сгладить/Сплайн/ Убрать сглаживание/Типлин/
Отменить]:).

Break (Разорвать) opsiýasy saýlanylanda, üzülmegiň birinji no­
kady hökmünde şol wagtky ulanylýan depe hasaplanylýar, üzülmegiň 
soňuny bolsa şu soraga jogap hökmünde görkezmeli:

Enter an option [Next/Previous/Go/Exit] <N>: (Задайте 
опцию [След/Пред/Выполнить/Выход] <С>:)

Eger üzmegi şol wagtky depede amala aşyrmak gerek bolsa 
(mundan soň ýarym çyzyk üzüliş ýerine umumy nokada eýe bolan iki 
sany ýarym çyzyga eýe bolýar), onda Go (Выполнить) opsiýasyny 
ulanmaly.

Eger üzmegi şol wagtky ulanylýan depede başlap başgasynda gu­
tarmaly bolsa (we şonuň bilen olaryň arasyndaky meýdançalary ýok 
etmeklik üçin), onda Break (Разорвать) düzgüninde Next (След) 
we Previous (Пред) opsiýalary arkaly ikinji depä geçmegi amala 
aşyrmaly we ondan soň Go (Выполнить) opsiýasyny ulanmaly. Re­
daktirlenme düzgüni gerek bolmasa Exit (Выход) opsiýasyny ulan­
maly.

Ýarym çyzyga täze depäni goşmak üçin Insert (Вставить) op­
siýasyny peýdalanmaly. Bu opsiýa geçmezden öň yzyndan täze depe 
goşulmaly depä geçmeli. Soňra Insert (Вставить) amalyny ulanmaly. 
AutoCAD soraýar:

Specify location for new vertex: (Положение новой вершины:)
Bu ýerde täze depäniň ýerleşmeli ýerini görkezmeli.
Bu opsiýa arkaly ýarym çyzygyň depesiniň öňünden depäni goş­

maklyk mümkin däl.
Move (Перенести) opsiýasy şol wagtky ulanylýan depäni täze 

ýere geçirmeklik zerur bolanda ulanylýar. Opsiýa ulanylanda sorag be­
rilýär: Specify new location for marked vertex: (Новое положение 
помеченной вершины:) Şol depäniň ýerleşmeli ýerini görkezmeli.
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Regen (Реген) opsiýasy Pedit (Полред) buýrugyndan çykman, 
şol wagtky üýtgetmeler bilen ýarym çyzygy täzeden çyzmaklygy 
amala aşyrýar.

Eger ýarym çyzykdan käbir depeleri ýok etmek gerek bolsa, 
onda Straighten (Выпрямить) opsiýasyny ulanmaly. Bu opsiýa ta­
rapyndan berilýän sorag Break (Разорвать) opsiýasynyň berýän 
soragyna meňzeş: Enter an option [Next/Previous/Go/eXit] <N>: 
(Задайте опцию [След /Пред /Выполнить /выХод] <С>:).

Bu opsiýa arkaly şol wagtky ulanylýan depeden başlanýan 
hem-de Next (След) we Previous (Пред) opsiýalary bilen geçip 
bolýan depe bilen tamamlanýan meýdançany göneldip bolýar. Go 
(Выполнить) opsiýasy göneltme amalyny tamamlaýar.

Tangent (Касательная) opsiýasy geljekde ýerine ýetirilip bil­
jek Fit (Сгладить) amaly üçin ýarym çyzygyň depelerinde galtaşma 
çyrygyň ugruny bellemegi mümkin edýär, bu bolsa tekizlenmeden 
soň alynýan çyzygyň görnüşine täsir etmegi mümkin edýär. Tangent 
(Касательная) opsiýasy saýlanylandan soň sorag berilýär:

Specify direction of vertex tangent: (Направление касатель­
ной в вершине:) Ugur burç bilen ýa-da nokat bilen berilýär. Berlen­
den soň şol wagtky ulanylýan depede görkezilen ugur bilen ok emele 
gelýär. Ugur Fit (Сгладить) opsiýasy peýdalanylanda ulanylar.

Width (Ширина) opsiýasy şol wagtky ulanylýan depeden baş­
lanýan meýdançada ýarym çyzygyň inini dolandyrýar. Birinji sorag:

Specify starting width for next segment: (Начальная ширина 
следующего сегмента:)

Başlangyç ini bellemeli (adatça klawiatura arkaly). Eger bu ýag­
daýda syçanjyk bilen nokat görkezilse, onda AutoCAD ikinji nokady 
sorar. Soňra:

Specify ending width for next segment <0.0000>: (Конечная 
ширина следующего сегмента <0.0000>:)

Burç ýaýynda deslapdan segmentiň başlangyç ini hökmünde al­
nan ähmiýet ýerleşdirilen. Ikinji in girizilenden soň ýarym çyzygyň 
şol wagtky ulanylýan segmenti täze in bilen çyzylýar.

Multiple (Несколько) opsiýasy ýarym çyzygy saýlamak bara­
da berilýän iň ilkinji soragda elýeterli bolup durýar we üstlerinden 
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bir kysymly amallary (meselem, ýapmak ýa-da global ini üýtgetmek) 
ýerine ýetirmek üçin bir wagtda birnäçe ýarym çyzygy saýlamaga 
mümkinçilik berýär. Bu opsiýa saýlanylanda Edit vertex (Вершина) 
opsiýasyny elýeterli däldigini göz öňünde tutmak gerek.

Multiçyzyklary redaktirlemek
Multiçyzyk – çylşyrymly obýekt we ony redaktirlemek üçin 

Mledit (Млред) ýörite buýrugy bar, oňa Modify > Object > Multiline 
(Редакт > Объект > Мультилиния) menýunyň bendi laýyk gelýär.

Mledit (Млред) buýrugy Multiline Edit Tools (Редактирование 
мультилиний) penjiräni çagyrýar. Bu penjiräni çagyrmaklygyň ýene 
bir usuly – multiçyzyk boýunça syçanjygyň çep düwmejigi bilen iki 
gezek basmaly (şonda suratda başga obýektler bellenilmeli däl).

Bu penjirede 12 amalyň düwmejikleri bar. Penjiräniň birinji 
sütüninde iki multiçyzygyň kesişmesini işläp bejermegiň düwmejik­
leri, ikinjisinde – bir multiçyzygyň beýlekisiniň ýanynda tamamlan­
magyny gurnamagyň düwmejikleri, üçünjide – iki multiçyzygyň burç 
bilen kesişmesini ýa-da bir multiçyzygyň burç bilen işläp bejermegiň 
(şeýle hem depeler bilen amallaryň) düwmejikleri we dördünjide – 
üzmeleriň amallary ýerleşen. Bu amallary her sütünde ýokardan aşak 
seredeliň.

Closed Cross (Закрытый крест) amaly (degişli düwme ) 
soraýar: Select first mline: (Выберите первую мультилинию:)
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Eger suratda iki sany kesişýän multiçyzyk bar bolsa, onda beýleki 
çyzyk bilen üsti ýapyljak multiçyzygy ilkinji görkezmeli syçanjygyň 
nyşany saýlanylan multiçyzygyň bir çyzygyna düşmelidir. Indiki sorag:

Select second mline: (Выберите вторую мультилинию:)
Ýokarky boljak ikinji multiçyzygy görkeziň. Amalyň ýerine 

ýetirilmeginiň netijesinde birinji multiçyzyk ikinji bilen kesişýän ýe­
rinde ýapylar.

Soňra şu sorag berler: Select first mline or [Undo]: (Выберите 
первую мультилинию или /Отменить]:)

Indiki multiçyzygy görkezmek bolar ýa-da buýrukdan çykmak 
üçin Enter düwmejigi basyň.

Open Cross (Открытый крест) amaly (  düwmejigi) ondan 
öňküsine meňzeş işleýär, kesişýän zolakda hemme daşky erňekleri we 
birinji görkezilen içki çyzyklary ýok edýär.

Merged Cross (Сплошной крест) amaly (  düwmejigi) 
ondan öňküsine meňzeş işleýär, emma kesişýän zolakda diňe daşky 
erňekleri ýok edýär.

Closed Tee amallary (Закрытое Т) (  düwmejigi), Open 

Tee (Открытое Т) (  düwmejigi) we Merged Tee (Сплошное 

Т) (  düwmejigi) birinji görkezilen multiçyzygy ikinji multi­
çyzyk bilen kesişýän ýerinden kesmegi amala aşyrýar. Bu amallaryň 
ýerine ýetirýän işi olaryň piktogrammalarynda görkezilen.

Corner Joint (Угловой стык) amaly (  düwmejigi) iki 
multiçyzygyň ahyrky segmentleriniň burçlaýyn kesişmesini gurnaýar 
ýa-da bir multiçyzygyňkyny, hemme zerur bolan kesişmeleri hasap­
laýar.

Add Vertex (Добавить вершину) amaly (  düwmejigi) 
multiçyzygyň göni çyzykly segmentiniň içinde depäni goşmaklygy 
mümkin edýär. Munuň üçin multiçyzygy görkezmek baradaky sora­
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ga jogap hökmünde multiçyzyga girýän çyzygyň birinde sepiň (täze 
depäniň) ýerini görkezmeli.

Delete Vertex (Удалить вершину) amaly (  düwmejigi) 
multiçyzygyň depesini ýok etmegi mümkin edýär we şonuň bilen 
degişli segmenti göneldýär. Ýok etmeklik üçin multiçyzygy görkez­
mek baradaky soraga jogap hökmünde ýok edilmeli depäniň go­
laýyndaky çyzygyň birini bellemeli. Netijede AutoCAD multiçyzygy 
şol depesiz gaýtadan çyzar.

Cut Single (Обрезать один) amaly (  düwmejigi) mul­
tiçyzyga girýän çyzyklaryň birini üzýär. Edil Break (Разорвать) 
buýrugyndaky ýaly, üzülmeli multiçyzyk görkezilýän nokat üzmegiň 
birinji nokady bolup durýar. Ikinji nokat görkezilenden soň AutoCAD 
üzmegi amala aşyrar.

Cut All (Обрезать все) amaly (  düwmejigi) multiçyzyga 
girýän hemme çyzyklary üzýär.

Üzülişleri aýyrmak üçin Weld All (Соединить все) amaly 

(  düwmejigi) gulluk edýär.

Ýazgylary redaktirlemek
Tekstleri redaktirlemegiň amallary Text (Текст) gurallar pane­

linde ýygnalan. Ýazgylary redaktirlemek üçin Text (Текст) paneliniň 
 düwmejigi göz öňünde tutulan we Modify > Object > Text > Edit 

(Редакт > Объект Текст > Редактировать) menýunyň buýrugy. Olar 
Ddedit (Диалред) buýrugy çagyrýar. Bu buýrugy çagyrmagyň has 
ýönekeý usuly – bir setirli tekste syçanjyk bilen iki gezek basmaly.

Ddedit (Диалред) buýrugy diňe ýazgyny redaktirlemek üçin 
niýetlenen däl-de, eýsem ölçeg ýazgyny, ýol bererlikleri we atribut­
lary kesgitlemek üçin niýetlenen.

Buýruk soraýar:
Select an annotation object or [Undo]: (Выберите текст 

или /Отменить]:) Eger bir setirli ýazgy görkezilse, onda Edit Text 
(Редактирование текста) dialog penjiresi emele geler.
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Text (Текст) bellenilen meýdanda zerur üýtgetmeleri girizme­
li soňra ОK düwmejigine basmaly. Ýazgynyň beýleki parametrleri 
(beýikligi, deňeşdirme görnüşi, baglaşdyrma nokady we ş.m.) bu 
buýrukda üýtgetmek mümkin däl.

Eger Ddedit (Диалред) buýrukda redaktirlenýän ýazgynyň de­
regine multitekst saýlanylan bolsa, onda multitekstiň redaktorynyň 
penjiresi çagyrylýar.

Text (Текст) paneliniň  düwmejigi Find (Найти) buýrugy 
çagyrýar, ol bolsa tutuş çyzgynyň ýönekeý tekstde ýa-da bellenilen 
meýdançada gözlemegiň we çalşyrmagyň işini ýerine ýetirýär.

 düwmejigi Style (Стиль) buýruga gabat gelýär, ol tekstleriň 
stillerini döredýär.

 düwmejigi Scaletext (Масштекст) buýrugy çagyrýar, ol 
teksti masştablamagy mümkin edýär. Buýrugy şeýle hem Modify 
> Object > Text > Scale (Редакт > Объект > Текст > Масштаб) 
menýudan çagyryp bolýar. Buýrugyň birinji soragy:

Select an annotation object or [Undo]: (Выберите текстовый 
объект или [Отменить]:) Bir setirli ýa-da köp setirli teksti görkez­
mek gerek. Mundan soň obýektleri saýlamak. Saýlamagy Enter düw­
mejigine basyp gutarmaly. Soňra:

Enter a base point option for scaling [Existing/Left/Cen­
ter/Middle/Right/TL /TC/TR/ML/MC/MR/BL/BC/BR] <Exis­
ting>: (Задайте опцию базовой точки для масштабирования 
[Существующая/Влево/Центр/Середина/Вправо/ ВЛ/ВЦ /ВП/
СЛ/СЦ/СП/НЛ /НЦ /НП] < Существующая >:)
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Justifytext (Выртекст) buýrugy, oňa  düwmejigi gabat gel­
ýär, ol ýazgynyň daşky görnüşini üýtgetmän onuň deňeşdirmesini 
üýtgetmegi mümkin edýär (meselem, ýazgy aşaky sag nokadyna 
baglaşdyrylan. Buýrugy şeýle hem Modify > Object > Text > Justify 
(Редакт > Объекты > Текст > Выравнивание) menýudan çagyrmak 
mümkin.

Buýrugyň başlangyç soragy: Select objects: (Выберите 
объекты:). Saýlamadan soň spesifiki sorag berilýär:

Enter a justification option [Left/Align/Fit/Center/Midd­
le/ Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]<Left>: (Задайте 
опцию выравнивания [Влево/Вписанный/Поширине/Центр /
Середина/Вправо/ВЛ/ВЦ/ВП/СЛ/СЦ/СП/НЛ/НЦ/НП] <Влево>:)

Opsiýa arkaly deňlemegiň täze opsiýasyny saýlamaly bolýar.
Text (Текст) paneliniň soňky  düwmejigi Spacetrans (Ед­

прост) buýrugyna gabat gelýär, ol modeliň we listiň giňişlikleriniň 
arasyndaky uzynlyklary gaýtadan hasaplamak üçin niýetlenen.

Bir setirli tekstleri redaktirlemek üçin amatly serişde bolup 
Change (Изменить) buýrugy çykyş edýär. Ol ýazgynyň islendik pa­
rametrlerini üýtgetmegi mümkin edýär.

Buýrugyň birinji soragy: Select objects: (Выберите объекты:). 
Bir setirli teksti görkezmeli we Enter basmaly. Soňra:

Specify change point or [Properties]: (Точка изменения или 
[Свойства]:)

Properties (Свойства) opsiýasy häsiýetleriň redaktirlenme­
sine eltýär. Täze nokady görkeziň. Ýazgy süýşüriler. Eger Enter 
klawişasyna basylsa, onda goşmaça sorag berler:

Specify new text insertion point <no change>: (Новая точка 
вставки текста <не изменять»?:)

Täze nokady görkeziň ýa-da teksti süýşürmek gerek däl bolsa 
onda Enter basmaly. Soňra:

Enter new text style <Standard>: (Новый текстовый стил 
<Standard>:) Eger başga stil alynmajak bolsa, onda Enter basmaly. 
Eger stilde harplaryň beýikligi bellenilmedik bolsa aşaky sorag beril­
ýär (başga ýagdaýda berilmeýär):

Specify new height <33.5000>: (Новая высота <33.5000>:)
Täze beýikligi giriziň. Eger beýiklik üýtgedilmeli däl bolsa Enter 

basmaly. Soňra:
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Specify new rotation angle <30>: (Новый угол поворота 
<30>:) Burçly ýaýyň içinde aşaky esasyň öwrülmeginiň şol wagtky 
ulanylýan burçy görkezilen (meselem – 30). Burçy görkeziň ýa-da 
Enter basyň. Indiki sorag:

Enter new text <... >: (Новый текст <...>:) Täze teksti girizmeli 
ýa-da öňki tekst bilen ylalaşylsa Enter basmaly.

Change (Изменить) buýrugy köp setirli tekstleri redaktirlemek 
üçin ulanylmaýar.

Ölçegleri redaktirlemek
Dimension (Размеры) panelinde öň döredilen ölçegleri redak­

tirlemek üçin ýene-de birnäçe düwmejikler bar. Olara gabat gelýän 
buýruklar Dimension (Размеры) menýuda hem bar.

Dimedit (Рзмре7п) oňa  düwmejigi gabat gelýär, ölçeg teksti 
we onuň ýerleşýän ýerini üýtgetmegi, şeýle hem çykaryş çyzyklary eg­
mek bolýar. Bu buýruga bölekleýin (bir opsiýanyň çäginde) Dimensi­
on (Размеры) menýunyň Oblique (Наклонить) buýrugy gabat gelýär.

Buýrugyň birinji soragy: Enter type of dimension editing [Home/
New/Rotate/Oblique] <Home>: (Операция редактирования 
размеров [Вернуть/Новый/Повернуть/Наклонить] <Вернутъ>:)

Jogabyň 4 görnüşi elýeterli. New (Новый) opsiýasy teksti Mul­
tiline Text Editor (Редактор многострочного текста) penjiresi ar­
kaly üýtgetmegi mümkin edýär. Bu buýruk amaly boýunça Ddedit 
(Диалред) buýrugyna gabat gelýär.

Hemme üýtgetmeler edilen soň penjire ýapylandan soňra diňe, 
teksti üýtgedilmeli ölçegleri görkezmeklik galýar.

Rotate (Повернуть) opsiýasy ölçeg teksti ölçeg çyzygyna görä 
öwürýär.

Ноmе (Вернуть) opsiýasy Rotate (Повернуть) opsiýasy bilen 
girizilen üýtgetmeleri ýok edýär.

Oblique (Наклонить) opsiýasy (bu opsiýa Dimension 
(Размеры) menýusynyň Oblique (Наклонить) bendi gabat gelýär) 
çykaryş çyzyklaryň kese okuna görä egilme burçuny görkezmegi 
mümkin edýär. Ol ilkibaşda obýektleri soraýar soňra bolsa burçy:

Enter oblique angle (press Enter for none): (Угол наклона 
(или Enter, если без наклона):)

Aşaky suratda çykaryş çyzyklaryň 60° çenli egilmegi görkezilen.
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Dimtedit (Рзмредтекст) buýrugy oňa  düwmejigi we Dimen­
sion (Размеры) menýunyň Align Text (Размерный текст) kömekçi 
menýusynyň bendleri gabat gelýär, ol ölçeg tekstiň we ölçeg çyzygyň 
ýerleşişini üýtgetmegi mümkin edýär.

Buýruk ilkibaşda redaktirlenýän ölçegi saýlamagy soraýar, soňra 
bolsa onuň täze ýerini soraýar: Specify new location for dimensi­
on text or [Left/Right/Center/Home/Angle]: (Новое положение 
размерного текста или [Влево/Вправо/Центр/Вернуть/ Угол]:).

Left (Влево), Right (Вправо), Center (Центр) opsiýalary ölçe­
gi bar bolan ölçeg çyzygyň ugry boýunça süýşürýärler. Angle (Угол) 
opsiýasy ölçeg çyzygyna görä ölçeg teksti öwürmegi mümkin edýär. 
Ноmе (Вернуть) opsiýasy bu buýruk arkaly ýerine ýetirilen ölçeg 
tekstiň öwrülmegini we süýşürilmegini ýok edýär.

Dimstyle (Рзмстиль) buýrugyna  düwmejigi gabat gelýär, ol 
hem Dimension (Размеры), hem-de Styles (Стили) paneline girýär. 
Bu buýruga Dimension (Размеры) menýunyň Style (Стиль) ben­
di we Format (Формат) menýunyň Dimension Style (Размерные 
стили) bendi gabat gelýär. Buýruk ölçeg stilleri redaktirlemegi müm­
kin edýär. Ölçeg stili – ýönekeý ölçegleriň görnüşini teswirleýän 
görkezmeleriň jemi.

Emma  düwmejigi ölçeg stilini redaktirlemän we täzesini 
döretmän ölçegleri taýýarlamagyna aýry üýtgetmeleri girizmeklik 
üçin ulanmak amatly. Dimension Style Manager gepleşik penjiresi­
ne has ünsli seredeliň.

Ölçegleri taýýarlamagyň hemme görkezmeleri ölçeg üýtgeýän­
lere ýazylýar, olar bolsa surat bilen ýatda saklanylýar. Olaryň hereket 
edýän bahalaryny görmek üçin Compare (Сравнить) düwmejigine 
basmaly.

Sanawy görüp Dimscale (Рзммасшт) üýtgeýäni üçin (Descrip­
tion (Описание) sütünde Overall scale (Общий масштаб) parame­
tri) 1.0000. bahasyna eýe bolup durýar.

Eger ölçeg goýlup ol örän ownuk bolsa, onda ölçegleri taýýar­
lamagyň hemme elementlerini proporsional ulaltmak mümkin – me­
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selem iki esse. Munuň üçin Compare Dimension Styles (Сравнение 
размерных стилей) penjiresini ýapalyň we Dimension Style Ma­
nager (Диспетчер размерных стилей) penjiresinde Override 
(Переопределить) düwmejigine basalyň. Mundan soň indiki penji­
re açylar – Override Current Style (Переопределение текущего 
стиля) ol 6 sany goşmaça eýe: Lines and Arrows (Линии и стрелки), 
Text (Текст), Fit (Размещение), Primary Units (Основные 
единицы), Alternate Units (Альтернативные единицы) we Tole­
rances (Допуски).

Hemme görkezilen goşmaçalar ölçeg üýtgeýänleriň bahalaryny 
we olary üýtgetmek üçin düwmejikleri saklaýarlar. Syçanjyk arkaly 
Fit (Размещение) goşmaça geçip Scale for Dimension Features 
(Масштаб размерных элементов) meýdany tapalyň.

Bu meýdanda Use overall scale of (Глобальный масштаб) ge­
çiriji işledilen. Bu bahany 2 etmeli.
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Öň goýlan ölçegleri ulaltmak üçin Dimension (Размеры) pane­
linde  düwmejigi bar, Dimension (Размеры) menýuda bolsa – Up­
date (Обновить) bendi bar.

Bu düwmejik basylanda obýektleri saýlamak barada sorag ber­
ler. Zerur ölçegler bellenilenden soň olar täze görkezmeler bilen gaý­
tadan çyzylar.

Команда Dimdisassociate (Рзмоткрепить) buýrugy ýönekeý 
ölçeglerden assosiatiwlik häsiýetini ýok edýär.

Assosiatiwligi dikeltmeklik ýa-da üýtgetmeklik üçin Dimreas­
sociate (Рзмприкрепить) buýrugy peýdalanmaly ýa-da oňa gabat 
gelýän Dimension (Размеры) menýunyň Reassociate Dimensions 
(Прикрепить размеры) bendinden peýdalanmaly. Buýruk ölçeg 
obýektleri soraýar:

Select dimensions to reassociate Select objects: (Выберите 
прикрепляемые размеры Выберите объекты:)

Obýektler saýlanylandan soň ulgam birinji çykaryş çyzygyň 
başynyň nokady assosirlenen nokady soraýar:

Specify first extension line origin or [Select object] <next>: 
(Начало первой выносной линии или [Выбрать объект] <далее>:)

Şonda çykaryş çyzygyň başynyň hereket edýän kesgitleýji no­
kady şu iki marker bilen  – eger ol assosiatiwlik häsiýetine eýe bol­
sa we  – eger şol häsiýete eýe bolmadyk bolsa belgilenýär. Ölçeg 
ýa doly, ýa-da bölekleýin berkidilip bilner.

Ştrihlemeleri we reňk bilen doldurylanlary redaktirlemek
Ştrihlemeleri we reňk bilen doldurylanlary redaktirlemek üçin 

Modify II (Редактирование-2) panelinde  düwmejigi bar, ol 
Hatchedit (Редштрих) buýrugyna gabat gelýär. Buýrugy çagyrmagyň 
başga usuly – Modify > Object > Hatch (Редакт > Объект > Штри­
ховка) menýunyň bendleri.
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Buýruk soraýar: Select associative hatch object: (Выберите 
объект – ассоциативную штриховку:) Ştrihleme görkezilenden soň 
Hatch Edit (Редактирование штриховки) gepleşik penjiresi açyl­
ýar, onda Hatch (Штриховка) goşmaçasy işjeň bolar. Eger reňk 
doldurylma görkezilse onda şol penjire Gradient (Градиентные) 
goşmaçasynda açylar.

Bu penjire Boundary Hatch and Fill (Штриховка и заливка 
по контуру) penjiresine laýyk gelýän hem bolsa, emma onda sudury 
saýlamak boýunça hemme amallar ýapylan. Bu ýerde ştrihlemegiň 
nusgasyny, egilmegiň burçuny we masştabyny üýtgetmek mümkin. 
Zerur bolan görkezmeler saýlanylandan soň AutoCAD şrihlemegi täze 
görnüşde regenerirleýär. Hatch Edit (Редактирование штриховки) 
gepleşik penjiresini şeýle hem ştrihlemä iki gezek basmak arkaly ça­
gyrmak mümkin. Şonda ştrihlemeden başga hiç obýekt bellenilmedik 
bolmaly.
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Splaýnlary redaktirlemek
Splaýnlary redaktirlemek Splinedit (Редсплайн) buýrugy ar­

kaly amala aşyrylýar, oňa Modify II (Редактирование-2) paneliniň 
 düwmejigi we Modify > Object > Spline (Редакт > Объекты > 

Сплайн) menýusy gabat gelýär.
Birinji sorag: Select spline: (Выберите сплайн:)
Syçanjyk arkaly splaýn görkeziň. Pedit (Полред) buýrugynyň 

Spline (Сплайн) opsiýasy bilen tekizlenen ýarym çyzygy hem saýla­
mak bolýar. Şonda Polyline awtomatiki Spline özgerdiler. Система 
AutoCAD redaktirlemegiň opsiýalarynyň sanawyny berer:

Enter an option [Fit data/Close/Move vertex/Refine/Rever­
se/Undo]: (Задайте опцию [Определяющие/Замкнуть/Перенести/
Исправить/Обратно/Отменить /Выход]:)

Şol bir wagtda AutoCAD dolandyryjy nokatlary ýagtyladýar, olar 
splaýnyň özünde däl-de şol görnüşli splaýny almak üçin tekizlenmeli 
karkas ýarym çyzykda ýerleşen. Kesgitleýji nokatlar (ulanyjy tara­
pyndan splaýn döredilenden girizilen nokatlar) şonda ýagtylanmaýar.

• Fit data (Определяющие) – splaýnyň kesgitleýji nokat­
laryny redaktirleýär;
• Close (Замкнуть) – splaýny ýapýar;
• Move vertex (Перенести) – dolandyryjy nokatlaryň 
ýerleşişini üýtgedýär (we kesgitleýji nokatlary ýok edýär);
• Refine (Исправить) – splaýnyň çyzygynyň tekizligini üýt­
gedýär;
• Reverse (Обратно) – splaýnyň ugruny üýtgedýär (nokatlary 
ters yzygiderlikde goýýar);
• Undo (Отменить) – splaýny redaktirlemegiň iň soňky ama­
lyny ýatyrýar.

Mundan başga hem Enter düwmejigine basylsa, buýrugyň işi 
tamamlaýar.

Eger splaýn ýapyk bolsa, Close (Замкнуть) opsiýasynyň dere­
gine Open (Разомкнуть) opsiýasy görkezilýär. Fit data (Опреде­
ляющие) opasiýasy saýlanylanda buýruk kesgitleýji nokatlary gör­
kezýär we olary redaktirlemegiň düzgünine geçýär.
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Sorag berilýär запрос: Enter a fit data option [Add/’Close/’
Delete/’Move/’Purge/Tangents/Tolerance /Exit] <Exit>: (Задайте 
опцию [Добавить/Замкнуть/Удалить/Перенести/Очистить/Каса­
тельные /Допуск/Выход] <Выход>:)

Opsiýalar:
• Add (Добавить) – splaýna täze kesgitleýji nokady goşýar;
• Close (Замкнуть) – splaýny ýapýar;
• Delete (Удалить) – käbir kesgitleýji nokatlary ýok edýär we 
splaýny galan kesgitleýji nokatlar boýunça hasaplap täzeden 
çyzýar;
• Move (Перенести) – kesgitleýji nokatlaryň ýerini üýtgedýär;
• Purge (Очистить) – kesgitleýji nokatlar baradaky maglu­
maty ýok edýär, şondan soň olar elýeterli däl bolýarlar;
• Tangents (Касательные) – splaýnyň başlangyç we ahyrky 
araçäk şertini üýtgedýär;
• Tolerance (Допуск) – splaýnyň kesgitleýji nokatlaryndan 
bolan gyşarmasyny görkezýän ýol bererligi üýtgedýär;
• Exit (Выход) – kesgitleýji nokatlary redaktirleme düzgünin­
den çykýar.

Splaýny redaktirlemegiň bu opsiýalary köp halatda ýarym çy­
zygy redaktirlemegiň meňzeş opsiýalaryna gabat gelýär.

Tejribe işleri
1. 20x35 ölçegde gönüburçlugyň göçürmesini almaly.
2. Radiusy R = 50 bolan tegelegiň radiusyny 3,5 esse artdyrmaly.
3. Uzynlygy 45 bolan we x okuna 560 gradus bilen duran kesimiň burçuny 

350 etmeli we uzynlygyny 65 edip artdyrmaly.
4. Dogry üçburçlugyň gurmaly aýnalyk şekilini almaly.
5. Öň ýazylan teksti üýtgetmek onuň şriftini Times New Roman 16 ölçegde 

etmeli.
6. Içinden aýlanan tegelegiň radiusy R=18 bolan dogry sekizburçlugyň bir 

tarapyny ýok etmeli. 
7. 6 göni çyzykdan we 7 sany egri çyzykdan ybarat bolan ýarymçyzygyň egri 

böleklerini ýok etmeli.
8. Setirde 8 we sütünde 6 sany 20x35 ölçegde gönüburçlukdan ybarat bolan 

köplügi döretmeli.
9. 9 sany aýry kesimleri bir ýarym çyzyga öwürmeli.
10. 3 sany çyzykdan ybarat bolan multiçyzygy çyzmaly.
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XI. Häsiýetler, stiller we standartlar

Häsiýetler
Her bir primitiwiň öz reňki, gaty we çyzygynyň tipi, çyzygynyň 

tipiniň masştaby, çap edilmeginiň stili, çyzygyň agramy, giperssylka 
we beýikligi bularyň hemmesi häsiýetlere degişli edilen. Obýektleriň 
şol wagtky häsiýetlerini List (Список) buýrugy arkaly kesgitlemek 
mümkin. Häsiýetler bilen işlemek üçin esasy panel bolup Properties 
(Свойства) çykyş edýär.

Bu panelde 4 sany açylýan sanaw bar:
• Color Control (Цвета) – reňkler;
• Linetype Control (Типы линий) – çyzyklaryň görnüşi;
• Lineweight Control (Веса линий) – çyzyklaryň agramy;
• Plot Style Control (Стили печати) – çap stilleri.

Ýene bir panel – Layers (Слои) – gatlaklar.

Panelde üç düwmejik bar:
•  Layers Properties Manager (Диспетчер свойств 
слоев) – gatlaklaryň häsiýetini üýtgetmek üçin;
•  Make Object’s Layer Current (Сделать слой объекта 
текущим) – obýektiň gatlagyny ulanýan etmek;
•  Layer Previous (Предыдущий слой) – mundan öňki 
gatlak.

Mundan başga hem Layers (Слои) paneline gatlaryň sanawy 
girýär, ol sanaw häzirki gatyň adyny we esasy häsiýetnamalaryny 
görkezýär.

Format (Формат) menýunyň ilkinji 4 sany bendi häsiýetleriň şol 
wagtky bahasyny dolandyrýar.
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Reňkler
Properties (Свойства) paneliniň birin­

ji sanawy Color Control (Цвета). Ol reňkiň 
häzirki ähmiýetini goýýar. Deslapdan 
reňkiň ähmiýeti ByLayer (Послою), ýagny 
reňk häzirki ulanylýan gatdan alynýar. Şol 
sebäpli ilkibaşdaky çyzylan obýektler reňki 
degişli bolan gatdan alýarlar, emma olara 
başga reňk hem bellemek bolýar.

Color Control (Цвета) açylýan sa­
nawy bar bolan obýektiň reňkini üýtgetmek üçin ulanylyp bilner. 
Obýekt bellenilen ýagdaýynda onuň reňki şol sanawda görkeziler, 
eger birnäçe obýekt bellenilse we olaryň reňki meňzeş bolsa onda şol 
reňki görkeziler, eger deň däl bolsa ol sanawyň setiri boş bolar.

Eger has inçe öwüşginler gerek bolsa Select Color (Выбор 
цвета) setiri ulanyp bilner, ol Select Color (Выбор цвета) gepleşik 
penjiresini çagyrýar, onda elýeterli bolan reňkleriň palitrasy getirilen.

Reňki şu goşmaçalaryň – Index Color (Цвет по номеру), True 
Color (Точный цвет) we Color Books (Цветовые книги) üçüsinden 
hem saýlap bolýar.

AutoCAD ulgamynda esasy reňkleri hökmünde 1-den 7-ä çenli 
reňkler bolup durýar:

• 1 – Red (Красный) –  gyzyl;
• 2 – Yellow (Желтый) – sary;
• 3 – Green (Зеленый) – ýaşyl;
• 4 – Cyan (Голубой) – mawy;
• 5 – Blue (Синий) – gök;
• 6 – Magenta (Фиолетовый) – gyrmyzy;
• 7 – White (Белый), hakykatda ak ýa-da gara bolup biler – 
grafiki ekranyň fonunyň reňkine baglylykda.

Format (Формат) menýusynyň Color (Цвета) bendi hem reňk 
saýlama gepleşik penjiresini çagyrýar. Mundan başga hem ony klawi­
aturadan girizilýän Color (Цвет) buýrugy hem çagyryp biler.
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Çyzygyň görnüşi we masştaby
Çyzygyň görnüşi we onuň 

masştaby – çyzykly obýektleriň ýe­
ne-bir iki sany möhüm häsiýetleri. Li­
netype Control (Типы линий) açyl­
ýan sanaw Properties (Свойства) 
panelinden çepden ikinji bolup durýar.

Onda ByLayer (Послою) we ByBlock (По-блоку) gulluk äh­
miýetlerden başga, diňe Continuous tipi bar, ol adaty inçe tutuş 
çyzygyň adyny belgilemek üçin ulanylýar. Çyzyklaryň beýleki 
görnüşlerini ýüklemek üçin Other (Другой) setirine basyň. Linetype 
Manager (Диспетчер типов линий) gepleşik penjiresini açyň.

Bu penjire arkaly bar bolan çyzygyň görnüşini ulanylýan edip 
bolýar, ony ýok edip ýa-da täze görnüşini ýükläp bolýar. Penjiräniň 
merkezi böleginde siziň suratyňyzyň faýlyna eýýäm ýüklenilen gör­
nüşler görkezilen. Täze görnüşleri ýüklemek üçin Load (Загрузить) 
düwmejigine basyň. Mundan soň ekranda Load or Reload Linetypes 
(Загрузка или перезагрузка типов линий) gepleşik penjiresi emele 
geler.
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Penjiräniň ýokarky böleginde görnüşleriň ýüklenilýän (acadi­
so.lin) faýlyň ady görkezilen. Tejribeli ulanyjylar çyzyklaryň täze 
görnüşlerini döredip olary öz faýllarynda ýatda saklap bilerler.

Eger bir görnüşi saýlap ОK düwmejigine basylsa onda ol Li­
netype Manager (Диспетчер типов линий) gepleşik penjiresiniň 
içindäki görnüşleriň hataryna girer. Çyzyklaryň görnüşleriniň hemme 
görnüşlerini ýüklemek üçin, Load or Reload Linetypes (Загрузка 
или перезагрузка типов линий) gepleşik penjiresinde kursory 
tipleriň ady sanalyp geçilýän töwerekde goýup kontekst menýuny 
syçanjygyň sag düwmejigi bilen çagyryp we Select All bendi saýla­
mak gerek.

Bar bolan obýektleriň çyzyklarynyň görnüşini üýtgetmeklik hem 
reňk saýlanyş ýaly bolup geçýär.

Linetype Manager (Диспетчер типов линий) gepleşik 
penjiresiniň çagyrylmagy şeýle hem Format (Формат) menýunyň 
Linetype (Типы линий) bendi ýa-da klawiaturadan girizilýän Li­
netype (Типлин) buýrugy bilen amala aşyrylyp bilner.

Ýene bir häsiýeti – çyzygyň görnüşiniň masştaby. Eger bir ob­
ýekte çyzygyň görnüşi bellenilen bolsa we ony düzýän elementleriň 
(ştrihleriň, nokatlaryň, ştrihleriň arasyndaky probelleriň we b.) ölçeg­
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lerini üýtgetmek üçin şol ob­
ýekt üçin çyzygyň görnüşiniň 
masştabyny üýtgedip bolar. Des­
lapdan masştab 1-e deň. Aşakdaky 
suratda çyzygyň görnüşleri deň 
bolan, emma çyzygyň görnüşiniň 
masştaby tapawutly bolan çyzyk­
lar görkezilen.

Obýektiň çyzygynyň gör­
nüşiniň masştabynyň ähmiýeti iki masştabyň: global we öz masştab­

larynyň köpeldilmegi hökmünde alynýar. Global masştaby çyzgynyň 
hemme obýektlerine degişli bolýar, öz masştaby bolsa hususan 
obýektde degişli edilýär. Iki masştabyň hereket edýän ähmiýetleri­
ni üýtgetmek üçin (Global scale factor (Глобальный масштаб) we 
Current object scale (Текущий собственный масштаб)) Linety­
pe Manager (Диспетчер типов линий) penjiräniň Show details (С 
подробностями) düwmejigi basmaly, ol penjiräniň aşaky böleginde 
goşmaça maglumaty görkezýär.
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Global masştabyň üýtgedilmegi çyzgynyň hemme elementlerine 
täsir eder. Klawiaturadaky Ltscale (Лмасштаб) buýrugy çyzyklaryň 
görnüşleriniň global masştabyny üýtgetmegi mümkin edýär. Onuň 
ähmiýeti Ltscale ulgamlaýyn üýtgeýände saklanylýar. Häzirki öz 
masştabyň ähmiýeti Celtscale ulgamlaýyn üýtgeýäne girizilýär.

Gatlar
Çylşyrymly suratlar döredilende aýry obýektlere ýa-da obýekt­

leriň toparlaryna atlary bermek zerurlygy ýüze çykýar. Bu maksatlar 
üçin ýönekeýleriň ýene bir häsiýeti gulluk edýär – gatlak. Mundan 
başga hem gat öçürilme häsiýetine eýe bolup durýar, bu esasan käbir 
obýektleri ýok etmän, wagtlaýyn ekrandan aýyrmak üçin ulanylýar.

Gatlar bilen işlemek boýunça esasy buýruk bolup Layer (Слой) 
çykyş edýär, oňa Layers (Слои) paneliniň  düwmejigi Format 
(Формат) menýunyň Layer (Слои) bendi gabat gelýär.
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Layer (Слой) buýruk Layer Properties Manager (Диспетчер 
свойств слоев) gepleşik penjiresini çagyrýar.

Birnäçe gat bar bolanda olaryň biri ulanylýan bolup durýar 
(işjeň). Onuň ady: Current Layer: 0 (Текущий слой: 0) meýda­
nynda görkezilýär

Häzirki ulanylýan gat – täze obýektleriň dörediljek gaty.
Ýokarky sag burçunda şeýle düwmejikler görünýär:

• New (Новый) – täze düwmejigi döredýär:
• Delete (Удалить) – suratdan gaty ýok edýär (bu diňe gat ula­
nylmaýan bolsa amala aşyrylýar);
• Current (Текущий) – başga gaty häzirki ulanylýan edip 
goýýar onuň ady Clayer ulgamlaýyn üýtgeýäne ýazylýar;
• Show details (С подробностями) – penjiräniň aşaky böle­
ginde saýlanylan gatyň häsiýetlerini görkezýär;
• Save state (Сохранить состояние) – gatlaryň häzirki gör­
kezmelerini las giňişlikli konfigurasiýa faýlynda olary soňra 
dikeltmek üçin ýatda saklaýar;
• State Manager (Диспетчер конфигураций слоев) – has 
giňişlikli ýatda saklanylýan gatlaryň görkezmeleriniň dikeldil­
megini saýlamak mümkin bolan gepleşik penjiresini çagyrýar.

Gatlaryň şeýle häsiýetnamalary bar:
• Name (Имя) – gatyň ady simwollaryň sany 1-den 255-e çen­
li bolup bilýär;
• On (Вкл) – gatyň işledilmeginiň ýagdaýy (işledilen ýa-da 
öçürilen);
• Freeze in all VP (Hemme görülýän ekranlarda doňdurylan) 
– hemme görülýän ekranlara görä doňdurylmagyň ýagdaýy 
(doňdurylan ýa-da doňdurylmadyk);
• Lock (Блокированный) – blokirlenmeginiň ýagdaýy (blo­
kirlenen we blokirlenmedik);
• Color (Цвет) – reňk hökmünde By Layer (Послою) ba­
hasyny berlen gatyň obýektleri üçin reňki belleýär;
• Linetype (Тип линии) – çyzygyň görnüşi hökmünde By 
Layer (Послою) bahasy berlen gatyň obýektleri üçin çyzygyň 
görnüşini belleýär;
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• Lineweight (Вес линии) – çyzygyň agramy hökmünde By 
Layer (Послою) ähmiýeti berlen gatyň çyzygyň agramyny 
belleýär;
• Plot Style (Стиль печати) – üçin çap etmegiň stili;
• Plot (Печать) – daşky gurala çykarmak üçin gatyň obýekt­
leriniň ýagdaýy (çap etmeli ýa-da däl).

Gat döredilende onuň ady berilýär we ОK düwmejigine basylsa, 
täze gat edil 0 gatyň häsiýetnamalary bilen dörediler.

Gatyň beýleki häsiýetnamasy – On (Вкл). Eger gatyň bu sütü­
ninde  (sary çyrajyk) duran bolsa, gat işledilen diýlip hasaplanyl­
ýar, eger  (gök çyrajyk) – onda öçürilen diýlip hasaplanylýar.

Öçürilen gatda ýerleşen obýektler ol işledilýänçä wagtlaýynça 
ekrandan ýitýärler, emma ýok edilmeýär. Islendik gat, eýsem häzirki 
hem öçürilip bilner.

Indiki häsiýetnama – Freeze in all VP. Eger gatlagyň bu sütü­
ninde  (sary gün) belgisi duran bolsa, onda gat doňdurylmadyk 
diýlip hasaplanylýar, eger  (gök buzjagaz) belgisi bolsa – onda 
doňdurylan diýlip hasaplanylýar.

Doňdurylýan gatda ýerleşen obýektler wagtlaýyn görünmeýän 
bolýar. Häzirkiden başga islendik gat doňdurylyp bilner.

Gatyň indiki häsiýetnamasy – Lock (Блокированный). Eger-de 
gatyň bu sütüninde  (açyk gulp) belgisi duran bolsa, onda ol blo­
kirlenmedik bolup durýar, eger  (ýapyk gulp) belgisi duran bolsa 
– blokirlenen diýlip hasaplanylýar. Blokirlenen gatda täze obýektleri 
döretmek mümkin, emma bar bolanlary ýok etmek we redaktirlemek 
mümkin däl.

Color (Цвет) häsiýetnamasy reňk hökmünde By Layer (По 
слою) bahasy berlen gatyň obýektleriniň hakyky reňkini görkezýär.

Indiki häsiýetnama – Linetype (Тип линии). Ol çyzygyň görnü­
şi hökmünde By Layer (По слою) bahasy berlen gatyň obýektlerini 
çyzmak üçin çyzygyň görnüşini belleýär.

Indiki häsiýetnama – Lineweight (Вес линии). Ol çyzygyň 
agramy hökmünde By Layer (По слою) bahasy berlen gatyň obýekt­
lerini çyzmak üçin çyzygyň agramyny belleýär.
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Plot Style (Стиль печати) häsiýetnamasy diňe çapyň stilini tes­
wirleýär.

Plot (Печать) häsiýetnamasy gatyň obýektleri çapa çykarylar­
my ýa-da ýok meselesini kesgitleýär.  (çyzylmadyk printer) belgisi 
obýektleriň çap ediljekdigini,  (çyzylan printer) belgisi çap edil­
mejekdigini görkezýär.

Layers (Слои) panelindäki  düwmejigi AI_MOLC buýrugy­
na gabat gelýär, ol häzirki ulanylýan edip gaty belleýär.

Buýrugyň soragy: Select object whose layer will become cur­
rent: (Выберите объект, слой которого должен стать текущим:)

Obýekt görkezilenden soň ony häzirki ulanylýan etmeli.  
düwmejigi Layerp (Слойп) buýrugyna gabat gelýär, ol gatlaryň öňki 
ýagdaýyna gelmegi mümkin edýär, emma aşakdakylar gaýdyp gel­
meýär:

• Ady üýtgedilen gatlaryň ady dikeldilmeýär;
• Ýok edilen gatlar dikeldilmeýär;
• Täze gatlar ýok edilmeýär.
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Bellik Layerp (Слойп) buýrugyň işini başga buýruk dolandyrýar 
– Layerpmode (Слойпрежим), ol Layerp (Слойп) buýrugyň işine 
rugsat ýa berýär ýa-da bermeýär.

Çyzygyň agramy – bu obýektiň çapa çykaryljak galyňlygy. 
Obýektleri inçe çyzyk emma nola deň bolmadyk agramy berseňiz, 
onda çapda olar goýy çyzyklar bilen çykarylar.

Eger Lwt düzgün düwmejigi basylan bolsa, onda grafiki ekranda 
çyzyklar agramsyz görkezilýär.

Agram galyňlygyň beýleki görnüşleri bellenilen obýektlere: 
ýarym çyzygyň nol däl inli meýdançalaryna, zolaklara, figuralara, 
reňk doldurylmalara, True Type şriftli ýazgylara, rastr şekillere täsir 
etmeýär.
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Täze obýektler agramyň häzirki ähmiýeti Properties (Свойства) 
paneliniň Lineweight Control (Веса) açylýan sanawy arkaly bellenilýär.

Agramyň häzirki ähmiýeti mundan başga hem Lweight (Веснин) 
buýrugy we oňa gabat gelýän Format (Формат) menýunyň Lineweig­
ht (Вес линий) agramy bilen bellenilýär. Lweight (Вес-Лин) buýru­
gy Lineweight Settings (Параметры весов линий) gepleşik penjire­
sini çagyrýar.

Bu gepleşik penjiresinde çyzyklaryň agramyny ýol berilýän 
ähmiýetleriň sanyndan kabul edip bolýar (0-dan 2,П-e mm çen­
li). Display Lineweight (Отображать линии в соответствии с 
весами) baýdajygyň goýulmagy Lwt (Вес) düwmejigiň basylma­
gyna deň täsir berýär. Adjust Display Scale (Масштаб экранного 
отображения) şkalnyň süýşgüji grafiki ekranda görkezilende ag­
ramlaryň masştablaryny dolandyrýar (bu sazlama çapda ulanylýan 
agramlaryň ululyklaryna täsir etmeýär).

Default (По умолчанию) açylýan sanaw Default (Обычный) 
aýratyn ähmiýet üçin agramy belleýär. Default (Обычный) atly 
agram adatça 0,25 mm (0,01 dýuým) deň edilip kabul edilýär. Bu äh­
miýet çyzgynyň esasy elementleriniň toplumy üçin ulanylýar.

Giperssylka
Giperssylka – bu grafiki obýektiň beýleki surata, resminama, 

elektron jetwele we islendik beýleki faýla salgylanma häsiýeti.
Giperssylkalaryň goýulmagy we redaktirlenmegi Hyperlink 

(Гиперссылка) buýrugy arkaly ýerine ýetirilýär, oňa Insert (Вставка) 
menýusynyň Hyperlink (Гиперссылка) bendi gabat gelýär.
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Buýruk obýektleri soraýar we eger giperssylkasy bolmadyk ob­
ýektler saýlanylsa onda Insert Hyperlink (Вставка гиперссылки) 
gepleşik penjiresi çagyrylýar.

Text to display (Выводимый текст) meýdanynda kursor obýek­
tiň üstünden geçirilende görkeziljek teksti girizilmeli. Insert Hy­
perlink (Вставка гиперссылки) gepleşik 
penjiresiniň Link to (Связать с) çep sütün­
den alnyp bilner, bu ýerde üç düwmejigiň 
ady bar:

• Existing File or Web Page (Имею­
щийся файл или Web-страница);
• View of This Drawing (Вид из этого рисунка);
• E-mail Address (Адрес электронной почты).

Häsiýetleri redaktirlemek
Beýleki häsiýetleri – beýiklik we dereje. Beýiklik – ölçegli 

çyzuwlarda ulanylýan ýönekeýleriň häsiýetleri. Ol Z okuň ugry 
boýunça gysylyp çykarmagyň ululygyny belleýär, bu ok X we Y 
oklaryna perpendikulýar bolýar. Meselem, tegelegi silindre öwürmek 
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üçin ony nol däl ululyga gysyp çykarmaly. Dereje – obýektiň döredi­
len tekizligiň XY tekizligine görä süýşmegi.

Esasy häsiýetnamalary (gat, reňk, çyzygyň görnüşi, çyzygyň ag­
ramy) eljagazlar we Properties (Свойства) paneliniň Layer Control 
(Слой), Color Control (Цвета), Linetype Control (Типы линий), 
Lineweight Control (Веса линий) açylýan sanawlar arkaly redaktir­
lemek mümkin.

Properties (свойства) uniwersal buýrugy obýektleriň islendik 
häsiýetlerini, şeýle hem geometriýany redaktirlemegiň mümkinçili­
gini berýär. Buýruga Standard (Стандартная) paneliniň  düw­
mejigi we Tools (Сервис) menýunyň Properties (Свойства) bendi 
gabat gelýär. Buýrugy çagyrmagyň ýene-de bir usuly – klawiaturada 
<CtrI>+<!> klawişalaryny girizmeklik. Properties (Okhocb) buýru­
gy Properties (Свойства) penjiresini açýar.

Bu penjiräni şeýle hem obýekte iki gezek syçanjyk bilen basmak 
arkaly çagyryp bolýar.

Properties (Свойства) penjiresiniň 
düzümi haýsy obýektleriň saýlanandygyna 
örän bagly bolup durýar.

Eger birnäçe obýekt saýlanylsa, haý­
sy‑da bir häsiýet bu obýektlerde dürli baha 
eýe bolan bolsa, onda (meselem, reňk), 
häsiýetiň meýdanyna *Varies* ähmiýeti gi­
rizilýär. Açylýan sanawyň çep tarapynda üç 
düwmejik bar:

•  Juck Select (Быстрый выбор) – su­
ratda filtrler arkaly obýektleri tiz saýlamak;

•  Select Objects (Выбор объектов) – 
obýektleri gaýtadan saýlamak üçin;

•  Toggle value of Pickadd Sysvar (Из­
менить значение системной перемен­

ной Pickadd) – Pickadd ulgam üýtgeýäniň bahasy 1-den 0-a 
üýtgedýär; eger onuň bahasy 1-e deň bolsa, onda Properties 
(Свойства) şol wagt saýlanylan obýektler üçin umumy hä­
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siýetleri görkezýär, eger 0 bolsa – onda diňe soňkyny we sere­

dilýän düwmejik –  şekile eýe bolar.
Properties (Свойства) penjiresiniň merkezi bölegi goşmaçalara 

eýe bolan tablisa hökmünde taýýarlanan. Goşmaçalaryň sanawy 
saýlanylan obýekte bagly bolup durýar. Eger saýlanylan obýekt bol­
masa, onda goşmaçalar hökmünde General (Общие), Plot Style 
(Стиль печати), View (Вид) we Misc (Разное) goşmaçalar çykary­
lar. Eger grafiki ekranynda saýlanylan obýekt bar bolsa, onda Gene­
ral (Общие) goşmaçasy çykarylar, oňa obýektleriň görnüşine bagly­
lykda Geometry (Геометрия) goşmaçasy ýa-da beýleki goşmaçalar 
goşulýar.

Gerekli häsiýeti saýlap onuň ähmiýetini üýtgedip bolýar.
Chprop (Свойства) buýrugy obýektiň häsiýetini buýruk setirin­

den üýtgedýär. Obýektleri saýlamak üçin soragdan soň şeýle sorag 
berilýär:

Enter property to change [Color/Layer/Ltype/Ltscale/Lweig­
ht/Thickness]: (Укажите изменяемое свойство [Цвет/Слой/Тип 
Линии/Лмасштаб/ Вес Линии/Высота]:).

Change (Изменить) buýrugy – buýruk setirden üýtgetmeleri 
girizmegiň ýene bir usuly. Ol obýektleri soraýar. Saýlanan obýektler 
ulanyjynyň koordinatalar ulgamynyň tekizligine parallel bolmalydyr. 
Bu şert beýikligi nola deň däl bolan kesimlere degişli däl. Soňra sorag 
berilýär:

Specify change point or [Properties]: (Точка изменения или 
[Свойства]:)

Eger nokat görkezilse, ol saýlanylan obýektiň üýtgedilýän no­
kady bolup durýar (meselem, kesimiň ahyrky nokatlarynyň biri täze­
sine geçirilýär. Properties (Свойства) opsiýasynyň ýagdaýynda şu 
sorag berilýär:

Enter property to change [Color/Elev/Layer/Ltype/Ltscale/L 
Weight/Thickness]: (Укажите изменяемое свойство /Цвет/Уро­
вень/Слой/Тип Линии/Лмасштаб/ Вcе Линии/Высота!:)

Bu ýerde – Elev (Уровень) opsiýasy bar. Bu opsiýa obýektden 
XY koordinat ulgamynyň tekizligine çenli aralygy berýär.
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AutoCAD ulgamynda bir obýektiň häsiýetlerini başga obýek­
te geçirmegiň buýrugy bar – Matchprop (Копироватьсв) buýrugy. 
Buýruga gabat gelýän  düwmejigi Standard (Стандартная) pa­
nelinde ýerleşýär. Buýrugy şeýle hem Modify (Редакт) menýusynyň 
Match Properties (Копирование свойств) bendi arklay çagyryp 
bolýar.

Buýrugyň birinji soragy: Select source object: (Выберите 
исходный объект:) Obýekt saýlanylandan soň Копировать (Match­
prop) buýrugyň şol wagtky sazlamalar barada habar berilýär:

Текущие активные настройки: (Current active settings:)
Habar buýrugyň beýleki obýekte geçirjek bolýan häsiýetleriň 

sanalmagy bilen bolup geçýär. Bu häsiýetleriň maksimal toplumy 
aşakdaky suratda görkezilen.

Soňra şu sorag berilýär: Select destination object(s) or [Set­
tings]: (Выберите целевой объект(ы) или [Настройки]:)

Stiller we standartlar
AutoCAD ulgamynda – Styles (Стили) paneli tekst we ölçeg 

stillerine tiz elýeterliligi üpjün edýär.
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Tekst stilleri örän wajyp bolup durýarlar we bir setirli tekst­
lerde ulanylyp köp beýleki obýektlere (ölçeg stillerine, atributlaryň 
kesgitlenilişi) täsir edýär. Häzirki ulanylýan stiliň ady Styles (Стили) 
gurallara paneliniň birinji açylýan sanawynda görkezilýär. Tekst stil­
leri suratyň içinde saklanylýar.

Tekst stiller bilen işlemeklik Style (Стиль) buýrugy arkaly amala 
aşyrylýar, oňa Format (Формат) menýunyň Text Style (Текстовые 
стили) bendi hem-de Text (Текст) we Styles (Стили) panelleriň 

 düwmejigi gabat gelýär. Style (Стиль) buýrugy Text Style 
(Текстовые стили) gepleşik penjiresini çagyrýar.

Penjiräniň orta böleginde şriftiň parametrleri: şriftiň ady, kur­
siwligi ýa-da ýok harplaryň beýikligi kesgitlenýär. Penjiräniň aşaky 
böleginde dürli effektler bellenilýär (agdarylmasy, süýnmesi we 
ş.m.). Apply (Применить) düwmejikler arkaly edilen üýtgetmeleri 
ýatda saklamak mümkin.

New (Новый) düwmejigine basylsa täze stili döretmek mümkin.

17. Sargyt 1372
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Täze stil hemme öz ilkibaşdaky häsiýetnamalaryny häzirki stil­
den alar. Gepleşik penjiresinde olary siz öz islegiňiz boýunça üýtge­
dip bilersiňiz.

Text Style (Текстовые стили) gepleşik penjiresinde Font Name 
(Имя шрифта) açylýan sanawynda – AutoCAD ulgamynda elýeterli 
şriftleri saýlamaly.

Çepinde  belgisi bolan – bu adaty AutoCAD ulgamynyň Shx-
şriftler, olar AutoCAD ulgamynyň programma üpjünçiliginiň Fonts 

bukjasynda shx giňişligi bilen ýatda saklanylýar. Çepinde  belgisi 
bolan – bular Windows ulgamynda ýüklenen True Type şriftleri. txt.
shx şriftine esaslanýan we täze suratda deslapdan ulanylýan Standard 
stili ýok edilip we ady üýtgedilip hem bilenok. Bu stili diňe dürli öl­
çeglerini redaktirlemek bilen üýtgetmek mümkin.

Penjiräniň Height (Высота) meýdany şol stiliň hemme ýazgy­
lary üçin şriftiň şol bir beýikligini goýmak üçin ulanylýar. Nola deň 
bolmadyk beýiklik bolanda Text (Текст) buýrugy harplaryň beýikligi 
barada sorag bermeýär.

Eger şrift hökmünde Shx-şriftleriň biri ulanylan bolsa onda Use 
Big Font (Использовать большой шрифт) baýdajygy elýeterli bolýar.

Параметр Width Factor (Степень растяжения) şriftleri 
gysmagy ýa-da süýndirmegi amala aşyrýar. 1-den uly bahalar şriftiň 
simwollaryny süýndürýärler, 1-den kiçi bahalar – gysýarlar. Oblique 
Angle (Угол наклона) parametri diklige görä harplaryň eňňitliginiň 
burçuny belleýär (tutuş ýazgynyň eňňitligine täsir etmän!). Ýol berer­
li bahalar –85° we +85° bahalaryň arasynda bolýar.

Ölçeg stilleri
Ölçeg stiller bilen işlemeklik Dimstyle (Рaзмстиль) buýrugy ar­

kaly amala aşyrylýar, oňa Styles (Стили) we Dimension (Размеры) 

panelleriň  düwmejigi, şeýle hem Dimension (Размеры) menýu­
synyň Style (Стиль) bendi we Format (Формат) menýusynyň Di­
mension Style (Размерные стили) bendi gabat gelýär.

Hemme ölçeg stilleriň atlary bar. Häzirki suratda bar bolan 
stilleriň sanawy Dimension (Размеры), şeýle hem Styles (Стили) 
panelinde saklanylýar. Eger bu paneller dik ýagdaýynda fiksirlenen 
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bolsa onda sanaw görkezilmeýär. Täze suratda azyndan bir stil – ISO-
25 stili bar.

Dimstyle (Рaзмстиль) buýrugy Dimension Style Manager 
(Диспетчер размерных стилей) gepleşik penjiresini açýar.

Gepleşik penjiresini merkezi böleginde Preview of (Образец 
стиля) serediliş meýdanynda şol wagtky ulanylýan stil bilen döredi­
len ölçegleriň görnüşi görkezilen. Aşakda, Description (Описание) 
meýdanynda hereket edýän stile bolan düşündirme getirilen.

Penjiräniň sag böleginde şu düwmejikler ýerleşen:
• Set Current (Установить) – stilleriň sanawynda bir stili hä­
zirki ulanylýan edip goýýar;
• New (Новый) – täze stili döretmek üçin;
• Modify (Изменить) – üýtgetmek;
• Override (Переопределить) – gaýtadan kesgitlemek;
• Compare (Сравнить) – deňeşdirmek.

Eger suratda bar bolanlardan täze häzirki ulanylýan stil ge­
rek bolsa, ony Styles (Стили) sanawyndan saýlaň we Set Current 
(Установить) düwmejigine basmaly.

Täze stili döretmek üçin, New (Новый) düwmejigine basmaly. 
Bu ýagdaýda Create New Dimension Style (Создание нового 
размерного стиля) penjiresi emele geler.
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Täze stil özbaşdak we hakykatdan täze bolup diňe Use for 
(Размеры) sanawynda All dimensions (Все размеры) opsiýasy 
saýlanylan bolsa bolýar. Eger başga opsiýalar saýlanylsa: Linear 
dimensions (Линейные размеры), Angular dimensions (Угловые 
размеры), Radius dimensions (Радиусы), Diameter dimensions 
(Диаметры), Ordinate dimensions (Ординатные размеры) ýa-da 
Leaders and Tolerances (Выноски и допуски), onda bu ýagdaý­
da täze stil döredilmän şol wagtky ulanylýan stiliň käbir parametrini 



261

gaýtadan kesgitlenmegi bolup geçer. Bu ýagdaýda täze stiliň adyny 
görkezýän meýdan elýeterli bolmaz.

Create New Dimension Style (Создание нового размерного 
стиля) gepleşik penjiresinde hemme gerekli görkezmeler goýlandan 
soň Continue (Далее) düwmejigine basmaly. Mundan soň New Di­
mension Style (Новый размерный стиль) penjiresi emele geler, ol 6 
sany goşmaça eýe bolar. Adatça ilkibaşda Lines and Arrows (Линии 
и стрелки) goşmaçasy aktiwizirlener.

Dimension Lines (Размерные линии) töweregi ölçeg çyzyklary 
çyzmagyň şeýle görkezmelerine eýe:

• Color (Цвет) – reňk;
• Lineweight (Вес линии) – çyzygyň agramy;
• Extend beyond ticks (Удлинение за выносные) çykaryş 
çyzyklaryň daşyna uzalma;
• Baseline spacing (Шаг в базовых размерах);
• Suppress Dim Line 1 (2) (Подавить 1-ю (2-ю) размерную) 
– 1-nji ýa-da ikinji ölçeg çyzygyň ujuny ýok etmek

Parametrleriň niýetlenilişi olaryň atlaryna gabat gelýär.
Extension Lines (Выносные линии) meňzeş görkezmeleri sak­

laýar emma çykaryş çyzyklary üçin:
• Color (Цвет) – reňk;
• Lineweight (Вес линии) – çyzygyň agramy;
• Extend beyond dim lines (Удлинение за размерные) ölçeg 
çyzyklaryň daşyna uzalma;
• Offset from origin (Отступ от объекта) – birinji obýektden 
süýşme;
• Suppress Ext Line 1 (2) (Подавить 1-ю (2-ю) выносную) 
– 1-nji ýa-da 2-nji çykaryş çyzygy ýok etmek.

Arrowheads (Стрелки) töweregi ölçeg çyzyklaryň we çykaryş­
laryň oklarynyň görnüşleriniň ýol bererli bahalarynyň degişli açyl­
ýan sanawlaryny saklaýar, şeýle hem oklaryň ululygyny kesgitleýän 
meýdanyny:

• 1st (1-я) – 1-nji;
• 2nd (2-я) – 2-nji;
• Leader (Выноска) – çykaryş ýangy;
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• Arrow size (Величина) – ululyk.
Center Marks for Circles (Маркеры центра для кругов) töwe­

regi tegelegiň we halkalaryň merkeziniň we oklaýyn çyzyklarynyň 
markeriniň görnüşini, şeýle hem markeriň we tegelegiň daşyna ok­
laýyn çyzyklaryň çykýanlygynyň ölçegini kesgitleýär:

• Туре (Тип) – markeriň görnüşiniň 3 ähmiýeti bilen sanaw 
– (None (Нет), Mark (Только маркер), Line (С линиями));
• Size (Размер) – markeriň ölçegi bilen sanawjynyň meýdany.

New Dimension Style (Новый размерный стиль) gepleşik 
penjiresiniň Text (Текст) goşmaçasy ölçeg tekstiniň görkezmelerini 
teswirleýär.

Text Appearance (Свойства текста) töweregi şeýle görkezme­
leri belleýär:

• Text style (Текстовый стиль) – ölçeg tekstiniň stiliniň ady;
• Text color (Цвет текста) – ölçeg tekstiniň reňkini;
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• Text height (Высота текста) – simwollaryň beýikligini;
• Fraction height scale (Масштаб дробей) – droblaryň 
simwollarynyň masştabyny.

Mundan başga hem Draw frame around text (Текст в рамке) 
baýdajygyň goýulmagy ölçeg tekstiň töwereginde çägi belleýär.

Text Placement (Выравнивание текста) töweregi ölçeg tekstiň 
ölçeg çyzygyna görä ýerleşişini kesgitleýär: Vertical (По вертикали) 
– ýol bererli bahalary Centered (По центру), Above (Над линией), 
Outside (Снаружи), JIS (Стандарт JIS)) hem-de Horizontal (По 
горизонтали) – ýol bererli bahalary Centered (По центру), At 
Ext Line 1 (У 1-й выносной). At Ext Line 2 (У 2-й выносной), 
Over Ext Line 1 (Над 1-й выносной), Over Ext Line 2 (Над 2-й 
выносной)), şeýle hem tekst üçin ölçeg çyzykdan süýşmegi Offset 
from dim line (Отступ от размерной) sanawjy arkaly belleýär.

Text Alignment (Ориентация текста) töweregi ölçeg tekstiniň 
ugrukdyrylyşynyň görnüşlerini belleýän üç geçirijini saklaýar: Ho­
rizontal (Горизонтально), Aligned with dimension line (Вдоль 
размерной линии) we ISO Standard (Согласно ISO).

Gepleşik penjiresiniň Fit (Размещение) goşmaçasy ölçegleri 
goýmagyň görnüşlerini tekst we oklar çykaryş çyzyklaryň arasynda 
sygmaýan ýagdaýynda kesgitleýär.

Fit Options (Опции размещения) opsiýasy «If there isn’t 
enough room to place both text and arrows inside extension li­
nes, the first thing to move outside the extension line is:» («Если 
текст и стрелки одновременно не могут быть размещены между 
выносными линиями, размещать их за пределами:») ýazgyny sak­
laýar we degişli geçirijileri saklaýar:

• Either the text or the arrows, whichever fits best (Либо 
текст, либо стрелки (оптимальное размещение)) – ýa tekst, 
ýa-da oklar;
• Arrows (Стрелки) – oklar;
• Text (Текст) – tekst;
• Both text and arrows (Текст и стрелки) – tekst we oklar;
• Always keep text between ext lines (Текст всегда между 
выносными) – tekst elmydama çykaryş çyzyklaryň arasynda.
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Bu töwerekde mundan başga hem Suppress arrows if they 
don’t fit inside the extension lines (Подавить стрелки, если они не 
помещаются между выносными) baýdajygy bar.

Text Placement (Размещение текста) töweregi «When text is 
not in the default position, place it» («При перемещении текста 
с позиции по умолчанию») ýazgyny we aşaky üç geçiriji arkaly 
saýlamagyň görnüşlerini saklaýar:

• Beside the dimension line (Перемещать размерную 
линию) – ölçeg çyzygy süýşürmek;
• Over the dimension line, with a leader (Строить выноску) 
– çykaryş ýazgyny gurmak;
• Over the dimension line, without a leader (He строить 
выноску) – çykaryş ýazgyny gurmaly däl.

Scale for Dimension Features (Масштаб размерных элемен­
тов) töweregi iki sany geçiriji saklaýar: Use overall scale of (Глобаль­
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ный масштаб), ölçegleri goýmagyň hemme elementlerine täsir edýär 
we üsti bilen masştab berilýän degişli sanawjy, alternatiwa hökmünde 
– listiň giňişligine görä ölçegleri masştablaýyn Scale dimensions to 
layout (paperspace) (Масштаб относительно листа) geçirijisi.

Fit (Размещение) goşmaçasynyň iň soňky töweregi Fine Tu­
ning (Подгонка элементов) iki baýdajyga eýe: Place text manually 
when dimensioning (Размещение размерного текста вручную) we 
Always draw dim line between extlines (Размерная линия всегда 
между выносными).

Primary Units (Основные единицы) goşmaçasy ölçeg sanlaryň 
birliklerini sazlamagyň parametrlerini kesgitleýär.

Linear Dimensions (Линейные размеры) töweregi häsiýetna­
malaryň şeýle meýdanlary öz içine alýar:

• Unit format (Формат единиц) – birlikleriň formaty;
• Precision (Точность) – takyklyk;
• Fraction format (Формат дробей) – droblaryň formaty;
• Decimal separator (Десятичный разделитель) – onluk 
bölüji;
• Round off (Округление) – tegeleklenme;
• Prefix (Префикс) – prefiks;
• Suffix (Суффикс) – suffiks.

Mundan başga hem, Linear Dimensions (Линейные размеры) 
töweregiň içinde ýene iki içki töwerek bar. Birinji töwerek Measure­
ment Scale (Масштаб измерений) Scale factor (Масштаб) masştab 
köpeldijini saklaýar, oňa hemme çyzykly ölçegler köpeldilýär. Bu kö­
peldiji diňe listiň giňişligine ulanylýar – eger Apply to layout di­
mensions only (Только для размеров на листе) degişli baýdajyk 
gurnalan bolsa.

Beýleki içki Zero Suppression (Подавление нулей) töweregi 
degişli baýdajyklar goýlandan soň başdaky we soňdaky nollary aýyr­
magy mümkin edýär:

• Leading (Ведущие);
• Trailing (Хвостовые);
• 0 Feet (0 футов);
• 0 Inches (0 дюймов).

Angular Dimensions (Угловые размеры) töweregi burç ölçeg­
leriň formadyny we takyklygyny sazlamagy mümkin edýär. Mundan 
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başga hem bu ýerde başdaky we soňdaky nollary ýok etmegiň müm­
kinçiligi bar.

Indiki goşmaça Alternate Units (Альтернативные единицы) 
diýlip atlandyrylýar.

Ol ölçegler bir wagtda esasy we alternatiw birliklerde goýlan öl­
çegler üçin görkezmeleri saklaýar – meselem, millimetrlerden başga 
duýmler gerek bolanda. Bu goşmaçanyň elementleri Display alter­
nate units (Разрешить альтернативные единицы) baýdajyk goýlan 
wagtynda elýeterli bolýar.

Alternate Units (Альтернативные единицы) töweregiň for­
mady we takyklygy, gaýtadan sanamagyň koeffisiýentini, çyzykly 
ölçegleriň tegeleklenmegini, alternatiw birlikleriň prefikslerini we 
suffikslerini dolandyrýar. Ol sazlamagyň degişli meýdanlaryny sak­
laýar:

• Unit format (Формат единиц) – birlikleriň formady;
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• Precision (Точность) – takyklyk;
• Multiplier for alt units (Коэффициент пересчета) – gaýta­
dan hasaplaýyş koeffisiýenti;
• Round distances to (Округление) – tegeleklenme;
• Prefix (Префикс) – prefiks;
• Suffix (Суффикс) – suffiks.

Zero Suppression (Подавление нулей) töweregi Primary Units 
(Основные единицы) goçmaça üçin bolan şol meýdança meňzeş. 
Placement (Размещение) töweregi iki geçiriji arkaly alternatiw öl­
çeg birligi geçirijileriň atlaryna degişlikde ýerleşdirmegi mümkin 
edýär, ýagny After primary value (За основным значением) ýa-da 
Below primary value (Под основным значением).

Tolerances (Допуски) goşmaçasy ölçeglerde ýol bererlikleriň 
goýulmagyny kesgitleýär.

Hemme görkezmeler goýlandan soň hemme goşmaçalary ОK 
düwmejigine basyp ýapmaly, Dimension Style Manager (Диспетчер 
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размерных стилей) gepleşik penjiresini bolsa – Close (Закрыть) 
düwmejigine basmak gerek.

Dimension Style Manager (Диспетчер размерных стилей) 
penjiresiniň Modify (Изменить) düwmejigi bar bolan ölçeg stiline 
üýtgetmeleri girizmegi we ýatda saklamagy mümkin edýär. Ol Mo­
dify Dimension Style (Изменение размерного стиля) gepleşik 
penjiresini çagyrýar, ol dolulykda New Dimension Style (Новый 
размерный стиль) penjiresine gabat gelýär we goşmaça 6 eýe.

Modify (Изменить) düwmejigine meňzeşlikde Override (Пере­
определить) düwmejigi işleýär ol Override Current Style (Пере­
определение текущего стиля) gepleşik penjiresini açýar.

Dimension Style Manager (Диспетчер размерных стилей) 
penjiresiniň Compare (Сравнить) düwmejigi degişlikde Compare 
Dimension Styles (Сравнение размерных стилей) gepleşik penji­
resini çagyrýar.

Bu penjirä Compare (Сравнить) we With (Co стилем) sana­
wynda stilleriň tapawutly atlary görkezilen bolsa ölçeg üýtgeýänleriň 
tapawutly ähmiýetleri çykarylýar. Eger iki sanawda hem atlar gabat 
gelýän bolsa ýa-da olaryň birinde <none> (<нет>) opsiýasy saýlany­
lan bolsa, onda üýtgeýänleriň doly sanawy we ähmiýetleri çykarylýar.
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Ölçegleriň goýulmagyny sazlamak üçin iň tiz usuly – bu degişli 
ulgamlaýyn üýtgeýäni üýtgetmeklik. Meselem, eger siz ölçegle­
ri goýmagyň global masştabyny üýtgetmegi isleseňiz, Command: 
(Команда:) setirde Dimscale girizmeli we muňa jogap hökmünde 
ululygyň duran bahasy görkezilip, täze bahany girizmek üçin sorag 
berler:

Enter new value for Dimscale <1.0000>: (Новое значение 
Dimscale <1.0000>:).

Multiçyzyklaryň stilleri
Täze stiliň döredilmegi Mlstyle (Млстиль) buýrugy arkaly amala 

aşyrylýar, oňa Format (Формат) menýunyň Multiline Style (Стили 
мультилиний) bendi gabat gelýär. Mlstyle (Млстиль) buýrugy Mul­
tiline Styles (Стили мультилиний) penjiresini çagyrýar.

Penjiräniň Multiline Style (Стиль мультилиний) töwere­
gi açylýan sanawy we iki meýdany saklaýar. Current (Текущий) 
açylýan sanaw häzirki stiliň adyny görkezýär. Bu sanaw suratyň 
multiçyzyklaryň stilleriniň hemme sanawyny görmegi, şeýle hem 
beýleki stili goýmagy mümkin edýär. Name (Имя) meýdany täze stili 
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döretmekde ýa-da bar bolanyň adyny üýtgetmekde at bermek üçin 
ulanylýar. Description (Пояснение) meýdany her stile uzynlygy 255 
simwola çenli bolan belligi ýazmagy mümkin edýär.

Mundan başga hem Multiline Style (Стиль мультилинии) 
töwereginde 4 düwmejik bar:

• Load (Загрузить) – ýüklemek;
• Save (Сохранить) – ýatda saklamak;
• Add (Добавить) – goşmak;
• Rename (Новое имя) – täzeden at bermek.

Load (Загрузить) düwmejigi Load Multiline Styles (Загрузка 
стилей мультилинии) gepleşik penjiresini çagyrýar.

Multiçyzyklaryň stillerini giňişligi mln bolan faýllarda ýatda sak­
lamak mümkin hem-de şol faýllardan ýüklemek mümkin. Ýüklemek 
we ýatda saklamak üçin standart faýl bolup acad.mln çykyş edýär.

Element Properties (Свойства элемента) we Multiline Pro­
perties (Свойства мультилинии) düwmejikleri häzirki ulanylýan 
we entek hiç hili multiçyzygy çyzmakda ulanylmadyk stiliň häsiýet­
namalaryny üýtgetmek üçin ulanylýar. Multiline Styles (Стили 
мультилинии) gepleşik penjiresiniň merkezinde häzirki stiliň hä­
siýetleri görkezilýär.

Multiçyzygyň täze görnüşini döredeliň. Özi bilen iki sany 
döwük çyzyklardan ybarat bolan Standart stilden başga ýene bir stil 
döredeliň we onuň adyny latin harplary bilen ýazmak gerek. Name 
(Имя) meýdanynda Standard ady üýtgedip täze at, meselem Triple 
bermeli.

Description (Пояснение) meýdanynda öz belligiňizi girizmeli– 
meselem, üç çyzyk. Soňra Add (Добавить) düwmejigine basmaly.
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Mundan soň multiçyzygyň stilleriniň sanawynda iki at görkeziler 
(Standard и Triple) we Triple ady häzirki ulanylýan stiliň ady bolar.

Stiliň iki çyzygyna ýene birini goşalyň. Element Properties 
(Свойства элемента) düwmejigine basmaly. Element Properties 
(Свойства элемента) gepleşik penjiresi açylar.
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Penjiräniň ýokarky böleginde Elements (Элементы) sanawy 
ýerleşdirilen, onda häzirki stile girýän çyzyklar we onuň häsiýetleri 
görkezilen. Häsiýetlere şular degişlidir: Offset (Смещение), Color 
(Цвет), Ltype (Тигашнии). Triple stilinde ilkibaşda Standard stilin­
de hem bar bolan diňe iki çyzyk bar. Çyzyklar 0,5 we – 0,5 süýşmelere 
eýe, ýagny multiçyzygyň okuna görä iki tarapa ýarym millimetre 
süýşürilen. Süýşmeleri üýtgetmek üçin syçanjyk bilen çyzygy belle­
meli we Offset meýdanynda baha girizmeli.

Multiçyzygyň iki elementine hem täze reňk bereliň. Munuň üçin 
Color (Цвет) düwmejigine basmaly we açylan gepleşik penjiresin­
de reňk saýlamaly. Multiçyzygyň iki elementiniň ýanyna üçünjini 
goşalyň.

Munuň üçin Add (Добавить) düwmejigine basmaly. Basylan­
dan soň elementleriň sanawynda üçünjisi emele geler. Bu çyzygyň 
hem häsiýetlerini üýtgetmek mümkin. Islendik elementiň çyzygyň 
görnüşini üýtgetmek mümkin, munuň üçin Linetype (Тип линии) 
düwmejigine basmaly. Eýýam tanyş, çyzygyň görnüşini almak üçin 
gepleşik penjiresi açylar. Onda çyzygyň täze görnüşini ýüklemeli. 
Bu amallardan soň Multiline Styles (Стили мультилинии) gepleşik 
penjiresine gaýdyp gelmeli.

Stiliň beýleki häsiýetnamalaryny Multiline Properties (Свойс­
тва мультилинии) düwmejigine basyp redaktirlemeli. Multiline 
Properties (Свойства мультилинии) penjiresi açylar.



273

Bu penjirede multiçyzyklar üçin şeýle parametrleri goýmak 
mümkin:

• Display joints (Показать стыки) – sepleri görkezmek;
• Caps (Торцы) – gyraňlak;
• Fill (Заливка) – reňk bilen doldurmak.

Display joints (Показать стыки) baýdajyklar goýulsa, multi­
çyzyklaryň döwülýän ýerlerinde sepler kesimler bilen görkeziler.

Caps (Торцы) töweregi uçlary (gyraňlary) çyzmagy amala 
aşyrýar. Gyraňlaryň islendiginde daşky erňekleriň kesimler bilen (Line 
(Отрезок)), şeýle hem halkalar bilen (Outer arc (Внешняя дуга)) 
birikdirilmeginiň bellenilmegi mümkin. Inner arcs (Внутренние 

18. Sargyt 1372
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дуги) baýdajygy elementleriň sany dört ýa-da köp bolsa taýlaýyn 
içki elementleri halkalaýyn birleşdirýär. Multiçyzygyň gyraňy kesýän 
burç Angle (Угол) meýdanynda berilýär. Fill (Заливка) töweregi 
multiçyzygyň içindäki doldurmagyň reňkini kesgitleýär, şeýle hem ol 
On (Вкл) baýdajygy arkaly doldurmagyň özüni işledip ýa-da öçürip 
bilýär.

Hemme parametrler goýlandan soň Multiline Styles (Стили 
мультилинии) gepleşik penjiresini ýapmaly.

Dolandyryş merkezi
Bu ýörite penjire Adcenter (Цувкл) buýrugy bilen çagyrylýar, 

oňa Standard (Стандартная) gurallar paneliniň  düwmejigi we 
Tools (Сервис) menýunyň DesignCenter (Центр управления) ben­
di gabat gelýär. Dolandyryş merkezini <Ctrl>+<2> klawişalar arkaly 
çagyrmak mümkin.

Netijede Designcenter (Цehtp Управления) penjiresi açylýar. 
Bu penjiräniň düzümi aşakdaky 4 sany goşmaçanyň açylmagyna bag­
ly bolup durýar:

• Folders (Папки) – faýla saýlamak ýa-da onuň elementlerini 
görmek üçin kompýuteriň disklerini we bukjalaryny görkez­
ýär;
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• Open Drawings (Открытые рисунки) – penjiräniň çep tara­
pynda grafiki elementleri, sag tarapynda bolsa şol elementleriň 
atlaryny görkezýär;
• History (Журнал) – Dolandyryş merkezindäki soňky amal­
laryň žurnalyny görkezýär;
• DC Online (ЦУ Online) – Autodesk saýtynda standart 
elementleriň kitaphanalaryna gönümel düzgündäki Internede 
bolan elýeterlilik; şonda AutoCAD ulgamynyň ekzemplýary 
barada maglumat berilýär.

Goşmacalaryň aşagynda Dolandyryş merkezi bilen işlemegi 
aňsatlaşdyrýan düwmejikler ýerleşen:

•  – Load (Загрузить), bellenilen suraty ýükleýär;
•  – Back (Назад), öňki ýüklenen elemente geçýär (surat);
•  – Forward (Вперед), indiki ýüklenen elemente (surata) 
geçýär;
•  – Up (Вверх), agaç düzümde bir dereje ýokary geçýär;
•  – Search (Поиск), bellenilen häsiýetler (gatlar, bloklar 
we b.) boýunça faýly gözleýär;
•  – Favorites (Избранное), AutoCAD Favorites 
(Избранное) bukjanyň içinde döreden Autodesk bukjanyň 
düzümini görkezýär;
•  – Home (Домой), AutoCAD ulgamynyň programma 
üpjünçiliginiň Sample bukjasynyň içinde ýerleşen Design­
Center bukjasynyň düzümini görkezýär;
•  – Tree View Toggle (Зона структуры), penjiräniň çep 
böleginde gerek bolýan görnüşiň düzümini görkezýär ýa-da 
aýyrýar (görnüş goşmaça bilen kesgitlenýär);
•  – Preview (Образцы), penjiräniň sag böleginde grafiki 
däl nusgalaryny görmegiň zolagyny goşýar ýa-da aýyrýar;
•  – Description (Описания), penjiräniň sag böleginde bel­
lenilen elementler üçin (meselem bloklar üçin) tekst bellikleri 
görmegiň zolagyny goşýar ýa-da aýyrýar;
•  – Views (Вид), elementleri ekrana çykarmak üçin 
penjiräniň görnüşini belleýär (Large icons (Крупные значки), 
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Small icons (Мелкие значки), List (Список) ýa-da Details 
(Таблица)).
 düwmejigi işledilende AutoCAD Designcenter (Центр 

Управления) penjiräni diklik boýunça iki bölege bölýär we çep böle­
ginde ýa iş stolunyň, ýa-da saýlanylan surat faýlynyň, işiň žurnalynyň 
agaç görnüşli düzümini gurýar (düzümi saýlanylan goşmaça bagly).

Designcenter (Центр Управления) penjiräniň sag bölegi bir, 
iki ýa-da üç bölege bölünip bilner, şeýle hem saýlanylan elementiň 
nusgasyny we teswirlenmesini görkezip ýa-da görkezmän bilýär, 
bu bolsa  we  düwmejikleri arkaly dolandyrýar. Open Dra­
wings (Открытые рисунки) goşmaçasynda Designcenter (Центр 
Управления) penjiräniň çep boleginde suratyň nyşanynyň çep ta­
rapynda ýerleşen plýusly nyşana syçanjyk bilen basylsa grafiki däl 
elementleriň düzümi görkeziler, olara şular degişli:

• Blocks (блоки) – bloklar;
• Dimstyles (размерные стили) – ölçeg stilleri;
• Layers (слои) – gatlaklar;
• Layouts (листы) – listler;
• Linetypes (типы линий) – çyzyklaryň görnüşleri;
• Textstyles (текстовые стили) – tekst stilleri;
• Xrefs (внешние ссылки) – daşky salgylanmalar.

Designcenter (Центр Управления) penjiresinde görkezilen is­
lendik elementler şol wagt açylan surada ýönekeý syçanjyk bilen ge­
çirilme bilen geçirilip bilner.

Tejribe işler
1. Içi gyzyl reňk bilen doldurylan kwadraty çyzmaly.
2. Iki kesişýän gönüburçluklaryň kesişýän töweregini reňklemeli.
3. Iki kesişýän gönüburçluklaryň kesişmeýän töweregini reňklemeli.
4. Orta çyzygynda Gas diýen ýazgyly multiçyzygy döretmeli.
5. Iki gatdan ybarat bolan çyzgyny gurmaly.
6. Üç gatdan ybarat bolan çyzgyny gurmaly.
7. Bölekleri çap edilmeýän çyzgyny gurmaly.
8. Bölekleri redaktirlenmeýän çyzgyny gurmaly.
9. Çyzyklarynyň galyňlygy dürli bolan çyzgyny gurmaly.
10. Çyzyklarynyň reňki dürli bolan çyzgyny gurmaly.
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XII. Çap, bloklar we daşky salgylanmalar

Çap
Plotter ulgamda gurnalandan soň çykyşy sazlamaga başlamak 

bolar. Munuň üçin Standard (Стандартная) paneliniň  düwme­
jigi we File (Файл) menýunyň Plot (Печать) bendi niýetlenen. Olar 
Plot (Печать) buýruga gabat gelýärler.

Plot (Печать) buýrugy çagyrylanda aşakdaky Plot (Печать) 
gepleşik penjiresi emele geler.

Penjire diklik boýunça üç bölege bölünýär, özem ortaky bölegi 
iki goşmaça eýe bolup durýar – Plot Device (Устройство печати) we 
Plot Settings (Параметры печати).

Gepleşik penjiräniň ýokarky çep böleginde ýerleşen Layo­
ut name (Имя вкладки) töweregi AutoCAD grafiki ekranynyň 
goşmaçasynyň adyny saklaýar: ol Model (Модель), Layout 1 
(Лист!) we Layout2 (Лист2), ýa-da ulanyjy tarapyndan bellenilen 
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baha eýe bolup biler. Goşmaçanyň adynyň ýanynda Save changes to 
layout (Сохранить установленные параметры) baýdajygy goýmak 
mümkin, ol şol penjirede bellenilen parametrleri indiki çap üçin ýatda 
saklamagy mümkin edýär.

Page setup name (Набор параметров листа) töweregi listiň 
parametrleriniň toparyny at bilen ýatda saklamagy we olary soň atlary 
boýunça çagyrmagy mümkin edýär.

Page setups (Наборы параметров листа) sanawynda şol sura­
tyň listiniň parametrleriniň toplumy sanalyp geçilýär.

Plot (Печать) gepleşik penjiresiniň birinji Plot Device 
(Устройство печати) goşmaçasy çykyş gurluşyň sazlaýyş parametrle­
rini saklaýar. Şol goşmaçanyň Plotter configuration (Конфигурация 
плоттера) töweregi bar bolanlaryň arasyndan zerur konfigurasiýasyny 
saýlamagy mümkin edýär (meselem, HP DeskJet 400 (Monoch­
rome)). Properties (Свойства) düwmejigi Plotter Configuration 
Editor (Редактор параметров плоттера) penjiresini çagyrýar, onda 
plotteriň konfigurasiýasynyň faýlyny ýatda saklamak mümkin (рсЗ 
giňişlikli).

Plot style table (pen assignments) (Таблица стилей печати 
(присвоения перьев)) töweregi Name (Имя) açylýan sanaw arkaly 
bar bolanlaryň arasyndan stilleriň tablisasyny saýlamagy mümkin 
edýär.

Number of copies (Количество экземпляров) hasaplaýjysy çap 
edilýän çyzgynyň göçürmeleriniň sanyny dolandyrýar.

Plot to file (Печать в файл) töweregi Plot to file (Печать в файл) 
baýdajyk goýlan bolanda çapy gönümel plottere däl-de, pit giňişlikli 
faýla amala aşyrýar, ol bolsa soň AutoCad ulgamyndan daşary plotte­
re çykarylyp bilner.

Plot (Печать) gepleşik penjiresiniň ikinji Plot Settings 
(Параметры печати) goşmaçasy listiň we çyzgynyň parametrlerini 
saklaýar. Paper size and paper units (Формат листа и единицы) 
töweregi iki parametri – açylýan sanawy we iki sany geçirijini sak­
laýar. Plot device (Устройство печати) parametri birinji goşmaçada 
saýlanylan plotteriň adyny saklaýar. Paper size (Формат листа) 
açylýan sanawda saýlanylan plotter üçin elýeterli bolan formatlar­
dan listiň formadyny saýlamak gerek. Printable area (Доступная 
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область) parametri berlen listiň formady üçin hakyky çap edilýän 
töwereginiň ölçeglerini görkezýär.

Drawing orientation (Ориентация чертежа) töweregi çyzgy­
nyň kagyzyň listinde ýerleşmegini dolandyrýar: Portrait (Книжная) 
ýa-da Landscape (Альбомная). Ikinji geçiriji işledilende çykarylýan 
şekil birinji ýerleşmä görä 90° öwrülýär. 
Şekili 180° öwrüp bolýar – Plot upside-
down (Перевернуть) baýdajygy goý­
maly.

Plot area (Печатаемая область) 
töweregi örän möhüm, onuň görkez­
meleri çyzgynyň dolulykda ýa-da onuň 
böleklerini çap etmegi mümkin edýär.

Model (Модель) goşmaçasy 
çap edilende Plot area (Печатаемая 
область) töwereginde aşakdaky geçiri­
jiler bar:
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• Limits (Лимиты) – limitleriň zolagy çykarylýar;
• Extents (Границы) – araçäkleriň zolagy çykarylýar, ýagny 
çyzgynyň hemme elementleri tutýan iň kiçi gönüburçluk zolak 
(doly şekili almagyň iň tygşytly warianty;
• Display (Экран) – diňe şol mahal grafiki ekranda görünýän 
zat çykarylýar;
• View (Вид) – saýlanylan atlandyrylan görnüş çykarylýar;
• Window (Рамка) – diagonal boýunça iki nokat bilen kesgit­
lenýän gönüburçluk zolak çykarylýar.

Plot scale (Масштаб печати) töweregi çyzgynyň plottere çyka­
rylmagynyň masştabyny belleýär. Bu töweregiň açylýan sanaw stan­
dart masştablaryny saklaýar: Scaled to Fit (Вписать), 1:1, 1:2, 1:4, 
1:8, 1:10, 1:16, 1:20, 1:30, 1:40, 1:50, 1:100, 2:1, 4:1, 8:1, 10:1, 100:1 
we b. Scaled to Fit (Вписать) bahasy çyzgynyň gönümel kagyzyň 
formadynda doly ýerleşdirýär. Eger çyzgynyň çykarylmagyny stan­
dart däl formatda amala aşyrmak gerek bolsa 1:27.5, onda çep meý­
danda 1 (mm (мм)), sagda bolsa – 27.5 (units (единиц рисунка)) 
girizmeli.

Plot scale (Масштаб печати) töwereginiň Scale lineweights 
(Масштабировать веса линий) baýdajygy çapda diňe obýektleriň 
ölçeglerini däl-de, eýsem olaryň agramlaryny hem masştablamagy 
mümkin edýär. Eger baýdajygy aýrylan bolsa, çyzyk berlen agram 
bilen çyzylýar.

Plot offset (Смешение от начала) töweregi Center the plot 
(Центрировать) baýdajyk aýrylan ýagdaýynda listde çapyň elýe­
terli töwereginiň çep aşaky burçundan goşmaça süýşmegi belleýär 
(süýşmegiň mm-däki ähmiýetini X we Y meýdanlaryna ýazmaly). 
Center the plot (Центрировать) goýlan bolsa çyzgy takyk listiň 
merkezinde ýerleşdirilýär. X we Y meýdanlaryň bahalary položitel 
bolsa süýşürilme kagyzyň listiniň içine amala aşyrylýar.

Shade plot (Раскраска чертежа) açylýan sanawda aşakdaky op­
siýalar bar:

• As Displayed (Как есть) – bolşy ýaly;
• Wireframe (Каркас) – karkas;
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• Hidden (Co скрытием невидимых линий) – görünmeýän 
çyzyklary bakmak bilen;
• Rendered (Тонированная) – tonirlenen.

Bu opsiýalar görnüş ekrany onuň suratda haýsy ýagdaýda 
ýerleşendigine garaşsyz (adaty, reňklenen, görünmeýän çyzyklary 
ýok etme bilen ýa-da tonirlenen ýagdaýda).

Quality (Качество) açylýan sanaw tonirlenen we reňklenen 
görnüşleriň hilini dolandyrýar. Sanawa şeýle elementler girýär:

• Draft (Черновое) – reňkleme we tonirleme inkär edilýär, 
çap karkas görnüşinde amala aşyrylýar;
• Preview (Предварительное) – 150 dpi rugsat;
• Normal (Обычное) – 300 dpi rugsat;
• Presentation (Высокое) – 600 dpi rugsat;
• Maximum (Максимальное) – şol printer üçin mümkin bo­
lan iň ýokary rugsat;
• Custom (Пользовательское) – rugsady ulanyjy belleýär.

Plot options (Опции печати) töweregi aşakdaky baýdajyklara 
eýe:

• Plot object lineweights (Учитывать веса линий объектов) 
– çyzyklaryň agramlaryny hasaba alýar; bu baýdajyk diňe Plot with 
plot styles (Учитывать стили печати) baýdajygy aýrylandan elýe­
terli bolup durýar;

• Plot with plot styles (Учитывать стили печати) – çapyň stil­
leri ulanylýar;

• Plot paperspace last 
(Объекты листа последними) 
– ilkibaşda list giňişliginiň ob­
ýektlerini ýa-da model giňiş­
liginiň obýektlerini çap etmeli;

• Hide paperspace ob­
jects (Скрывать объекты) – 
görünmeýän çyzyklary bukýar.

Plot Device (Устройство 
печати) we Plot Settings (Па­
раметры печати), goşmaçala­
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ryň hemme parametrleri goýlandan soň çapyň görnüşine seretmeli, 
munuň üçin Plot (Печать) gepleşik penjiresiniň aşagynda ýerleşen 
düwmejikleri ulanmaly. Olaryň birinjisi Partial Preview (Контурный 
просмотр) düwmejigi Partial Plot Preview (Контурный просмотр 
чертежа) penjiresinde çap edilýän töweregiň ýerleşişini görkezýär.

Partial Preview (Контурный просмотр) düwmejigi ulanylan­
dan soň Full Preview (Полный просмотр) düwmejigine basmaklyk 
ündelýär, ol boljak çapyň netijesini kagyzyň listinde görkezýär.

Çapyň dogry çykjakdygyna doly göz ýetirip Plot (Печать) 
gepleşik penjiresinde ОK düwmejige basmaly we çyzgyny plottere 
ibermeli.

Plot stamp (Штемпель) töwereginde baýdajygyň On (Вкл) 
ýagdaýynda çyzga çykarylýan ştempeliň deslapky düzülmegi Plots­
tamp (Штемпель) buýrugy bilen ýerine ýetirilýär. Bu buýruk Plot 
Stamp (Штемпель) gepleşik penjiresini açýar.

Bu penjirede Preview (Просмотр) töweregi şertli görnüşinde 
döredilýän ştempeliň nirede ýerleşjekdigini görkezýär.

Ştempeliň düzümi tekst setiri bolup durýar, onuň elementleri çy­
karylanda oturlar bilen aýrybaşgalanýarlar. Şeýle elementler 9-a çenli 
bolup durýar. Esasy elementler (7-ä çenli):
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• Drawing name (Имя рисунка) – suratyň ady;
• Layout name (Имя вкладки) – goşmaçanyň ady;
• Date and Time (Дата и время) – sene we wagt;
• Login name (Пользователь) – ulanyjy;
• Device name (Устройство) – gurluş;
• Paper size (Формат листа) – listiň formaty;
• Plot scale (Масштаб чертежа) – çyzgynyň masştaby.

Ştempele ikiden köp bolmadyk ulanyjynyň elementlerini goşmak 
mümkin, olar User defined fields (Дополнительная информация) 
töwerekde ýerleşen açylýan sanawlaryndan alynýar.

Bloklar we salgylanmalar
Çyzgylary we modelleri taýýarlamagyň möhüm guraly bolup 

bloklaryň we daşky salgylanmalaryň ulanylmagy durýar. Blok – bu 
çylşyrymly atlandyrylan obýekt, onuň üçin teswirleme döredilýär, 
ol teswirleme öz içine şol wagt ulanylýan ýönekeý suratyň islendik 
sanyny alýar. Blok baza nokadyna eýe bolýar; ol çyzgynyň islendik 
ýerine goýmaklyk üçin ulanylyp bilner. Blok atributlara eýe bolup bi­
ler. Bloguň goýulmagynyň netijesinde emele gelýän primitiw bloguň 
girmegi diýlip atlandyrylýar.

Daşky salgylanma – şol wagtky ulanylýan elementleri bilen 
daşky faýlyň şekili, özem salgylanýan faýlyňyz esasy surata ýazyl­
maýar. Netijede şol wagtky ulanylýan surat täze obýektleriň daşky 
şekilleriniň köp sany bilen doldurylyp bilner, emma şol faýlyň ölçegi 
kän ýokarlanmaýar. Daşky salgylanmany goýma amalyndan emele 
gelýän daşky salgylanmanyň girmegi ýa-da ýöne daşky salgylanma 
diýlip atlandyrylýar.

Bloklar arkaly bir görnüşli obýektleri gurup we diňe olaryň birini 
teswirlemek arkaly galanlaryny bolsa blogy goýmak bilen alyp bol­
ýar. Daşky salgylanmalar öň döredilen standart grafiki elementlerini 
ulanmaga mümkinçilik berýär.

Bloklar
Blogy ulanmaklyk üçin birinji ädim – onuň teswirlenmesini 

döretmek. Munuň üçin bloguň haýsylardan durýandygyny we baza 
nokadyň nirede bolmalygyny kesgitlemeli.
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Bloguň teswirlenmesini dö­
retmek üçin Block (Блок) buýru­
gy saýlamaly. Buýruga Draw 
(Рисование) gurallar paneliniň  
düwmejigi Draw > Block > Make 
(Рисование > Блок > Создать) 
menýunyň bendi gabat gelýär.

Block (Блок) buýrugy Block 
Definition (Описание блока) 
gepleşik penjiresini çagyrýar.

Bu penjire arkaly bloguň 
adyny, baza nokadyň koordinata­
laryny, bloga girjek obýektleri we 
b. bellemek mümkin.

Blogy goýma amaly üçin 
Insert (Вставить) buýrugy ula­

nylýar, oňa Draw (Рисование) paneliniň  topar 
düwmejiginiň  düwmejigi we Insert (Вставка) 

menýusynyň Block (Блок) bendi gabat gelýär. Mundan başga hem 
bu buýruga Insert (Вставка) paneliniň  düwmejigi gabat gelýär.

Insert (Вставить) buýrugy işlände Insert (Вставка блока) 
gepleşik penjiresi açylýar. Bu penjire şol wagt ulanylýan surata onda 
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kesgitlenen bloklary goýmagy mümkin edýär (eýsem beýleki surat­
lardan bolan faýllary). Bu penjire içinde görkezilen bloklary atlary 
boýunça saýlamagy we goýulmagy amala aşyrýar. Baza nokadyň su­
ratda ýerleşmegini, bloguň goýlanda masştabyny we haýsy burç bilen 
goýulmagy belli bir baýdajyklar işledilende ýa gönümel penjirede, 
ýa-da surata goýlan wagty amala aşyrmak mümkin.

Şeýle hem bu penjirede Explode (Расчленить) baýdajygy goý­
mak bilen blogy goýlan mahaly bölmek mümkin.

Tool Palettes paneli
Bu panel iň köp ulanylýan bloklary, ştrihlemeleri we reňk dol­

durmalary (beýleki suratlardan) goýmagy amala aşyrýar.
Deslapdan Tool Palettes (Палитры Инструментов) panelinde 

üç palitra bar, olaryň her biri goşmaça hökmünde ýerine ýetirilen: ISO 
Hatches (Штриховки ISO), Sample office project (Примерный 
офисный проект), Imperial Hatches (Английские штриховки).

Palitranyň elementine syçanjygy sag düwmejigi bilen basylsa 5 
elementden ybarat bolan kontekst menýu emele geler:

Şol menýudan Properties (Свойства) bendine basylsa elementiň 
häsiýetnamalaryň penjiresi emele geler.

Bu penjire reňk doldurmalar we ştrihlemeler üçin meňzeş gelýär. 
Meselem, aşaky suratda Office trim carpet elementi üçin penjiräniň 
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düzümi getirilen. Pattern (Образец) parametrler toparynda spesifiki 
häsiýetler getirilen, General (Общие) parametrler toparynda – stan­
dart häsiýetler (reňk, we ş.m.).

Bloklar üçin şol penjiräniň düzümi birneme tapawutly bolýar. 
Sanawda Pattern (Образец) parametrler toparynyň deregine Insert 
(Вставка) topary bar.

Bloklary eksport etmek
Teswirlemesinde bloga goşulan obýektler goýlan blokda hem öz 

esasy häsiýetlerini saklaýarlar (gat, reňk, çyzygyň görnüşi, agramy). 
Byblock (Поблоку) ýörite ähmiýet üçin degişli däl bolup durýar, bu 
ähmiýet reňke, çyzygyň görnüşine we agramyna berlip bilner.

Suratyň islendik bölegi (meselem, bloguň teswirlenmesi) Wblock 
(Пблок) buýrugy arkaly aýry faýla çykarylyp bilner. Bu buýruk Wri­
te Block (Запись блока на диск) gepleşik penjiresini çagyrýar.

Bu penjiräniň Source böleginde eksportirlemek üçin blogy, su­
raty ýa-da obýektleri saýlamaklyk mümkin edilen.

Eger Object geçirijisi işledilse, onda Base point we Objects 
töwerekleri elýeterli bolup durýar.

Base point töweregi baza nokadynyň koordinatalaryny belle­
megi mümkin edýär. Objects (Объекты) töwereginiň düwmejikleri 
çykarylýan ýönekeýleri saýlamagy mümkin edýär, şeýle hem saýla­
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nylan obýektler bilen Wblock (Пблок) buýrugy ýerine ýetirilenden 
soň näme etmelidigini görkezýär:

• Retain (Оставить) – şol wagtky ulanylýan suratda saýlany­
lan görnüşde öňki ýagdaýynda galdyrmaly;
• Convert to block (Сделать блоком) – şol wagtky ulanyl­
ýan suratda bloguň teswirlenmesini döretmek (bloguň ady 
hökmünde Destination (Размещение) töwereginden faýlyň 
adyny almaly), saýlanylan obýektleri şol bloguň girmesine 
çalşyrmaly;
• Delete from drawing (Удалить из рисунка) – saýlanylan­
lary şol suratdan ýok etmeli.

Bloguň atributlary
Köplenç blok bilen bilelikde ol goýlan mahaly öz bahalaryny 

üýtgedip bilýän ýazgylary saklamak zerurlygy ýüze çykýar. Auto­
Cad ulgamynda Attribute Definition (Описание Атрибута) bar, ol 
bloguň teswirlenmesine goşulyp bilýär we şol blok goýlanda, onuň 
bahasy soralyp bloguň düzümine girýän atribut (tekst setiri) dörediler.
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Atributlary döretmek üçin Attdef (Атопр) buýrugy döredilýär, 
Draw > Block > Define Attributes (Рисование > Блок > Задание 
атрибутов) bendi gabat gelýär. Attdef (Атопр) buýrugy Attribute 
Definition (Описание атрибута) penjiresini çagyrýar.

Bu penjiräniň parametrlerini aşaky mysalda seredeliň. Meselem, 
otagda kompýuterleriň ýerleşişiniň ülňüsini çyzmak gerek bolan ýag­
daýda. Kompýuteriň şertli belgisi hökmünde iki gönüburçlukdan yba­
rat bolan blogy ulanmaly. Gönüburçluklaryň şekiliniň aşagynda atri­
butlardan iki ýazgyny ýerleşdirmeli. Bir ýazgy prosessoryň görnüşini, 
ikinjisi operatiw huşuň ululygyny kesgitlär.

Şol gönüburçluklary çyzyp, Attribute Definition (Описание 
атрибута) gepleşik penjiresini çagyrmaly.

Mode (Режим) töweregi 4 baýdajyk arkaly atributyň düzgünini 
belleýär:

• Invisible (Скрытый) – atribut görünmeýär (ony görkezmek 
üçin Attdisp (Атэкр) buýrugy ulanmaly);
• Constant (Постоянный) – atribut hemişelik (üýtgemeýän) 
baha eýe bolýar we ol blok goýlanda soralmaýar;
• Verify (Контролируемый) – blok goýlanda gözegçilik üçin 
atributyň bahasy iki gezek soralýar;
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• Preset (Установленный) – atribut bellenilen baha bilen 
goýulýar (baha soralmaýar).

Attribute (Атрибут) töwerekde aşakdaky üç parametri goýmak 
mümkin:

• Tag (Имя) – atributyň ady;
• Prompt (Подсказка) – atributyň bahasy soralanda çykýan 
sorag;
• Value (Значение) – atributyň deslapky bahasy.

Insertion Point (Точка вставки) töwereginde her atribut üçin 
goýulmagyň nokady bellenilmeli, Text Options (Параметры текста) 
töwereginde bir setirli tekst üçin parametrler bellenilýär.

19. Sargyt 1372
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Biziň mysalymyzda PROCESSOR we RAM atly atributlary 
kesgitlemeli. Iki atribut üçin Mode (Режим) töwereginde hiç baý­
dajygy goýmaly däl. Kömek sözler hökmünde Prosessor we Opera­
tiw huş ýazmaly. Deslapky bahalar hökmünde Р-3 800 МГц we 256 
Мб alalyň. Birinji atributyň goýulma nokadyny daşky gönüburçlugyň 
aşagynda ortadan ýerleşdirmeli Justification (Выравнивание) pa­
rametrini bolsa – Center (Середина) edip goýmaly. Ikinji atribut 
üçin Align below previous attribute definition (Выровнять по 
предыдущему атрибуту) baýdajygy goýmaly.
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Block (Блок) buýrugy arkaly bloguň teswirlenmesini döredip, 
Computer ady bermeli, oňa iki gönüburçlugy we iki atribut teswir­
lenmesini goşmaly. Başlangyç obýektleri ýok etmeli.

Insert (Вставить) buýrugy boýunça döredilen blogy goýmak 
mümkin. Blok goýlan mahaly AutoCAD ulgamy ilkibaşda birinji 
atributyň bahasyny girizmek barada sorag berer:

Prosessor <Р-3 800 MGz>:
Soňra: ikinji atributyň bahasyny girizmek barada sorag berer
Operatiw hus <256 Mb>:
Goýlan bloklar üçin atributlaryň bahalaryny redaktirlemek müm­

kin. Munuň üçin Eattedit Сатрелакт) buýrugy ýa-da oňa gabat gel­
ýän Modify II (Редактирование 2) paneliniň  düwmejigi gabat 
gelýär.

Daşky salgylanma
Insert (Вставить) buýrugy arkaly bir faýlyň beýleki surat 

faýlyna goýulmagy soňkynyň ölçegini artdyrýar, sebäbi onuň içine 
goýulýan ýönekeý faýl geçirilýär. Emma şol wagtky ulanylýan surata 
beýleki suratyň şekilini goýmagyň beýleki usuly bar – faýly daşky 
salgylanma arkaly goýmaklyk. Şonda salgy goýulýan faýl gönümel 
geçirilmän, diňe salgylanýan faýlyň ady ýatda saklanylýar. Geljek­
de AutoCAD suraty açanda ilkibaşda surat, soňra goşmaça faýl-
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salgylanmanyň düzümi ýüklenýär. Bu ýagdaýda suratyň faýly uly 
ölçege eýe däl, emma bu ýagdaýda onuň faýl-salgylanma bolan bag­
ly bolmagy artdyrylýar we soňky ýok bolanda ýa-da ady üýtgedilse 
ýalňyşlyk ýüze çykar.

Goşulan salgylanmalar hem mümkin, bu ýagdaýda öz içinde 
daşky faýla salgylanma eýe bolan faýla salgylanma bolýar.

Daşky salgylanmalaryň dispetçeri
Xref (Ссылка) buýrugy suratda başga faýllara salgylanmalary 

dolandyrýar. Buýruga Insert (Вставка) paneliniň  düwmejigi 
ýa-da Reference (Ссылки) paneliniň meňzeş düwmejigi gabat gel­
ýär, bu buýruk şeýle hem Insert (Вставка) menýusynyň Xref Ma­
nager (Диспетчер внешних ссылок) bendi arkaly çagyrylýar. Şeýle 
düwmejigi Draw (Рисование) panelinde  düwmejikler toparynda 
tapmak mümkin.

Xref (Ссылка) buýrugy Xref Manager (Диспетчер внешних 
ссылок) gepleşik penjiresini çagyrýar.
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Bu penjire daşky salgylanmalaryň üstünde amallary ýerine ýetir­
megi mümkin edýär (goşmak, ýok etmek, täzelenme we ş.m.). Mer­
kezi böleginde suratda saklanylýan daşky salgylanmalaryň sanawy 
ýerleşen. Sanaw tablisa ýa-da agaç düzüminde ýerleşdirilip bilner.

Tablisa we agaç görnüşleriň arasynda geçmek üçin <F3> 
we <F4> klawişalar ýa-da penjirede ýerleşen  (List View (F3) 
(Таблица)) we  (Tree View (F4) (Дерево)) düwmejikler arkaly 
mümkin. Tablisa görnüşi şeýle sütünlere eýe:

• Reference Name (Имя) – ady;
• Status (Статус) – derejesi;
• Size (Размер) – ölçeg;
• Туре (Тип) – görnüş;
• Date (Дата) – sene;
• Saved Path (Сохраненный путь) – ýatda saklanylan ýaly.

Sütünleriň niýetlenilişi olaryň atlaryna laýyk gelýär. Olariň ikisi­
ni düşündirmek maksadalaýyk

Status (Статус) parametri aşakdaky ähmiýetlere eýe bolup biler:
• Loaded (Загружена) – daşky salgylanma tapylan we surata 

ýüklenen;
• Unloaded (Выгружена) – daşky salgylanma suratdan ýüklen­

meden çykarylan;
• Unreferenced (He используется) – daşky salgylanma goýlan 

emma soňra ýok edilen;
• Not Found (He найдена) – daşky salgylanma hiç ýol boýunça 

tapylmadyk;
• Unresolved (He обработана) – daşky salgylanma tapylan, 

emma okalyp bilinmeýär;
• Orphaned (Разорвана) – daşky salgylanma tapylmadyk, 

işlenip bejerilmedik ýa-da üzülen beýleki daşky salgylanma goşulan.
Туре (Тип) parametri daşky salgylanmanyň görnüşini görkez­

ýär: Attach (Вставленная) ýa-da Overlay (Наложенная). Goýlan 
diýlip öz içinde beýleki daşky salgylanmalaryň hemmesini görkezýän 
salgylanma aýdylýar. Üstünden goýlan diýlip öz içindäki salgylanma­
lary görkezmeýän salgylanma aýdylýar.



Daşky salgylanmalaryň üstündäki amallar
Xref Manager (Диспетчер внешних ссылок) gepleşik 

penjiresiniň sag tarapynda daşky salgylanmanyň üstündäki 
amallarynyň düwmejikleri ýerleşen:

• Attach (Вставить) – goýmak;
• Detach (Удалить) – ýok etmek;
• Reload (Обновить) – täzelemek;
• Unload (Выгрузить) – ýüksüzlendirmek;
• Bind (Внедрить) – ornaşdyrmak;
• Open (Открыть) – açmak.

Tejribe işleri
1. Keseligine A4 formada çap etmek üçin sazlama döretmeli.
2. Dikligine A4 formada çap etmek üçin sazlama döretmeli.
3. Keseligine A3 formada çap etmek üçin sazlama döretmeli.
4. Dikligine A2 formada çap etmek üçin sazlama döretmeli.
5. Çapda iki gezek ulaldylan sazlamany döretmeli.
6. Çapda üç gezek ulaldylan sazlamany döretmeli.
7. Çap penjiresiniň ölçegine deňeşdirilen sazlamany döretmeli.
8. Sagdan 20 mm daşlaşma bilen çapyň sazlamasyny döretmeli.
9. Çyzgynyň ýartysyny çap edýän sazlamany döretmeli.
10. Çyzgynyň diňe bir figurasyny çap edýän sazlamany döretmeli.
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XIII. Beýleki formatlaryň üstündäki amallar

AutoCAD ulgamy rastr şekilli faýly okap we ony öz suratyna 
reňkli gönüburçluk hökmünde goýmagy amala aşyrýar (daşky salgy­
lanma meňzeş). Nokatlaýyn derejede goşulan şekili AutoCAD redak­
tirläp bilmeýär, emma şekili kesip, masştablamagyny, geçirmegi we 
beýleki ýönekeý redaktirleme amallaryny ýerine ýetirip bilýär. Bir 
rastr şekili beýlekiň üstüne goýlanda olaryň görünmeginiň tertibi do­
landyrmak mümkin.

Rastr şekiller bilen işlemek üçin Image (Изоб) buýrugy ulanyl­
ýar, oňa Reference (Ссылки) we Insert (Вставка) panelleriň  
düwmejigi, şeýle hem Insert (Вставка) menýunyň Image Manager 
(Диспетчер изображений) degişli.

Image (Изоб) buýrugy Image Manager (Диспетчер растровых 
изображений) gepleşik penjiresini açýar. Penjire şol wagt işlenilýän 
surata goýlan rastr şekilleriň sanawyny görkezýär.

Sanaw şeýle sütünlere eýe:
• Image Name (Имя);
• Status (Статус);
• Size (Размер);
• Туре (Тип);
• Date (Дата);
• Saved Path (Сохраненный путь).
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Status (Статус) aşakdaky bahalary kabul edip bilýär:
• Loaded (Загружено) – şekil tapylan we surata ýüklenen;
• Unload (Выгружено) – şekil suratdan ýüklenmeden çykary­
lan;
• Reload (Перегружено) şekil gaýtadan ýüklenilen;
• Not Found (He найдено) – şekil hiç standart ýol boýunça 
tapylmadyk.

Туре (Тип) parametri şekiliň formadyny görkezýär. AutoCAD 
rastr faýllaryň şeýle formatlaryny okaýar: BMP (– bmp, rle, dib), 
CALS1 (rst, gp4, mil, cal, cg4), FLIC (flc, fli), GEOSPOT (bil), IG4 
(ig4), IGS (igs), JFIF (jpg), PCX (pcx), PICT (pet), PNG (png), 
RLC (rlc), TGA (tga), TIFF (tif, tiff).

Image Manager (Диспетчер растровых изображений) gepleşik 
penjiresiniň sag böleginde şekilleriň üstünden bolan amallaryň düw­
mejikleri toplanylan:

• Attach (Вставить) – goýmak;
• Detach (Удалить) – ýok ýetmek;
• Reload (Обновить) – täzelemek;
• Unload (Выгрузить) – ýüksüzlendirmek;
• Details (Подробнее) – jikme-jik.

Attach (Вставить) düwmejigi Image (Растровое изображение) 
penjiräni çagyrýar, onda surata goýulýan şekiliň adyny bellemek 
mümkin.
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Bu penjirede Name (Имя) açylýan sanaw goýulýan şekiliň adyny 
görkezýär. Eger rastr şekili surata goýlan bolsa, onda ony sanawyň 
içinden saýlamak mümkin. Eger ol öň goýulmadyk bolsa, ony Brow­
se (Обзор) düwmejigi arkaly tapyp goýmak bolar. Insertion point 
(Точка вставки), Scale (Масштаб) we Rotation (Угол поворота) 
töwerekleri bloklary we daşky salgylanmalary goýmak boýunça gep­
leşik penjirelerdäki ýalydyr.

Rastr şekilleri Image Manager (Диспетчер растровых 
изображений) gepleşik penjiresini ulanman goýmak üçin Image­
attach (Изобвставить) buýrugy ulanmaly, ol Reference (Ссылки) 
paneliniň  düwmejigi ýa-da Insert (Вставка) menýusynyň Raster 
Image (Растровое изображение) bendi arkaly çagyrylýar.

Rastr şekiliniň goýulmagynyň netijesinde – Image emele gelýär. 
Onuň häsiýetleri baradaky maglumaty List (Список) ýa-da Proper­
ties (Okhocb) buýruklary arkaly almak mümkin.

Eger birnäçe rastr şekilleri biri-biriniň üstünden goýlan bol­
sa, Draworder (Порядок) buýrugy arkaly ekranda rastr şekilleriň 
görkezilmegini dolandyrmak mümkin. Bu buýruga Modify II 
(Редактирование-2) paneliniň  düwmejigi gabat gelýär. Drawor­
der (Порядок) buýrugy çagyrylanda ol ilkibaşda obýektleri saýla­
magy sorar. Aşaky şekili syçanjyk bilen suduryna basyp saýlamaly 
we saýlamagy tamamlamak üçin <Enter> klawişany basmaly. Soňra 
şeýle sorag berler:

Enter object ordering option [Above object/Under object/
Front/Back] <Back>: (Задайте опцию перестановки [Перед 
объектом/За объектом/Передний План/Зaдний План] <Задний>:)

Front (Передний план) opsiýasy saýlanylan şekili beýleki hem­
me obýektleriň üstünden goýýar.

• Above object (Перед объектом) – şekili başga obýektiň 
öňünde goýýar, şol başga obýekti hem soň görkezmeli bolýar;
• Under object (За объектом) – şekili başga obýektiň yzyndan 
goýýar, şol başga obýekti hem soň görkezmeli bolýar;
• Back (Задний План) – obýekti iň yzky plana 
geçirýär (hemme beýleki obýektleriň yzyna).
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AutoCAD ulgamynda ýörite Draw Order (Порядок вывода) pa­
neli bar, onuň dört düwmejigi ýokarky bentlere gabat gelýär.

Imageclip (Изобрез) buýrugy – oňa Reference (Ссылки) pa­
neliniň  düwmejigi we Modify > Clip > Image (Редакт > Подрез­
ка > Изображение) menýunyň bendi gabat gelýär. Bu buýruk şekili 
gönüburçluk ýa-da köpburçluk sudur arkaly şekili kesmegi amala 
aşyrýar.

Buýruk soraýar:
Select image to clip: (Выберите изображение для подрезки:)
Kesilmeli şekiliň araçägine syçanjygyň çep düwmejigi bilen bas­

maly. Indiki sorag:
Enter image clipping option [ON/OFF/Delete/New boun­

dary] <New>:
(Задайте опцию подрезки [Вкл/Откл/Удалить/Новый контур] 

<Новый>:)
Aşakdaky opsiýalar mümkin:

• ON (Вкл) – kesiş sudur bellenilip öçürilen bolsa şekiliň ke­
silmegini işledýär;
• OFF (Откл) – kesiş sudury bellenilen hem bolsa kesmegi 
öçürýär;
• Delete (Удалить) – kesiş suduryny ýok edýär;
• New boundary (Новый контур) – täze gönüburçluk ýa-da 
köpburçluk sudury belleýär.

New boundary (Новый контур) opsiýasy saýlanylanda Auto­
CAD soraýar:

Enter clipping type [Polygonal/Rectangular] <Rectangular>:
(Тип контура подрезки [Многоугольный/Прямоугольный] 

<Прямоугольный>:)
Şekiliň sudury Imageframe (Изобконтур) buýrugy arkaly 

işledilip hem-de öçürilip bilinýär, ol buýruga Reference (Ссылки) 
paneliniň  düwmejigi we Modify > Object > Image > Frame 
(Редакт > Объекты > Изображения > Контур) bendi gabat gelýär.

Buýruk soraýar:
Enter image frame setting [ON/OFF]: (Контур подрезки 

изображения [Вкл/Откл]:).
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Sudury öçürilen şekil hiç bir redaktirlemäge degişli däl.
Imageadjust (Изобрегул), buýrugy ýagtylyk, kontrastlyk we 

fon bilen birigiş ýaly häsiýetnamalary üýtgetmegi mümkin edýär, oňa 
Reference (Ссылки) paneliniň  düwmejigi we Modify > Object > 
Image >Adjust (Редакт > Объекты > Изображения > Регулировка) 
menýunyň bendi gabat gelýär.

Buýruk ilkibaşda şekili soraýar, soňra Image Adjust (Регули­
ровка изображения) gepleşik penjiresini çagyrýar.
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Imagequality (Изобкачество) buýrugy şekili ekrana çykarma­
gyň hilini dolandyrýar. Buýruga Reference (Ссылки) paneliniň  
düwmejigi we Modify > Object > Image > Quality (Редакт > Об­
ъекты > Изображения > Качество) menýunyň bendi gabat gelýär.

Buýruk soraýar:
Enter image quality setting [High/Draft]: (Качество изобра­

жения [Высокое/Черновое]:).
Rastr şekilleriň käbir görnüşleri açyklyk häsiýetine eýe we ol hä­

siýet işledilende olaryň yzyndan duran obýektler görnüp başlanýar. 
Transparency (Прозрачность) buýrugy şol hili dolandyrýar. Bu 
buýruga Reference (Ссылки) paneliniň  düwmejigi we Modify > 
> Object > Image > Transparency (Редакт > Объекты > 
> Изображения > Прозрачность) menýunyň bendi gabat gelýär.

Buýruk ilkibaşda şekili soraýar, soňra şeýle soragy berýär:
Enter transparency mode [ON/OFF]: (Состояние прозрач­

ности [Вкл/Откл]:).
AutoCAD ulgamy grafiki ekranyň şekilini rastr formatda ýat­

da saklap bilýär. Bu Saveimg (Сохризоб) buýrugy ýa-da oňa gabat 
gelýän Tools > Display Image > Save (Инструменты > Показать 
изображение > Сохранить) menýunyň bendi arkaly ýerine ýetirilip 
bilner. Bu buýruk Save Image (Сохранение изображения) gepleşik 
penjiresini çagyrýar.
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Hemme parametrler goýlandan soň we ОK düwmejige basylan­
dan soň AutoCAD ulgamy Image File (Файл изображения) penji­
resini çagyrýar, onda saýlanylan giňişlik (bmp, tga или tif) belli bir 
rastr format bilen bellenilen (BMP, TGA или TIFF), faýlyň adyny 
bolsa ulanyjy bermeli.

WipeOut ýönekeýi
Käwagt döredilen suratda käbir çyzyklary ýa-da olaryň bölek­

lerini fon bilen ýapmak gerek bolýar. Munuň üçin ulgamda rastr 
şekilleriň bir görnüşi girizilen Wipeout buýrugy tarapyndan döredil­
ýän tegmil.

Wipeout hem täze obýekti döredýär hem-de öň döredilen ýarym 
çyzygy üýtgedip gurýar.

Bu buýrugy klawiaturadan Wipeout girizip ýa-da Draw (Ри­
сование) menýusynyň Wipeout (Пятно) bendini saýlap çagyryp bo­
lýar:

Specify first point or [Frames/Polyline]<Polyline>: (Первая 
точка или [Границы/Полилиния] <Полилиния>:)

Nokat görkezilen ýagdaýda ulgam gaýtalamak bilen ýapyk su­
durly köpburçlugyň nokatlaryny sorap durar (nokatlaryň girizilme­
gini tamamlamak üçin – <Enter> klawişasyny basmaly). Polyli­
ne (Полилиния) opsiýasy saýlanylsa: Select a closed polyline; 
(Выберите замкнутую полилинию:) sorag berler.

Obýekt görkezilenden soň ýene bir sorag berler:
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Erase polyline [Yes/No] <No>: Стереть полилинию [Да/Нет] 
<Нет >:

Yes (Да) jogap berilse, başlangyç ýarym çyzyk ýok ediler, ýog­
sam hem suratda galar.

Ýarym çyzyk ýok edilse hem onuň sudury ekranda galar. Hem­
me Wipeout obýektleriniň sudurlaryny öçürmek üçin Wipeout 
buýrugynyň Frames (Контуры) opsiýasyny ulanmaly we
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Enter mode [ON/OFF] <ON>: (Введите режим [Вкл/Откл] 
<Вкл >:) soraga OFF (Откл) jogap berilse, hemme tegmilleriň su­
dury öçürilýär.

Tegmil edil rastr şekilleriň häsiýetlerine eýe.

Beýleki formatlardan bolan import
Insert (Вставка) menýusynda käbir beýleki formatlaryň 

şekillerini importirlemegi mümkin edýän 6 sany bendi bar:
• 3D Studio (Файл 3D Studio) – 3ds max ulgamyndan faýllary 
import edýär (3Dsin (Импортздс) buýrugy), geometriýany we 
tonirleme, torlar, materiallar, ýagtylyk çeşmeler we kameralar 
baradaky maglumaty bermek bilen;
• ACIS File (Файл ACIS) –ACIS formatdaky faýllaryň im­
portyny belleýär, bu format giňişlik gaty jisimli obýektleriň ge­
ometriýasyny saklamak üçin ulanylýar (Acisin (Импорттел) 
buýrugy);
• Drawing Exchange Binary (Файл DXB) – faýlyň im­
portyny DXB ikilik alyş-çalyş formatda ýerine ýetirýär (Dx­
bin (Импортд) buýrugy);
• Windows Metafile (Метафайл Windows) – Windowsyň 
grafiki metafaýllarynyň importyny belleýär (Wmfin 
(Импортмтф) buýrugy);
• OLE Object (Объект OLE) – OLE tehnologiýasyny gol­
daýan programmadan, meselem, Microsoft Word-dan ýa-da 
Microsoft Excel-den baglaşan ýa-da gurnalan obýektiň goýul­
magyny ýerine ýetirýär (Insertobj (Встобъект) buýrugy);
• Markup (Пометка) – RML formatly faýlda Autodesk 
firmasynyň Volo View Express moduly arkaly ýatda saklany­
lan bellikleriň çyzgy faýlyna goýmagy amala aşyrýar (Rmlin 
(Пометка) buýrugy).

Beýleki formatlara eksport etmek
Export (Экспорт) buýrugy we oňa gabat gelýän File (Файл) 

menýusynyň Export (Экспорт) bendi Export Data (Экспорт 
данных) penjiresini çagyrýar, onda Files of type (Тип файлов) açyl­



ýan sanawy ulanyp aşakdaky formatlaryň görnüşini saýlap şoňa eks­
port etmek mümkin:

Metafile (Метафайл) – wmf Wmfout (Экспортмтф);
Acis (Acis) – sat Acisout (Экспорттел);
Lithography (Литография) – stl Stlout (Экспортстл);
Encapsulated PS (Encapsulated PS) – eps psout (экспортпс);
DXX Extract (Файлы вывода DXX) – dxx Аттехт (Атэксп);
Bitmap (Растровые файлы) – bmp Bmpout (Экспортный);
3D Studio (Файлы 3D Studio) – 3ds 3Dsout (Экспортздс);
Block (Блок) – dwg Wblock (Пблок).

Tejribe işleri
Aşakdakylary import etmeli:
1. Metafile (Метафайл) – wmf;
2. ACIS (ACIS) – sat;
3. Lithography (Литография) – stl;
4. Encapsulated PS (Encapsulated PS) – eps;
5. DXX Extract (Файлы вывода DXX) – dxx;
6. Bitmap (Растровые файлы) – bmp;
7. 3D Studio (Файлы 3D Studio) – 3ds;
8. Block (Блок) – dwg;
9. Iş meýdany;
10. Wideoşekiliň pursadyny.
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XIV. Üç ölçegli çyzmalar. Netijeliligi 
ýokarlandyrma

AutoСad ulgamy çyzmalary diňe XY tekizlikde 
gurman, eýsem olary üç ölçegli giňişligiň islendik te­
kizliginde hem gurup bilýär.

Koordinatalaryň esasy ulgamynyň XY tekizli­
gi dünýä koordinatalar ulgamy diýlip atlandyrylýar 
(МСК), ol grafiki ekranyň tekizligi bilen gabat gel­
ýär. Üçünji ok (Z) ekrana perpendikulýar we ekran­
dan ulanyjy tarapyna ugrukdyrylan. Dünýä koor­
dinatalar ulgamynyň alamaty hökmünde oklaryň piktogrammasy 
koordinatalaryň başlangyjynda gönüburçluga eýe bolýar.

Hemme beýleki koordinatalar ulgamlary ulanyjy koordinatalar 
ulgamlary diýlip atlandyrylýar.

UCS belgini dolandyrmak
UCS Icon (Знак ПСК) penjiresi View > Display > UCS Icon > 

Properties (Вид > Отображение > Знак ПСК > Свойства) menýunyň 

20. Sargyt 1372
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bendi arkaly ýa-da Ucsicon (Знакпск) buýrugyň 
Properties (Свойства) opsiýasy arkaly çagyryl­
ýar.

Bu penjire 4 töwerege eýe. UCS icon sty­
le (Стиль пиктограммы ПСК) töwereginde 
degişli 2D we 3D geçirijiler arkaly koordina­
talar ulgamyň piktogrammasynyň görkezilişini 

dolandyrmak mümkin. 3D stili ýokarky suratda 2D – aşaky suratda 
görkezilen.

2D stil ulanylanda W harpy WCS belgileýär.
3D stil goýlanda Cone (Конус) baýdajygyň goýulmagy oklaryň 

ahyrlarynda ýapyk oky (konusy) , baýdajyk aýrylanda bolsa – ýapyl­
madyk oky çykarýar. Line width (Ширина линии) parametri oklaryň 
inini dolandyrýar.

UCS icon size (Размер знака ПСК) töwereginde nyşanyň ekranyň 
ölçeginden göterimde bolan ululygy bellenilýär (5-den 95%-e çenli). 
UCS icon color (Цвет знака ПСК) töwereginde piktogrammanyň 
reňkini üýtgetmek mümkin – Model space icon color (Цвет знака 
в пространстве модели) и Layout tab icon color (Цвет знака на 
листах)).

Üç ölçegli giňişlikdäki koordinatalar
Öň seredilen buýruklaryň köpüsinde nokatlaryň üç ölçegli ko­

ordinatalaryny girizmegine ýol berilýär. Meselem, Line (Отрезок) 
buýrugy üçin From point: (От точки:) soraga: 114,47,200 giriz­
mek mümkin – bu guruljak çyzygyň birinji nokady oklar boýunça: 
Х= 114, Y= 47 we Z= 200 koordinatalara eýedigini görkezýär. Eger 
Line (Отрезок) buýrugynyň beýleki soragyna То point: (К точке:): 
62.81,–39.4,–4.55 jogap berilse, onda ahyrky nokady: Х= 62.81, Y= 
-39.4 и 2= -4.55 koordinatalara eýe bolan nokat bolan kesim gurlar.

Dekart koordinatalarynda nokatlaryň göräleýin girizilmegi hem 
üç koordinatalaryň girizilmegini mümkin edýär, meselem: @28,0,44 
– çyzylýan nokat öňki X okundan 28 mm-e, У oky boýunça – 0 mm, 
Z oky boýunça –44 mm-e süýşürilen.

Polýar koordinatalarynda nokady göräleýin girizilmeginiň 
ýazgysyna hem üçünji koordinata goşulyp bilner, meselem: 
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@12.6<19.4,20.79 ol şuny aňladýar: öňki nokatdan ikinji görkezilen 
nokada çyzylan kesimiň XY tekizligine bolan proýeksiýasy XY te­
kizlikde X okunyň položitel ugry bilen 19,4° burçy emele getirýär 
we şol tekizlikde 12,6 mm uzynlyga eýe, kesimiň soňky nokadynyň 
Z koordinatasy bolsa başlangyç nokatdan Z oky boýunça 20,79 mm 
süýşürilen (silindrik koordinatalary).

@73<35<57 ýazgy bilen koordinatalaryň girizilmegi müm­
kin (sfera koordinatalary). Muňa şeýle düşünmeli: kesim X okunyň 
položitel ugry bilen 35 gradus burçy döredip ilkibaşda XY tekizlikde 
gurulýar, soňra kesim XY tekizligine göräleýin 57° egilýär we şeýleik 
bilen kesgitlenen şöhlede kesimiň ahyrky nokady başlangyç nokatdan 
73 mm süýşürilýär.

Üç ölçegli çyzgylary izometriýa görnüşlerinde seljermek amat­
ly. Günorta-günbatar izometriýa diýlip atlandyrylýan standart görnüşi 
bellemek mümkin. Munuň View > 3D Views > SW Isometric (Вид 
> ЗМ виды > ЮЗ изометрия) menýunyň bendlerini ulanmaly. Bu 
ýagdaýda oklaryň proýeksiýasyny arasyndaky burçlar gönüburç bol­
mazdan 120° deň bolar.

Dereje we beýiklik
Izometriýadaky işi tegelegi çyzmakda göreliň. Circle (Круг)) 

buýrugy arkaly merkezi X = 0, Y = 0 koordinataly nokatda bolan we 
radiusy 100 mm bolan tegelegi çyzmaly.

Izometriýa görnüşinde tegelek ellips ýaly görünýär. Z oky 
bu ýagdaýda dik gidýär. Tegelegiň derejesini üýtgedeliň (munuň 
üçin tegelegiň merkeziniň Z koordinatasyny üýtgetmeli). Tegele­
ge syçanjyk bilen basmaly – onda eljagazlar emele geler. Stan­
dard (Стандартная) paneliniň  düwmejigi arkaly Properties 
(Свойства) penjiresini çagyrmaly.
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Bu penjirede tegelegiň hemme häsiýet­
namalary görkezilen Center Z (Центр Z) 
häsiýetnamanyň gapdalynda 0 bahany 250 edip 
üýtgetmeli. Netijede tegelek 250 mm ýokary 
süýşüriler. Eger tegelegi aşak süýşürmek gerek 
bolsa Z = –250 edip girizmeli bolardy.

Şeýlelik bilen ilkibaşda çyzgy tekizligi 
hökmünde ilkibaşda esasy XY tekizlik Z=0 de­
rejesi bilen bolupdy, soňra bolsa obýekt täze te­
kizlige geçirildi (250 mm z ok boýunça ýokarda).

Indi tegelegiň ýene-de bir häsiýetnamasyny 
üýtgedeliň – beýikligi. AutoCAD ulgamynda­
beýiklik hökmünde obýektiň Z oky boýunça 
galyňlygy düşünilýär. Munuň üçin Properties 
(Свойства) penjiresinde Thickness (Высота) 
parametriň bahasyny 100 edip goýalyň. Netije­
de üç ölçegli silindr emele geler.

Silindriň egri çyzykly ýerlerinde AutoCAD 
görkezmek üçin düzüjileriň birnäçe sanyny 
çykarýar. Mundan başga hem, iş düzgüninde 

silindriň hemme diwarjyklary redaktirlemek üçin 
elýeterli we açyk.

Beýikligi üýtgetmegiň amaly başgaça iki 
ölçegli obýekti gysyp çykarma diýlip hem at­
landyrylýar. Emele gelen obýekt üç ölçegli bo­
lup durýar. Indi silindriň görünmeýän böleklerini 
bukmak üçin View (Вид) menýusyndan Hide 
(Скрыть) bendini ulanmaly. Bu bende Hide 
(Скрыть) buýrugy gabat gelýär.

Görünmeýän çyzyklary bukmagyň netijesinde emele gelen şekil 
işçi däl bolup durýar – redaktirlemegi mümkin etmek üçin View (Вид) 
menýunyň Regen (Регенерировать) ýa-da Regen All (Регенерировать 
все) bendi basmaly.

AutoCAD ulgamy çyzgylar amala aşyrylýan derejäniň ulanylýan 
bahasyny Elevation ulgam üýtgeýäninde saklaýar. Elev (Уровень) 
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buýrugy obýektler üçin ulanylýan derejeleri we beýiklikleri üýtged­
ýär. Buýruk soraýar (ýaýyň içinde ulanylýan baha bar):

Specify new default elevation <0.0000>: (Новый уровень по 
умолчанию <0.0000>:)

250 girizmeli bu, silindriň aşaky esasyna gabat geler. Şeýlelik 
bilen çyzgy tekizligi 250 mm derejä geçirilýär. Indiki sorag (ýaýyň 
içinde ulanylýan baha):

Specify new default thickness <0.0000>: (Новая высота по 
умолчанию <0.0000>:)

100 girizmeli – bu ýagdaýda obýektler Z okunyň otrisatel ugry 
boýunça 100 mm gysylyp çykarylýar. Indi bolsa 0,0 koordinatalary 
nokatda merkezi bolan we radiusy 200 
mm bolan tegelegi çyzmaly. Eger nokat­
da Z koordinatalary ýok bolsa Z bahasy 
ulanylýan derejä deň edilip kabul edilýär 
(ýagny 250 mm). Netijede birinjiden tege­
lek däl-de ýene bir silindr çyzylar, sebäbi 
nola deň däl beýiklik bellenilen, ikinjiden 
bolsa silindriň bir esasy birinji silindriň 
aşaky esasynyň tekizligine düşer, ikinji esasy bolsa 150 mm derejeli 
tekizlikde ýerleşer (sebäbi ulanylýan 250 derejä gysyp çykaryş beýik­
ligi goşulýar – 100).

Koordinatalar ulgamlary
МСК-nyň XY tekizligine parallel däl beýleki çyzgy tekizlikleri 

bellemek üçin UCS (ПСК) buýrugy ulanylýar. Ulanyjy koordinata­
lar ulgamlary atlandyrylyp bilner. UCS (ПСК) buýrugy täze koor­
dinatalar ulgamynyň başyny bellemegi we täze X we Y oklaryň 
ýerleşmegini bellemegi, täze Z okunyň ýerleşişi bolsa degişli Х we У 
oklaryň ýerleşmegine bagly we şol sebäpli awtomatiki kesgitlenýär.

Bu buýruga iki sany gural panel gabat gelýär: UCS (ПСК) we 
UCS II (ПСК-2)

UCS
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UCS II

Görnüşler we görnüş ekranlary
Üç ölçegli obýektiň modeli bilen işläp, görnüşleri, bellemek we 

üýtgetmek, grafiki ekrany böleklere bölmek mümkin, olaryň her bi­
rinde öz proýeksiýany we serediş nokady bellemek mümkin.
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Umumy görnüş
Çylşyrymly çyzgyny ýa-da modeli görkezmegi amatly etmek 

üçin Aerial View (Общий вид) penjiräni ekrana çykarmak peýdaly. 
Şonda esasy ekranda bir görnüş, goşmaça penjirede bolsa beýleki 
görnüş bellenilip bilner.

Bu penjiräniň çagyrylmagy Dsviewer (Глаз) buýrugy ýa-da View 
(Вид) menýunyň Aerial View (Общий вид) bendi arkaly çagyrmak 
mümkin. Uly ekranyň kiçi ekran arkaly zummirlenmegi mümkin. 
Munuň üçin Aerial View (Общий вид) penjiräni içine syçanjyk bilen 
basmaly. Ýerine ýetirilýän zummirleme esasy grafiki ekranda görke­
zilýär.

Görnüş ekranlaryň konfigurasiýasy
AutoCAD ulgamy model giňişliginde bölekleriň islendik sa­

nyndan konfigurasiýalary döretmegi ama­
la aşyrýar (biri-birini ýapmaýan ekran­
lary) we şol konfigurasiýa at berip bolýar. 
Vports (Вэ-Кран) buýrugy görnüş ekranlaryň konfigurasiýasyny 
döredýär. Oňa Viewports (Порты) menýunyň  düwmejigi View 
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> Viewports > New Viewports (Вид > Порты > Названные виды) 
menýunyň bendleri gabat gelýär.

Vports (Вэкран) buýrugy Viewports (Видовые экраны) 
gepleşik penjiresini açýar.

Şol penjiräniň New name (Новое имя) meýdany dörediljek 
görnüş ekranlaryň konfigurasiýasynyň adyny bellemek üçin niýetlenen.

Preview (Образец) töwereginde şol konfigurasiýanyň görnüşi 
görkezilýär. Standard viewports (Стандартные конфигурации) 
sanaw bölünmegiň wariantlaryny saýlamak mümkin. Apply to 
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(Применить) açylýan sanawda grafiki ekranyň haýsy böleginde 
ýerleşdirmegi görkezmegi amala aşyrýar:

• Display (Ко всему экрану);
• Current Viewport (К текущему ВЭкрану).

Setup (Режим) açylýan sanawda diňe iki baha elýeterli:
• 2D – ulanylýan görnüş (ýagny aktiw görnüş ekranynda bel­
lenilen görnüş) hemme täze görnüş ekranyna degişli bolýar;
• 3D – ulanylýan görnüş döredilýän görnüş ekranlaryň birinde 
bellenilýär, galanlarynda bolsa AutoCAD ulgamy degişli orto­
gonal görnüşleri saýlaýar.

Görnüş ekranlaryň biri işjeň bolup durýar. Islendik ekrany işjeň 
etmek üçin oňa syçanjyk bilen basmaly.

Bir ekranly konfigurasiýa gaýtmak üçin galdyrylmaly ekra­
na basmaly we ony işjeň etmeli, Vports (Вэкран) buýrugy bilen 
Viewports (Видовые экраны) gepleşik penjiresini açmaly. New 
Viewports (Новые ВЭкраны) goşmaçasynyň Standard viewports 
(Стандартные конфигурации) sanawynda Single (Один) konfigura­
siýasyny saýlamaly, Apply to (Применить) açylýan sanawda bolsa 
Display (Ко всему экрану) goýmaly. Bir ekrana geçmek üçin beýle­
ki usul – Viewports (Видовые экраны) paneliniň  düwmejigine 
basmaly.

Galtaşýan görnüş ekranlary bir ekrana birleşdirmeli. Munuň üçin 
View > Viewports > Join (Вид > Видовые экраны > Соединить) 
menýunyň bendinden peýdalanmaly.

Görnüşler
Görnüş ekranynda (ýa-da tutuş grafiki ekranda, eger ol bölün­

medik bolsa) seretmegiň ugruny we görkezmegiň masştabyny belläp 
görnüşi gurnamak mümkin.

View (Вид) gurallar panelinde aşakdaky düwmejikler ýerleş­
dirilen:

•  – View (Вид) gepleşik penjiresini açýar;
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• 6 sany standart ortogonal görnüşi gurnaýyş düwmejikler 
–  (ýokarky görnüş),  (aşakdan görnüş),  (çepden 
görnüş),  (sagdan görnüş),  (öňünden görnüş) we  
(yzdan görnüş);
• Standart izometriýa görnüşleriň 4 düwmejigi –  (günor­
ta‑günbatar izometriýa),  (günorta-gündogar izometriýa), 

 (demirgazyk-günbatar izometriýa) we  (demirgazyk-
günbatar izometriýa);
•  – kameranyň nokady seretmegiň ugrunyň nokady arkaly 
seretmegiň ugruny belleýär.

Görnüşi sazlamak
Perspektiwanyň we kesiji tekizlikleriň bellenilmegi Dview 

(Двид) buýrugy arkaly ýerine ýetirilýär. Buýrugyň birinji soragy:
Select objects or <use Dviewblock>: (Выберите объекты или 

Использовать Dviewblock>:)
Soraga jogap hökmünde obýektleri görkezmek gerek.
Ondan soň:
Enter option [Camera/Target/Distance/Points/ Pan/Zoom/

Twist/Clip/Hide/Off/Undo]: (Задайте Опцию [Камера/Цель/
Расстояние/Точки/Пан/Показатъ/Вращать/Сечение/Скрыть/
Откл/Отменить/:)

Buýrugyň opsiýalary:
• Саrаеrа (Камера) – seretmegiň ugruny kesgitleýän kamera-
maksat wektory üçin başlangyç nokadynyň dinamiki görkezil­
megi;
• Target (Цель) – seretmegiň ugruny kesgitleýän kamera-
maksat wektory üçin ahyrky nokadynyň dinamiki görkezilme­
gi;
• Distance (Расстояние) – kamera bilen maksadyň arasynda 
täze aralygyň girizilmegi; Ох-den 16х çenli şkala aralygy hä­
zirkiden 16 esse artdyrmagy mümkin edýär;
• Points (Точки) – maksadyň we kameranyň nokatlaryny ko­
ordinatalarda bermek;
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• Раn (Пан) – görnüşi ulaltman hereketlendirişiň iki wektory 
arkaly süýşürmek;
• Zoom (Показать) –0х-den 16х çenli ulaldyş koeffisiýentiň 
berilmegi, şeýle hem işledilen perspektiwada fokus aralygyň 
berilmegi;
• Twist (Вращать) – görnüşiň seretmegiň ugruna göräleýin 
aýlanylmagy we eňilmegi;
• Clip (Сечение) – görnüşde kesiji tekizlikleriň goýulmagy 
ýa-da aýrylmagy;
• Hide (Скрыть) – saýlanylan obýektler üçin gizlin çyzyklaryň 
ýapylmagy;
• Off (Откл) – perspektiw proýeksiýasyny öçürýär; ony 
işletmek üçin ýene Distance (Расстояние) opsiýasyny ýerine 
ýetirmeli;
• Undo (Отменить) – Dview (Двид) buýrugynyň soňky 
amalynyň hereketini ýatyrýar.

Görnüşi dolandyrmak üçin ýene bir gyzykly mümkinçilik – 
3Dorbit (3-Орбита) buýrugy, oňa 3D Orbit (3M орбита) paneliniň 

 düwmejigi we View (Вид) menýunyň 3D Orbit (3M орбита) 
bendi gabat gelýär.

Buýruk üç ölçegli obýektleriň görnüşini görkezme gurluşy ar­
kaly dinamiki üýtgetmegi mümkin edýär. Buýruk çagyrylan mahaly 
haýsy-da bolsa obýektler saýlanylan bolsa, onda görnüşi üýtgetmede 
diňe olar çykyş edýär. Saýlanylan obýektler ýok bolanda dinamiki 
üýtgetme suratyň hemme görünýän obýektleriň täze ýerleşmegini 
görkezýär.

3Dorbit (3-Орбита) işlän wagty ПСК nyşany reňkli üç ölçegli 
oklaryň nyşanyna öwrülýär we görnüşde orbital halka emele gelýär.

Orbital halkanyň merkezi görnüşiň merkezi bilen gabat gelýär. 
Görkeziji orbital halkanyň içinde ýa-da daşynda hereketlendirilen­
de kursor dürli nyşanlara eýe bolýar. Eger ol orbital halkanyň içinde 
ýerleşende, ol iki kesişýän sferanyň görnüşini alýar – . Eger kursor 
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orbital halkanyň daşynda ýerleşen bolsa, ol daşynda tegelek-ok bo­
lan sfera görnüşinde bolýar . Eger kursor orbital halkanyň çep we 
sag kwadrantlaryň nokatlarynda ýerleşen tegelekleriň içinde bolsa ol 
kese ellips-okly bolan sferanyň görnüşini alýar . Eger kursor orbi­
tal halkanyň ýokarky we aşaky kwadrantlaryň nokatlarynda ýerleşen 
tegelekleriň içinde bolsa ol dik ellips-okly bolan sferanyň görnüşini 
alýar .

Kursor şu görnüşlere eýe bolanda syçanjygyň çep düwmejigi 
basylyp orbital halka şol şekillere görä aýlanar we obýektleri degişli 
görnüşe getirerler. 3Dorbit (3-Орбита) buýrukdan çykmak üçin 
<Esc> we <Enter> klawişalaryna basmaly.

Orbital halka ekrandaky kontekst menýusy çagyryp Shading Mo­
des (Раскрашивание) menýuny çagyrmak we 6 opsiýa arkaly obýekt­
ler aýlanylanda olary reňklemegiň wariantyny bellemek mümkin:

• Wireframe (Каркас) – obýektler kesimleriň we çyzyklaryň 
(gyraňlaryň we jisimleriň erňekleriň) utgaşmasy görnüşinde 
görkezilýär, reňklenme ýok;
• Hidden (Скрытие линий) – Wireframe (Каркас) ýaly, em­
ma yzky görünmeýän gyraňlaryň çyzyklary görkezilmeýär;
• Flat Shaded (Плоское) – gyraňlar reňklenýär, emma reňk­
lemegiň pes birsydyrgynlylyk bilen;
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• Gouraud Shaded (По Гуро) – gyraňlar reňklenýär; 
gyraňlaryň geçişleri öwüşginler bilen düzlenýär; reňklemegiň 
birsydyrgynlylygy öňki opsiýanyňkydan ýokary;
• Flat Shaded, Edges On (Плоское, с кромками) – Wi­
reframe (Каркас) we Flat Shaded (Плоское) opsiýalar 
utgaşdyrylýar (reňklenmede karkaslaryň çyzyklary yşyklanyp 
görünýär);
• Gouraud Shaded, Edges On (По Гуро, с кромками) – Wi­
reframe (Каркас) we Gouraud Shaded (По Гуро) opsiýalar 
utgaşdyrylýar.
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Üç ölçegli ýarym çyzyklar
Aýratyn üç ölçegli obýekt bolup üç ölçegli ýarym çyzyk bolup 

durýar, ol baglanyşan gönüçyzykly segmentlerden ybarat, emma 
segmentleriň depeleri üç ölçegli giňişligiň islendik koordinatalaryna 
eýe bolup bilýär. Üç ölçegli ýarym çyzyk iki ölçegliden tapawutlykda, 
kada bolşy ýaly, üç ölçegli giňişligiň ýeke-täk tekizliginde ýerleşýär 
we 3Dpoly (3-Плиния) buýrugy arkaly gurulýar.

Üç öplçegli çyzyklary redaktirlemek üçin şol bir Pedit (Полред) 
buýrugy ulanylýar.
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Tonirleme
Üç ölçegli modelleri AutoCAD ulgamynda hakyky görkezmek 

üçin birnäçe amallary göz öňünde tutulan. Olaryň arasynda Hide 
(Скрыть) buýrugy, Dview (Двид) buýrukda hem görünmeýän çyzyk­
lary ýaşyrmak opsiýasy hem göz öňünde tutulan.

3Dorbit (3-Орбита) buýru­
gy obýektleri reňklemegi müm­
kin edýär. Şeýle mümkinçilikleri 
hem View (Вид) menýunyň Shade 
(Раскрашивание) bendi hödürleýär. Reňklemegiň hemme görnüşleri 
düwmejik hökmünde Shade (Раскрашивание) panelinde getirilen. 
Bu düwmejikler Shademode (Режимраскр) buýrugynyň opsiýasy 
bolup durýar.

Üç ölçegleri hakyky şekillerini almagyň has gyzykly mümkinçi­
ligi bolup tonirleme amaly çykyş edýär. Tonirleme ekrana perpendi­
kulýar ugrukdyrylan adaty daşlaşdyrylan yşyklandyryş çeşmesinden 
başgalary – nokatlaýyn çeşmeleri we prožektorlary ulanmagy müm­
kin edýär. Obýektleriň üstlerine materiallaryň häsiýetlerini bellemek 
mümkin. Ýörite effektleriň arasynda dumany we fony (şol sanda 
taýyn rastr şekilinden) ulanmak mümkin.

Tonirlemegiň hemme buýruklary View (Вид) menýunyň Ren­
der (Тонирование) şeýle hem Render (Тонирование) panelinde 
ýerleşen.

Bu panel şeýle düwmejiklere eýe:

•  – üç ölçegli modeliň ýaşyrylan çyzyklaryny ýapmak bi­
len şekili (Hide (Скрыть) buýrugy);

•  – üç ölçegli modeliň hakyky tonirlenen şekiliniň ýerine 
ýetirilmegi (Render (Тонировать) buýrugy);

•  – model giňişliginde sahnalary dolandyrmak (sahna – 
görnüşiň we yşyklandyryş çeşmeleriň topary) (Scene (Сцена) 
buýrugy);
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•  – yşyklandyryş çeşmelerini dolandyrmak (Свет (Light) 
buýrugy);

•  – materiallary dolandyrmak (Rmat (Материал) buýrugy);

•  – materiallaryň importy we eksporty (Matlib (Бибмат) 
buýrugy);

•  – teksturalary goýmak (materiallary üste baglaşdyrmak, 
Setuv (Налтек) buýrugy);

•  – fony bermeklik (Background (Фон) buýrugy);

•  – dumany dolandyrmak (Fog (Туман) buýrugy);

•  – landşaftyň elementlerini goýmaklyk (çogdumlaryň, 
agaçlaryň, adamlaryň we ş.m. şekili, Lsnew (Ландновый) 
buýrugy);

•  – landşaftyň elementlerini redaktirlemek (Lsedit (Ланд-
Ред) buýrugy);

•  – landşaftyň elementleriniň bibliotekasy bilen işler ýerine 
ýetirmek (Lslib (Ландбиб) buýrugy);

•  – tonirlemegiň düzgünlerini bellemek (Rpref (Режим­
тон) buýrugy);

•  – tonirleme barada statistiki maglumatlaryň çykarylmagy 
(Stats (Стат) buýrugy).

Render (Тонировать) buýrugy tonirlemegi amala aşyrmak 
üçin onuň parametrlerini bellemek boýunça Render (Тонирование) 
gepleşik penjiresini açýar.

Penjiräniň aşagynda ýerleşen Render (Тонирование) düwmeji­
gi ony ýapýar, goýlan parametrler bilen tonirlemegi gönümel ýerine 
ýetirýär.

Render (Тонирование) gepleşik penjiresiniň Rendering Type 
(Тип тонирования) açylýan sanawynda ýerine ýetirmegiň algo­
ritmini saýlamak gerek: Render (Упрощенное), Photo Real (Фото­
реалистичное) we Photo Raytrace (Трассировка луча). Köplenç 
olaryň arasyndaky tapawut bildirmeýär.
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Scene to Render (Сцена для тонирования) sanawynda sah­
nanyň saýlawyny ady boýunça amala aşyrmak (eger olara at berlen 
bolsa) ýa-da şol wagtky sahnany saýlamak mümkin. Rendering 
Procedure (Процедура тонирования) töwereginde üç baýdajyk 
ýerleşdirilen, olar tonirlemäni ýerine ýetirmegiň usulyny kesgitleýär­
ler:

• Query for Selections (Выбирать объекты) – tonirlenýän 
obýektleriň gönümel görkezilmegi bellenilýär;
• Crop Window (Задать область тонирования) – tonirleme 
töweregini bermeklik ýerine ýetirilýär (baýdajyk Destination 
(Вывод) töwereginde açylýan sanawdan Viewport (Видовой 
экран) bendi saýlanylan ýagdaýda elýeterli);
• Skip Render Dialog (Без диалога) – gepleşiksiz, tutuş 
görnüş ekranyň tonirlenmegi bellenilýär.

Light Icon Scale (Масштаб символа источника) meýdany 
yşyklandyryş çeşmesini belgilemek üçin ulanylýan bloguň masştabyny 
belleýär, Smoothing Angle (Угол сглаживания) meýdany bolsa – 
gyraňlaryň arasynda burçuň maksimal bahasyny belleýär, şol burçda 
AutoCAD ulgamy olaryň gyraňlaryny düzleýär (deslapdan – 45°).
21. Sargyt 1372
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Rendering Options (Параметры тонирования) töwereginde 4 
baýdajyk ýerleşen:

• Smooth Shade (Плавное) – köp gyraňly üstüň gyraňlaryň 
arasynda birsydyrgyn geçmegini kesgitleýär (gyraňlaryň reňk­
lerini garmak arkaly);
• Apply Materials (С материалами) – bellenilen materiallaryň 
ulanylmagyny amala aşyrýar; baýdajyk aýrylan ýagdaýynda 
*GLOBAL* («ГЛОБАЛЬНЫЙ*) standart materialy ulanyl­
ýar;
• Shadows (С тенями) – tonirlemegiň iki görnüşi üçin 
kölegeleriň generasiýasyny belleýär: Photo Real (Фото­
реалистичное) we Photo Raytrace (Трассировка луча);
• Render Cache (Кэширование) – tonirleme üçin keş-faýlyň 
ulanylmagyny görkezýär, bu bolsa tonirleme amalynyň gaýta­
dan ýerine ýetirilmegini tizleşdirýär.

Şol töwerekde More Options (Дополнительно) düwmejigi bar, 
ol Rendering Type (Тип тонирования) sanawda saýlanylan obýektiň 
görnüşine baglylykda goşmaça sazlamalaryň penjiresini açýar: Ren­
der Options (Параметры упрощенного тонирования), Photo Real 
Render Options (Параметры фотореалистического тонирования) 
ýa-da Photo Raytrace Render Options (Параметры тонирования 
методом трассировки лучей). Bu penjire tonirleme düzgünleri­
ni has takyk sazlamagy amala aşyrmagy, gyraňlary tonirlenmeginiň 
birsydyrgynlygyna täsir etmegi, kertikleri aýyrmagyň derejesini do­
landyrmagy we ş.m. mümkin edýär.

Destination (Вывод) töwereginde açylýan sanaw arkaly tonir­
lenen obýektiň çykarylmagyny ugurlaryny bellemegi mümkin edýär:

• Viewport (Видовой экран) – görnüş ekranyna çykarmak;
• Render Window (Окно) – netijäni ýörite Render penjiresi­
ne çykarmak;
• File (Файл) – faýla ýazgy.

Şol töweregiň More Options (Дополнительно) düwmejigi 
faýlyň parametrlerini görkezmegiň gepleşik penjiresini açýar, emma 
diňe opsiýalaryň sanawynda çykaryş gönümel faýla bellenilen.
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Sub Sampling (Проба) töweregi açylýan sanaw arkaly 
tonirlenmegiň barlanmasyny tizleşdirilen ýagdaýda kesgitleýär: 1:1-
den (Best) (iň gowy hil, emma haýal) 8:1 çenli (Fastest) (tiz, emma 
hili pes). Background (Фон) düwmejigi fony bellemegiň penjiresiniň 
açmagyny ýerine ýetirýär, Fog/Depth Cue (Туман/Затемнение) 
düwmejigi bolsa – garamtylaýan effektleriň bellemegiň gepleşik pen­
jiresini açmagy amala aşyrýar.

Yşyklandyryş çeşmeler
Light (Свет) buýrugy we Render (Тонирование) paneliniň 

 düwmejigi surata täze yşyklandyryş çeşmeleri goşmagy müm­
kin edýär, ol çeşmeler 4 görnüşli bolup biler: dagynyk ýagtylygy, 
daşlaşdyrylan çeşme, nokatlaýyn çeşme we prožektor. Dagynyk 
ýagtylygy – ol fon yşyklandyryşa meňzeş, ony öçürmek ýa-da dep­
ginliligini üýtgetmek mümkin.

Daşlaşdyrylan çeşme ýagtylygy diňe bir ugurda göni çyzyk­
ly ýaýradýar we ýagtylygyň depginliligi aralyk bilen üýtgemeýär. 
Daşlaşdyrylan çeşme gün ýagtylygyna meňzetme döretmek üçin ula­
nylyp bilner.

Nokatlaýyn çeşme ýagtylygy hemme ugurlarda berýär we onuň 
depginliligi ondan daşlaşylýan mahaly peselýär. Nokatlaýyn çeşmeler 
arkaly elektrik lampalara gowy meňzetme döredilýär (meselem, 
otaglaryň modelleri döredilende).

Prožektordan ýagtylyk şöhleleri berlen ugurda konusy döredip 
gidýär, bu ýagtylanýan obýektlerde ýagty yşyk tegmilleri we olaryň 
töwereginde yşyklanmagynyň peseliş zolaklaryny döredýär. Yşyk 
tegmiline gabat gelýän konusyň burçy, öz içine ýagty yşyk tegmille­
ri we olaryň töwereginde yşyklanmagynyň peseliş zolaklaryny alýan 
doly ýagtylyk konusyň burçundan kiçi bolmalydyr. Iki burç 0 we 160 
gradusyň arasynda bolmalydyr. Hemme ýagtylyk çeşmeleri (dagynyk 
ýagtylykdan başga) suratda bloklaryň şekilleri bilen görkezilýär.
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Light (Свет) buýrugy Lights (Источники света) gepleşik pen­
jiresini çagyrýar.

Şol gepleşik penjiräniň Ambient Light (Рассеянный свет) 
sag bölegi umumy dagynyk ýagtylygyň depginliligini (Intensity 
(Интенсивность) şkalasy) we reňki (Color (Цвет) töweregi) sazla­
magy mümkin edýär.

Çepde Lights (Источники) sanawy ýerleşen, ol hemme at­
landyrylan çeşmeleriň sanawyny saklaýar. Ondan sagda Modify 
(Изменить), Delete (Удалить) we Select (Выбор) düwmejikleri bar, 
olar degişlilikde çeşmäni üýtgetmegi, ýok etmegi we syçanjyk bilen 
saýlamagy mümkin edýär.

New (Новый) düwmejigi täze yşyk çeşmesini döretmek üçin 
ulanylýar. Emma oňa basmazdan öň, ondan sagdaky açylýan sanaw­
da çeşmäniň görnüşini saýlamaly: Point Light (Точечный), Distant 
Light (Удаленный) ýa-da Spotlight (Прожектор). Nokatlaýyn çeşme 
üçin New (Новый) düwmejigi New Point Light (Новый точечный 
источник света) gepleşik penjiresini açýar.

Bu penjiredäki Light Name (Имя источника) meýdanynda 
çeşmäniň adyny girizmeli (uzynlygy 8 simwola çenli). Intensity 
(Интенсивность) şkalasy täze çeşmäniň depginliligini görkezme­
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gi mümkin edýär. Position (Положение) töwereginde ýerleşdirilen 
Show (Показать) düwmejigi ekrana döredilýän çeşmäniň koordina­
talaryny deslapdan çykarýar. Çeşmäniň gurnalyş nokadynyň hakyky 
koordinatalaryny Modify (Изменить) düwmejik arkaly mümkin, 
ol ýagtylyk çeşmesiniň ýerleşmeginiň nokadyny ulanyjy görkezer 
ýaly New Point Light (Новый точечный источник света) penjiräni 
wagtlaýyn ýapýar.

Color (Цвет) töwereginde çeşme üçin reňk bellenilýär.
Attenuation (Спад) geçirijiler topary aralyk bilen depginliligi­

niň nähili üýtgediljekdigini kesgitleýär. Üç görnüş mümkin:
• None (Нет) – depginliligiň peselmegi ýok, ýagny çeşme 
ýakyn hem-de daşky obýektleri deň yşyklandyrýar;
• Inverse Linear (Линейная инверсия) – depginligiň pesel­
megi çeşmeden bolan aralyga proporsional üýtgeýär;
• Inverse Square (Квадратичная инверсия) – depginligiň pe­
selmegi aralygyň kwadratyna proporsional.
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Shadows (Тени) töwerekde Shadow On (Включить) baýdajygy 
goýmak mümkin, ondan soň tonirleme geçirilende obýektlerden bo­
lan kölegeler goşulýar. Kölegeleriň häsiýetnamalary Shadow Opti­
ons (Параметры теней) düwmejik arkaly dolandyrylýar, ol Shadow 
Options (Параметры теней) gepleşik penjiresini açýar.

New Point Light (Новый точечный источник света) gepleşik 
penjiresi ýapylandan soň Lights (Источники света) gepleşik penji­
resine gaýdýarys. Täze çeşme hökmünde açylýan sanawda Distant 
Light (Удаленный) saýlamak mümkin. Şonda New (Новый) düw­
mejigi basylanda New Distant Light (Новый удаленный источник 
света) gepleşik penjiresi açylar.
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Light Name (Имя источника), Intensity (Интенсивность) 
meýdanlary hem-de Color (Цвет) we Shadows (Тени) meýdanlary 
öň seredilen New Point Light (Новый точечный источник света) 
penjiredäkilere meňzeş. Sun Angle Calculator (Положение солнца) 
düwmejigi Sun Angle Calculator (Положение солнца) gepleşik 
penjiresini açýar, şol penjirede Günüň anyk bir geografiki ýeriň belli 
wagtynda ýerleşmegini kesgitlemegi mümkin edýär.

Bu penjirede Geographic Location (Географическое поло­
жение) düwmejigi öz gezeginde Geographic Location (Геогра­
фическое положение) gepleşik penjiresini açmagy mümkin edýär, 
ol gerek bolan ýeriň giňişligini, uzaklygyny kartany we şäherleriň 
sanawyny ulanmaklyk bilen kesgitleýär. Hasaplanan ähmiýetler aw­
tomatiki ondan öňki penjirä geçirilýär.

New Distant Light (Новый удаленный источник света) 
penjiresiniň Azimuth (Азимут) we Altitude (Возвышение) meýdan­
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lary daşlaşdyrylan çeşmäniň geografiki koordinatalarda ýerleşmegini 
belleýär. Light Source Vector (Направление луча) töweregi çeşmäniň 
wektorynyň görkezilmegini ýa-da girizilmegini mümkin edýär.

Eger Lights (Источники света) penjirede täze çeşme hökmün­
de açylýan sanawda Spotlight (Прожектор) saýlanylsa, onda New 
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(Новый) düwmejigi açylanda New Spotlight (Новый прожектор) 
gepleşik penjiresi açylýar.

Bu penjire öňki çeşmelere bolan penjirelere meňzeş gelýär. Täze 
bolup Hotspot (Яркое пятно) we Falloff (Полный конус) meýdan­
lary çykyş edýär.

Sahnalar
Scene (Сцена) buýrugy 

we Render (Тонирование) 
paneliniň  düwmejigi Sce­
nes (Сцены) penjiresini açýar, 
ol penjire ulanylýan suratyň 
atlandyrylan sahnalaryny do­
landyrýar.

Sahna düşünjesi öz içi­
ne ýagtylygyň görnüşini we 
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çeşmesini alýar. Scenes (Сцены) 
penjiräniň çep böleginde at­
landyrylan sahnalaryň sanawy bar. 
Eger sahnalar bellenilmedik bolsa 
onda Scenes (Сцены) sanawy diňe 
*None* (*Het*) setiri saklaýar.

New (Новый) düwmeji­
gi New Scene (Новая сцена) 
gepleşik penjiresini çagyrýar.

Täze sahnany döretmek üçin 
Views (Виды) sanawynda gerek 

bolan görnüşiň adyny saýlamaly, Lights (Источники) sanawynda – 
hemme gerek bolan çeşmeleriň adyny saýlamak gerek. Eýýam saýla­
nylan çeşmelerine beýlekilere goşmak üçin <Ctrl> klawişany basyp 
durmaly. Scene Name (Имя сцены) täze sahna berilmeli at girizmeli.

Materiallar
Tonirlemegiň sazlamalaryny bellemegiň beýleki buýruk bolup, 

Render (Тонирование) paneliniň  düwmejigine gabat gelýän 
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Rmat (Материал) buýrugy bolup durýar, ol gurlan obýektlere materi­
allary belleýär. Buýruk Materials (Материалы) penjiresini çagyrýar.

Penjiräniň çep böleginde Materials (Материалы) sanawynda 
ulanylýan sanawa ýüklenen materiallaryň sanawy getirilen. *Glo­
bal* («Глобальный*) diýlip atlandyrylýan material hökmany suratda 
duş gelýär we üste eýe bolan hemme obýektlere berkidilýär. Hemme 
beýleki materiallary Matlib (Бибмат) buýruk arkaly ýa-da Render 
(Тонирование) paneliniň  düwmejigi arkaly importirlemek müm­
kin, olar Materials Library (Библиотека материалов) penjiräni ça­
gyrýar.

Şol penjiräniň çep böleginde Current Drawing (Текущий 
рисунок) töwereginde ulanylýan surata importirlenen materiallaryň 
sanawy getirilendir. Bu sanawy Purge (Очистить) düwmejigi ar­
kaly arassalamak mümkin ýa-da mli giňişlikli aýry faýl hökmünde 
ýatda saklamak mümkin. Ýokarky sag burçda Current Library 
(Текущая библиотека) töwereginiň açylan sanawynda ulanylýan 
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bibliotekanyň ady ýerleşen, onuň aşagynda bolsa, materiallarynyň sa­
nawy ýerleşdirilen. Deslapdan AutoCAD ulgamynyň render.mli atly 
standart bibliotekasy ulanylýar.

Eger materiallaryň sanawynda materialy saýlap Preview (Про­
смотр) düwmejige basylsa, onda şol materialyň görnüşini görmek 
bolar.

Materiallaryň importy şeýle ülňi boýunça ýerine ýetirilýär. Ge­
rekli material sanawda bellenilýär we soňra Import (Импорт) düw­
mejik arkaly ulanylýan suratyň materiallar sanawyna geçirilýär.

Hemme materiallar import edilenden soň Materials Library 
(Библиотека материалов) penjiräni ýapmaly. Mundan soň Materi­
als (Материалы) gaýtadan açylýar.

Materials (Материалы) penjiresinde hem Preview (Просмотр) 
düwmejigi bar. Modify (Изменить) düwmejigi bellenilen mate­
rial üçin Modify Standard Material (Изменение стандартного 
материала) penjiräni çagyrmagy we oňa käbir häsiýetnamalary üýt­
getmegi mümkin edýär.

Bu penjiräniň Attributes (Параметры) töwereginde 7 geçiriji 
bar:
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• Color/Pattern (Цвет/Текстура) – materialyň esasy reňki 
sazlanylýar (diffuz serpikme); Value (Значение) meýdany we 
Color (Цвет) töweregi bilen kesgitlenýär;
• Ambient (Рассеяние) – üst bilen serpikýän ýagtylygyň 
reňki sazlanylýar; Value (Значение) we Color (Цвет) bilen 
dolandyrylýar;
• Reflection (Отражение) – serpikýän üstde blikleriň reňki 
sazlanylýar; Value (Значение) we Color (Цвет) bilen do­
landyrylýar;
• Roughness (Шероховатость) – düz dälligiň derejesiniň saz­
lanmagy amala aşyrylýar (has düz üstde blikler az);
• Transparency (Прозрачность) – açyklygyň sazlanmasy 
ýerine ýetirilýär; Value (Значение) bilen dolandyrylýar; File 
Name (Имя файла) meýdanynda teksturanyň faýlynyň adyny 
bermek mümkin;
• Refraction (Преломление) – serpikmede şöhleleriň 
döwülmeginiň derejesi sazlanylýar. Value (Значение) bilen 
dolandyrylýar;
• Bump Map (Выдавливание) – gysyp çykarma effektine 
meňzetme ýerine ýetirilýär; teksturanyň faýlynyň ady File 
Name (Имя файла) meýdanynda bellenilýär.

Her material 4 görnüşinden birine eýe bolup bilýär, olar New 
(Новый) düwmejiginiň aşagynda ýerleşen açylýan sanawda ýerleş­
ýär: Standard (Стандартный), Granite (Гранит), Marble (Мра­
мор), Wood (Дерево) standart materialyndan tapawutlykda beýleki 
üç görnüş öz öwüşginini materiala goşýar (degişlikde granit, mermer 
ýa-da agaç). Standart bolmadyk görnüş alnanda Modify Standard 
Material (Изменение стандартного материала) gepleşik penjiresi 
öz adyny üýtgedýär (meselem, Granite (Гранит) görnüşi üçin penji­
re Modify Granite Material (Изменение материала Гранит) diýlip 
atlandyrylýar).

Materials (Материалы) gepleşik penjiresiniň Select (Выбор) 
düwmejigi obýekte öň berkidilen materialy kesgitlemegi mümkin 
edýär. Bu düwmejige basylandan soň AutoCAD wagtlaýynça Materi­
als (Материалы) ýapýar we suratda obýekti görkezmegi hödürleýär. 



334

Soňra gaýtadan Materials (Материалы) penjiresi açylýar, ýöne sa­
nawda bellenilen material bilen.

Materialy berkitmek üçin sanawda bellemeli we soňra Attach 
(Присвоить) düwmejigi basmaly. AutoCAD Materials (Материалы) 
penjiresini ýapyp obýektleri sorar. Obýektler görkezilenden soň ma­
teriallar berkidilýär we Materials (Материалы) penjiresi işi dowam 
etmek üçin gaýtadan açylýar.

Berkidilen materialy aýyrmak gerek bolsa Detach (Снять) düw­
mejige basmaly. Materialy berkitmegiň ýene iki mümkinçiligi bar: 
reňk we gat boýunça. By Aci (По Ица) düwmejigi reňkiň belgisini 
material bilen, By Layer (По слою) düwmejigi bolsa material bilen 
gaty baglaşdyrýar.

Setuv (Налтек) buýrugy we oňa gabat gelýän Render (Тони­
рование) paneliniň  düwmejigi teksturalary üstünden goýmagy 
mümkin edýär.

Fon we duman
Background (Фон) buýrugy we Render (Тонирование) pane­

liniň  düwmejigi tonirlemede fony döretmek üçin ulanylýar we ýe­
rine ýetirilende Background (Фон) gepleşik penjiresini açýarlar.
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Bu penjirede fonuň görnüşini saýlamak gerek:
• Solid (Сплошной) – bir reňkli fony belleýär;
• Gradient (Переход) – iki ýa-da üç reňklerden bolan bir­
sydyrgyn geçýän fony kesgitleýär;
• Image (Изображение) – rastr faýlyndan bolan fony belleýär;
• Merge (Слияние) – fon hökmünde görnüş ekranyň düzü­
mini kesgitleýär (diňe Render (Тонирование) penjiresinde 
Destination (Вывод) bölümiň açylýan sanawynda Viewport 
(Видовой экран) bendi saýlanylan bolsa mümkin); bu ýag­
daýda adaty tonirlemede ýitýän obýektler görünýär.

Fog (Туман) buýrugy we oňa gabat gelýän Render 
(Тонирование) paneliniň  düwmejigi dumanyň effektini gazan­
magy mümkin edýär. Buýruk Fog/Depth Cue (Туман/Затемнение) 
penjiresini açýar.
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Bu penjirede eger duman bilen tonirlemeklik gerek bolsa, Ena­
ble Fog (Включить туман) baýdajygy goýmaly, ýogsam beýleki 
meýdanlar elýeterli bolmaz. Dumanyň reňkiniň we depginliliginiň 
sazlanylmagy penjiräniň degişli düwmejikleri arkaly amala aşyrylýar.

Landşaftyň elementleri
Lsnew (Ландновый) buýrugy we oňa gabat gelýän Render 

(Тонирование) paneliniň  düwmejigi tonirlemede landşaftyň ele­
mentini goşmagy mümkin edýär. Buýruk Landscape New (Новый 
ландшафт) gepleşik penjiresini çagyrýar.

Bu penjirede landşaftyň elementiniň adyny saýlamaly. Preview 
(Просмотр) düwmejigi saýlanylan elementi görmegi mümkin edýär. 
Goýmazdan öň şekiliň parametrleri (Geometry (Геометрия) töwere­
gi) we ölçegleri (Height (Высота) meýdany) bellenilýär.

Position (Положение) düwmejik arkaly landşaftyň elementi 
suratyň meýdanynda ýerleşdirilýär. Tonirlemeden daşarda goýlan ele­
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mentler üçburçluk görnüşe eýe. Tonirlemede olar şekili janlandyrmak 
üçin fona goşulýar.

Lsedit (Ландред) buýrugy goýlan elementiň parametrlerini üýt­
getmegi mümkin edýär, Lslib (Ланд-Биб) buýrugy bolsa – landşaftlar 
bibliotekasynda saklanylýan elementleri görmegi, üýtgetmegi we 
goşmagy mümkin edýär.

Gyraňlar we torlar
Tonirlemede obýektleriň üstleri açyk bolmaz ýaly, olar ýörite usul 

bilen döredilen bolmalydyr. Silindriň (gysylyp çykarylan tegelegiň) 
hemme üstleri iki ölçegli karkasyň düzgüninde görünmeýän çyzyk­
lar ýaşyrylandan açyk däl bolýarlar, gysylyp çykarylan gönüburçluk 
görnüşindäki ýarym çyzykda bolsa diňe gapdal diwarlary açyk däl. 
Gönüburçlugyň özi tutuş tekiz obýekt bolup durmaýar, ol diňe sudura 
eýe.

Açyk däl üçburçluklar we dörtburçluklar üçin AutoCAD-da ýöri­
te obýekt bar – gyraň. Üznüksiz ýerleşen gyraňlar «torlara» birleş­
dirilip bilner.

Draw > Surfaces > 3D Surfaces (Рисование > Поверхности 
ЗМ поверхности) bendi saýlamaly. Ekranda 3D Objects (ЗМ 
объекты) gepleşik penjiresi emele geler.

22. Sargyt 1372
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Bu penjirede 9 obýekt elýeterli (Box3d (ЗМ ящик), Pyramid 
(Пирамида), Wedge (Клин), Dome (Купол), Sphere (Сфера), Cone 
(Конус), Torus (Top), Dish (Чаша) we Mesh (Сеть)), olaryň para­
metrleri goýlandan soň, suratda dörtburçlukly we üçburçlukly öýjükli 
torlar gornüşindäki üstler bilen gurlarlar.

Hemme öýjükler görünmeýän çyzyklary ýaşyrmak, reňklemek 
we tonirlemek amallary açyk däl.

Surfaces (Поверхности) gurallar panelinde gyraňlar we torlar 
bilen işlemedik adamlar üçin hemme amallaryň düwmejikleri bar.

Birinji  düwmejigi tekiz dörtburçluklary çyzmagyň Solid 
(Фигура) buýrugyny çagyrýar.

Figuralar goşmaça häsiýete eýe – olar açyk däl. Figura tekiz 
(ikiölçegli) obýekt bolup durýar we XY tekizligine parallel bolan te­
kizlikde ýerleşýär.

3Dface (3-Грань) buýrugy we oňa gabat gelýän Surfaces 
(Поверхности) paneliniň  düwmejigi hem-de Draw > Surfaces 
> 3D Face (Рисование > Поверхность > ЗМ грань) bendi hem ýö­
nekeý dörtburçluklary gurýarlar, emma olar eýýam üçölçegli obýekt 
bolup durýar we olaryň depesi bir tekizlikde bolman hem bilýär.

Buýrugyň birinji soragy: Specify first point or [Invisible]: 
(Первая точка или (Невидимая):)

Invisible (Невидимая) buýrugy saýlanylsa, onda birinji nokat­
dan ikinjä barýan gyraň erňegi, görünmeýän bolar. Şol opsiýa saýla­
nylandan soň AutoCAD birinji nokadyň soragyny gaýtalar. Eger bi­
rinji nokat berilse indiki sorag berler:

Specify second point or [Invisible]: (Вторая точка или 
[Невидимая]:)

Bu ýerde Invisible (Невидимая) opsiýanyň saýlanylmagy, ikin­
ji we üçünji nokatlaryň arasyndan geçýän erňek görünmeýän bolar. 
Ikinji nokat girizilenden soň: Specify third point or [Invisible] 
<exit>: (Третья точка или [Невидимая] <выход>:)
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Eger bu ýagdaýda <Enter> klawişasy basylsa, onda buýruk öz 
işini tamamlar. Soňra üçünji nokat girizilenden soň:

Specify fourth point or [Invisible] <create three-sided face>: 
(Четвертая точка или [Невидимая! <создать треугольную грань>:)

Bu ýagdaýda <Enter> klawi­
şanyň basylmagy üçburçluk gyraňy 
döredýär (ýagny üçünji we dördün­
ji nokatlar gabat gelýär). Dördünji 
nokat görkezilenden soň bolsa ýene 
üçünji nokat barada sorag berler.

Edge (Кромка) buýrugy we 
oňa gabat gelýän Surfaces (Поверх­
ности) paneliniň  düwmejigi gy­
raňlaryň we torlaryň erňekleriniň görünmegini üýtgetmegi mümkin 
edýär. Erňekleriň görünmegini üýtgetmegiň amatly guraly bolup Pro­
perties (Свойства) penjiresi bolup durýar.

Torlary Explode (Расчленить) buýrugy arkaly gyraňlara bölmek 
mümkin, özem bir öýjükden bir gyraň emele geler.

Standart görnüşli hemme torlar çyzmalaryň ulanylýan tekizligine 
göräleýin gurulýar, şol sebäpli şeýle obýekti döretmezden öň gerekli 
ПСК geçmek gerek.

8 sany standart üstleriň gurulmagy diňe Surfaces (Поверхнос­
ти) paneliniň düwmejikleri bilen däl-de, eýsem 3D (ЗМ) buýruklary 
arkaly hem gurlup bilner.

Standart üstüň gurulmagyny gönüburçluk parallelepipediň esa­
synda seredeliň:

Select option [Box/Cone/Dish/Dome/Mesh/ Pyramid/Sphere/
Torus /Wedge]: (Задайте опцию [Ящик/Конус/Чаша/Купол/Сеть/
Пирамида/Сфера /Тор/Клин]:)

Box (Ящик) opsiýasyny saýlamaly. Indiki sorag:
Specify comer point of box; (Угловая точка ящика:)
Birinji burçuň nokadyny görkezmeli. Soňra:
Specify length of box: (Длина ящика:)
Uzynlygy san bilen ýa-da nokat bilen görkezmeli. Soňra: Speci­

fy width of box or [Cube]: (Ширина ящика или {Куб/:)
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Ini san bilen ýa nokat arkaly, ýa-da Cube (Куб) opsiýasyny 
saýlamaly. Eger in berlen bolsa, ýagny gapyrjak kub bolmadyk bolsa, 
onda goşmaça sorag berler:

Specify height of box: (Высота 
ящика:)

Indi hemme ölçegler bellenilen, 
emma ýene gapyrjagy Z okunyň da­
şyndan aýlamak bolýar. Indiki sorag:

Specify rotation angle of box 
about the Z axis or [Reference]: 
(Угол поворота ящика вокруг оси Z 
или /Опорный угол]:)

Umumy ýagdaýda tor bu bir ugry boýunça belli bir nokatlaryň 
sany (М), beýleki ugur boýunça bolsa nokatlaryň beýleki sany (N) 
bolan obýekt. Bu ugurlary – М-ugur we N-ugur diýlip atlandyrylýar. 
Degişlilikde öýjükleriň umumy sany (М – 1)-ň (N – 1)-a bolan köplük 
hasyly bolup durýar. Torlar ýapyk we ýapylmadyk bolup bilerler, özem 
ýapylmagy bir ýa-da iki ugur boýunça bolmagy mümkin. Belli bir ugur 
boýunça ýapylmadyk tor Pedit (Полред) buýrugy arkaly ýapylyp bilner.

3Dmesh (3-Сеть) buýrugy we oňa gabat gelýän Surfaces 
(Поверхности) paneliniň  düwmejigi toruň depesiniň koordinata­
lary boýunça ýapylmadyk islendik tory gurmagy mümkin edýär.

Buýrugyň birinji soragy: Mesh M size: (Размер сети в 
направлении М:)

M ugur boýunça toruň ölçegini kesgitleýän 2-den 256-e çenli bolan 
sany girizmeli Soňra: Mesh N size: (Размер сети в направлении N:)

Edil ýokarky ýaly jogap bermeli. Soňra toruň her depesi boýun­
ça soraglar berler. Her ugur boýunça nokatlar 0-dan М – 1-çenli we 
0-dan N – 1-e çenli belgilenýär. Meselem: Vertex (0, 0): (Положение 
вершины (0, 0):)

Soňra nobat boýunça beýleki depeler 
gurulýar (0, 1), (0, 2), (0, 3), (1, 0), (1, 1), 
(1, 2), (1. 3), (2, 0), (2, 1), (2, 2), (2, 3).

 düwmejigi we oňa gabat gelýän 
Revsurf (П-Вращ) buýrugy giňişlikde 
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kesimiň daşyndan çyzyk aýlananda emele gelýän 
üsti almagy mümkin edýär.

 – süýşmegiň üstüni döredýär, ol bir 
egri çyzygyň beýlekä görä hereketinden 
alynýar (Tabsurf (П-Сдвиг) buýrugy);

 – bir çyzykdan beýlekä birsydyrgyn 
geçilende emele gelýän birleşme üsti 
döredýär (Rulesurf (П-Соед) buýrugy);

 – ýapyk egriçyzykly dörtbuçlugy emele getirýän erňekleriň 
arasynda Kuns üsti döredýär (Edgesurf (П-Кромка) buýrugy).

Bu dört buýrukda Surftab1 we Surftab2 üýtgeýänler uly orun 
oýnaýar.

Töwerekler
Töwerek – iki ölçegli obýekt, ol ýapyk sudur bilen çäklendirilip 

we içlige eýe. Töwerekde deşikler bolup biler. Töwerekleri goşup we 
aýyrmak mümkin. Olar açyk däl (deşik bolup durýan meýdanlardan 
başga). Töwerekler – çylşyrymly görnüşli jisimleri gurmak üçin ula­
nylyp bilner (gysyp çykarma ýa-da aýlama arkaly).

Islendik tekiz ýapyk sudury (tegelegi, ýapyk ýarym çyzygy, ýa­
pyk döwük görnüşindäki kesimleri we olara meňzeş beýleki obýekt­
leri) töwerek edip bolýar. Munuň üçin Region (Область) buýrugy 

ulanylýar, oňa Draw (Рисование) paneliniň  düwmejigi we Draw 
(Рисование) menýusynyň Region (Область) bendi gabat gelýär.

Region (Область) buýrugy obýektleri soraýar we olar saýlany­
landan soň döredilen töwerekleriň sany barada habar berýär.

Töwerekleriň üstünden birleşdirme, aýyrma we kesişme amal­
lary ýerine ýetirmek mümkin. Bu amallaryň düwmejikleri Solids Edi­
ting (Редактирование тел) gurallar panelinde ilkinji üç düwmejik 
bolup durýar.
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Aşakdaky suratda üç töwerekleriň birine birleşmegi görkezilen. 
Degişli gurallar – Union (Объединение) buýrugy we Solids Editing 
(Редактирование тел) paneliniň  düwmejigi.

Aşaky suratda obýektleriň aýrylmagy görkezilen. Degişli gurallar 
Subtract (Вычитание) buýrugy we Solids Editing (Редактирование 
тел) paneliniň  düwmejigi.

Aşaky suratda üç töweregiň kesişmesi görkezilen. Kesişme 
amaly üçin Intersect (Пересечение) buýrugy we oňa laýyk gelýän 
Solids Editing (Редактирование тел) paneliniň  düwmejigi ula­
nylýar.

Eger kesişmeýän töwerekler birleşdirilse, onda köp baglanyşyk­
ly daşky sudura eýe bolan töwerek emele geler. Explode (Расчле­
нить) buýrugy töweregi ýönekeýlere bölýär (kesimlere, halkalara, 
tegeleklere, ellipslere, splaýnlara).

Jisimler
Üç ölçegli torlar, olar ýapyk hem bolsalar içliksiz bolan obýekt­

lerdir. Içlige şeýle hem gysylyp çykarylan iki ölçegli obýektler hem 
eýe däl (meselem, silindr).
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Jisimler diýlip atlandyrylýan obýektler içlige eýe we olaryň 
göwrümini birleşdirmek, aýyrmak we kesişdirmek mümkin.

Jisimler standart jisimleri gurmagyň buýruklary ulanylanda eme­
le gelýär (gapyrjaklar, konuslar, şarlar we ş.m.), şeýle hem töwerekle­
ri aýlamagyň we gysyp çykarmagyň netijesi hökmünde çykyş edýär­
ler. Jisimleri böleklere kesip bolýar we tekizlikler arkaly kesimlerini 
alyp bolýar.

AutoCAD ulgamynda gaty jisimli modeli döretmek üçin ony pi­
kir bilen ilkibaşda ýönekeý standart böleklere bölmeli. Soňra logiki 
amallary arkaly (birleşdirme, aýyrma we kesişme), şeýle hem redak­
tirleme amallary arkaly gerekli görnüşli obýekti döretmeli.

Jisimleri gurmak
Solids (Тела) gurallar panelinde jisimleri gurmagyň düwmejik­

leri bar.

Bu paneliň birinji düwmejikleri standart gaty jisimli obýektleri 
gurmak üçin niýetlenen. Bu düwmejiklere degişlilikde şu buýruklar 
gabat gelýär: Box (Ящик), Sphere (Шар), Cylinder (Цилиндр), 
Cone (Конус), Wedge (Клин) we Torus (Top).

Box (Ящик) buýrugy arkaly МСК-da gaty jisimli parallelepipedi 
guralyň. Arassalanan grafiki ekranda günorta-günbatar izometriýany 
görnüş hökmünde goýmaklyk ündelýär.

Box (Ящик) buýrugyň birinji soragy:
Specify corner of box or [Center]<0,0,0>: (Угол ящика или /

Центр/ <0,0,0>:)
<Enter> klawişasy basylsa – bu 

gapyrjagyň birinji burçunyň nokady 
deslapdan saýlanylan, ýagny МСК-nyň 
başynda ýerini alar. Center (Центр) 
opsiýasynyň saýlanylmagy gapyrjagy bi­
rinji burçdan däl-de parallelepipediň mer­
kezinden gurlup başlamaklyga getirer. 
Indiki sorag:
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Specify corner or [Cube/Length]: (Угол или [Куб/Длина]:)
Bu ýerde gapyrjagyň beýleki burçunyň nokadyny bermek müm­

kin. Cube (Куб) opsiýasy kubuň gurulmagyna getirer. Length (Длина) 
opsiýasyny saýlaň. Soňra gapyrganyň uzynlygyny görkezmeli:

Specify length: (Длина:) 400. Soňra:
Specify width (Ширина:) ini girizmeli 350. Soňra:
Specify height: (Высота:) beýikligi bermeli 200.
Indi gapyrjagyň ýokarky üstünde radiusy 100 mm we beýikligi 

150 mm bolan silindri guralyň. Cylinder 
(Цилиндр) buýrugy sorar:

Current wire frame density: Iso­
lines=4 Specify center point for base 
of cylinder or [Elliptical] <0,0,0>: (Те­
кущая плотность каркаса: Isolines=4 
Центральная точка основания ци­
линдра или [Эллиптический] <0,0,0>:)

200,175, 200 nokady belläli. Soňra:
Specify radius for base of cylinder or [Diameter]: (Радиус 

основания цилиндра или [Диаметр]:)
Radiusy 100 girizeliň.
Specify height of cylinder or [Center of other end]: (Высота 

цилиндра или [Центр другого основания]:)
Silindriň beýikligini 150 girizeliň.
AutoCAD silindri emele getiriji çyzyk­

larynyň sanyny (dört) Isolines ulgamlaýyn 
üýtgeýäniň bahasyna deň edip alýar.

Başlangyç ýagdaýda suratda olar diňe iki 
bolup görünýär. Emma obýektiň öňki tara­
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pynyňky bilen yzyndakysy gabat gelýär. Emele getiriji çyzyklaryň 
sanyny 28-e çenli artdyralyň. Munuň üçin buýruk setirinde: Isolines 
ýazmaly we <Enter> basmaly:

New value for Isolines <4>: (Новое значение Isolines <4>:). 
28 girizmeli. Ekrany regenerasiýa etmeli – View (Вид) menýunyň 
Regen (Регенерировать) bendini saýlamaly ýa-da Regen (Реген) 
buýrugy girizmeli.

Indi bolsa gapyrjagyň bize golaý sag gapdal diwarynda beýle­
ki gapyrjagy guralyň, ol soňra çuňlaşdyrma bolar. Munuň üçin Täze 
Пск-ny sag gapdal diwar boýunça gurnalyň. Munuň üçin Ucs (Пск) 
paneliniň  düwmejigini ulanalyň:

Select face of solid object: (Выберите грань твердотельного 
объекта:) Syçanjyk bilen gapyrjagyň sag öňki diwarynyň aşaky ga­
pyrgasyna basalyň. Sag gyraň yşyklanar we sorag emele geler:

Enter an option [Next/Xflip/Yflip] <accept>: (Задайте опцию 
[Сменить/обратитьХ/обратитьУ] <принять>:)

Eger koordinatalar ulgamynyň piktogrammasy aşaky suratdaky 
ýaly görünýän bolsa onda ylalaşmak üçin <Enter> klawişasyny bas­
maly.

Indi Box (Ящик) buýrugy arkaly gapyrjagy guralyň, onuň 
burçunyň nokadyny (100,0,0), ikinji burçuňkyny – (300,–170,0), 
beýikligi bolsa – 250 mm edip girizeliň. Esasy gapyrjagyň içinde 
ikinjisi emele geler.

Indi bolsa  we  düwmejikleri arkaly uly gapyrjagy si­
lindr bilen birleşdireliň, emele gelen düzüm jisimden kiçi gapyrjagy 
aýralyň.

Indi bolsa öň seredilen Chamfer (Фаска) we Fillet (Сопряжение) 
jisimlere ulanalyň.
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Jisimleri gysyp çykarma we aýlama usullary arkaly gurmak 
mümkin. Bu amallar Тела (Solids) paneliniň  we  düwmejikle­
ri arkaly amala aşyrylýar. Bu düwmejikler Extrude (Выдавить) we 

Revolve (Вращать) buýruklara gabat gelýär.
Mysal hökmünde Extrude (Выдавить) 

buýrugy arkaly turbanyň gaty jisimli 
meýdanynyň gurulmagyna seredeliň. Boş 
ekranda görnüş hökmünde günorta-günba­
tar izometriýany goýalyň. Merkezleri ko­
ordinatalar başynda bolan iki sany tegelegi 
degişlilikde 100 we 80 radius bilen çyzalyň. 
Olary töwereklere özgerdeliň. Uly töwerek­
den kiçini aýryp halka görnüşindäki töwere­
gi alalyň.

Görkezilen suratda halkadan başga gysylyp çykarmagyň ýoly 
hem görkezilen. Ony gurmak üçin Ucs (Пск) paneliniň  düwme­
jigi arkaly панели инструментов Ucs (Пск) oklary öwreliň (diklik 
ýagdaýa çenli). Täze koordinatalar ulgamynda üç segmentden yba­

rat bolan ýarym çyzygy guralyň: olaryň bi­
rinji gönüçyzykly bolup durýar we depeleri 
(0,0) we (0,500) nokatlarda, ikinjisi – halka­
laýyn, birinjä galtaşýar we (100,600) nokatda 
tamamlanýar, üçünjisi – ýene gönüçyzykly 
halkalaýyn bölege galtaşýar we (1000,600) 
nokatda tamamlanýar (hemmesinde z koordi­
natasy 0 deň Extrude (Выдавить) buýrugy 
çagyralyň. Obýektleri saýlamak barada sora­

ga halkany görkezmeli. Indiki sorag: Specify height of extrusion or 
[Path]: (Глубина выдавливания или [Траектория]:)

Path (Траектория) opsiýany saýlamaly. Soňra ulgam sorar:
Select extrusion path: (Траектория выдавливания:)
Ýarym çyzygy görkezeliň.
Interfere (Взаимод) buýrugy iki we köp jisimleriň göwrümini 

tutýan jisimi döretmegi mümkin edýär. Buýruga  düwmejigi gabat 
gelýär.
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Kesişler
Slice (Разрез) buýrugy we oňa gabat gelýän Тела (Solids) 

paneliniň  düwmejigi, tekizlik bilen jisimi iki jisime kesmegi 
mümkin edýär we gerek bolanda olaryň birini ýok edýär.

Ucs (Пск) buýrugy arkaly МСК geçeliň. Syçanjyk bilen  
düwmejige basalyň we obýektler barada sorag berlende öň çyzylan 
turbany görkezeliň.

Indiki sorag: Specify first point on slicing plane by [Object/Za­
xis/View/XY/YZ/ZX/3points] <3points>: (Первая тонка на режу­
щей плоскости [Объект/2ось/Вид/Х¥/¥2/7Х/Зточки] <3точки >:)

<Enter> klawişany basyp kesimi üç nokat arkaly ýerine ýetir­
megi tassyklaýarys. Soňra yzygiderli soraglara jogap berip, aşakdaky 
nokatlary girizmeli: (100,-50,100), (-100,80,100) we (300,0,600). 
Indi ulgama haýsy jisimleri galdyrmak barada habar bermeli:

Specify a point on the desired side of the plane or [keep Both 
sides]:

(Укажите точку с нужной стороны от плоскости [Обе 
стороны]:)

Keep Both sides (Обе стороны) 
opsiýany saýlalyň. Turba iki jisime 
bölüner, özem bir jisimde iki sany 
kesişmeýän bölek bolar. Bir jisimi çepe 
süýşüreliň. Netije aşakdaky suratda.

Sag jisimi gerek bolanda iki 
aýratyn jisime Solids Editing (Редак­
тирование тел) paneliniň  düwmejigi arkaly bölmek mümkin.

Section (Сечение) buýrugy we oňa gabat gelýän Solids (Тела) 
paneliniň  düwmejigi, jisimiň kesimini döredip, kesimiň çyzyk­
laryny saklaýan töweregi emele getirýär, soňkuny çykaryp çyzgyda 
ulanmak mümkin.

Jisimleri redaktirlemek
Jisimleriň üstünden umumy redaktirlemegiň buýruklaryny ýeri­

ne ýetirmek mümkin (ýok etme, süýşürme, göçürme we ş.m.). Mo­
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dify (Редакт) menýusyna 3D Operation (3M операции) kömekçi 
menýu girýär, onda şeýle peýdaly bendler ýygnanylan:

• 3D Array (3M массив) – üç ölçegli massiwiň döredilmegi 
(3Darray (3-Массив) buýrugy);
• Mirror 3D (ЗМ зеркало) – berlen tekizligine görä 
obýektleriň aýna serpikdiriş görnüşiniň döredilmegi (Mir­
ror3d (3-Зеркало) buýrugy);
• Rotate 3D (ЗМ поворот) – obýektleriň giňişlikde islendik 
okuň daşyndan öwrülmegi (Rotate3d (3-Повернуть) buýrugy);
• Align (Выровнять) – obýektleriň beýleki nokatlar we obýekt­
ler bilen iki ölçegli we üç ölçegli giňişliklerde deňleşmegi 
(Align (Выровнять) buýrugy).

Jisimleriň eljagazlaryny süýndürme, gyraňlaryň we gapyrgalaryň 
modifikasiýasy ýaly amallary ulanmak bolmaýar. Munuň üçin Solids 
Editing (Редактирование тел) gurallar paneli göz öňünde tutulan.

Solidedit (Редтел) buýrugyň opsiýalaryna gabat gelýän düwme­
jikler:

•  – jisimleriň gyraňlarynyň berlen çuňluga ýa-da ýol 
boýunça gysylyp çykarylmagy;
•  – jisimiň gyraňlaryny berlen aralyga geçirmek;
•  – gyraňlaryň berlen aralyga ýa-da görkezilen nokada çen­
li deňölçegli süýşürilmegi;
•  – jisimleriň gyraňlarynyň baglaşdyrmalar we faskalar bi­
len ýok edilmegi;
•  – berlen ok boýunça gyraňlaryň öwrülmegi;
•  – berlen burç boýunça gyraňlaryň konusa özgerdilmegi;
•  – jisimiň gyraňlarynyň töwerek ýa-da gaty jisimli 
gabyklar görnüşindäki göçürmelerini döretmek;
•  – aýry gyraňlaryň reňkiniň üýtgedilmegi;
•  – jisimiň gapyrgalarynyň kesimler, halkalar, tegelekler 
ýa-da splaýnlar görnüşindäki göçürmeleriniň döredilmegi;
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•  – gapyrgalaryň reňkiniň üýtgedilmegi;
•  – gyraňda tagma döretmek (beýleki obýektiň yzy bolup 
durýan täze gapyrganyň döredilmegi);
•  – artykmaç gapyrgalaryň we depeleriň ýok edilmegi;
•  – köpbaglanyşykly jisimleri (giňişlikde birnäçe ýapyk 
göwrümleri tutýan) aýry jisimlere bölmek;
•  – berlen galyňlykly boş inçe diwarjykly gabygyň döre­
dilmegi;
•  – obýektiň ýol bererli jisimdigi baradaky barlag.

Hemme bu amallar şeýle hem Modify (Редакт) menýusynyň 
Solids Editing (Редактирование тел) kömekçi menýusy arkaly hem 
ýerine ýetirilip bilner.

Solidedit (Редтел) buýrugy aşaky habardan öz işini başlaýar:
Solids editing automatic checking: Solidcheck=1 Enter 

a solids editing option [Face/Edge/Body/Undo/Exit] <Exit>: 
(Автоматическая проверка тел при редактировании: Solidcheck=1 
Задайте опцию редактирования тела {Грань/Ребро/Тело Acis/
Отменить/ Выход] <Выход>:)

Birinji soragda Solidedit (Редтел) buýrugy dört opsiýany hödürleýär:
• Face (Грань) – gyraňlary redaktirlemek düzgüni;
• Edge (Ребро) – gapyrgalary redaktirlemek düzgüni;
• Body (Тело ACIS) – jisim bilen işlemegiň ýörite düzgüni 
(barlag, tagma goýmak we ş.m.);
• Undo (Отменить) – iň soňky amaly ýatyrmak;
• Exit (Выход) – buýrugyň işini tamamlamak.

Tejribe işleri
1. Radiusy R=30 bolan tegelekden beýikligi 100 bolan silindr gurmaly.
2. Deň taraply üçburçlukdan beýikligi 70 bolan piramida gurmaly.
3. Deň taraply üçburçlugy aýlamak arkaly konus gurmaly.
4. Bedräniň şekilini gurmaly.
5. Aýna penjiresini gurmaly.
6. Diwarlary bolan otagy gurmaly.
7. Gül goýulýan küýzäni gurmaly.
8. Daşky radiusy 40 we içki radiusy 30 bolan egri turbany gurmaly.
9. Basgançaklary gurmaly.
10. Ýönekeýje minarany gurmaly.
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